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    Για την ολοκλήρωση της συγγραφής ενός βιβλίου, εκτός από τη συγγραφική ομάδα υπάρχει πάντα μια πληθώρα ατόμων που την επηρέασε με άμεσο ή με έμμεσο τρόπο. Για το παρόν σύγγραμμα, το κύριο υλικό προέρχεται από τη διδασκαλία τα τελευταία 15 χρόνια σχετικών με το αντικείμενο προπτυχιακών και μεταπτυχιακών μαθημάτων, στο Τμήμα Γεωγραφίας του Χαροκόπειου Πανεπιστημίου. Οι παρατηρήσεις, τα σχόλια και οι ερωτήσεις των φοιτητών Γεωγραφίας αποτέλεσαν σε πολλές περιπτώσεις πηγή έμπνευσης. Επιπρόσθετα, σημαντική ήταν και η συνεισφορά των συναδέλφων μελών ΔΕΠ του τμήματος Γεωγραφίας καθώς η αλληλεπίδραση μαζί τους, μέσα από την καθημερινή εκπαιδευτική διαδικασία αλλά και τις ερευνητικές μας εργασίες, διαμόρφωσε αρκετές ιδέες αλλά και υλικό το οποίο παρουσιάζεται στο βιβλίο. Σημαντική επίσης ήταν και η υποστήριξη, κυρίως σε τεχνικά και διαδικαστικά θέματα, της ομάδας υποστήριξης του προγράμματος ¨ΚΑΛΛΙΠΟΣ¨ του Εθνικού Μετσόβειου Πανεπιστημίου, την οποία και ευχαριστώ. Ονομαστικά θα ήθελα να ευχαριστήσω θερμά τους άμεσους συνεργάτες μου, μέλη της συγγραφικής ομάδας κα Μαρία Γκούσια και κο Γιώργο Χαλκιά για την γλωσσική επιμέλεια και την τεχνική υποστήριξη - επιμέλεια του εποπτικού υλικού αντίστοιχα. Επίσης θα ήθελα να ευχαριστήσω θερμά τον κριτικό αναγνώστη καθ. Βασίλη Παππά – με τον οποία συνεργαστήκαμε άψογα - για τις ιδιαίτερα εποικοδομητικές παρατηρήσεις του σχετικά με τη διαμόρφωση και το περιεχόμενο του βιβλίου. Τέλος, θα ήθελα να ευχαριστήσω για την βοήθεια και την κατανόηση όλους όσους με στήριξαν με διάφορους τρόπους κατά τη διάρκεια της συγγραφής του βιβλίου σε προσωπικό επίπεδο.
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    Κοινωνικές ομάδες και μεμονωμένα άτομα διαχειρίζονται καθημερινά πληροφορίες και λαμβάνουν αποφάσεις οι οποίες σχετίζονται με τον χώρο. Έτσι, είναι φανερό ότι τα γεωγραφικά ή χωρικά δεδομένα παίζουν καθοριστικό ρόλο σε πολλές πτυχές της καθημερινότητας. Όταν χρησιμοποιούμε έναν τουριστικό χάρτη, όταν καλούμαστε να επιλέξουμε τοποθεσία εγκατάστασης ή όταν επιχειρούμε να χρησιμοποιήσουμε ένα κινητό τηλέφωνο, εξαρτώμαστε ή χρησιμοποιούμε – άμεσα ή έμμεσα – χωρικά δεδομένα. Στην περίπτωση της χρήσης του χάρτη υφίσταται μια άμεση σχέση με τα χωρικά δεδομένα ενώ στο παράδειγμα της χρήσης του κινητού τηλεφώνου, η επιτυχής η όχι κλήση εξαρτάται από την τοποθέτηση των κεραιών κινητής τηλεφωνίας οι οποίες βρίσκονται σε οπτική επαφή με τη θέση μας. Σε όλες αυτές τις περιπτώσεις, η χρήση της γεωπληροφορικής έχει καθοριστική σημασία καθώς με τις εφαρμογές της, όπως για παράδειγμα με τα Γεωγραφικά Πληροφοριακά Συστήματα (Geographical Information Systems - GIS), την Τηλεπισκόπηση (Remote Sensing - RS) και τα Συστήματα Παγκόσμιου Εντοπισμού Θέσης (GPS), συντελούνται οι μετασχηματισμοί ακατέργαστων γεωγραφικών δεδομένων σε χρήσιμες γεωγραφικές πληροφορίες μέσα από λειτουργίες παραγωγής, εισαγωγής, τροποποίησης, διαχείρισης, ανάλυσης και απόδοσης/οπτικοποίησης χωρικών δεδομένων.


    Η διαδικασία της ανάλυσης, μεθοδολογικά, βασίζεται στην αποδόμηση ενός προβλήματος με στόχο την καλύτερη κατανόησή του και την επίλυσή του. Η κύρια επιδίωξη του συγγράμματος είναι η παρουσίαση μεθόδων και τεχνικών για την ανάλυση γεωγραφικών δεδομένων με την αξιοποίηση της Γεωπληροφορικής με ιδιαίτερη έμφαση στην αξιοποίηση των ΓΠΣ. Στα κεφάλαια του βιβλίου παρουσιάζονται προσεγγίσεις


    · Επιλογής γεωγραφικών οντοτήτων και περιοχών με βάση τη θεματική τους διάσταση, δηλαδή τα περιγραφικά τους χαρακτηριστικά. Ένα παράδειγμα αυτού του τύπου είναι η επιλογή των παράκτιων περιοχών της Ελλάδας (με υψόμετρο 0-50μ).


    · Στατιστικής επεξεργασίας ιδιοτήτων γεωγραφικών αντικειμένων. Για παράδειγμα, μπορούμε να αναζητήσουμε την εύρεση της μέσης πυκνότητας πληθυσμού των περιοχών εντός ζώνης απόστασης < 2000μ από την εθνική οδό Αθηνών – Θεσσαλονίκης.


    · Αναγνώρισης περιοχών οι οποίες συγκεντρώνουν έναν συνδυασμό χαρακτηριστικών μέσα από τεχνικές υπέρθεσης χαρτών (π.χ. αναζήτηση περιοχών της Κρήτης οι οποίες έχουν δασική κάλυψη γης, βρίσκονται σε χρονοαπόσταση μικρότερη των 15΄από πόλεις με πληθυσμό μεγαλύτερο από 10000 κατοίκους και έχουν κλίση εδαφών μικρότερη από 10%.


    · Χαρτογράφησης σύνθετων γεωγραφικών φαινομένων μέσα από πολυκριτηριακή ανάλυση παραμέτρων που σχετίζονται με αυτά.


    · Κατασκευής μοντέλων λήψης χωρικών αποφάσεων στα οποία λαμβάνονται υπόψη τόσο οι απόψεις του αναλυτή και των εμπειρογνωμόνων όσο και οι απόψεις των πολιτών


    · Εκτιμήσεις σχετικά με διαμόρφωση του τοπίου μέσα από την κατασκευή και αξιοποίηση ειδικών μοντέλων προσομοίωσης του αναγλύφου.


    Όλα τα παραπάνω εδράζονται στο θεμελιώδες σκεπτικό της καταγραφής και αξιοποίησης των βασικών διαστάσεων των γεωγραφικών δεδομένων: της χωρικής, της θεματικής και της χρονικής διάστασής τους.


    Η έμφαση στα κεφάλαια του βιβλίου δεν δίνεται στην απλή εκμάθηση τεχνικών και λογισμικών, αλλά πολύ περισσότερο στην εμβάθυνση και εκπαίδευση σε γενικές μεθοδολογίες ανάλυσης του χώρου. Έτσι, ο αναγνώστης θα συναντήσει σε μεγαλύτερο βαθμό πληροφορίες για την γενική προσέγγιση και επίλυση ενός γεωγραφικού προβλήματος παρά για το πώς απλά θα υλοποιήσει κάποια βήματα επίλυσης με τη χρήση ενός συγκεκριμένου λογισμικού. Πιο συγκεκριμένες αναφορές σε λογισμικά GIS θα βρει ο αναγνώστης στην παρουσίαση των πρακτικών παραδειγμάτων/ασκήσεων τα οποία πλαισιώνουν κάθε κεφάλαιο. Η παρουσίαση αυτών των παραδειγμάτων είναι αρκετά αναλυτική παρουσιάζοντας ταυτόχρονα βήματα επεξεργασίας χωρικών δεδομένων μέσα από διαδεδομένα εμπορικά και ελεύθερα λογισμικά GIS. Έτσι, ο στόχος του βιβλίου είναι διπλός: αφενός να παρέχει θεωρητική κατάρτιση σε βασικά θέματα γεωγραφικής ανάλυσης με τη χρήση μεθόδων Γεωπληροφορικής, αφετέρου να εμβαθύνει αυτήν την κατάρτιση μέσα από την παρουσίαση πρακτικών εφαρμογών. Επιπλέον, καθώς υπάρχει πλούσια Αγγλική ορολογία και πληθώρα ακρωνυμίων στο επιστημονικό πεδίο το οποίο πραγματεύεται το παρόν σύγγραμμα, παρατίθεται σε παράρτημα λίστα / ευρετήριο τεχνικών όρων και ακρωνυμίων και η αντίστοιχη μετάφρασή τους στην Ελληνική γλώσσα.


    Το σύγγραμμα φιλοδοξεί να αποτελέσει ένα εισαγωγικό ανάγνωσμα στο πεδίο της ανάλυσης γεωγραφικών δεδομένων με στόχο την εξέταση γεωγραφικών φαινομένων και την επίλυση αντίστοιχών προβλημάτων. Αυτή η ανάλυση γίνεται με την αξιοποίηση σύγχρονων τεχνολογικών εργαλείων. Παρότι η έμφαση δίνεται στην αξιοποίηση των GIS και παρουσιάζονται αναλυτικά τεχνικές ανάλυσης διανυσματικών και ψηφιδωτών δεδομένων στο πλαίσιο ενός GIS στο παρόν βιβλίο δεν αναπτύσσονται εισαγωγικές έννοιες της τεχνολογίας των GIS. Αυτές οι έννοιες θεωρούνται προαπαιτούμενες, για την ανάγνωση και κατανόηση του βιβλίου, γνώσεις. Στη διεθνή και την ελληνική βιβλιογραφία υπάρχει πληθώρα εξαιρετικών συγγραμμάτων εισαγωγής στα ΓΠΣ.


    Η δομή του βιβλίου έχει ως εξής: μετά το παρόν εισαγωγικό κεφάλαιο, στο κεφάλαιο 1 παρουσιάζονται οι βασικές μεθοδολογίες ανάλυσης διανυσματικών δεδομένων σε περιβάλλον Συστημάτων Γεωγραφικών Πληροφοριών. Αρχικά, γίνεται η εισαγωγή στο αντικείμενο, ενώ στη συνέχεια παρουσιάζονται αναλυτικά οι δύο βασικοί τύποι λειτουργιών: οι λειτουργίες σ’ ένα θεματικό επίπεδο και οι λειτουργίες οι οποίες απαιτούν υπέρθεση θεματικών επιπέδων. Ακολουθεί λεπτομερής αναφορά στις λειτουργίες: επιλογής οντοτήτων με διάφορες εναλλακτικές τεχνικές, δημιουργίας περιμετρικών ζωνών (Buffer Zones), δημιουργίας πολυγώνων Thiessen, δημιουργίας κυρτού πολυγωνικού κελύφους, συγχώνευσης, αποκοπής, ένωσης, τομής, συμμετρικής διαφοράς, ταυτοποίησης και απαλοιφής δεδομένων. Κατόπιν, γίνεται αναφορά στα σφάλματα τα οποία ενδέχεται να προκύψουν από την εφαρμογή των λειτουργιών οι αυτών και αναλύονται εκτενέστερα τεχνικές εντοπισμού και απαλοιφής σφαλμάτων από την ύπαρξη σφηνοειδών πολυγώνων (sliver polygons). Τέλος, το κεφάλαιο ολοκληρώνεται με την υλοποίηση παραδειγματικής πρακτικής εφαρμογής ανάλυσης διανυσματικών δεδομένων σε περιβάλλον GIS, στο πλαίσιο του ελεύθερου λογισμικού QGIS.


    Στο Κεφάλαιο 2 Στο παρουσιάζονται μεθοδολογίες ανάλυσης ψηφιδωτών (raster) δεδομένων σε περιβάλλον ΓΠΣ. Αρχικά γίνεται μια εισαγωγή στο αντικείμενο, δίνονται βασικοί ορισμοί και παρουσιάζεται η δομή του κεφαλαίου. Στη συνέχεια αναπτύσσονται οι τέσσερεις βασικοί τύποι λειτουργιών: οι τοπικές (local), οι εστιακές (focal), οι λειτουργίες ζώνης (zonal) και οι γενικευμένες (global) λειτουργίες. Τέλος, το κεφάλαιο ολοκληρώνεται με την υλοποίηση παραδειγματικών πρακτικών εφαρμογών ανάλυσης ψηφιδωτών δεδομένων στο περιβάλλον του διαδεδομένου λογισμικού ArcGIS.


    Στο κεφάλαιο 3 παρουσιάζεται η μεθοδολογία της Χωρικής Πολυκριτηριακής Ανάλυσης και η εφαρμογή της στο πλαίσιο ενός Γεωγραφικού Πληροφοριακού Συστήματος με τη σταθμισμένη χαρτογραφική υπέρθεση θεματικών επιπέδων. Αρχικά, γίνεται μια εισαγωγή στο αντικείμενο της Πολυκριτηριακής Ανάλυσης Αποφάσεων (Multicriteria Decision Analysis - MCDA), παρουσιάζονται τα γενικά βήματα υλοποίησης ενός τέτοιου μοντέλου, και αναλύονται τα κύρια στοιχεία αυτής της ανάλυσης (γενικός στόχος, επιμέρους στόχοι, περιγραφές κριτηρίων, περιορισμοί, συντελεστές βαρύτητας, εναλλακτικές επιλογές, ανάλυση ευαισθησίας). Στη συνέχεια, γίνεται εμβάθυνση στη Χωρική Πολυκριτηριακή ανάλυση και την υλοποίησή της με τεχνικές χαρτογραφικής υπέρθεσης στο πλαίσιο ενός ΓΠΣ. Τέλος, το κεφάλαιο ολοκληρώνεται με την παρουσίαση παραδειγματικής πρακτικής εφαρμογής ανάλυσης με τη μέθοδο της σταθμισμένης χωρικής πολυκριτηριακής ανάλυσης σε περιβάλλον λογισμικού GIS.


    Στο κεφάλαιο 4 παρουσιάζεται η μεθοδολογία της αναλυτικής ιεράρχησης (Analytic Hierarchy Process - AHP) και αναλύονται τεχνικές αξιοποίησης αυτής της μεθόδου για την επίλυση γεωγραφικών προβλημάτων. Συγκεκριμένα, χρησιμοποιείται η μέθοδος AHP ως εργαλείο λήψης χωρικών αποφάσεων. Στόχος του κεφαλαίου είναι αφενός η κατανόηση του τρόπου χρήσης της μεθόδου αναλυτικής ιεράρχησης στο πλαίσιο πολυκριτηριακής ανάλυσης χωρικών αποφάσεων, αφετέρου η πρακτική χρήση της μεθόδου σε χωρικά προβλήματα με την αξιοποίηση των Γεωγραφικών Πληροφοριακών Συστημάτων (GIS). Αρχικά, γίνεται η εισαγωγή στη θεωρία της αναλυτικής ιεράρχηση, δίνεται το γενικό σκεπτικό ανάπτυξης της μεθόδου σε γεωγραφικές εφαρμογές και παρουσιάζεται η δομή του κεφαλαίου. Στη συνέχεια, παρουσιάζεται εκτενέστερα η μέθοδος με λεπτομερή αναφορά στα στάδια υλοποίησής της. Το κεφάλαιο αυτό ολοκληρώνεται με την παρουσίαση παραδειγματικής πρακτικής εφαρμογής ανάλυσης με τη μέθοδο AHP σε περιβάλλον διανυσματικού GIS.


    Τέλος, στο κεφάλαιο 5 παρουσιάζεται η τεχνολογία των Ψηφιακών Μοντέλων Εδάφους (ΨΜΕ). Αρχικά, γίνεται μια εισαγωγή στο αντικείμενο και τη βασική ορολογία και παρουσιάζονται οι κύριες πηγές δεδομένων για την κατασκευή ενός ΨΜΕ. Στη συνέχεια παρουσιάζονται οι δύο βασικοί τύποι των ψηφιακών μοντέλων εδάφους: το μοντέλο τριγωνικού ακανόνιστου δικτύου (TIN) και το ψηφιακό μοντέλο υψομέτρων (DEM). Ακολουθεί η αναφορά στα παραγόμενα δεδομένα από την ανάλυση ενός ΨΜΕ, καθώς και στους εναλλακτικούς τρόπους οπτικοποίησης των δεδομένων υψομέτρου. Κατόπιν, παρουσιάζονται οι δυνατότητες δημιουργίας, παρουσίασης και αξιοποίησης ενός ΨΜΕ σε περιβάλλον λογισμικού Συστημάτων Γεωγραφικών Πληροφοριών. Τέλος, το κεφάλαιο ολοκληρώνεται με την υλοποίηση παραδειγματικής πρακτικής εφαρμογής ανάλυσης επιφάνειας σε περιβάλλον GIS. Θα πρέπει να σημειωθεί ότι σε κάθε κεφάλαιο δίνονται πληροφορίες για τις απαραίτητες προαπαιτούμενες γνώσεις. Επιπλέον, στο τέλος κάθε κεφαλαίου παρατίθενται επιλεγμένες βιβλιογραφικές αναφορές και δίνεται μια λίστα από ερωτήσεις κατανόησης του κεφαλαίου οι οποίες έχουν ως κύρια στόχευση την αυτοαξιολόγηση και τη σύνοψη των κυριότερων σημείων του κάθε κεφαλαίου. Σε Παράρτημα, στο τέλος του συγγράμματος παρατίθεται ευρετήριο αγγλικών τεχνικών όρων και εννοιών που εμφανίζονται στο βιβλίο. Όπου υφίσταται δόκιμη ελληνική μετάφραση παρατίθεται και αυτή. Εκεί μπορεί να ανατρέξει ο αναγνώστης είτε για την αποκωδικοποίηση ενός αρκτικόλεξου, είτε για την αναζήτηση της μετάφρασης ενός τεχνικού όρου της Γεωπληροφορικής στα ελληνικά. Στις περιπτώσεις όπου εμφανίζονται στη βιβλιογραφία περισσότερες της μιας αποδόσεις ενός όρου στην ελληνική, παρατίθενται όλες οι εκδοχές. Τέλος, παρουσιάζεται συνολικά η βιβλιογραφία του συγγράμματος.


    Το αντικείμενο της γεωγραφικής ανάλυσης με την αξιοποίηση της Γεωπληροφορικής είναι ευρύτατο και οι τεχνικές ανάλυσης οι οποίες χρησιμοποιούνται είναι πολυάριθμες. Ως εκ τούτου θα ήταν αδύνατο να καλυφθεί στο σύνολό του το αντικείμενο σε ένα σύγγραμμα. Καθώς ο χαρακτήρας του βιβλίου είναι κυρίως εκπαιδευτικός, αποτελεί μια εισαγωγή στο αντικείμενο τόσο σε θεωρητικό όσο και πρακτικό επίπεδο. Πολλά άλλα βιβλία έχουν ως αντικείμενο την ανάλυση γεωγραφικών δεδομένων ή τη γεω-χωρική ανάλυση. Χαρακτηριστικά αναφέρονται από τη διεθνή βιβλιογραφία: το βιβλίο των Smith et al με τίτλο Geospatial Analysis, το οποίο είναι διαθέσιμο και on-line στο www.spatialanalysisonline.com, το βιβλίο των Fischer and Getis (2010), το βιβλίο των Ο’Sullivan και Unwin (2002) και το βιβλίο του Malczewski (1999) ενώ χαρακτηριστικά παραδείγματα από την Ελληνική Βιβλιογραφία αποτελούν τα βιβλία των Κουτσόπουλου (2002), Φώτη (2009) και Παππά (2011). Όλα τα παραπάνω περιέχουν ιδιαίτερα χρήσιμο υλικό, σε πολλές περιπτώσεις απευθυνόμενα σε σπουδαστές σε προχωρημένο επίπεδο, που σχετίζεται με το αντικείμενο της Γεωγραφικής ανάλυσης. Το κοινό στο οποίο απευθύνεται το βιβλίο είναι οι σπουδαστές προχωρημένου επιπέδου οι οποίοι ασχολούνται με τα εφαρμοσμένα GIS και τη γεωγραφική ανάλυση. Είναι επίσης κατάλληλο για σπουδαστές ερευνητές και επαγγελματίες οι οποίοι ενδιαφέρονται για το αντικείμενο της εφαρμοσμένης Γεω-χωρικής Ανάλυσης. Η παρακολούθηση του συγγράμματος, αν και προϋποθέτει κάποιες βασικές γνώσεις στο αντικείμενο, δεν απαιτεί προχωρημένες γνώσεις μαθηματικών, στατιστικής και προγραμματισμού. Η προσπάθεια εστιάστηκε στην παρουσίαση γενικών αρχών μεθοδολογιών και τεχνικών παρακάμπτοντας πολλές φορές εξειδικευμένες τεχνικές λεπτομέρειες. Αυτές μπορούν να αναζητηθούν από τους σπουδαστές στην πλούσια βιβλιογραφία, μέρος της οποίας παρατίθεται στο τέλος κάθε κεφαλαίου. Στο κομμάτι που αφορά την πρακτική εξάσκηση των σπουδαστών η έμφαση δόθηκε στην παρουσίαση γενικών βημάτων-τεχνικών εργασίας οι οποίες μπορούν να εφαρμοστούν σε οποιοδήποτε λογισμικό GIS. Τα εκπαιδευτικά δεδομένα που χρησιμοποιούνται στα παραδείγματα που παρουσιάζονται σε κάθε κεφάλαιο είναι διαθέσιμα στην ιστοσελίδα του παρόντος συγγράμματος στον Ελληνικό Συσσωρευτή Ακαδημαϊκών Βιβλίων (http://repository.kallipos.gr).
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    Στο κεφάλαιο αυτό παρουσιάζονται μεθοδολογίες ανάλυσης διανυσματικών δεδομένων σε περιβάλλον Συστημάτων Γεωγραφικών Πληροφοριών. Αρχικά, γίνεται μια εισαγωγή στο αντικείμενο, δίνονται βασικοί ορισμοί και παρουσιάζεται η δομή του κεφαλαίου. Στη συνέχεια, αναπτύσσονται οι δύο βασικοί τύποι λειτουργιών: οι λειτουργίες σ’ ένα θεματικό επίπεδο και οι λειτουργίες οι οποίες απαιτούν υπέρθεση θεματικών επιπέδων. Ακολουθεί λεπτομερής αναφορά στις παρακάτω λειτουργίες: της επιλογής οντοτήτων (με διάφορες τεχνικές), της δημιουργίας περιμετρικών ζωνών (buffer zones), της δημιουργίας πολυγώνων Thiessen, της δημιουργίας κυρτού πολυγωνικού κελύφους, της συγχώνευσης, αποκοπής, ένωσης, τομής, και συμμετρικής διαφοράς, της ταυτοποίησης και απαλοιφής δεδομένων. Κατόπιν, γίνεται αναφορά σε ορισμένα σφάλματα τα οποία ενδέχεται να προκύψουν από την εφαρμογή των λειτουργιών οι οποίες προαναφέρθηκαν και αναλύονται εκτενέστερα τεχνικές εντοπισμού και απαλοιφής σφηνοειδών πολυγώνων (sliver polygons). Τέλος, το κεφάλαιο ολοκληρώνεται με την υλοποίηση παραδειγματικής πρακτικής εφαρμογής ανάλυσης διανυσματικών δεδομένων σε περιβάλλον GIS.


    


    Προαπαιτούμενη γνώση


    Οι προαπαιτούμενες γνώσεις τις οποίες θα πρέπει να έχει ο αναγνώστης εστιάζονται στην κατανόηση του διανυσματικού μοντέλου χωρικών δεδομένων, στον τρόπο οργάνωσης της χωρικής και της περιγραφικής διάστασης των γεωγραφικών οντοτήτων σ’ αυτό το μοντέλο, καθώς και στις βασικές λειτουργίες της Boolean άλγεβρας (λογικό AND, OR, XOR).


    


    [bookmark: _Toc438361079]1.1 Γενικά


    Το διανυσματικό μοντέλο χωρικών δεδομένων (vector spatial model) είναι μια αναπαράσταση γεωγραφικών δεδομένων με τη χρήση αντικειμένων σημειακής, γραμμικής ή πολυγωνικής μορφής (Χαλκιάς, 2006). Αυτός ο τρόπος αναπαράστασης είναι ιδιαίτερα αποδοτικός για την αποθήκευση δεδομένων τα οποία παρουσιάζουν διακριτά όρια, όπως είναι για παράδειγμα τα οικοδομικά τετράγωνα, τα όρια διοικητικών μονάδων (π.χ. δήμων) ή οι δρόμοι (Burrough, 2000). Συνήθως, τα δεδομένα αυτού του τύπου οργανώνονται σε επίπεδα (layers) ομοειδών αντικειμένων τα οποία έχουν κοινή χωρική αναφορά (Chang, 2003) (Σχήμα 1.1).
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    Σχήμα 1.1 Θεματικά επίπεδα διανυσματικού GIS (εμφανίζονται κατά σειρά: δίκτυα συγκοινωνίας, χρήσεις γης, προστατευμένες περιοχές, υδάτινο στοιχείο, σκίαση αναγλύφου, λιθολογία).


    


    Οι λειτουργίες ανάλυσης στα διανυσματικά δεδομένα διακρίνονται σε δύο βασικές κατηγορίες: τις λειτουργίες ανάλυσης ενός επιπέδου και τις λειτουργίες υπέρθεσης δύο ή περισσότερων επιπέδων. Αναλυτικές λεπτομέρειες εφαρμογής αυτών των λειτουργιών στο περιβάλλον των λογισμικών GIS ArcMap και QGIS μπορεί να βρεθούν στους αντίστοιχους οδηγούς χρήσης (ArcGIS, QGIS manuals).


    


    [bookmark: _Toc438361080]1.2 Λειτουργίες ανάλυσης ενός διανυσματικού επιπέδου


    Κατά την εκτέλεση των λειτουργιών αυτών, αναλύονται στοιχεία τα οποία προέρχονται από ένα και μόνο επίπεδο γεωγραφικών οντοτήτων. Η επιλογή (select) οντοτήτων, η δημιουργία περιμετρικών ζωνών (buffer zones), η συγχώνευση (dissolve) οντοτήτων, καθώς και η δημιουργία πολυγώνων Thiessen, αποτελούν τα κυριότερα παραδείγματα λειτουργιών τέτοιου τύπου.


    


    [bookmark: _Toc438361081]1.2.1 Επιλογή οντοτήτων


    Η επιλογή οντοτήτων βάσει κριτηρίων, συχνά αποτελεί μια από τις αρχικές επεξεργασίες σε εφαρμογές γεωγραφικής ανάλυσης. Η επιλογή αυτή μπορεί να πραγματοποιηθεί με διάφορες τεχνικές οι οποίες αξιοποιούν τόσο τη χωρική όσο και την θεματική διάσταση των γεωγραφικών δεδομένων. Έτσι η επιλογή οντοτήτων γίνεται:


    α) Με βάση ένα ερώτημα (Query) το οποίο αξιοποιεί τις θεματικές ιδιότητες των γεωγραφικών οντοτήτων. Για το λόγο αυτό, τα λογισμικά GIS διαθέτουν ένα εύχρηστο περιβάλλον εργασίας μέσω του οποίου οι χρήστες μπορούν να διαμορφώσουν ένα ερώτημα τέτοιου τύπου. Η γλώσσα SQL (Structured Macro Language) χρησιμοποιείται γι’ αυτόν τον σκοπό (Σχήμα 1.2).
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    [bookmark: _Hlk422300353]Σχήμα 1.2 Επιλογή οντοτήτων με βάση κάποιο χαρακτηριστικό τους από τον πίνακα περιγραφών (λογισμικό ArcGIS).


    


    β) Με βάση χωρικά-τοπολογικά χαρακτηριστικά των οντοτήτων. Αυτές οι μέθοδοι επιλογής αξιοποιούν τη χωρική διάσταση των γεωγραφικών δεδομένων. Η επιλογή με βάση γεωμετρικά χαρακτηριστικά (π.χ. έκταση πολυγώνου, μήκος γραμμής, γεωγραφικό πλάτος σημείου) αποτελεί παράδειγμα αυτού του τύπου. Θα πρέπει να σημειωθεί, ότι οι τιμές των χαρακτηριστικών αυτών, οι οποίες αποθηκεύονται τους πίνακες περιγραφών των διανυσματικών επιπέδων, θα πρέπει να ενημερώνονται μετά από κάθε λειτουργία γεωεπεξεργασίας. Για παράδειγμα, η επιλογή πολυγώνων με βάση την έκτασή τους υλοποιείται με βάση το παρακάτω ερώτημα (Σχήμα 1.3).
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    Σχήμα 1.3 Επιλογή νομών με βάση την έκτασή τους (λογισμικό QGIS). Οι επιλεγμένοι νομοί σημειώνονται με κίτρινο χρώμα και έχουν έκταση > 3000 Km2.


    


    Εκτός από τις επιλογές με βάση τα γεωμετρικά χαρακτηριστικά οντοτήτων, ιδιαίτερα χρήσιμη είναι και η επιλογή οντοτήτων με βάση τη θέση τους σε σχέση με άλλες οντότητες. Τα ερωτήματα αυτά – τα οποία ονομάζονται χωρικά ερωτήματα – υλοποιούνται με την επεξεργασία στοιχείων από ένα ή περισσότερα διανυσματικά επίπεδα γεωγραφικών διδομένων. Έτσι, είναι δυνατόν να χρησιμοποιηθούν διαφορετικές μέθοδοι επιλογής για να επιλεγούν σημειακές, γραμμικές ή πολυγωνικές οντότητες από ένα επίπεδο οι οποίες βρίσκονται κοντά, γειτονεύουν ή επικαλύπτουν οντότητες στο ίδιο ή σε άλλα επίπεδα. Ένα από τα συνηθέστερα ερωτήματα σε εφαρμογές γεωγραφικής ανάλυσης στο πλαίσιο ενός GIS είναι του τύπου: «ποιες οντότητες του επιπέδου Α τοποθετούνται σε κοινές περιοχές με άλλες οντότητες επιπέδου Β οι οποίες συγκεντρώνουν συγκεκριμένα χαρακτηριστικά;» Τα ερωτήματα αυτά είναι ερωτήματα χαρτογραφικής υπέρθεσης διανυσματικών δεδομένων. Παραδείγματα ερωτημάτων αυτού του τύπου παρατίθενται παρακάτω:


    · Τι είδους εδαφοκάλυψη βρίσκεται σε συγκεκριμένες διοικητικές μονάδες;


    · Ποια κτίρια βρίσκονται σε συγκεκριμένο τύπο λιθολογίας;


    · Ποιοι οικισμοί απέχουν λιγότερο από 1000 μ από την ακτογραμμή;


    


    Τα σύγχρονα λογισμικά ΣΓΠ παρέχουν δυνατότητες επιλογής οντοτήτων διανυσματικών δεδομένων με διάφορους τρόπους. Ιδιαίτερα χρήσιμη δυνατότητα είναι και η επιλογή με βάση τις χωρικές τους ιδιότητες. Για παράδειγμα, μπορεί να γίνει επιλογή των πολυγώνων τα οποία γειτονεύουν μ’ ένα πολύγωνο στόχο σ’ ένα θεματικό επίπεδο, τα σημεία ενός επιπέδου (π.χ. οικισμοί) που απέχουν σε ευθεία απόσταση μικρότερη από μια συγκεκριμένη τιμή από γραμμές (π.χ. Εθνική οδός) γραμμικού θεματικού επιπέδου κ.λ.π.


    Σε κάθε περίπτωση, η επιλογή με βάση χωρικά χαρακτηριστικά ακολουθεί τα παρακάτω βήματα.


    1. Εισαγωγή των διανυσματικών θεματικών επιπέδων προς επεξεργασία.


    2. Επιλογή της σχετικής εντολής από το μενού εντολών του λογισμικού.


    3. Καθορισμός της μεθόδου επιλογής από το αντίστοιχο μενού.


    4. Επιλογή του επιπέδου επεξεργασίας (θα επιλεγούν οντότητες απ’ αυτό το επίπεδο) .


    5. Καθορισμός του κριτηρίου επιλογής.


    6. Καθορισμός του επιπέδου το οποίο θα χρησιμοποιηθεί, σε συνδυασμό με το επίπεδο επεξεργασίας - για την επιλογή των οντοτήτων.


    7. Εκτέλεση του ερωτήματος. Σημειώνεται, ότι μπορεί να οριστεί ότι το ερώτημα θα εφαρμόζεται μόνο για τις επιλεγμένες οντότητες.


    


    Στο λογισμικό ArcGIS, η εντολή βρίσκεται στο μενού Selection > Select By Location, ενώ στο λογισμικό QGIS, η εντολή βρίσκεται στο μενού vector > Εργαλεία έρευνας > Επιλογή με βάση την τοποθεσία. Στο παράδειγμα που παρουσιάζεται στην εικόνα που ακολουθεί, έχει εφαρμοστεί η συγκεκριμένη τεχνική στο λογισμικό QGIS για την επιλογή των Νομών που γειτονεύουν με το νομό Καρδίτσας (Σχήμα 1.4).
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    Σχήμα 1.4 Επιλογή οντοτήτων με βάση χωρικά χαρακτηριστικά (λογισμικό QGIS).


    


    γ) Ένας εναλλακτικός τρόπος επιλογής γεωγραφικών οντοτήτων είναι η χρήση ενός γεωμετρικού σχήματος (π.χ. ορθογώνιο, κύκλος ή πολύγωνο ελεύθερου σχήματος) το οποίο εισάγει ο χρήστης. Μ’ αυτόν τον τρόπο, επιλέγονται όλες οι οντότητες οι οποίες τέμνονται από το σχήμα (Σχήμα 1.5).
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    Σχήμα 1.5 Επιλογή με βάση ένα ορθογώνιο παραλληλόγραμμο το οποίο εισάγεται από τον χρήστη.


    


    δ) Τέλος, η επιλογή γεωγραφικών αντικειμένων σ’ ένα διανυσματικό επίπεδο μπορεί να πραγματοποιηθεί και χειροκίνητα με κατάδειξη μιας ή περισσότερων οντοτήτων είτε από τον πίνακα περιγραφών (επιλογή γραμμών/εγγραφών) είτε από την απεικόνισή τους σε χάρτη με επιλογή αντικειμένων (Σχήμα 1.6).
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    Σχήμα 1.6 Επιλογή οντοτήτων από το επίπεδο Α με βάση την τιμή μιας ιδιότητάς τους ( = 1) για την κατασκευή του επιπέδου Β.


    


    [bookmark: _Toc438361082]1.2.2 Δημιουργία περιμετρικών ζωνών (buffer zones)


    Η δημιουργία περιμετρικών ζωνών είναι μια από τις κύριες τεχνικές που χρησιμοποιούνται για την ανάλυση ερωτημάτων εγγύτητας στο πλαίσιο ενός GIS (Longley et al). Η χάραξη των περιµετρικών ζωνών περιλαµβάνει τη δημιουργία περιοχών γύρω από σηµεία, γραµµές ή πολύγωνα. Το αποτέλεσµα είναι η δηµιουργία νέων πολυγώνων (που αντιστοιχούν στις περιµετρικές ζώνες) τα οποία συχνά χρησιμοποιούνται σε ερωτήµατα καθορισµού των γεωγραφικών οντοτήτων που βρίσκονται εντός ή εκτός αυτών των ζωνών.


    


    [bookmark: _Toc438361083]1.2.2.1 Περιµετρικές ζώνες γύρω από σηµειακά δεδοµένα


    Πολλές φορές, στο πλαίσιο ενός ΓΠΣ, απαιτείται ο υπολογισµός περιµετρικών ζωνών γύρω από γραµµές, σηµεία ή πολύγωνα. Η απλούστερη λειτουργία υπολογισµού περιµετρικής ζώνης, είναι γύρω από σηµεία, αφού η διαδικασία περιλαµβάνει τον υπολογισµό κυκλικών πολυγώνων γύρω από κάθε σηµείο, µε ακτίνα ίση µε το πάχος της περιµετρικής ζώνης. Σε γενικές γραµµές, για τον καθορισµό του μεγέθους των ζωνών ακολουθούνται δύο µέθοδοι. Η πρώτη - και απλούστερη - χρησιµοποιεί µια σταθερή απόσταση για όλα τα σηµεία, η οποία συνήθως εισάγεται από το χρήστη. Στη δεύτερη, για κάθε σηµείο χρησιμοποιείται διαφορετική απόσταση, η οποία καταγράφεται στον πίνακα περιγραφών του θεµατικού επιπέδου των σηµείων (Σχήμα 1.7).
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    Σχήμα 1.7 Δημιουργία περιμετρικών ζωνών από σημειακές οντότητες με σταθερή και μεταβαλλόμενη ζώνη απόστασης.


    


    Αν υπάρχουν πολλά σημεία στο επίπεδο χωρικών δεδομένων, ενδέχεται να υπάρχουν επικαλύψεις των παραγόμενων περιμετρικών ζωνών. Οι περιοχές επικάλυψης (αν υπάρχουν), συχνά θα πρέπει να απαλειφθούν, έτσι ώστε το αποτέλεσμα της διαδικασίας να είναι ένα πολύγωνο. Το τελικό αποτέλεσμα της λειτουργίας αυτής είναι η δημιουργία ενός νέου επιπέδου το οποίο αποτελείται από πολύγωνα (Σχήμα 1.8) που αντιστοιχούν στις περιμετρικές ζώνες (σταθερής ή µεταβαλλόμενης ακτίνας). Ο πίνακας περιγραφών του παραγόμενου πολυγωνικού θεματικού επιπέδου περιέχει ένα πεδίο αναγνώρισης στο οποίο καταγράφεται αν ένα πολύγωνο είναι εντός ή εκτός της ζώνης.
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    Σχήμα 1.8 Συγχώνευση περιμετρικών ζωνών από σημειακές οντότητες.


    


    [bookmark: _Toc438361084]1.2.2.2 Περιμετρικές ζώνες γύρω από γραμμικά δεδομένα


    Πολύ συχνά, αναζητείται ο υπολογισμός περιμετρικών ζωνών γύρω από γραµµικές οντότητες. Ο υπολογισµός ζωνών προστασίας γύρω από το οδικό ή το υδρογραφικό δίκτυο σε εφαρµογές χωροθέτησης, αποτελούν χαρακτηριστικά παραδείγµατα αυτού του τύπου. Ο αλγόριθµος δηµιουργίας περιµετρικών ζωνών γύρω από γραµµές είναι αρκετά πιο πολύπλοκος από αυτόν της δηµιουργίας ζωνών γύρω από σηµεία, αφού οι γραµµές αποτελούνται από πολλά ευθύγραµµα τµήµατα. Συνοπτικά, τα βήµατα που ακολουθούνται είναι τα παρακάτω (Σχήμα 1.9):


    Αρχικά, ανατίθεται σε κάθε ευθύγραµµο τµήµα η τιµή του πάχους της ζώνης (η οποία µπορεί να διαφοροποιείται για κάθε γραµµή, ακριβώς όπως και στην περίπτωση των σηµείων). Η απόσταση αυτή, στο σχήµα που ακολουθεί, είναι η b. Κάθε ευθύγραµµο τµήµα έχει ένα σηµείο εκκίνησης (Ε1, Ν1) και ένα σηµείο λήξης (Ε2, Ν2). Με τη χρήση αυτών των συντ/νων υπολογίζονται τα ∆x , ∆y µεταξύ των δύο σηµείων.


    Τα ακραία σηµεία των παράλληλων περιµετρικών γραµµών που βρίσκονται εκατέρωθεν του ευθύγραµµου τµήµατος και σε απόσταση b, προσδιορίζονται µε βάση τις παρακάτω σχέσεις:
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    Σχήμα 1.9 Κατασκευή περιμετρικής ζώνης από γραμμική οντότητα.


    


    Όταν η γραµµή είναι οριζόντια ή κάθετη στον άξονα συντεταγµένων, οι παραπάνω σχέσεις είναι αρκετά απλοποιηµένες. Σ’ αυτό το σηµείο ελέγχονται τα ευθύγραµµα τµήµατα που θα προστεθούν ή θα αφαιρεθούν, ανάλογα µε την διεύθυνση της γραµµής. Όταν προσδιοριστούν οι δύο παράλληλες περιµετρικές γραµµές για ένα ευθύγραµµο τµήµα, επεξεργάζεται και το επόµενο τµήµα µε τον ίδιο ακριβώς τρόπο.


    Αφού υπολογιστούν οι παράλληλες περιµετρικές γραµµές και για το επόµενο τµήµα, προσδιορίζονται τα σηµεία τοµής των παράλληλων γραµµών που κείνται στην ίδια πλευρά της γραµµής και καταγράφονται οι συντεταγµένες αυτών των σηµείων. Σηµειώνεται ότι υπάρχει πάντα ένα σηµείο τοµής αυτών των γραµµών που προσδιορίζεται εύκολα από τις εξισώσεις τους. Τα βήµατα αυτά επαναλαµβάνονται µέχρι και το τελευταίο ευθύγραµµο τµήµα κάθε γραµµής.


    Το τελευταίο βήµα, σχετίζεται µε τον προσδιορισµό του τρόπου «κλεισίµατος» (ολοκλήρωσης) κάθε ζώνης στους κόμβους έναρξης και λήξης της γραµµής με τριγωνικό, ημικυκλικό ή ευθύγραμμο τρόπο.


    Αν υπάρχουν περισσότερες από µία γραµµές στο επίπεδο, τότε θα πρέπει να γίνει έλεγχος για επικαλύψεις και – αν είναι επιθυμητό - να συγχωνευτούν οι πιθανές περιοχές επικάλυψης.


    Το τελικό αποτέλεσµα είναι η δηµιουργία ενός νέου επιπέδου το οποίο αποτελείται από πολύγωνα που αντιστοιχούν στις περιµετρικές ζώνες (σταθερής ή µεταβαλλόµενης ακτίνας) (Σχήμα 1.10).
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    Σχήμα 1.10 Δημιουργία περιμετρικών ζωνών από γραμμικές οντότητες.


    


    [bookmark: _Toc438361085]1.2.2.3 Περιµετρικές ζώνες γύρω από πολυγωνικά δεδοµένα


    Οι περιµετρικές ζώνες γύρω από πολυγωνικές οντότητες χρησιµοποιούνται ευρύτατα, όταν είναι επιθυμητός ο προσδιορισµός των εκτάσεων που βρίσκονται εξωτερικά (ή εσωτερικά) των πολυγωνικών γεωγραφικών οντοτήτων (π.χ. ζώνη προστασίας περιµετρικά µιας δασικής έκτασης). Οι εκτάσεις αυτές υπολογίζονται µε τον ίδιο τρόπο που υπολογίζονται οι περιµετρικές ζώνες γύρω από γραµµές, µε µια µικρή διαφορά: το πολύγωνο που ορίζει τη ζώνη δηµιουργείται σε µια από τις δύο πλευρές της κλειστής γραµµής που ορίζει την πολυγωνική οντότητα. Έτσι, υπάρχει η δυνατότητα υπολογισµού τόσο της εσωτερικής, όσο και της εξωτερικής περιµετρικής ζώνης (Σχήμα 1.11).
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    Σχήμα 1.11 Δημιουργία περιμετρικών ζωνών από πολυγωνικές οντότητες.


    


    Όπως και στους υπόλοιπους τύπους περιμετρικών ζωνών, το τελευταίο στάδιο στη διαδικασία κατασκευής τους, συχνά περιλαμβάνει απομάκρυνση περιοχών επικαλύψεων των ζωνών σε επίπεδα µε πολλές πολυγωνικές οντότητες (Σχήμα 1.12).
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    Σχήμα 1.12 Παραδείγματα δημιουργίας buffer zones.


    


    [bookmark: _Toc438361086]1.2.3 Δημιουργία πολυγώνων Thiessen


    Τα πολύγωνα Thiessen είναι πολύγωνα τα οποία δημιουργούνται από ένα σύνολο σημείων με μια σχέση ένα προς ένα με εφαρμογή κανόνων Ευκλείδειας Γεωμετρίας. Τα πολύγωνα Thiessen έχουν την ιδιότητα ότι κάθε πολύγωνο περιέχει μόνο ένα αρχικό σημείο, καθώς και ότι κάθε θέση εντός ενός πολυγώνου βρίσκεται πλησιέστερα στο αντίστοιχο του αρχικού σημείου, παρά σε οποιοδήποτε άλλο (Σχήμα 1.13). Η ονομασία τους δόθηκε προς τιμήν του Αμερικανού μετεωρολόγου Alfred H. Thiessen (1872-1931).
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    Σχήμα 1.13 Δημιουργία πολυγώνων Thiessen.


    


    Η δημιουργία των πολυγώνων Thiessen γίνεται με βάση τα παρακάτω βήματα: α) Με βάση τα αρχικά σημεία, γίνεται τριγωνισμός της περιοχής μελέτης με το κριτήριο Delaunay, σύµφωνα µε το οποίο ο περιγεγραµμένος στις κορυφές του τριγώνου κύκλος, δε θα πρέπει να περιέχει άλλο σηµείο. Μ’ αυτόν τον τρόπο, όλα τα σημεία συνδέονται µε τα δύο πλησιέστερα. Επίσης, η ικανοποίηση του κριτηρίου αυτού, εξασφαλίζει τη µονοσήµαντη δηµιουργία του τριγωνικού δικτύου, η οποία επιπλέον δεν εξαρτάται από τη σειρά επεξεργασίας των δεδοµένων. β) Σχηματίζονται οι μεσοκάθετες για κάθε πλευρά τριγώνου. Αυτές οι μεσοκάθετες αποτελούν τις πλευρές των πολυγώνων Thiessen, ενώ τα σημεία τομείς των μεσοκαθέτων αποτελούν τις κορυφές κάθε πολυγώνου. Τα πολύγωνα Thiessen είναι επίσης γνωστά, ως πολύγωνα Voronoi ή πολύγωνα Dirichlet (Σχήμα 1.14).
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    Σχήμα 1.14 Δημιουργία πολυγώνων Voronoi - Thiessen (λογισμικό QGIS).


    


    [bookmark: _Toc438361087]1.2.4 Δημιουργία κυρτού πολυγωνικού κελύφους (Convex Hull)


    Για κάθε σύνολο σημειακών, γραμμικών ή πολυγωνικών οντοτήτων μπορεί να κατασκευαστεί ένα κυρτό πολύγωνο (ελάχιστης περιμέτρου), το οποίο να περιβάλλει όλες τις οντότητες. Το πολύγωνο αυτό το οποίο ονομάζεται κυρτό κέλυφος (Convex Hull), δημιουργείται σε περιβάλλον διανυσματικού GIS (Σχήμα 1.15).
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    Σχήμα 1.15 Κυρτό πολύγωνο (Convex Hull) σημειακών οντοτήτων.


    


    [bookmark: _Toc438361088]1.2.5 Συγχώνευση (Dissolve ) οντοτήτων


    [bookmark: _Hlk422303688]Με την λειτουργία αυτή συγχωνεύονται οντότητες σ’ ένα επίπεδο με βάση κάποια κοινή ιδιότητά τους (θεματική περιγραφή). Στο Σχήμα 1.16 φαίνεται ένα παράδειγμα συγχώνευσης οντοτήτων.
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    [bookmark: _Hlk422304285]Σχήμα 1.16 Συγχώνευση οντοτήτων του επιπέδου Α για τη δημιουργία του επιπέδου Β.


    


    Με την λειτουργία αυτή, μπορεί να υλοποιηθεί και επαναταξινόμηση των οντοτήτων ενός επιπέδου. Ο χρήστης θα πρέπει να είναι ιδιαίτερα προσεκτικός στον καθορισμό του κατάλληλου πεδίου βάσει του οποίου θα πραγματοποιηθεί η συγχώνευση των οντοτήτων. Χαρακτηριστικό παράδειγμα αυτής της λειτουργίας αποτελεί η συγχώνευση των Δήμων της Ελλάδας με βάση την περιφέρεια στην οποία ανήκουν.
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    Σχήμα 1.17 Συγχώνευση (Dissolve) διοικητικών μονάδων τοπικού επιπέδου για τη δημιουργία μονάδων περιφερειακού επιπέδου.


    


    Παρότι η λειτουργία αυτή συνήθως εφαρμόζεται σε πολυγωνικές οντότητες, είναι εφικτή η εφαρμογή της τόσο σε σημειακές όσο και σε γραμμικές. Επειδή η λειτουργία συγχώνευσης έχει ως αποτέλεσμα τη δημιουργία νέων οντοτήτων, θα πρέπει κάθε φορά να καθορίζεται ο τρόπος συνδυασμού των περιγραφών των οντοτήτων οι οποίες συγχωνεύονται. Για παράδειγμα, με τη συγχώνευση των νομών για τη δημιουργία των περιφερειών, για το πεδίο POP (πληθυσμός) θα πρέπει να καθοριστεί η λειτουργία άθροισης (Sum) τιμών, έτσι ώστε, η κάθε περιφέρεια στο πεδίο POP να έχει καταχωρημένο το άθροισμα των τιμών του πληθυσμού (POP) των νομών από τους οποίους αποτελείται (Σχήμα 1.17).


    


    [bookmark: _Toc438361089]1.3 Λειτουργίες ανάλυσης διανυσματικών επιπέδων με υπέρθεση (overlay)


    Οι λειτουργίες αυτού του τύπου λαμβάνουν χώρα όταν δύο ή περισσότερα επίπεδα διανυσματικών δεδομένων τα οποία αναφέρονται στην ίδια περιοχή συνδυάζονται – με διάφορους τρόπους – έτσι ώστε, να δημιουργηθεί ένα παραγόμενο επίπεδο. Σημειώνεται ότι, για την εφαρμογή οποιασδήποτε λειτουργίας υπέρθεσης, θα πρέπει να υπάρχει κοινό σύστημα αναφοράς και συντεταγμένων σ’ όλα τα θεματικά επίπεδα τα οποία συνδυάζονται. Οι πιο συνηθισμένες λειτουργίες γεωεπεξεργασίας με υπέρθεση επιπέδων διανυσματικών δεδομένων είναι:


    


    · Η Αποκοπή (Clip ), όταν οι οντότητες ενός επιπέδου επεξεργασίας αποκόπτονται στα όρια του επιπέδου αποκοπής.


    · Η Τομή (Intersect), όταν μετά το συνδυασμό επιπέδων διατηρούνται στο παραγόμενο επίπεδο μόνο οι οντότητες οι οποίες βρίσκονται στον κοινό χώρο μεταξύ των επιπέδων.


    · Η Ένωση (Union), με την οποία συνδυάζονται όλες οι οντότητες των επιπέδων επεξεργασίας και στο παραγόμενο επίπεδο διατηρείται το σύνολο των οντοτήτων.


    · Η Συμμετρική διαφορά (symmetrical difference), κατά την οποία, μετά το συνδυασμό επιπέδων, διατηρούνται στο παραγόμενο επίπεδο μόνο οι οντότητες οι οποίες δεν βρίσκονται στον κοινό χώρο μεταξύ των επιπέδων.


    · Η Ταυτοποίηση (Identity), με την οποία συνδυάζονται οι οντότητες του επιπέδου επεξεργασίας, με το επίπεδο υπέρθεσης, κι όλες οι οντότητες του πρώτου (ή το τμήμα τους το οποίο έχει επικάλυψη με τις οντότητες του επιπέδου υπέρθεσης) λαμβάνουν τις περιγραφές από το επίπεδο υπέρθεσης.


    · Συνένωση (Merge), με την οποία λαμβάνει χώρα ένωση δύο επιπέδων σε ένα.


    · Απαλοιφή (Erase ή Difference), όταν από το επίπεδο επεξεργασίας απαλείφονται οι οντότητες (ή μέρος τους), οι οποίες επικαλύπτονται με τις οντότητες του επιπέδου επεξεργασίας.


    


    Σημειώνεται ότι μετά από την εκτέλεση των παραπάνω λειτουργιών, θα πρέπει να υπολογίζονται εκ νέου, οι γεωμετρικές ιδιότητες (έκταση / περίμετρος) των οντοτήτων στο παραγόμενο επίπεδο, καθώς αν υπάρχουν οι τιμές γι’ αυτές τις ιδιότητες στους αρχικούς πίνακες περιγραφών, «κληρονομούνται» αυτούσιες στον πίνακα περιγραφών του παραγόμενου επιπέδου.


    Για να υλοποιήσουν οι χαρτογράφοι επεξεργασίες υπέρθεσης αυτού του τύπου - την εποχή πριν την ανάπτυξη των GIS - δημιουργούσαν χάρτες σε διαφανές υλικό και στη συνέχεια προχωρούσαν στην τοποθέτησή τους – ο ένας πάνω στον άλλο - σε «φωτοτράπεζα», έτσι ώστε, να είναι δυνατή η συνδυαστική ανάλυσή τους και ο σχεδιασμός ενός παραγόμενου χάρτη. Ο σύγχρονος τρόπος της παραπάνω διαδικασίας γίνεται με ακριβέστερο τρόπο αξιοποιώντας την τεχνολογία των Συστημάτων Γεωγραφικών Πληροφοριών.


    


    [bookmark: _Toc438361090]1.3.1 Αποκοπή - CLIP


    Στην λειτουργία αυτή χρησιμοποιείται ένα επίπεδο ως επίπεδο αποκοπής, έτσι ώστε, ν’ αποκοπούν οι οντότητες από ένα άλλο επίπεδο (επίπεδο επεξεργασίας), στα όρια των οντοτήτων του επιπέδου αποκοπής. Θα πρέπει να υπάρχει βεβαιότητα για το ποιο είναι το επίπεδο επεξεργασίας και ποιο το επίπεδο των ορίων αποκοπής, καθώς οι οντότητες (και οι αντίστοιχες περιγραφές) που διατηρούνται στο παραγόμενο, είναι αυτές του επιπέδου επεξεργασίας. Σημειώνεται ότι, παρόμοιας λογικής λειτουργία είναι η λειτουργία διαχωρισμού (SPLIT), κατά την οποία το επίπεδο επεξεργασίας διαχωρίζεται σε υποσύνολα (συχνά γειτονικά) με βάση το επίπεδο διαχωρισμού. Η λειτουργία αποκοπής είναι ιδιαίτερα χρήσιμη όταν επιθυμούμε τη δημιουργία βάσης χωρικών δεδομένων στα όρια της περιοχής μελέτης (ή περιοχής ενδιαφέροντος) και έχουμε διαθέσιμα δεδομένα από μια ευρύτερη περιοχή (Σχήμα 1.18).
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    Σχήμα 1.18 Η λειτουργία αποκοπής (CLIP).


    


    [bookmark: _Toc438361091]1.3.2 Τομή – Intersect


    Μ’ αυτήν τη λειτουργία, έπειτα από την υπέρθεση δύο (ή περισσότερων) επιπέδων, διατηρούνται στο παραγόμενο επίπεδο μόνο οι οντότητες (ή τμήματα αυτών) οι οποίες βρίσκονται στον κοινό χώρο εμφάνισης των επιπέδων (γεωμετρική τομή των επιπέδων). Συνήθως, το επίπεδο υπέρθεσης περιέχει πολύγωνα έτσι ώστε, να ορίζεται η περιοχή τομής. Σημειώνεται ότι, καθώς το παραγόμενο επίπεδο «κληρονομεί» τις περιγραφές και από τα δύο επίπεδα επεξεργασίας μπορεί να χρησιμοποιηθεί σε διαδικασίες κατάτμησης συνόλου δεδομένων μεγάλου μεγέθους (Σχήμα 1.19).
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    Σχήμα 1.19 Η λειτουργία τομής (INTERSECT).


    


    [bookmark: _Toc438361092]1.3.3 Ένωση – UNION


    Με τη γεωμετρική ένωση (union) συνδυάζονται δύο ή περισσότερα επίπεδα κι όλες οι οντότητές τους (ασχέτως αν επικαλύπτονται ή όχι) μεταφέρονται στο παραγόμενο επίπεδο. Στην λειτουργία αυτή, όλα τα επίπεδα τα οποία συνδυάζονται θα πρέπει να περιέχουν πολύγωνα. Το παραγόμενο επίπεδο «κληρονομεί» τις περιγραφές και από τα δύο (ή περισσότερα) επίπεδα επεξεργασίας. Στο επίπεδο υπέρθεσης είναι δυνατόν να χρησιμοποιηθούν όλες τις οντότητες ή επιλεγμένες οντότητες. Σημειώνεται επίσης ότι, καθώς μετά από αυτήν τη λειτουργία διαμορφώνονται νέες οντότητες, με γεωμετρία διαφορετική από των δεδομένων εισόδου, επιβάλλεται ο επανϋπολογισμός των γεωμετρικών ιδιοτήτων (π.χ. έκταση) στο παραγόμενο επίπεδο.


    Θα πρέπει να σημειωθεί ότι κατά τη λειτουργία ένωσης θεματικών επιπέδων το παραγόμενο επίπεδο έχει πολλαπλάσιες οντότητες από αυτές των δεδομένων εισόδου. Ο αριθμός των οντοτήτων αυτών δεν είναι δυνατόν να υπολογιστεί πριν την εφαρμογή της λειτουργίας, καθώς σχετίζεται με την πολυπλοκότητα των δεδομένων εισόδου. Μια άλλη παράμετρος η οποία επηρεάζει το πλήθος των οντοτήτων του παραγόμενου επιπέδου είναι και η τοπολογική συνέπεια των δεδομένων, δηλαδή η ταύτιση των κοινών ορίων στα επίπεδα εισαγωγής (Σχήμα 1.20).
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    Σχήμα 1.20 Η λειτουργία ένωσης (UNION).


    


    [bookmark: _Toc438361093]1.3.4 Συμμετρική διαφορά


    Με την λειτουργία αυτή, συνδυάζονται δύο (ή περισσότερα) επίπεδα κι όλες οι οντότητές τους οι οποίες δεν επικαλύπτονται διαμορφώνουν το παραγόμενο επίπεδο (Σχήμα 1.21).
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    Σχήμα 1.21 Η λειτουργία συμμετρικής διαφοράς.


    


    [bookmark: _Toc438361094]1.3.5 Ταυτοποίηση - IDENTITY


    Στη λειτουργία ταυτοποίησης αρχικά καθορίζεται ο κοινός γεωμετρικός τόπος του επιπέδου επεξεργασίας και του επιπέδου αναγνώρισης. Στη συνέχεια στις οντότητες (ή στα τμήματα των οντοτήτων) του επιπέδου εισαγωγής που βρίσκονται μέσα σ’ αυτόν τον κοινό χώρο αποδίδονται οι περιγραφές των οντοτήτων του επιπέδου αναγνώρισης (Σχήμα 1.22).
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    Σχήμα 1.22 Η λειτουργία ταυτοποίησης (IDENTITY).


    


    [bookmark: _Toc438361095]1.3.6 Συνένωση - MERGE


    Για την λειτουργία συνένωσης, δύο ή περισσότερα επίπεδα (συχνά γειτονικά), ενώνονται και δημιουργούν ένα νέο ενιαίο. Κατά την εκτέλεση της λειτουργίας συνένωσης θα πρέπει να καθοριστεί το επίπεδο που θα «κληρονομήσει» τις περιγραφές του στο τελικό παραγόμενο επίπεδο. Συνεπώς, θα πρέπει να λαμβάνεται υπόψη το συγκεκριμένο επίπεδο, ιδιαίτερα σε περιπτώσεις που έχουμε διαφορές στους πίνακες περιγραφών των επιπέδων εισόδου (Σχήμα 1.23).
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    Σχήμα 1.23 Η λειτουργία συνένωσης (MERGE).


    


    [bookmark: _Toc438361096]1.3.7 Απαλοιφή ή Διαφορά – ERASE / DIFFERENCE


    Με την επεξεργασία απαλοιφής, δημιουργούνται οντότητες μετά από την υπέρθεση των οντοτήτων του επιπέδου επεξεργασίας με τα πολύγωνα του επιπέδου απαλοιφής. Οι οντότητες του επιπέδου επεξεργασίας οι οποίες περιλαμβάνονται στο παραγόμενο επίπεδο, είναι μόνον όσες βρίσκονται εκτός των ορίων των πολυγώνων απαλοιφής (Σχήμα 1.24).
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    Σχήμα 1.24 Η λειτουργία απαλοιφής (ERASE).


    


    Θα πρέπει να τονιστεί, ότι παρότι οι λειτουργίες υπέρθεσης έχουν αρκετές ομοιότητες ως προς το σκεπτικό τους, διαφοροποιούνται ως προς τα δεδομένα εισόδου, καθώς και, ως προς τον τρόπο με τον οποίο αυτά «κληρονομούνται» στο παραγόμενο επίπεδο. Παρακάτω (Σχήμα 1.25) υπογραμμίζεται αυτή η διαφοροποίηση για τις βασικές λειτουργίες υπέρθεσης.
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    Σχήμα 1.25 Λειτουργίες υπέρθεσης διανυσματικών δεδομένων.


    


    Η χαρτογραφική υπέρθεση διανυσματικών δεδομένων συχνά αποτελεί αναλυτικό εργαλείο μέσω του οποίου συνδυάζονται τα χαρακτηριστικά διαφόρων επιπέδων δεδομένων για την παραγωγή ενός τελικού επιπέδου. Στη συνέχεια, απ’ αυτό το παραγόμενο επίπεδο είναι δυνατή η επιλογή περιοχών οι οποίες συγκεντρώνουν μια σειρά από ιδιότητες των αρχικών επιπέδων, έτσι ώστε να ικανοποιούνται τα αναλυτικά κριτήρια ανάλογα με το αντικείμενο της έρευνας. Αυτή η μεθοδολογία είναι ιδιαίτερα συνηθισμένη σε μελέτες χωροθετήσεων ή ζωνοποίησης του χώρου, ανάλογα με τα εκάστοτε κριτήρια. Επομένως, μπορεί να επιτευχθεί η υπέρθεση θεματικών επιπέδων τα οποία αντιστοιχούν στην κλίση του εδάφους, της λιθολογίας, τις βροχοπτώσεις, κ.λ.π. έτσι ώστε, να είναι δυνατή η δημιουργία σ’ ένα επίπεδο της ζωνοποίησης της περιοχής μελέτης με βάση την επιδεκτικότητα στην εκδήλωση κατολισθήσεων. Στο παρακάτω σχήμα παρουσιάζεται η υπέρθεση των επιπέδων κλίσης, λιθολογίας και έντασης βροχόπτωσης. Το πολύγωνο το οποίο είναι επιλεγμένο στο παραγόμενο επίπεδο συγκεντρώνει μια σειρά από δυσμενή (ως προς την εκδήλωση κατολίσθησης), χαρακτηριστικά (Σχήμα 1.26).
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    Σχήμα 1.26 Υπέρθεση τη λειτουργία UNIOΝ διανυσματικών θεματικών επιπέδων.


    


    Θα πρέπει επίσης να τονιστεί ότι η ανάλυση με χαρτογραφική υπέρθεση, στην πράξη λαμβάνει χώρα σε συνδυασμό με άλλους τύπους ανάλυσης, όπως είναι για παράδειγμα η δημιουργία περιμετρικών ζωνών, η χωρική διασύνδεση δεδομένων και η ανάλυση επιφανειών. Στο παράδειγμα που παρουσιάστηκε παραπάνω, το επίπεδο της κλίσης έχει προέλθει από ανάλυση επιφάνειας, ενώ θα μπορούσε να χρησιμοποιηθεί επιπρόσθετα και το επίπεδο απόστασης από το οδικό δίκτυο (buffer zones).


    


    [bookmark: _Toc438361097]1.4 Σφάλματα κατά την υπέρθεση διανυσματικών δεδομένων


    Οι λειτουργίες υπέρθεσης θεματικών επιπέδων είναι ίσως οι πιο δημοφιλείς μέθοδοι συνδυασμού/μοντελοποίησης γεωγραφικών δεδομένων. Επειδή οι λειτουργίες αυτές παρέχονται σχεδόν στο σύνολό τους από όλα τα λογισμικά ΓΠΣ, η χρήση τους είναι ευρύτατα διαδεδομένη και εκτείνεται από απλές εφαρμογές εκπαιδευτικού χαρακτήρα μέχρι σύνθετες εφαρμογές χωρικής ανάλυσης. Πολύ συχνά όμως, με την εφαρμογή λειτουργιών υπέρθεσης, μπορεί να προκύψουν προβλήματα. Το πιο χαρακτηριστικό παράδειγμα τέτοιων προβλημάτων είναι η δημιουργία των sliver polygons (σφηνοειδή ή επιμήκη πολύγωνα) μετά από υπέρθεση θεματικών επιπέδων τα οποία περιέχουν πολύγωνα τα οποία, ενώ θα έπρεπε να ταυτίζονται απόλυτα, παρουσιάζουν μικρές αποκλίσεις στα όριά τους. Οι αποκλίσεις αυτές συχνά οφείλονται σε σφάλματα ψηφιοποίησης ή είναι αποτέλεσμα συνδυασμού δεδομένων διαφορετικής κλίμακας ή προέλευσης. Για παράδειγμα, αν σε μια περιοχή μελέτης εξετάζεται συνδυαστικά η λιθολογία με την κάλυψη γης και τα όρια ενός τύπου κάλυψης (π.χ. «δάσος») ταυτίζονται με τα όρια ενός λιθολογικού σχηματισμού (π.χ. «φλύσχης»),τότε το επίπεδο της λιθολογίας προέρχεται από ψηφιοποίηση γεωλογικού χάρτη κλίμακας 1:50.000, ενώ το επίπεδο της κάλυψης γης από το χάρτη του προγράμματος CORINE (κλίμακα 1:100.000) ο οποίος βασίζεται σε εικόνες Τηλεπισκόπησης. Επειδή τα όρια του «δάσους» στο χάρτη CORINE δεν ταυτίζονται απόλυτα με τα όρια του «φλύσχη», στο γεωλογικό χάρτη – ενώ θα έπρεπε να ταυτίζονται – η υπέρθεσή τους, για παράδειγμα μέσα από τη λειτουργία ένωσης (Union), θα έχει ως αποτέλεσμα τη δημιουργία σφηνοειδών πολυγώνων. Συνηθισμένη, επίσης, είναι η δημιουργία sliver polygons με την υπέρθεση χρονοσειράς δεδομένων. Για παράδειγμα, αν υποτεθεί ότι γίνεται η σύγκριση μεταξύ των δασικών περιοχών σε μια περιοχή μελέτης για δύο διαφορετικές χρονικές περιόδους t1 και t2 και ψηφιοποιούνται δύο φορές τα αμετάβλητα όρια του δάσους τότε ενδέχεται να δημιουργηθούν επιμήκη πολύγωνα (Σχήμα 1.27).


    Εφόσον τα επιμήκη πολύγωνα δημιουργούνται λόγω τοπολογικών ασυνεπειών στα υπερτιθέμενα δεδομένα, ο καλύτερος τρόπος για να αποφευχθεί η δημιουργία τους είναι η πρόληψη, δηλαδή η διασφάλιση της τοπολογικής συνέπειας στα δεδομένα τα οποία υπερτίθενται. Στο παράδειγμα της υπέρθεσης δεδομένων για τη δασοκάλυψη κατά τη διάρκεια δύο χρονικών περιόδων, όπως αναφέρθηκε παραπάνω, η ορθή στρατηγική δημιουργίας των δεδομένων είναι η ψηφιοποίηση του επιπέδου με την αρχική δασοκάλυψη (αρχική κατάσταση) και στη συνέχεια η δημιουργία ενός αντιγράφου αυτού του επιπέδου καθώς και η τροποποίηση μόνο των οντοτήτων οι οποίες έχουν μεταβληθεί για τη δημιουργία του επιπέδου της τελικής δασοκάλυψης. Με αυτήν την τεχνική, τα κοινά όρια είναι απολύτως ταυτόσημα.
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    [bookmark: _Hlk422304892]Σχήμα 1.27 Δημιουργία σφηνοειδών πολυγώνων (sliver polygons) μετά από υπέρθεση επιπέδων με τοπολογική ασυνέπεια.


    


    Ένας άλλος τρόπος αποφυγής της δημιουργίας sliver polygons, σχετίζεται με τον καθορισμό μιας απόστασης η οποία καλείται ανοχή γεωεπεξεργασίας (cluster tolerance) κατά την εκτέλεση των λειτουργιών υπέρθεσης δεδομένων. Με αυτόν τον τρόπο, οντότητες οι οποίες απέχουν απόσταση μικρότερη από αυτήν την ανοχή θα ενοποιούνται. Εδώ θα πρέπει να είμαστε αρκετά προσεκτικοί καθώς μια πολύ μικρή τιμή ανοχής γεωεπεξεργασίας ενδεχομένως να μην επιφέρει τις επιθυμητές ενοποιήσεις ενώ με την εισαγωγή μιας μεγάλης τιμής για αυτήν την ανοχή ενδέχεται να ενοποιηθούν οντότητες οι οποίες εννοιολογικά δεν ταυτίζονται και έτσι να επιφέρουμε δραστικές (και ανεπιθύμητες) αλλαγές στη γεωμετρία των παραγόμενων πολυγώνων. Τέλος, με τα κατάλληλα εργαλεία και τις τεχνικές εξόρυξης δεδομένων, μπορούν να εντοπιστούν και να διορθωθούν τα επιμήκη πολύγωνα. Για παράδειγμα, στο λογισμικό ArcGIS της ESRI, αξιοποιούνται τα εργαλεία ελέγχου και διορθώσεων γεωμετρίας (“check geometry” και “repair geometry” αντίστοιχα). Επιπρόσθετα, μπορούν να αξιοποιηθούν σχετικές επεκτάσεις, οι οποίες εστιάζουν στην ανίχνευση sliver polygons.


    Ένας εναλλακτικός τρόπος ανίχνευσης των επιμηκών πολυγώνων βασίζεται στη γενική παρατήρηση ότι τα πολύγωνα αυτά έχουν πολύ μικρό λόγο εμβαδού προς περίμετρο. Ο λόγος αυτός αποτυπώνεται στον δείκτη λέπτυνσης (thinness index) o οποίος πρακτικά ποσοτικοποιεί την κανονικότητα του σχήματος ενός αντικειμένου με δεδομένη την έκτασή (Ε) και την περίμετρό (Π). Ο δείκτης λέπτυνσης (Τ) δίνεται από τον τύπο Τ = 4π(Ε/Π2) και παίρνει την μέγιστη τιμή 1 για κυκλικό αντικείμενο. Για αντικείμενο με δεδομένη έκταση, όσο ο δείκτης Τ τείνει προς το 0, τόσο περισσότερο επίμηκες είναι το αντικείμενο. Ο δείκτης αυτός μπορεί εύκολα να υπολογιστεί στον πίνακα περιγραφών επιπέδου με πολυγωνικές οντότητες με βάση την έκφραση: 4 * 3.14 * [Shape_Area] / ([Shape_Length] * [Shape_Length]).


    Τα περισσότερα επιμήκη πολύγωνα έχουν τιμή δείκτη T , η οποία πλησιάζει στο 0, ενώ πολύγωνα με δείκτη μικρότερο από 0,2 είναι άξια εξέτασης. Παρ’ όλα αυτά, τα πολύγωνα αυτού του τύπου δε θα πρέπει να αντιμετωπίζονται μαζικά (π.χ. μαζική διαγραφή τους), καθώς είναι πιθανό να αντιστοιχούν σε αντικείμενα με ακανόνιστο σχήμα και όχι σε επιμήκη πολύγωνα. Τα πολύγωνα αυτά, παρότι έχουν μικρό δείκτη λέπτυνσης, συνήθως καταλαμβάνουν μεγάλη έκταση, σε σύγκριση με τα επιμήκη πολύγωνα. Σ’ αυτήν την περίπτωση, η διάταξη των οντοτήτων με μικτό δείκτη λέπτυνσης, με βάση την έκταση την οποία καταλαμβάνουν, βοηθά στην ανίχνευση των πραγματικών επιμηκών πολυγώνων.


    


    [bookmark: _Toc438361098]1.5 Ανάλυση διανυσματικών δεδομένων σε περιβάλλον λογισμικού GIS – Η χρήση του QGIS


    Το ελεύθερο λογισμικό QGIS παρέχει αρκετές δυνατότητες επεξεργασίας διανυσματικών δεδομένων μέσα από το μενού [bookmark: _Hlk422305244][bookmark: _Hlk422305775]Vector > Geoprocessing Tools (Σχήμα 1.28). Οι κυριότερες λειτουργίες αυτού του τύπου οι οποίες παρουσιάζονται παρακάτω είναι:


    [bookmark: _Hlk422305514]1. Η δημιουργία κυρτού κελύφους (Convex Hull)


    2. Η δημιουργία περιμετρικών ζωνών (buffer Zones)


    3. Τομή δεδομένων (Intersect)


    4. Ένωση δεδομένων (Union)


    5. Συμμετρική διαφορά δεδομένων (Symmetrical Difference)


    6. Αποκοπή δεδομένων (Clip)


    7. Απαλοιφή – διαφορά δεδομένων (Difference – Erase)


    8. Συγχώνευση δεδομένων (Dissolve)
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    [bookmark: _Hlk422306160]Σχήμα 1.28 Οι βασικές λειτουργίες Γεωεπεξεργασίες σε περιβάλλον QGIS.


    


    Ο τρόπος εκτέλεσης όλων αυτών των λειτουργιών είναι παραπλήσιος, καθώς περιλαμβάνει την εισαγωγή των δεδομένων εισόδου (ένα ή περισσότερα διανυσματικά θεματικά επίπεδα), τον καθορισμό των παραμέτρων της επιθυμητής λειτουργίας και τέλος την εκτέλεση της λειτουργίας και τη δημιουργία του παραγόμενου θεματικού επιπέδου. Εκτός από τις λειτουργίες γεωεπεξεργασίας οι οποίες απεικονίζονται στο παραπάνω σχήμα, το λογισμικό QGIS παρέχει επιπρόσθετες δυνατότητες γεωμετρικής ανάλυσης μέσα από το μενού Vector > Geometry Tools. Η δημιουργία των πολυγώνων Thiessen – Voronoi και ο τριγωνισμός Delauny, αποτελούν χαρακτηριστικά παραδείγματα αυτού του τύπου.


    


    [bookmark: _Toc438361099]1.5.1 Δημιουργία κυρτού κελύφους (Convex Hull)


    [bookmark: _Hlk422306228]Η λειτουργία αυτή, εκτελείται μέσα από το μενού Vector > Geoprocessing Tools > Convex Hull. Ο χρήστης, αφού καθορίσει το επίπεδο εισόδου, προσδιορίζει (προαιρετικά) το πεδίο ομαδοποίησης των οντοτήτων εισόδου και το παραγόμενο πολυγωνικό επίπεδο. Η εκτέλεση του αλγόριθμου παράγει ένα (ή περισσότερα, εφόσον οριστεί πεδίο ομαδοποίησης), κυρτά πολυγωνικά κελύφη (Σχήμα 1.29).
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    Σχήμα 1.29 Κυρτό κέλυφος του επιπέδου LAND (ακτογραμμή ν. Ανάφης).


    [bookmark: _Hlk422306397]


    [bookmark: _Toc438361100]1.5.2 Δημιουργία περιμετρικών ζωνών (buffer Zones)


    Η λειτουργία αυτή εκτελείται μέσα από το μενού Vector > Geoprocessing Tools > Buffer(s).
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    Σχήμα 1.30 Περιμετρικές ζώνες γύρω από τον οικισμό της Ανάφης (1000μ, [bookmark: _Hlk422306493]ζώνη κόκκινου χρώματος), και από την ακτογραμμή (500μ, ζώνη γαλάζιου χρώματος).


    Αφού καθοριστεί το επίπεδο εισόδου, εισάγεται η ακτίνα της ζώνης (ή προσδιορίζει το πεδίο το οποίο την καθορίζει), και το παραγόμενο επίπεδο. Η εκτέλεση του αλγόριθμου παράγει τις περιμετρικές ζώνες (Σχήμα 1.30).


    


    [bookmark: _Toc438361101]1.5.3 Τομή δεδομένων (Intersect)


    Μ’ αυτήν τη λειτουργία, έπειτα από την υπέρθεση των επιπέδων, διατηρούνται μόνο οι κοινές οντότητες τους. Για την εκτέλεση της λειτουργίας αυτής, ορίζεται ένα επίπεδο επεξεργασίας και ένα επίπεδο υπέρθεσης. Το επίπεδο υπέρθεσης θα πρέπει να περιέχει πολύγωνα έτσι ώστε, να ορίζεται η περιοχή τομής των δύο επιπέδων. Το παραγόμενο θεματικό επίπεδο «κληρονομεί» τις περιγραφές και από τα δύο επίπεδα επεξεργασίας. Επιπλέον, επειδή με τη λειτουργία τομής επιπέδων ενδέχεται να δημιουργούνται νέες πολυγωνικές οντότητες, επιβάλλεται ο εκ νέου υπολογισμός των γεωμετρικών ιδιοτήτων (π.χ. έκταση) στο παραγόμενο επίπεδο. Η λειτουργία αυτή εκτελείται στο λογισμικό QGIS, μέσα από το μενού Vector > Geoprocessing Tools > Intersect(Σχήμα 1.31).
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    Σχήμα 1.31 Τομή του επιπέδου ξηράς (Land) με το επίπεδο της περιοχής γύρω από τη Χώρα (Buf_Xwra) στη ν. Ανάφη. Το αποτέλεσμα αυτής της λειτουργίας απεικονίζεται με κόκκινο χρώμα (εργασία με το λογισμικό QGIS).


    


    [bookmark: _Toc438361102]1.5.4 Ένωση δεδομένων (Union)


    Με τη λειτουργία ένωσης θεματικών επιπέδων, συνδυάζονται δύο ή περισσότερα επίπεδα και όλες οι οντότητές τους (ανεξαρτήτως της επικάλυψης ή μη) μεταφέρονται στο παραγόμενο επίπεδο.Με ανάλογο τρόπο, όπως με τη λειτουργία τομής, θα πρέπει να ορίζεται ένα επίπεδο επεξεργασίας και ένα επίπεδο υπέρθεσης, ενώ το παραγόμενο θεματικό επίπεδο «κληρονομεί» τις περιγραφές και από τα δύο επίπεδα επεξεργασίας. Η λειτουργία αυτή εκτελείται στο λογισμικό QGIS, μέσα από το μενού Vector > Geoprocessing Tools > Union. Η ένωση θεματικών επιπέδων χρησιμοποιείται συχνά σε εφαρμογές πολυκριτηριακής ανάλυσης σε περιβάλλον vector GIS (Σχήμα 1.32).


    [bookmark: _Toc438361103]1.5.5 Συμμετρική διαφορά δεδομένων (Symmetrical Difference)


    Με την λειτουργία της συμμετρικής διαφοράς συνδυάζονται δύο θεματικά επίπεδα και όλες οι οντότητές τους οι οποίες δεν επικαλύπτονται μεταφέρονται στο παραγόμενο επίπεδο. Η λειτουργία αυτή εκτελείται στο λογισμικό QGIS μέσα από το μενού Vector > Geoprocessing Tools > Symmetrical Difference(Σχήμα 1.33).
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    Σχήμα 1.32 Ένωση του επιπέδου περιμετρικής ζώνης από την ακτογραμμή με το επίπεδο περιμετρικής ζώνης γύρω από τη Χώρα στη ν. Ανάφη. Το αποτέλεσμα αυτής της λειτουργίας φαίνεται στην εικόνα με καφέ ανοιχτό χρώμα.


    


    


    [image: ]


    Σχήμα 1.33Συμμετρική διαφορά του επιπέδου περιμετρικής ζώνης από την ακτογραμμή (BufCoast) με το επίπεδο περιμετρικής ζώνης γύρω από τη Χώρα (Buf_Xwra) στη ν. Ανάφη. Το αποτέλεσμα αυτής της λειτουργίας απεικονίζεται με πράσινο χρώμα (εργασία με το λογισμικό QGIS). Σημειώνεται ότι το επίπεδο αυτό έχει αποκοπεί (λειτουργία CLIP) στα όρια της ξηράς.


    


    [bookmark: _Toc438361104]1.5.6 Αποκοπή δεδομένων (Clip)


    Στην λειτουργία αποκοπής χρησιμοποιείται ένα επίπεδο δεδομένων και ένα επίπεδο αποκοπής. Η Εκτέλεση αυτής της λειτουργίας έχει ως αποτέλεσμα την αποκοπή των δεδομένων εισόδου στα όρια του επιπέδου αποκοπής. Η λειτουργία αυτή εκτελείται στο λογισμικό QGIS, μέσα από το μενού Vector > Geoprocessing Tools > Clip (Σχήμα 1.34).
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    Σχήμα 1.34 Αποκοπή του επιπέδου περιμετρικής ζώνης από την ακτογραμμή (BufCoast) στα όρια της ξηράς (επίπεδο LAND) στη ν. Ανάφη. Το αποτέλεσμα αυτής της λειτουργίας απεικονίζεται με σκούρα μπλε απόχρωση . Με γαλάζια απόχρωση φαίνεται το τμήμα του αρχικού επιπέδου το οποίο δεν αποκόπτεται.


    


    [bookmark: _Toc438361105]1.5.7 Απαλοιφή – διαφορά δεδομένων (Difference – Erase)


    Με την επεξεργασία απαλοιφής δημιουργούνται οντότητες μετά από την υπέρθεση των οντοτήτων του επιπέδου εισόδου με τα πολύγωνα του επιπέδου απαλοιφής. Σημειώνεται ότι, οι οντότητες του επιπέδου εισόδου που περιλαμβάνονται στο παραγόμενο επίπεδο είναι μόνον εκείνες οι οποίες βρίσκονται εκτός των ορίων των πολυγώνων απαλοιφής (Σχήμα 1.35).
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    Σχήμα 1.35 Απαλοιφή του επιπέδου περιμετρικής ζώνης από τη Χώρα (BufXwra) από το επίπεδο της ξηράς (επίπεδο LAND) στη ν. Ανάφη. Το αποτέλεσμα αυτής της λειτουργίας απεικονίζεται με μωβ χρώμα.


    


    [bookmark: _Toc438361106]1.5.8 Συγχώνευση δεδομένων (Dissolve)


    Με την λειτουργία αυτή, συγχωνεύονται οντότητες σ’ ένα επίπεδο με βάση κάποιο κοινό χαρακτηριστικό τους (θεματική περιγραφή). Παράδειγμα: Συνένωση νομών της Ελλάδας με βάση την περιφέρεια στην οποία υπάγονται. Με αυτόν τον τρόπο μπορεί να υλοποιηθεί και επαναταξινόμηση (ομαδοποίηση) των οντοτήτων ενός επιπέδου. Θα πρέπει επίσης να καθοριστεί το πεδίο βάσει του οποίου θα γίνει η συγχώνευση. Εφικτή είναι η εφαρμογή της λειτουργίας σε σημεία, γραμμές και πολύγωνα (multipoint, multiline και multipolygon επίπεδα) αλλά θα πρέπει να καθοριστεί ο τρόπος χειρισμού των υπολοίπων περιγραφών (First / last, Sum, min, max, mean) (Σχήμα 1.36).
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    Σχήμα 1.36 Συγχώνευση δεδομένων δήμων (πολύγωνα με λευκό περίγραμμα) για την κατασκευή του επίπεδου των Νομών (πολύγωνα με μαύρο περίγραμμα).


    


    [bookmark: _Toc438361107]1.5.9 Δημιουργία πολυγώνων Thiessen – Voronoi


    Για τη δημιουργία των πολυγώνων Thiessen / Voronoi σε περιβάλλον QGIS, θα πρέπει σε πρώτο στάδιο να γίνει εισαγωγή του επιπέδου εισαγωγής με σημειακές οντότητες. Στη συνέχεια, από το μενού Vector > Geometry Toolsεπιλέγουμε Voronoi Polygonsκαι αφού καθοριστεί το επίπεδο εισαγωγής και το παραγόμενο, με εκτέλεση του αλγόριθμου, προκύπτει η κατασκευή των πολυγώνων Thiessen / Voronoi (Σχήμα 1.37).
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    Σχήμα 1.37 Δημιουργία πολυγώνων Thiessen / Voronoi σε περιβάλλον QGIS.


    


    Με παρόμοιο τρόπο και από το μενού Vector > Geometry Tools> Delaunay Triangulation, λαμβάνει χώρα ο τριγωνισμός Delaunay, από σημειακά αρχικά δεδομένα (Σχήμα 1.38).
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    Σχήμα 1.38 Τριγωνισμός Delaunay σε περιβάλλον QGIS.
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    [bookmark: _Toc438361109]Κριτήρια Αξιολόγησης


    [bookmark: _Toc438361110]Κριτήριο Αξιολόγησης 1 - Ερωτήσεις Κατανόησης


    · Με ποιες μεθόδους λαμβάνει χώρα η επιλογή οντοτήτων από διανυσματικά θεματικά επίπεδα;


    · Τι είδος χωρικών αντικειμένων (σημεία, γραμμές ή πολύγωνα), παράγεται μετά την εκτέλεσης της δημιουργίας περιμετρικών ζωνών (Buffer zones); Αναφέρατε παραδείγματα εφαρμογής της λειτουργίας Buffer zones από σημειακές γραμμικές και πολυγωνικές οντότητες.


    · Πώς ορίζονται και πώς δημιουργούνται τα πολύγωνα Thiessen;


    · Ποιες είναι οι βασικές λειτουργίες υπέρθεσης διανυσματικών δεδομένων;


    · Τι γνωρίζετε για τα σφάλματα λόγω δημιουργίας επιμηκών πολυγώνων (sliver polygons). Ποια είναι τα κύρια αίτια δημιουργίας τους και ποιες είναι οι ενέργειες απαλοιφής τους;


    


    [bookmark: _Toc438361111][bookmark: _Hlk422214373]Κριτήριο Αξιολόγησης 2 - ΑΣΚΗΣΗ: [bookmark: _Hlk422301523][bookmark: _Hlk422302082]Επιλογές με βάση χωρικές ιδιότητες


    Με δεδομένο το επίπεδο των Δήμων της Ελλάδας, ζητείται η δημιουργία, σε περιβάλλον λογισμικού GIS, του επιπέδου των Νομών και η αξιοποίηση αυτού του επιπέδου για την επιλογή των Νομών οι οποίοι απέχουν απόσταση < 100 χλμ από το Νομό Θεσσαλονίκης. Πόση είναι η συνολική έκταση αυτών των Νομών;


    


    [bookmark: _Toc438361112]ΕΠΙΛΥΣΗ: Αρχικές ενέργειες – Εισαγωγή των δεδομένων


    Το θεματικό επίπεδο στο οποίο βασίζεται η άσκηση είναι το πολυγωνικό θεματικό επίπεδο των Δήμων της Ελλάδας. Στον πίνακα περιγραφών αυτού του επιπέδου καταγράφεται για κάθε Δήμο της χώρας τόσο το όνομα του Δήμου όσο και το όνομα του Νομού στον οποίο ανήκει. Αρχικά, γίνεται εισαγωγή του επιπέδου των Δήμων σε περιβάλλον QGIS (Σχήμα 1.39).
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    Σχήμα 1.39 Θεματικό επίπεδο Δήμων.


    


    Στη συνέχεια, για την δημιουργία του επιπέδου των Νομών της Ελλάδας θα γίνει συγχώνευση (dissolve) των Δήμων με βάση το πεδίο στο οποίο καταγράφεται ο νομός στον οποίο ανήκουν (στήλη FIRST_NA_1).


    Έτσι, από το μενού Vector > Geoprocessing Tools επιλέγεται η εντολή Dissolve και καθορίζονται οι παράμετροι για τη λειτουργία που φαίνονται στο παρακάτω σχήμα (Σχήμα 1.40).
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    Σχήμα 1.40 Μενού Dissolve.


    


    Η ενέργεια αυτή έχει ως αποτέλεσμα τη δημιουργία του επιπέδου των Νομών (Σχήμα 1.41).
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    Σχήμα 1.41 Παραγόμενο επίπεδο Νομών.


    


    Στη συνέχεια, αφού επιλεγεί το επίπεδο ΝΟΜΟΙ από τη λίστα θεματικών επιπέδων του έργου, η επιλογή του πολυγώνου που αντιστοιχεί στο Ν. Θεσσαλονίκης γίνεται με το εργαλείο Select features from expression και τη σύνταξη του παρακάτω ερωτήματος (Σχήμα 1.42).
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    Σχήμα 1.42 Επιλογή με βάση θεματικά χαρακτηριστικά.


    


    Η εκτέλεση του ερωτήματος έχει ως αποτέλεσμα την επιλογή του Ν. Θεσσαλονίκης, τόσο στον πίνακα περιγραφών όσο και στο χάρτη (πολύγωνο με κίτρινο χρώμα) (Σχήμα 1.43).
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    Σχήμα 1.43 Επιλογή Ν. Θεσσαλονίκης.


    


    Ακολουθεί η επιλογή των γειτονικών νομών με βάση ένα χωρικό ερώτημα από το μενού Vector > Research Tool > Select by Location (Σχήμα 1.44, Σχήμα 1.45).
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    Σχήμα 1.44 Επιλογή με βάση χωρικές ιδιότητες.
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    Σχήμα 1.45Αποτέλεσμα επιλογής γειτονικών οντοτήτων Ν. Θεσσαλονίκης.


    


    Οι επιλεγμένες οντότητες αποθηκεύονται σε νέο θεματικό επίπεδο με δεξί κλικ πάνω στο επίπεδο ΝΟΜΟΙ και επιλογή Save as (Σχήμα 1.46).
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    Σχήμα 1.46 Αποθήκευση επιλογής.


    


    Τέλος, με την εντολή Vector > Analysis Tools > Basic Statistics μπορεί να υπολογιστεί το άθροισμα της έκτασης των νομών το επιπέδου THES_OMOROI (~ 1746 Km2) (Σχήμα 1.47).
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    Σχήμα 1.47 Βασικά στατιστικά στοιχεία επιλογών.
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    Σύνοψη


    Στο κεφάλαιο αυτό παρουσιάζονται μεθοδολογίες ανάλυσης ψηφιδωτών (raster) δεδομένων σε περιβάλλον Συστημάτων Γεωγραφικών Πληροφοριών. Αρχικά γίνεται μια εισαγωγή στο αντικείμενο, δίνονται βασικοί ορισμοί και παρουσιάζεται η δομή του κεφαλαίου. Στη συνέχεια αναπτύσσονται οι τέσσερεις βασικοί τύποι λειτουργιών: τοπικές (local), εστιακές (focal), ζώνης (zonal) και γενικευμένες (global) λειτουργίες. Τέλος, το κεφάλαιο ολοκληρώνεται με την υλοποίηση παραδειγματικών πρακτικών εφαρμογών ανάλυσης ψηφιδωτών δεδομένων σε περιβάλλον λογισμικού GIS.


    


    Προαπαιτούμενη γνώση


    Οι προαπαιτούμενες γνώσεις τις οποίες θα πρέπει να έχει ο αναγνώστης εστιάζονται στην κατανόηση του ψηφιδωτού μοντέλου χωρικών δεδομένων και στις βασικές διαφορές του από το διανυσματικό μοντέλο, ενώ επιθυμητή είναι και η γνώση των λειτουργιών υπέρθεσης διανυσματικών δεδομένων, καθώς υπάρχουν αρκετές εννοιολογικές αναλογίες.
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    Το ψηφιδωτό μοντέλο χωρικών δεδομένων (raster model), σε αντιδιαστολή με το διανυσματικό μοντέλο στο οποίο εξετάζονται αντικείμενα του χώρου, έχει ως βασικό χαρακτηριστικό την εξέταση τμημάτων (tiles) του χώρου, τα οποία συνήθως έχουν τη μορφή περιοχών τετραγωνικού σχήματος οι οποίες καλούνται ψηφίδες ή κελιά (Χαλκιάς, 2006). Αυτός ο τρόπος αναπαράστασης είναι ιδιαίτερα αποδοτικός – μεταξύ των άλλων – και για την αποθήκευση δεδομένων τα οποία προέρχονται από αισθητήρες Τηλεπισκόπησης. Συνήθως, τα ψηφιδωτά δεδομένα οργανώνονται σε επίπεδα (raster layers ή grids) ορθογώνιου σχήματος, αφού αποτελούνται από ένα συγκεκριμένο αριθμό στηλών και γραμμών οι οποίες περιέχουν τετραγωνικές ψηφίδες (Σχήμα 2.1).
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    Σχήμα 2.1 To ψηφιδωτό μοντέλο χωρικών δεδομένων.


    


    Σε συνέχεια της παρουσίασης μεθόδων επεξεργασίας διανυσματικών δεδομένων η οποία επιχειρήθηκε στο προηγούμενο κεφάλαιο, στο κεφάλαιο αυτό παρουσιάζεται η ανάλυση ψηφιδωτών δεδομένων η οποία αποτελεί ένα ιδιαίτερα ισχυρό εργαλείο εξόρυξης και ανάλυσης γεωγραφικών πληροφοριών. Οι γεωεπεξεργασίες αυτού του τύπου, είναι αρκετά συνηθισμένες σε εφαρμογές διαχείρισης - ανάλυσης του χώρου, ιδιαίτερα λόγω της απλότητάς τους σε σχέση με τις επεξεργασίες διανυσματικών δεδομένων, καθώς και λόγω της μεγάλης διαθεσιμότητας ψηφιδωτών δεδομένων που προέρχονται από αισθητήρες Τηλεπισκόπησης.


    Η χρήση ψηφιδωτών δεδομένων απλοποιεί αρκετές λειτουργίες χωρικής ανάλυσης οι οποίες θα ήταν δύσκολο να εκτελεστούν σε διανυσματικά δεδομένα. Μερικές από αυτές τις λειτουργίες και τεχνικές ανάλυσης γεωχωρικών δεδομένων παρουσιάζονται στο παρόν κεφάλαιο, ενώ για κάποιες ειδικές κατηγορίες τους γίνεται σύντομη νύξη και παρουσιάζονται λεπτομερώς σε επόμενα κεφάλαια (π.χ. ανάλυση επιφανειών, υδρολογική ανάλυση κεφ.6).


    Τα σύγχρονα λογισμικά GIS διαθέτουν πληθώρα εργαλείων γεωεπεξεργασιών ψηφιδωτών δεδομένων. Για παράδειγμα, στο λογισμικό ArcGIS μέσω της επέκτασης ArcGIS Spatial Analyst παρέχεται μια πλούσια εργαλειοθήκη λειτουργιών επεξεργασίας ψηφιδωτών δεδομένων (Verbyla, 2002). Αυτές οι λειτουργίες ταξινομούνται σε τέσσερις βασικές κατηγορίες: τις τοπικές (local), τις κεντρικές ή λειτουργίες γειτονίας (focal), τις λειτουργίες ζωνών (zonal) και τις γενικευμένες (global) λειτουργίες. Στις παραπάνω κατηγορίες χρησιμοποιείται η θεωρία της άλγεβρας χαρτών (Map Algebra) η οποία τεκμηριώθηκε στις αρχές τις δεκαετίας του 1990 (Tomlin, 1990). Μέσω αυτής της θεωρίας, η οποία στην ουσία είναι μια υπολογιστική γλώσσα, η επιφάνεια της γης μοντελοποιείται με τη χρήση επιπέδων γεωγραφικών δεδομένων τα οποία είναι θεματικά ανεξάρτητα μεταξύ τους, αλλά έχουν χωρική ταύτιση. Τα επίπεδα αυτά επεξεργάζονται μεμονωμένα ή συνδυαστικά – με τη χρήση λειτουργιών ή πράξεων οι οποίες εφαρμόζονται στα επίπεδα ψηφιδωτών δεδομένων (Bruns & Egenhofer, 1997, DeMers, 2002). Το αποτέλεσμα της εφαρμογής επεξεργασιών «άλγεβρας χαρτών», είναι ένα νέο επίπεδο ψηφιδωτών δεδομένων το οποίο ταυτίζεται χωρικά με τα επίπεδα επεξεργασίας. Παρακάτω, παρατίθενται παραδείγματα λειτουργιών και πράξεων άλγεβρας χαρτών:


    Λειτουργία άλγεβρας χαρτών: OutputRAS = combine (RAS1, RAS2) (Σχήμα 2.2).
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    Σχήμα 2.2 Λειτουργία άλγεβρας μεταξύ χαρτών (συνδυασμός / combine επιπέδων).


    Με την πράξη αυτή, δημιουργείται το επίπεδο στο οποίο καταγράφονται οι συνδυασμοί μεταβολών κάλυψης γης, από δύο επίπεδα κάλυψης. Πράξη άλγεβρας χαρτών: ΘΕΡΜΟΚΡΑΣΙΑ_C_raster = 5 * (ΘΕΡΜΟΚΡΑΣΙΑ_F_raster - 32) / 9. Με τη συγκεκριμένη διαδικασία δημιουργείται το επίπεδο θερμοκρασίας σε βαθμούς Κελσίου, από επίπεδο θερμοκρασίας, όπου η μονάδα είναι βαθμοί Φαρενάϊτ. Θα πρέπει να σημειωθεί ότι, για να εφαρμοστούν επεξεργασίες άλγεβρας χαρτών οι οποίες απαιτούν πολλά επίπεδα δεδομένων, θα πρέπει τα δεδομένα αυτά να έχουν ταυτόσημες γεωμετρικές ιδιότητες (χωρική αναφορά, μέγεθος ψηφίδας, κ.λ.π).


    Παρότι, όπως και με τα διανυσματικά δεδομένα, οι λειτουργίες ανάλυσης ψηφιδωτών δεδομένων μπορούν να ταξινομηθούν με βάση την εφαρμογή τους σ’ ένα ή περισσότερα θεματικά επίπεδα, παρακάτω θα παρουσιαστεί η ταξινόμησή τους σύμφωνα με την κλίμακα ανάλυσης. Σύμφωνα με αυτήν την ταξινόμηση, η οποία προτάθηκε από τον Tomlin, οι λειτουργίες ανάλυσης ψηφιδωτών δεδομένων διακρίνονται σε τοπικές (Local), εστιακές ή κεντρικές (focal), ζώνης (zonal) και γενικευμένες (global).
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    Οι τοπικές λειτουργίες μπορούν να εφαρμοστούν είτε σ’ ένα μεμονωμένο είτε συνδυαστικά σε δύο ή περισσότερα ψηφιδωτά θεματικά επίπεδα. Η εφαρμογή μιας τοπικής λειτουργίας σ’ ένα θεματικό επίπεδο συνήθως εξαρτάται από την εφαρμογή μιας μαθηματικής ή και λογικής πράξης για κάθε ψηφίδα του επιπέδου. Η τιμή για κάθε ψηφίδα του παραγόμενου επιπέδου μετά από μια τοπική λειτουργία εξαρτάται αποκλειστικά και μόνο από την τιμή της συγκεκριμένης ψηφίδας του επιπέδου (ή των επιπέδων) εισόδου. Οι τοπικές λειτουργίες μπορεί να έχουν τη μορφή απλών αριθμητικών πράξεων (πρόσθεση, αφαίρεση, πολλαπλασιασμός, διαίρεση), μαθηματικών λειτουργιών (λογαριθμικές, εκθετικές, τριγωνομετρικές κ.λ.π), λογικών τελεστών και συνθηκών (π.χ. AND, OR, NOT, IF, THEN, ELSE), επαναταξινομήσεων ή επιλογών σ’ ένα ψηφιδωτό θεματικό επίπεδο, καθώς και άλλων σύνθετων λειτουργιών (π.χ. συνδυασμοί / COMBINE επιπέδων, έλεγχος συνθηκών / εντολή CON).


    Στο Σχήμα 2.3 παρουσιάζεται μια απλή τοπική αριθμητική λειτουργία μεταξύ δύο ψηφιδωτών επιπέδων.
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    Σχήμα 2.3 Τοπική λειτουργία (αριθμητική πρόσθεση επιπέδων).


    


    Η εκτέλεση μιας τοπικής λειτουργίας σε δύο ή περισσότερα θεματικά επίπεδα είναι ιδιαίτερα συνηθισμένη λειτουργία σε πολλές εφαρμογές γεωγραφικής ανάλυσης. Σε μοντέλα σταθμισμένης χαρτογραφικής υπέρθεσης συχνά η τελική σύνθεση των κριτηρίων / μεταβλητών του μοντέλου γίνεται με την εκτέλεση τοπικής λειτουργίας της παρακάτω μορφής: Output = Layer_1 * w1 + Layer_2 * W2 + …+ Layer_n * wn, όπου Layer_1, 2, …, n είναι τα θεματικά επίπεδα των κριτηρίων/μεταβλητών τα οποία συνδυάζονται και w1, 2, ..., n είναι συντελεστές βαρύτητας κάθε κριτηρίου (Σχήμα 2.4).
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    Σχήμα 2.4 Τοπική λειτουργία: σταθμισμένη άθροιση επιπέδων.


    


    Μια άλλη συνηθισμένη εφαρμογή τοπικής λειτουργίας σε πολλά θεματικά επίπεδα σχετίζεται με την ανίχνευση αλλαγών από χρονοσειρές ψηφιδωτών δεδομένων. Για παράδειγμα, αν διαθέτουμε δύο ψηφιδωτά θεματικά επίπεδα με τη μέση θερμοκρασία θερινής και χειμερινής περιόδου, με μια απλή τοπική πράξη αφαίρεσης των δύο επιπέδων είναι δυνατόν να ανιχνευτεί η χωρική κατανομή του εύρους της ετήσιας θερμοκρασίας (Σχήμα 2.5).
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    Σχήμα 2.5 Τοπική λειτουργία: αφαίρεση επιπέδων.
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    Οι λειτουργίες αυτές οι οποίες καλούνται και λειτουργίες γειτονίας, σχετίζονται άμεσα με τον 1ο νόμο της Γεωγραφίας (Tobler, 1970) σύμφωνα με τον οποίο κάθε αντικείμενο του χώρου σχετίζεται μ’ όλα τα άλλα αντικείμενα, αλλά τα κοντινά μεταξύ τους αντικείμενα σχετίζονται περισσότερο από τα απομακρυσμένα. Οι λειτουργίες αυτές μπορούν να εφαρμοστούν είτε σ’ ένα μεμονωμένο είτε συνδυαστικά σε δύο ή περισσότερα ψηφιδωτά θεματικά επίπεδα και για την εκτέλεσή τους χρειάζεται να οριστεί η περιοχή (ή παράθυρο) γειτονίας (kernel ή moving window). Σ’ αυτές τις λειτουργίες, η τιμή για μια συγκεκριμένη ψηφίδα στο παραγόμενο θεματικό επίπεδο είναι μια συνάρτηση της τιμής των ψηφίδων σε περιοχή γειτονίας περιμετρικά αυτής της ψηφίδας. Για παράδειγμα, αν οριστεί ως περιοχή γειτονίας ένα παράθυρο μεγέθους 3Χ3 μπορεί να εκτελεστεί η κεντρική λειτουργία άθροισης τιμών (FocalSUM) (Σχήμα 2.6).
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    Σχήμα 2.6 Κεντρική λειτουργία άθροισης τιμών (FocalSUM).


    


    Συνεπώς, για τη σημειωμένη ψηφίδα με αρχική τιμή 3, υπολογίζεται το άθροισμα των τιμών των ψηφίδων γύρω από αυτήν σε παράθυρο 3Χ3 (άθροισμα = 2+0+1+2+3+0+4+2+2) και η τιμή αυτή (16) είναι η τιμή της ψηφίδας στο παραγόμενο επίπεδο. Θα πρέπει να σημειωθεί ότι, στα όρια του επιπέδου το παράθυρο 3Χ3 δεν περιέχει 9 άλλα 6 (στις πλευρές) ή 4 (στις γωνίες) ψηφίδες. Έτσι, οι υπολογισμοί των κεντρικών λειτουργιών σε αυτές τις ψηφίδες προκύπτουν από τις αρχικές τιμές και δε λαμβάνουν υπόψη τις γειτονικές τιμές, εκτός των ορίων του επιπέδου. Αν αυτό δεν είναι επιθυμητό, μια πιθανή λύση δίνει η επέκταση της περιοχής μελέτης. Οι κεντρικές λειτουργίες στατιστικής ανάλυσης (Focal_mean, Focal_StDev, Focal_sum, Focal_Min, Focal_Max, Focal_Range, Focal_Majority, Focal_Frequency κλπ) σε ψηφιδωτό θεματικό επίπεδο αποτελούν χαρακτηριστικά παραδείγματα λειτουργιών αυτού του τύπου (Σχήμα 2.7).
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    Σχήμα 2.7 Κεντρικές λειτουργίες στατιστικής ανάλυσης.


    


    Η εκτέλεση των κεντρικών λειτουργιών, βασίζεται στην ιδέα του «κινητού παραθύρου» το οποίο διατρέχει το επίπεδο εισόδου και το οποίο ορίζει την περιοχή επεξεργασίας τιμών για κάθε ψηφίδα. Η επεξεργασία αρχίζει να εκτελείται από την πάνω αριστερή ψηφίδα, καθώς το παράθυρο κινείται από αριστερά προς τα δεξιά και από πάνω προς τα κάτω. Το σχήμα του κινητού παράθυρου γειτονίας μπορεί να είναι ορθογώνιο, κύκλος, δακτύλιος, κυκλικός τομέας ή ακανόνιστο (Σχήμα 2.8).
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    Σχήμα 2.8 Τύποι παραθύρων γειτονίας κεντρικών λειτουργιών : α) ορθογώνιο 3 Χ 3, β) κύκλος, γ) δακτύλιος δ) κυκλικός τομέας ε) ακανόνιστο.


    


    Παρόμοια λογική χρησιμοποιείται και για τις λειτουργίες «φιλτραρίσματος» εικόνων. Για παράδειγμα, με το φίλτρο μέσου όρου (ΜΕΑΝ), απομακρύνονται οι τοπικές εξάρσεις και ταπεινώσεις του αναγλύφου με αποτέλεσμα τη δημιουργία ενός εξομαλυμένου παραγόμενου επιπέδου. Με ανάλογο τρόπο μπορούν να εκτελεστούν κεντρικές λειτουργίες για την ενίσχυση των αντιθέσεων σ’ ένα ψηφιδωτό θεματικό επίπεδο. Χαρακτηριστικά παραδείγματα αυτού του τύπου είναι οι κεντρικές λειτουργίες ανίχνευσης ορίων (edge detection). Η στατιστική λειτουργία εύρους τιμών (RANGE) είναι μια από αυτές. Στο παραγόμενο επίπεδο, έπειτα από την εκτέλεση της κεντρικής λειτουργίας RANGE, οι ψηφίδες με μεγάλες τιμές σχετίζονται με περιοχές ύπαρξης ορίων. Επιπρόσθετα, για την ανίχνευση ορίων σ’ ένα παράθυρο γειτονίας μπορούν να οριστούν κι άλλες πράξεις εκτός από τις στατιστικές επεξεργασίες. Στο παρακάτω σχήμα (Σχήμα 2.9) παρουσιάζεται ένα παράδειγμα κεντρικής λειτουργίας για την ανίχνευση ορίων μεταξύ ζωνών ψηφίδων με παρόμοιες τιμές. Στο παραγόμενο Α, γίνεται ανίχνευση των ορίων με διεύθυνση Α-Δ (οριζόντια όρια), ενώ στο παραγόμενο Β ορίων με διεύθυνση Β-Ν (κάθετα όρια).
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    Σχήμα 2.9 Κεντρική λειτουργία σε παράθυρο 3Χ3 για την ανίχνευση οριζόντιων και κάθετων ορίων.
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    Στις λειτουργίες ζώνης, μονάδα ανάλυσης αποτελούν οι περιοχές με εσωτερική ομοιογένεια στο επίπεδο ζωνών. Σ’ αυτές τις λειτουργίες η τιμή για κάθε ψηφίδα του παραγόμενου επιπέδου υπολογίζεται με βάση τις τιμές όλων των ψηφίδων της ζώνης στην οποία ανήκει η συγκεκριμένη ψηφίδα στο επίπεδο εισόδου. Θα πρέπει να σημειωθεί ότι, οι ζώνες αυτές αποτελούνται από ψηφίδες οι οποίες δεν είναι απαραίτητα γειτονικές. Για το λόγο αυτό, στο παραγόμενο επίπεδο όλες οι ψηφίδες εντός συγκεκριμένης ζώνης έχουν την ίδια τιμή. Από τα παραπάνω, γίνεται φανερό ότι το αποτέλεσμα μιας λειτουργίας ζώνης μπορεί να αποδοθεί και σε πίνακα με αριθμό εγγραφών ίσο με τον αριθμό των ζωνών. Για παράδειγμα, αν επιχειρείται η εύρεση της μέγιστης κλίσης του εδάφους, για κάθε τύπο κάλυψης γης σε μια περιοχή ενδιαφέροντος θα πρέπει να εκτελεστεί η λειτουργία ZonalMax στο επίπεδο Κλίση_εδάφους με τον ορισμό του επιπέδου Εδαφική_κάλυψη ως επίπεδο ζωνών (Σχήμα 2.10).
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    Σχήμα 2.10 Λειτουργία ζώνης (ZonalMAX).


    


    Στο παράδειγμα του σχήματος που ακολουθεί στο αρχικό επίπεδο καταγράφεται ο πληθυσμός των ατόμων ενός συγκεκριμένου ζώου σε κάθε ψηφίδα. Το επίπεδο ζώνης αντιστοιχεί σε διαφορετικούς τύπους βλάστησης. Στο παραγόμενο επίπεδο (λειτουργία zonalSum) καταγράφεται το σύνολο των ατόμων σε κάθε τύπο βλάστησης (Σχήμα 2.11).
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    Σχήμα 2.11 Λειτουργία ζώνης (ZonalSUM).


    


    Επομένως, στην ζώνη με κωδικό 1 υπάρχουν συνολικά 25 (3+4+8+5+5) άτομα, στη ζώνη 2 συνολικά 21 (1+2+5+3+5+5) άτομα, ενώ στη ζώνη 3 η οποία σημειώνεται με κόκκινο χρώμα υπάρχουν συνολικά 15 (6+7+2) άτομα. Θα πρέπει να σημειωθεί ότι για περιοχές στις οποίες το επίπεδο ζώνης έχει την τιμή NoValue (κενές ψηφίδες) η εκτέλεση της λειτουργίας ζώνης αποδίδει την τιμή NoValue.


    


    [bookmark: _Toc438361118]2.5 Γενικευμένες (Global) λειτουργίες


    Στις γενικευμένες λειτουργίες οι τιμές σε κάθε ψηφίδα του παραγόμενου επιπέδου υπολογίζονται δυνητικά συναρτήσει όλων των ψηφίδων του επιπέδου εισόδου. Έτσι, οι γενικευμένες λειτουργίες είναι ανάλογες με τις λειτουργίες ζώνης αν θεωρήσουμε ότι το σύνολο του επιπέδου εισόδου αντιπροσωπεύει μια ζώνη. Παραδείγματα αυτού του τύπου αποτελούν οι λειτουργίες εύρεσης απόστασης, οι λειτουργίες παρεμβολής, οι γενικευμένες στατιστικές λειτουργίες (π.χ. λειτουργία global range), οι λειτουργίες υδρολογικής ανάλυσης, οι λειτουργίες ανάλυσης ορατότητας κλπ. (Σχήμα 2.12).
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    Σχήμα 2.12 Γενικευμένη λειτουργία εύρους τιμών (GlobalRange).


    


    Οι γενικευμένες λειτουργίες μέτρησης απόστασης χρησιμοποιούνται ευρύτατα σε εφαρμογές γεωγραφικής ανάλυσης. Η πιο απλή μορφή λειτουργίας αυτού του τύπου είναι ο υπολογισμός της ευθείας (ή ευκλείδειας) απόστασης. Στο παρακάτω σχήμα (Σχήμα 2.13) φαίνεται η εκτέλεση της γενικευμένης λειτουργίας ευκλείδειας απόστασης από τις ψηφίδες του αρχικού επιπέδου με τιμές 1 και 2. Στο παραγόμενο θεματικό επίπεδο υπολογίζεται για κάθε ψηφίδα η απόσταση προς την πλησιέστερη ψηφίδα με τιμή 1 ή 2. Στο αποτέλεσμα η απόσταση αυτή καταγράφεται σε μονάδα μήκους ίση με την πλευρά κάθε ψηφίδας.
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    Σχήμα 2.13 Γενικευμένη λειτουργία ευκλείδειας απόστασης (distance). Στο παραπάνω παράδειγμα η πλευρά κάθε ψηφίδας έχει τιμή 1.


    


    Είναι προφανές ότι, με επαναταξινόμηση του επιπέδου απόστασης από οντότητες μπορούν να δημιουργηθούν ζώνες απόστασης οι οποίες αποτελούν παράγωγο επίπεδο αντίστοιχο των περιμετρικών ζωνών (Buffer Zones).


    


    [bookmark: _Toc438361119]2.6 Ανάλυση ψηφιδωτών δεδομένων σε περιβάλλον λογισμικού GIS – Η χρήση του λογισμικού ArcGIS


    Το λογισμικό ArcGIS παρέχει πληθώρα λειτουργιών ανάλυσης ψηφιδωτών δεδομένων μέσω της επέκτασης Spatial Analyst. Μετά από μια σύντομη παρουσίαση των βασικών δυνατοτήτων της επέκτασης παρουσιάζονται οι κυριότερες λειτουργίες ανάλυσης ψηφιδωτών δεδομένων στο λογισμικό ArcGIS.


    


    [bookmark: _Toc438361120]2.6.1 Spatial Analyst – Βασικές δυνατότητες


    Παρακάτω, ακολουθεί εισαγωγή στη δημιουργία και διαχείριση ψηφιδωτών χωρικών δεδομένων, τα οποία στην ορολογία του λογισμικού ArcGIS καλούνται GRIDs. Βασικός στόχος είναι η παρουσίαση του τρόπου εμφάνισης και διαχείρισης ψηφιδωτών δεδομένων με την αξιοποίηση της επέκτασης Spatial Analyst του λογισμικού GIS ArcGIS. επίσης, παρουσιάζονται οι διαδικασίες μετατροπών διανυσματικών χωρικών δεδομένων σε ψηφιδωτά δεδομένα.


    Μετά την εκκίνηση του λογισμικού ArcGIS ,θα πρέπει να ενεργοποιηθεί η επέκταση Spatial Analyst (μενού Tools>Extensions> Spatial Analyst). Από τη μπάρα επιλογών Spatial Analyst, καθορίζεται ο προσωπικός φάκελος εργασίας (Properties > Working Directory). H εισαγωγή ενός ψηφιδωτού θεματικού επιπέδου γίνεται με παρόμοιο τρόπο με την εισαγωγή διανυσματικού θεματικού επιπέδου (επιλογή File > Add Data) (Σχήμα 2.14).
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    Σχήμα 2.14 Προσθήκη επιπέδου GRID σε περιβάλλον ArcGIS.


    


    Σημείωση : Πριν την εκτέλεση οποιασδήποτε εργασίας που αξιοποιεί τις δυνατότητες του Spatial Analyst (και έχει σαν αποτέλεσμα τη δημιουργία ενός νέου GRID), από το μενού επιλογών Spatial Analyst > Properties θα πρέπει να καθοριστούν, από την υποεπιλογή «General», ο κατάλογος εργασίας και το επίπεδο το οποίο θα χρησιμοποιηθεί σαν «χωρική μάσκα» για την ανάλυση. Με την υποεπιλογή «Extent», καθορίζονται τα όρια της ανάλυσης (συνήθως ορίζοντας κάποιο θεματικό επίπεδο περιοχής ενδιαφέροντος), και με την υποεπιλογή «cell size», καθορίζεται το μέγεθος της ψηφίδας για τα παραγόμενα.


    


    [bookmark: _Toc438361121]2.6.2 Μετατροπές διανυσματικών επιπέδων σε ψηφιδωτά (vector to raster)


    Ένας σύνηθες τρόπος δημιουργίας ψηφιδωτών χωρικών δεδομένων είναι η μετατροπή διανυσματικών δεδομένων. Ακολουθεί η ανάπτυξη της τεχνικής μετατροπής διανυσματικών επιπέδων σε ψηφιδωτά μέσω του λογισμικού ArcGIS.


    


    Μετά την εκκίνηση του ArcGIS διασφαλίζεται ότι είναι ενεργή η επέκταση Spatial Analyst. Στη συνέχεια εισάγεται το διανυσματικό θεματικό επίπεδο το οποίο επιθυμούμε να μετασχηματιστεί σε ψηφιδωτό.
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    Σχήμα 2.15 Διανυσματικό επίπεδο κάλυψης γης.


    


    Όταν ένα διανυσματικό επίπεδο μετατρέπεται σε ψηφιδωτό θα πρέπει να επιλεγεί ένα πεδίο (από τον πίνακα περιγραφών του διανυσματικού επιπέδου), η τιμή του οποίου θα αποτελέσει την τιμή για κάθε ψηφίδα του τελικού παραγόμενου GRID. Για παράδειγμα, στη διαδικασία μετατροπής του διανυσματικού επιπέδου χρήσης γης σε ψηφιδωτό η επιλογή του πεδίου Land_use εξασφαλίζει ότι στο τελικό ψηφιδωτό επίπεδο με τις χρήσεις γης για κάθε ψηφίδα καταγράφεται ο τύπος της χρήσης γης που αντιστοιχεί σε αυτήν την ψηφίδα (Σχήμα 2.15).


    Από το μενού επιλογών Spatial analyst επιλέγεται Convert > Features to Raster και στο παράθυρο που εμφανίζεται προσδιορίζεται το διανυσματικό επίπεδο που θα χρησιμοποιηθεί, το πεδίο με τις χαρακτηριστικές τιμές, το μέγεθος της ψηφίδας και την περιοχή – όνομα αποθήκευσης του τελικού ψηφιδωτού επιπέδου.


    


    [bookmark: _Toc438361122]2.6.3 Τοπικές λειτουργίες στο Spatial Analyst – το εργαλείο Raster Calculator


    Οι τοπικές λειτουργίες αριθμητικών ή και λογικών πράξεων είναι τυπικές σ’ ένα ΓΠΣ.


    


    Με τις αριθμητικές λειτουργίες εκτελούνται πράξεις τιμών από ένα επίπεδο μ’ αυτές ενός άλλου επιπέδου στην αντίστοιχη θέση, ενώ με τις λογικές διενεργούνται λογικές συσχετίσεις μεταξύ των δεδομένων.


    


    


    Οι λειτουργίες αυτές υλοποιούνται τόσο σε περιβάλλον διανυσματικού όσο και σε περιβάλλον ψηφιδωτού ΓΠΣ. Στο λογισμικό ArcGIS, ένας από τους αποτελεσματικότερους τρόπους υλοποίησης λειτουργιών επίθεσης, πραγματοποιείται με τη χρήση ψηφιδωτών δεδομένων και τη χρήση του υποπρογράμματος Spatial Analyst. Συγκεκριμένα, το εργαλείο Raster Calculator, επιτρέπει τη διενέργεια πράξεων μεταξύ ψηφιδωτών θεματικών επιπέδων. Το εργαλείο αυτό περιγράφεται παρακάτω (Σχήμα 2.16).
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    Σχήμα 2.16 Το εργαλείο χαρτογραφικής άλγεβρας Raster Calculator.


    


    [bookmark: _Toc438361123]2.6.3.1 Επιλογή δεδομένων από ψηφιδωτά θεματικά επίπεδα


    Μια από τις βασικές χρήσεις του εργαλείου Raster Calculator αφορά την επιλογή δεδομένων. Η σχετικά απλή και ιδιαίτερα χρήσιμη αυτή διαδικασία περιγράφεται παρακάτω:


    1. Επιλογή του μενού Spatial Analyst> Raster Calculator


    2. Καθορισμός του επιπέδου που θα χρησιμοποιηθεί, (π.χ. elevation), στο παράθυρο που εμφανιστεί


    3. Επιλέξτε τον τελεστή που θα χρησιμοποιηθεί ( π.χ. >)


    4. Επιλέξτε η πληκτρολογήστε μια τιμή (π.χ. 1000) ή ένα άλλο επίπεδο ανάλογα με τη λειτουργία που εκτελείται.


    5. Κάντε κλικ στην επιλογή evaluate για να ολοκληρωθεί η διαδικασία.


    


    [bookmark: _Toc438361124]2.6.3.2 Συνδυασμός ψηφιδωτών δεδομένων


    1. Επιλογή του μενού Spatial Analyst> Raster Calculator


    2. Διπλό κλικ στο πρώτο επίπεδο


    3. Κλικ στο εργαλείο στην επιθυμητή αριθμητική ή λογική πράξη


    4. Κλικ στο δεύτερο επίπεδο


    5. Επανάληψη των βημάτων 4 και 5, έτσι ώστε να προστεθούν επιπλέον επίπεδα


    6. Κλικ evaluate


    


    [bookmark: _Toc438361125]2.6.3.3 Μαθηματικές και λογικές πράξεις μεταξύ θεματικών επιπέδων δεδομένων


    1. Επιλογή του μενού Spatial Analyst> Raster Calculator


    2. Κλικ στο εργαλείο επέκτασης των δυνατοτήτων του Raster Calculator


    3. Κλικ στην επιθυμητή λειτουργία


    4. Διπλό κλικ στο επιθυμητό επίπεδο εφαρμογής της λειτουργίας


    5. Κλικ Evaluate
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    Σχήμα 2.17 Αριθμητική και Λογική τοπική λειτουργία.


    


    Ιδιαίτερα ενδιαφέρουσα είναι η δυνατότητα σύνταξης πολλαπλών ή και εμφωλευμένων λειτουργιών στο περιβάλλον του Raster Calculator (Σχήμα 2.17). Αυτή η δυνατότητα είναι πολύ χρήσιμη όταν ζητείται η αυτόματη υλοποίηση πολύπλοκων διαδικασιών ή η αλληλουχία επεξεργασιών. Για παράδειγμα, με την παρακάτω πολλαπλή έκφραση υπολογίζεται η διαδρομή μετακίνησης με τη λειτουργία COSTPATH:


    [cost] = ([rlanduse] + [rslope])


    [dist] = COSTDISTANCE([source], [cost], backlink)


    Path = COSTPATH([destination], [dist], backlink)


    


    [bookmark: _Toc438361126]2.6.4 Εστιακές λειτουργίες στατιστικής ανάλυσης στο ArcGIS (Neighborhood Statistics)


    Το λογισμικό ArcGIS παρέχει τη δυνατότητα εκτέλεσης κεντρικών λειτουργιών μέσα από την επέκταση spatial analyst. Στις λειτουργίες αυτές, η τιμή κάθε ψηφίδας στο παράγωγο θεματικό επίπεδο υπολογίζεται με βάση την τιμή της στο αρχικό επίπεδο, καθώς και τις τιμές των ψηφίδων σε μια περιβάλλουσα περιοχή (περιοχή γειτονίας). Κατά την εκτέλεση των λειτουργιών αυτών, ο χρήστης έχει τη δυνατότητα ορισμού της περιοχής αυτής, καθώς και τη δυνατότητα προσδιορισμού του τρόπου στατιστικής επεξεργασίας της στο αρχικό επίπεδο.


    


    [bookmark: _Toc438361127]2.6.4.1 Βήματα υλοποίησης:


    1. Άνοιγμα του εργαλείου ArcToolbox. Επιλογή Spatial Analyst Tools > Neighborhood > Focal Statistics (Σχήμα 2.18).


    


    [image: ]


    Σχήμα 2.18 Ο οδηγός κεντρικής λειτουργίας στατιστικής ανάλυσης.


    


    2. Επιλογή του ψηφιδωτού θεματικού επιπέδου εισόδου για το οποίο επιθυμούμε την εκτέλεση εστιακής στατιστικής ανάλυσης.


    3. Επιλογή του ονόματος και της θέσης αποθήκευσης του παραγόμενου ψηφιδωτού θεματικού επιπέδου.


    4. Επιλογή του σχήματος προσδιορισμού της γειτονίας. Τα διαθέσιμα σχήματα είναι τα παρακάτω: δακτύλιος, κύκλος, ορθογώνιο και κυκλικός τομέας. Επίσης, ο χρήστης μπορεί να προσδιορίσει το παράθυρο (Kernel) το οποίο επιθυμεί και τον τρόπο της στατιστικής επεξεργασίας σε αυτό το παράθυρο.


    5. Καθορισμός του μεγέθους γειτονίας με τον καθορισμό του ύψους και πλάτους σε πραγματικές μονάδες ή σε μονάδες αριθμού ψηφίδων.


    6. Καθορισμός του τύπου στατιστικής ανάλυσης. Οι διαθέσιμοι στατιστικοί υπολογισμοί είναι οι παρακάτω: ελάχιστη τιμή, μέγιστη τιμή, εύρος τιμών, άθροισμα τιμών, μέση τιμή, μεταβλητότητα, πλειονότητα, μειονότητα, και ενδιάμεσης τιμής.


    7. Επιλογή οριστικοποίησης των παραπάνω.


    


    [bookmark: _Toc438361128]2.6.4.2 Εστιακή λειτουργία υπολογισμού πυκνότητας


    Με την λειτουργία αυτή, είναι δυνατή η δημιουργία ψηφιδωτού επιπέδου πυκνότητας από ένα σύνολο οντοτήτων εισόδου. Για την εκτέλεση αυτής της λειτουργίας ακολουθούνται τα παρακάτω βήματα (Σχήμα 2.19):


    1. Επιλογή Spatial Analyst > Density.


    2. Εισαγωγή του θεματικού επιπέδου εισόδου, το οποίο περιέχει τις οντότητες για τις οποίες επιθυμούμε τον προσδιορισμό της πυκνότητας.


    3. Προσδιορισμός του πεδίου πληθυσμού. Το βήμα αυτό είναι προαιρετικό. Αν δεν προσδιοριστεί τέτοιο πεδίο, μετριέται το πλήθος των οντοτήτων ανά μονάδα επιφάνειας. Σε αντίθετη περίπτωση, κατά τον υπολογισμό της πυκνότητας σταθμίζεται κάθε οντότητα ανάλογα με την τιμή του πληθυσμού της.


    4. Προσδιορισμός της μεθόδου (Simple – Kernel) υπολογισμού της πυκνότητας.


    5. Προσδιορισμός της ακτίνας ανίχνευσης οντοτήτων. Με βάση αυτήν την ακτίνα θα γίνει ο προσδιορισμός της πυκνότητας.


    6. Προσδιορισμός της μονάδας επιφάνειας.


    7. Προσδιορισμός του μεγέθους ψηφίδας για το παραγόμενο GRID.


    8. Καθορισμός του ονόματος του παραγόμενου αρχείου ή εναλλακτικά δημιουργία προσωρινού αρχείου.


    9. Επιλογή ΟΚ.
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    Σχήμα 2.19 Βήματα υλοποίησης κεντρικής λειτουργίας εύρεσης πυκνότητας στο λογισμικό ArcGIS.


    


    Το αποτέλεσμα είναι η δημιουργία ενός ψηφιδωτού επιπέδου με τις τιμές πυκνότητας των γεωγραφικών οντοτήτων με βάση τις παραπάνω παραμέτρους υπολογισμού (Σχήμα 2.20).
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    Σχήμα 2.20 Παραγόμενο κεντρικής λειτουργίας Χαρτογράφησης πυκνότητας.


    


    [bookmark: _Toc438361129]2.6.5 Λειτουργίες ζώνης στο ArcGIS


    Το λογισμικό ArcGIS παρέχει λειτουργίες ζώνης μέσα από τη σχετική εργαλειοθήκη της επέκτασης Spatial Analyst. Παρακάτω παρουσιάζονται τα βήματα εκτέλεσης των λειτουργιών στατιστικής ανάλυσης ανά ζώνες (Zonal Statistics), καθώς και αυτά των λειτουργιών υπολογισμού γεωμετρικών ιδιοτήτων των ζωνών (Zonal Geometry).


    


    [bookmark: _Toc438361130]2.6.5.1 Λειτουργίες ζώνης στατιστικής ανάλυσης (Zonal statistics)


    Με τη λειτουργία Zonal Statistics λαμβάνει χώρα στατιστική ανάλυση για κάθε κατηγορία (ζώνη) του επιπέδου ζωνών, με βάση τις τιμές για κάθε ζώνη στο επίπεδο τιμών. Το αποτέλεσμα αυτής της λειτουργίας αποθηκεύεται είτε σε ένα νέο ψηφιδωτό θεματικό επίπεδο είτε σε έναν πίνακα (Σχήμα 2.21). Παρότι το επίπεδο τιμών θα πρέπει να είναι απαραίτητα raster το επίπεδο ζωνών μπορεί να είναι είτε raster είτε vector. Στη δεύτερη περίπτωση, κατά την εκτέλεση της λειτουργίας ζώνης πραγματοποιείται αυτόματα ο μετασχηματισμός vector to raster στο επίπεδο ζωνών. Όταν το επίπεδο τιμών περιέχει ακέραιους αριθμούς μπορούν να εκτελεστούν οι παρακάτω στατιστικές λειτουργίες: ελάχιστη τιμή (minimum), μέγιστη τιμή (maximum), εύρος τιμών (range), μέσος (mean), τυπική απόκλιση (standard deviation), άθροισμα (sum), μεταβλητότητα (variety), πλειονότητα (majority), μειονότητα (minority), και ενδιάμεσος (median). Όταν το επίπεδο τιμών περιέχει αριθμούς κινητής υποδιαστολής τότε δεν είναι διαθέσιμες οι λειτουργίες πλειονότητας, μειονότητας, ενδιάμεσου και μεταβλητότητας.


    


    [bookmark: _Toc438361131]Βήματα υλοποίησης:


    1. Άνοιγμα του εργαλείου ArcToolbox. Επιλογή Spatial Analyst Tools > Zonal > Zonal Statistics as Table.


    2. Επιλογή του επιπέδου (vector ή raster) ζωνών για τις οποίες θα υλοποιηθεί η στατιστική ανάλυση. dataset that defines the zones.


    2. Επιλογή του πεδίου (Zone field) το οποίο περιέχει τις τιμές για κάθε ζώνη.


    4. Επιλογή του ψηφιδωτού επιπέδου εισόδου (Value Raster). Το επίπεδο αυτό παρέχει τις τιμές οι οποίες χρησιμοποιούνται για τους στατιστικούς υπολογισμούς για κάθε ζώνη.


    5. Επιλογή του ονόματος και της θέσης αποθήκευσης του παραγόμενου πίνακα.


    6. Επιλογή οριστικοποίησης των παραπάνω.
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    Σχήμα 2.21 Παραγόμενο λειτουργίας ζώνης στατιστικής ανάλυσης.


    


    [bookmark: _Toc438361132]2.6.5.2 Λειτουργία ζώνης ανάλυσης γεωμετρίας (Zonal geometry)


    Με το εργαλείο Zonal Geometryυπολογίζονται διάφορες γεωμετρικές ιδιότητες των ζωνών. Το αποτέλεσμα αυτών των υπολογισμών αποθηκεύεται σε πίνακα.


    


    [bookmark: _Toc438361133]Βήματα υλοποίησης:


    1. Άνοιγμα του εργαλείου ArcToolbox. Επιλογή Spatial Analyst Tools > Zonal > Zonal Geometry as Table.


    2. Επιλογή του επιπέδου (vector ή raster) ζωνών για τις οποίες θα υλοποιηθεί η στατιστική ανάλυση. dataset that defines the zones.


    3. Επιλογή του πεδίου (Zone field) το οποίο περιέχει τις τιμές για κάθε ζώνη.


    4. Επιλογή του ονόματος και της θέσης αποθήκευσης του παραγόμενου πίνακα.


    5. Καθορισμός του μεγέθους της ψηφίδας του παραγόμενου ψηφιδωτού θεματικού επιπέδου (προαιρετικά).


    6. Επιλογή οριστικοποίησης των παραπάνω.


    Ο παραγόμενος πίνακας από αυτήν τη λειτουργία περιλαμβάνει μετρήσεις για την έκταση, την περίμετρο, το πάχος και την ελλειψοειδή προσέγγιση για κάθε ζώνη με τον καθορισμό των αξόνων και του προσανατολισμού για κάθε έλλειψη που αντιστοιχεί σε κάθε ζώνη. Επιπρόσθετα, με την επιλογή ZONALTHICKNESS υπολογίζεται και το μέγιστο πάχος κάθε ζώνης (Σχήμα 2.22).
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    Σχήμα 2.22 Λειτουργίας ζώνης γεωμετρίας – πάχους ζώνης.


    


    [bookmark: _Toc438361134]2.6.6 Γενικευμένες λειτουργίες εκτίμησης απόστασης – εγγύτητας – κατεύθυνσης


    Παρακάτω, παρουσιάζονται γενικευμένες λειτουργίες ανάλυσης με τη χρήση ψηφιδωτών δεδομένων. Συγκεκριμένα αναπτύσσονται τεχνικές υπολογισμού ευκλείδειας ή ευθείας απόστασης με το λογισμικό ArcGIS. Οι λειτουργίες αυτές ενεργοποιούνται από το μενού Spatial Analyst > Distance > Straight Line. Στο αναδυόμενο παράθυρο θα πρέπει να προσδιοριστεί το επίπεδο εισόδου, οι διαστάσεις της ψηφίδας για τα παραγόμενα ψηφιδωτά θεματικά επίπεδα, καθώς και το αν τα παραγόμενα θα είναι μόνιμα ή προσωρινά αρχεία. Το επίπεδο εισόδου περιέχει τα αντικείμενα αναφοράς από τα οποία γίνεται η εκτίμηση της απόστασης. Τα αντικείμενα αυτά μπορεί να είναι αποθηκευμένα τόσο σε διανυσματικά όσο και σε ψηφιδωτά θεματικά επίπεδα.


    Ειδικά για τα χαρακτηριστικά των παραγομένων, θα πρέπει να σημειωθεί ότι ακολουθούν τις ιδιότητες (μέγεθος ψηφίδας, χωρική μάσκα, όρια επιπέδου) που έχουν προσδιοριστεί από την επιλογή Spatial Analyst > Options. Με τη χρήση των λειτουργιών αυτών, περιγράφεται η θέση κάθε ψηφίδας σε σχέση με κάποια αντικείμενα αναφοράς. Υπάρχουν τρία πιθανά παραγόμενα: α) το επίπεδο ευθείας απόστασης από οντότητες, β) το επίπεδο ζωνών επιρροής από οντότητες, και γ) το επίπεδο κατεύθυνσης προς τις οντότητες εισόδου.


    


    [bookmark: _Toc438361135]2.6.6.1 Απόσταση σε ευθεία γραμμή ή ευκλείδεια απόσταση (straight line distance, euclidean distance )


    Σε κάθε ψηφίδα του παραγόμενου GRID καταγράφεται η ευθεία απόστασή της από το πλησιέστερο αντικείμενο αναφοράς. Παράδειγμα: «Ποια είναι η ευθεία απόσταση στην πλησιέστερη πρωτεύουσα νομού της Πελοποννήσου;» Το αποτέλεσμα αυτής της λειτουργίας είναι ένα ψηφιδωτό επίπεδο το οποίο περιέχει τα δεδομένα υπολογισμού ευθείας απόστασης απ’ όλα τα αντικείμενα αναφοράς (Σχήμα 2.23). Η λειτουργία αυτή χρησιμοποιείται είτε αυτόνομα είτε σε εφαρμογές κατασκευής χαρτών καταλληλότητας, όπου ως ένα από τα κριτήρια καταλληλότητας εμφανίζεται και η ευθεία απόσταση από συγκεκριμένες γεωγραφικές οντότητες.
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    Σχήμα 2.23 Γενικευμένη λειτουργία ευθείας απόστασης από τις πρωτεύουσες των νομών της Πελοποννήσου.


    


    [bookmark: _Toc438361136]2.6.6.2 Ζώνη επιρροής από οντότητες (επιλογή allocation)


    Με την λειτουργία αυτή, αναγνωρίζονται οι ψηφίδες που βρίσκονται πλησιέστερα σε κάθε αντικείμενο αναφοράς και συσχετίζονται τμήματα του χώρου με τα πλησιέστερα αντικείμενα αναφοράς. Στις περιπτώσεις που επιθυμείται ο υπολογισμός της «ζώνης επιρροής», γύρω από γεωγραφικές οντότητες στηριζόμενοι σε ευθεία απόσταση, αυτή η λειτουργία είναι ιδιαίτερα χρήσιμη.


    


    Στο ακόλουθο σχήμα (Σχήμα 2.24) φαίνονται αυτές οι περιοχές γύρω από τις πρωτεύουσες της Πελοποννήσου. Είναι προφανές ότι η λειτουργία αυτή είναι ανάλογη μ’ εκείνη της δημιουργίας πολυγώνων Thiessen.
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    Σχήμα 2.24 Λειτουργία δημιουργίας ζωνών επιρροής από οντότητες ( πρωτεύουσες των νομών της Πελοποννήσου).


    


    


    [bookmark: _Toc438361137]2.6.6.3 Κατεύθυνση σε πλησιέστερη οντότητα (επιλογή direction)


    Σε κάθε ψηφίδα του παραγόμενου GRID καταγράφεται η κατεύθυνση προς το πλησιέστερο αντικείμενο αναφοράς. Στο Σχήμα 2.25 φαίνεται η απάντηση στο ερώτημα, αυτό με την κωδικοποίηση της κατεύθυνσης σε 9 κατηγορίες.
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    Σχήμα 2.25 Γενικευμένη λειτουργία κατεύθυνσης προς πλησιέστερη οντότητα ( πρωτεύουσες των νομών της Πελοποννήσου).


    


    Σημειώνεται ότι μπορεί να υλοποιηθεί επαναταξινόμηση (Spatial Analyst > Reclassification) του ψηφιδωτού επιπέδου απόστασης για τη δημιουργία ζωνών απόστασης από συγκεκριμένες γεωγραφικές οντότητες. Στο παρακάτω σχήμα (Σχήμα 2.26) παρουσιάζονται οι περιοχές που απέχουν λιγότερο από 20 Km, σε ευθεία απόσταση, από τις πρωτεύουσες των Νομών της Πελοποννήσου.
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    Σχήμα 2.26 Ζώνες εγγύτητας ακτίνας 20 χλμ. από τις πρωτεύουσες των νομών της Πελοποννήσου.
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    [bookmark: _Toc438361139]Κριτήρια Αξιολόγησης


    [bookmark: _Toc438361140]Κριτήριο Αξιολόγησης 1 - Ερωτήσεις Κατανόησης


    · Τι είναι η άλγεβρα μεταξύ χαρτών (Map Algebra) και ποιες οι προϋποθέσεις για το συνδυασμό ψηφιδωτών θεματικών επιπέδων με λειτουργίες Map Algebra;


    · Δώστε από ένα παράδειγμα τοπικής, εστιακής, ζώνης και γενικευμένης λειτουργίας σε ψηφιδωτά δεδομένα


    · Τι γνωρίζετε για την ευκλείδεια απόσταση; Ποια τα βήματα κατασκευής χάρτη ευκλείδειας απόστασης από γεωγραφικές οντότητες στο λογισμικό ArcGIS;


    · "Οι κεντρικές λειτουργίες σε ψηφιδωτά δεδομένα παρουσιάζουν αναλογίες με τις επεξεργασίες εφαρμογής φίλτρων σε εικόνες Τηλεπισκόπησης". Συμφωνείτε με την παραπάνω πρόταση; Σχολιάστε.


    



    [bookmark: _Toc438361141]­Κεφάλαιο 3: Χωρική Πολυκριτηριακή Ανάλυση με Χαρτογραφική Υπέρθεση


    Σύνοψη


    Στο κεφάλαιο αυτό παρουσιάζεται η μεθοδολογία της Χωρικής Πολυκριτηριακής Ανάλυσης (ΧΠΚΑ) και η εφαρμογή της στο πλαίσιο ενός Γεωγραφικού Πληροφοριακού Συστήματος με τη σταθμισμένη χαρτογραφική υπέρθεση θεματικών επιπέδων. Αρχικά, γίνεται μια εισαγωγή στο αντικείμενο της Πολυκριτηριακής Ανάλυσης Αποφάσεων (Multicriteria Decision Analysis - MCDA), παρουσιάζονται τα γενικά βήματα υλοποίησης ενός τέτοιου μοντέλου, και αναλύονται τα κύρια στοιχεία αυτής της ανάλυσης (γενικός στόχος, επιμέρους στόχοι, περιγραφές κριτηρίων, περιορισμοί, συντελεστές βαρύτητας, εναλλακτικές επιλογές, ανάλυση ευαισθησίας). Στη συνέχεια, γίνεται εμβάθυνση στη Χωρική Πολυκριτηριακή ανάλυση και την υλοποίησή της με τεχνικές χαρτογραφικής υπέρθεσης στο πλαίσιο ενός ΓΠΣ. Τέλος, το κεφάλαιο ολοκληρώνεται με την παρουσίαση παραδειγματικής πρακτικής εφαρμογής ανάλυσης με τη μέθοδο της σταθμισμένης χωρικής πολυκριτηριακής ανάλυσης σε περιβάλλον λογισμικού ΓΠΣ.


    


    Προαπαιτούμενη γνώση


    Για την παρακολούθηση των εννοιών που αναπτύσσονται σε αυτό το κεφάλαιο, ο αναγνώστης θα πρέπει να γνωρίζει τα βασικά της τεχνολογίας των Γεωγραφικών Πληροφοριακών Συστημάτων, τις βασικές αναλυτικές λειτουργίες σε διανυσματικά και ψηφιδωτά ΓΠΣ και τις αρχές της χαρτογραφικής άλγεβρας. Επιπρόσθετα, επιθυμητή είναι και η βασική γνώση των αρχών της επιχειρησιακής έρευνας.


    


    [bookmark: _Toc438361142]3.1. Πολυκριτηριακή Ανάλυση


    Άτομα και κοινωνικές ομάδες λαμβάνουν αποφάσεις σε καθημερινή βάση, εξετάζοντας διαφορετικές εναλλακτικές επιλογές και συνυπολογίζοντας διαφορετικά κριτήρια. Η αγορά κάποιου αγαθού, η επιλογή του τόπου κατοικίας, η επιλογή μιας διαδρομής, η χωροθέτηση μιας υπηρεσίας είναι μερικά χαρακτηριστικά παραδείγματα στα οποία λαμβάνει χώρα η διαδικασία λήψης αποφάσεων. Όσο πιο πολύπλοκη είναι μια απόφαση, λαμβάνοντας υπόψη πολλούς παράγοντες οι οποίοι αρκετές φορές αλληλοσυγκρούονται, τόσο μεγαλώνει η ανάγκη για τη διαμόρφωση μιας τυποποιημένης διαδικασίας λήψης αποφάσεων. Άξιο αναφοράς είναι και το γεγονός ότι για το ίδιο ακριβώς πρόβλημα, διαφορετικοί άνθρωποι ή και κοινωνικές ομάδες ενδέχεται να λαμβάνουν διαφορετικές αποφάσεις.


    Η πολυκριτηριακή ανάλυση αποφάσεων (MultiCriteria Decision Analysis ή MCDA), η οποία εφεξής θα αναφέρεται ως ΠολυΚριτηριακή Ανάλυση (ΠΚΑ), έχει ως κύριο στόχο τη διαμόρφωση τυποποιημένων διαδικασιών οι οποίες βοηθούν τους λήπτες αποφάσεων στην επίλυση διαφόρων προβλημάτων ή και ερωτημάτων με βάση τη σύνδεση παραγόντων που σχετίζονται με το πρόβλημα. Η σύνθεση αυτή βασίζεται σε κανόνες λήψης αποφάσεων για την αξιολόγηση των εναλλακτικών επιλογών ή λύσεων του προβλήματος.


    Η ανάπτυξη μεθόδων ΠΚΑ υπήρξε ραγδαία μετά τον Β' παγκόσμιο πόλεμο. Τις δεκαετίες που ακολούθησαν παρουσιάστηκαν δύο βασικές σχολές ανάπτυξης μεθόδων ΠΚΑ: η αμερικανική και η ευρωπαϊκή σχολή. Η πρώτη, ακολούθησε τις αρχές της επιχειρησιακής έρευνας και βασίζεται σε κριτήρια τα οποία συνδυάζονται, με συγκεκριμένους συντελεστές βαρύτητας, οι οποίοι αποδίδονται από τους λήπτες αποφάσεων. Στη συνέχεια, τα σταθμισμένα κριτήρια αθροίζονται και αποδίδεται μια τελική επίδοση-σκόρ για κάθε εναλλακτική επιλογή. Η ευρωπαϊκή σχολή είχε ως βασική διαφοροποίηση την υιοθέτηση της ιδέας ότι οι λήπτες των αποφάσεων δεν έχουν την ικανότητα ακριβούς καθορισμού της βαρύτητας κάθε κριτηρίου. Έτσι, οι μέθοδοι ΠΚΑ που αναπτύχθηκαν από την ευρωπαϊκή σχολή παρέχουν τεχνικές για τον καθορισμό της σχετικής βαρύτητας κάθε κριτηρίου. Στις μέρες μας αυτός ο μεθοδολογικός διαχωρισμός πρακτικά δεν υφίσταται, καθώς αυτές οι μέθοδοι χρησιμοποιούνται πολλές φορές συνδυαστικά για την επίλυση διαφόρων τύπων προβλημάτων.


    Σε κάθε περίπτωση, τα ισχυρά χαρακτηριστικά των μεθόδων ΠΚΑ είναι η απλότητα στη σύλληψη και την εκτέλεση, η δυνατότητα ενσωμάτωσης στην ανάλυση ποιοτικών, αλλά και ποσοτικών κριτηρίων, καθώς και η δυνατότητα εμπλοκής στη διαδικασία λήψης απόφασης διαφορετικών ληπτών (εμπειρογνώμονες, ομάδες ειδικών, διαχειριστές του χώρου, ομάδες πολιτών κ.λ.π.).


    Τα γενικά στάδια υλοποίησης μεθοδολογιών ΠΚΑ που σχετίζονται με την επιχειρησιακή έρευνα παρουσιάζονται στο Σχήμα 3.1. Αρχικά γίνεται ο προσδιορισμός του γενικού προβλήματος, καθώς και των επιμέρους στόχων. Όταν το προς επίλυση πρόβλημα προϋποθέτει την εξέταση πολλών αντικρουόμενων επιμέρους στόχων, τότε η μέθοδος καλείται ΠΚΑ πολλαπλών στόχων (MultiObjective Decision Analysis - MODA). Σε αντίθετη περίπτωση, όταν η στόχευση είναι μία, τότε η μέθοδος καλείται ΠΚΑ πολλαπλών περιγραφών (MultiAttribute Decision Analysis MADΑ), καθώς η ανάλυση βασίζεται στην εξέταση κριτηρίων με μετρήσιμες περιγραφές που σχετίζονται με το γενικό πρόβλημα.
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    Σχήμα 3.1 Στάδια υλοποίησης μοντέλου Πολυκριτηριακής Ανάλυσης.


    


    Στη συνέχεια, λαμβάνει χώρα ο προσδιορισμός των κριτηρίων και των εναλλακτικών επιλογών. Τα κριτήρια μπορεί να είναι παράγοντες (factors) και περιορισμοί (restrictions) που σχετίζονται με το πρόβλημα προς εξέταση. Ένα παράδειγμα περιορισμού σε χωρικά προβλήματα σχετίζεται με την ελάχιστη συνεχή επιφάνεια την οποία μπορεί να έχει μια προτεινόμενη λύση. Για παράδειγμα, σε μια εφαρμογή χωροθέτησης ηλιακού πάρκου ενδέχεται να υπάρχει ο περιορισμός ελάχιστου εμβαδού (π.χ. έκτασης τουλάχιστον 250 στρεμμάτων) για την τελική χωροθέτηση. Οι εναλλακτικές επιλογές (alternatives) μπορεί να είναι περιορισμένες σε αριθμό (π.χ. επιλογή αγοράς μεταξύ τριών διαφορετικών υπολογιστικών συστημάτων, η συγκριτική ανάλυση δύο διαφορετικών προεπιλεγμένων περιοχών χωροθέτησης ΧΥΤΥ). Σ’ αυτές τις περιπτώσεις το αποτέλεσμα της ανάλυσης οδηγεί στον προσδιορισμό μιας "βέλτιστης" επιλογής. Στον αντίποδα βρίσκονται τα προβλήματα στα οποία υπάρχει μεγάλος ή ακόμη και άπειρος αριθμός εναλλακτικών επιλογών (π.χ. η εξέταση όλων των πιθανών θέσεων για χωροθέτηση ενός δασικού παρατηρητηρίου). Αυτή η δεύτερη κατηγορία προβλημάτων είναι πολύ συνηθισμένη στη Χωρική Πολυκριτηριακή Ανάλυση (π.χ. σε εφαρμογές μοντελοποίησης καταλληλότητας εδαφών).


    Η επόμενη φάση σχετίζεται με την αξιολόγηση των κριτηρίων και τον καθορισμό των προτιμήσεων των ληπτών απόφασης. Ο αριθμός των ληπτών απόφασης μπορεί να ποικίλει. Όταν πρόκειται για ομαδικές αποφάσεις χρησιμοποιούνται διάφορες τεχνικές έτσι ώστε να επιτυγχάνονται συμβιβαστικές λύσεις (π.χ. μετά από ψηφοφορία ή διαπραγματεύσεις). Επιπλέον, μπορούν να παρθούν συμμετοχικές αποφάσεις, συχνά μέσω διαδικτύου, με την αξιοποίηση των απόψεων των πολιτών.


    Στη συνέχεια, αφού επιλεγεί η μέθοδος σύνθεσης των κριτηρίων και καθοριστούν οι συντελεστές βαρύτητας τους, παράγονται τα τελικά αποτελέσματα-αποτιμήσεις για τις εναλλακτικές επιλογές. Ο απλούστερος τρόπος υλοποίησης των παραπάνω, είναι η σύνταξη απλών κανόνων οι οποίοι βασίζονται σε κρίσιμες τιμές-κατώφλια των κριτηρίων. Έτσι, τα κριτήρια μετασχηματίζονται σε δίτιμα κριτήρια (επιθυμητό - μη επιθυμητό χαρακτηριστικό) και προσδιορίζονται οι τελικές επιλογές που ικανοποιούν ένα, μερικά ή όλα τα δίτιμα κριτήρια. Αυτές οι τεχνικές είναι αδρές καθώς δεν περιέχουν κανενός είδους διαβάθμιση ούτε στα κριτήρια ούτε στα παραγόμενα αποτελέσματα και καλούνται μη εξισωτικές μέθοδοι. Οι εξισωτικές μέθοδοι βασίζονται στην αξιολόγηση του βαθμού συμμετοχής των κριτηρίων στη διαμόρφωση του τελικού στόχου. Η αξιολόγηση αυτή λαμβάνει χώρα με την ανάθεση συντελεστών βαρύτητας. Η ποσοτική έκφραση αυτών των συντελεστών γίνεται με τιμές στο διάστημα 0-1. Το άθροισμα των συντελεστών βαρύτητας ισούται με 1. Η ανάθεση των συντελεστών βαρύτητας μπορεί να γίνει απευθείας από τους αναλυτές - εμπειρογνώμονες ή μέσω κάποιων άλλων επιβοηθητικών τεχνικών. Για παράδειγμα, στη μεθοδολογία της Αναλυτικής Ιεράρχησης (Saaty, 1987) η οποία παρουυσιάζεται στο επόμενο κεφάλαιο χρησιμοποιούνται συγκρίσεις κριτηρίων ανά ζεύγη για τον καθορισμό των συντελεστών βαρύτητας.


    Θα πρέπει επίσης να σημειωθεί ότι τα κριτήρια, αλλά και οι συντελεστές βαρύτητας, μπορούν να αποτιμηθούν μ’ ένα απόλυτο-αιτιοκρατικό τρόπο ή με αβεβαιότητα, όπως γίνεται για παράδειγμα με τη χρήση της ασαφούς λογικής (fuzzy logic, Shepard, 2005). Παρότι τις περισσότερες φορές η επιλογή ανάμεσα σ’ αυτές τις δύο γενικές κατευθύνσεις γίνεται με βάση την υποκειμενική κρίση των αναλυτών, σε αρκετά προβλήματα η επιλογή βασίζεται και στη φύση των κριτηρίων. Επιπλέον, για την επιλογή της μεθόδου ΠΚΑ θα πρέπει να λαμβάνονται υπόψη και κάποιοι πρακτικοί παράγοντες, όπως είναι το διαθέσιμο υλικό και λογισμικό, καθώς και η εμπειρία και ο βαθμός εκπαίδευσης του αναλυτή και των ληπτών των αποφάσεων.
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    Σχήμα 3.2 Γενικό πλαίσιο Πολυκριτηριακής Ανάλυσης.


    


    Η ανάλυση της ευαισθησίας του μοντέλου (Sensitivity Analysis), είναι το επόμενο βήμα πριν τη διαμόρφωση των τελικών προτάσεων. Στην ανάλυση ευαισθησίας ελέγχεται αν το μοντέλο και τα τελικά αποτελέσματα είναι ευαίσθητα σε μικρές αλλαγές είτε στη βαθμονόμηση των κριτηρίων, είτε στους συντελεστές βαρύτητας. Οι έλεγχοι αυτοί πραγματοποιούνται υπολογιστικά με διαδοχικές επανεκτελέσεις του μοντέλου. Στην περίπτωση διάγνωσης μεγάλης ευαισθησίας του μοντέλου σε τέτοιες μικροαλλαγές, θα πρέπει να επανέλθει κανείς σε προηγούμενα στάδια και να προβεί στις απαραίτητες τροποποιήσεις.


    Η τελική φάση της ΠΚΑ είναι η διαμόρφωση των οριστικών προτάσεων οι οποίες βασίζονται στην αποτίμηση των εναλλακτικών επιλογών. Από τα παραπάνω είναι φανερό ότι η όλη διαδικασία εδράζεται στο σκεπτικό της τελικής αξιολόγησης των εναλλακτικών επιλογών (alternatives) με την αξιολόγηση κριτηρίων και υποκριτηρίων από τους εμπειρογνώμονες - συχνά με την ανάθεση συντελεστών βαρύτητας - για την επίτευξη ενός γενικού στόχου. Το συνολικό πλαίσιο αυτής της προσέγγισης φαίνεται στο Σχήμα 3.2.


    Η πρακτική διαμόρφωση αυτής της δομής σ’ ένα υπολογιστικό σύστημα γίνεται με τη δημιουργία του πίνακα αποφάσεων (Decision Matrix), ο οποίος παρουσιάζεται στο Σχήμα 3.3. Οι γραμμές του πίνακα αντιστοιχούν στις εναλλακτικές επιλογές (altenratives), ενώ οι στήλες στις περιγραφές (attributes) αντιστοιχών στα κριτίρια και τα υποκριτήρια. Στα κελιά του πίνακα υπολογίζονται οι παραγόμενες τιμές κάθε περιγραφής για κάθε εναλλακτική επιλογή λαμβάνοντας υπόψη και τον αντίστοιχο συντελεστή βαρύτητας (weight), ενώ η τελική στήλη περιέχει την τελική αξιολόγηση - αποτίμηση κάθε εναλλακτικής επιλογής.


    Δυνητικά, κάθε εφαρμογή ΠΚΑ μπορεί να εφαρμοστεί σ’ ένα χωρικό πλαίσιο και συνεπώς εμπεριέχει χωρικά χαρακτηριστικά. Υπάρχει όμως πληθώρα εφαρμογών όπου τόσο ο γενικός στόχος όσο και τα κριτήρια έχουν χωρική κατανομή. Σ’ αυτές τις εφαρμογές, το υπό μελέτη πρόβλημα αντιμετωπίζεται με τεχνικές Xωρικής Πολυκριτηριακής Ανάλυσης οι οποίες και παρουσιάζονται παρακάτω.
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    Σχήμα 3.3 Πίνακας απόφασης (Ε: Εναλλακτικές επιλογές, W: Weights - Συντ/στές βαρύτητας).


    


    [bookmark: _Toc438361143]3.2. Μοντελοποίηση με Χαρτογραφική Υπέρθεση


    Η ιδέα της μοντελοποίησης-εξέτασης γεωγραφικών φαινομένων και προβλημάτων με την υπέρθεση θεματικών χαρτών (Cartographic overlay / χαρτογραφική υπέρθεση) είναι αρκετά παλιά με τις ρίζες της να πηγάζουν από το παρελθόν, στην εποχή πριν την αλματώδη ανάπτυξη της Πληροφορικής και της τεχνολογίας. Για το σκοπό αυτό, οι σχεδιαστές και διαχειριστές του χώρου χρησιμοποιούσαν αντίγραφα χαρτών σε αδιάσταλτες διαφάνειες (mylar). Σε κάθε διαφάνεια, γινόταν σχεδίαση ενός χαρακτηριστικού ενδιαφέροντος ανάλογα με την εφαρμογή. Για παράδειγμα, μια διαφάνεια θα μπορούσε να περιέχει τη ζώνη προστασίας 200 μέτρων περιμετρικά του υδρογραφικού δικτύου, μια άλλη τους αδιαπέρατους από το νερό γεωλογικούς σχηματισμούς και μια τρίτη τις ζώνες προστασίας (π.χ. εθνικοί δρυμοί) σε μια περιοχή ενδιαφέροντος.


    Για τη συνδυαστική αξιοποίηση αυτών των διαφανειών, έπρεπε να εξασφαλίζεται η χωρική τους ταύτιση (γεωαναφορά). Με τα συμβατικά μέσα, αυτό λάμβανε χώρα με το τρύπημα των διαφανειών σε κοινά σημεία (τουλάχιστον 2) και τη στερέωσή τους σε σταθερά στελέχη ίσου αριθμού. Η υπέρθεση των διαφανειών διευκόλυνε τον εντοπισμό περιοχών οι οποίες συγκέντρωναν συνδυαστικά μια σειρά από επιθυμητά (ή ανεπιθύμητα) χαρακτηριστικά. Έτσι, στην περίπτωση του προηγούμενου παραδείγματος, μετά από τη διαδικασία που περιγράφηκε παραπάνω, ήταν εύκολος ο εντοπισμός των περιοχών εκτός της ζώνης προστασίας από το υδρογραφικό δίκτυο, σε αδιαπέρατους σχηματισμούς και εκτός προστατευόμενων περιοχών (Σχήμα 3.4).


    Ο McHarg (1969), στο βιβλίο του με τίτλο «Design with Nature» περιγράφει αναλυτικά αυτή τη μεθοδολογία η οποία αναφέρεται στη βιβλιογραφία και ως “ανάλυση McHarg”. Είναι φανερό ότι ιδιαίτερα κρίσιμος παράγοντας για την αποτελεσματικότητα της μεθόδου είναι η χωρική ταύτιση των επιπέδων η οποία εξασφαλίζεται με τη χρήση κοινής κλίμακας και χαρτογραφικής προβολής. Επιπλέον, σημαντικό παράγοντα αποτελεί και η χρήση των σημείων αναφοράς στα επίπεδα και η ταύτισή του με τα σταθερά στελέχη.


    Με την ανάπτυξη των ΓΠΣ, το σκεπτικό αυτό άρχισε να υλοποιείται στο πλαίσιο ενός ΓΣΠ, αξιοποιώντας-συνδυάζοντας τα θεματικά επίπεδα της χωρικής βάσης δεδομένων του. Σε τέτοιου είδους εφαρμογές και μετά τον προσδιορισμό του προβλήματος, λαμβάνει χώρα η απλοποίηση και η αποδόμησή του έτσι ώστε να μπορεί να αναλυθεί στα επιμέρους στοιχεία του εντός ενός ΓΠΣ. Στη συνέχεια, ακολουθεί η οργάνωση των δεδομένων τα οποία είναι απαραίτητα για την επίλυση του προβλήματος. Το στάδιο αυτό μπορεί να περιλαμβάνει είτε απλές επεξεργασίες εισαγωγής δεδομένων (π.χ. ψηφιοποιήσεις) είτε πιο σύνθετες επεξεργασίες (χωρικοί μετασχηματισμοί, αλλαγή συστήματος αναφοράς κλπ). Μετά από αυτές τις προεπεξεργασίες, ακολουθεί η δημιουργία του λογικού διαγράμματος λειτουργιών που απαιτούνται για την υλοποίηση του μοντέλου. Η φάση αυτή η οποία αφορά στο λογικό σχεδιασμό είναι ιδιαίτερα καθοριστική για την αποτελεσματικότητα του μοντέλου. Εδώ καθορίζονται με σαφήνεια όλες οι επεξεργασίες στα αρχικά δεδομένα με στόχο την παραγωγή των δευτερογενών επιπέδων-κριτηρίων τα οποία τελικά θα συμμετέχουν στη χαρτογραφική υπέρθεση.
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    Σχήμα 3.4 Χαρτογραφική υπέρθεση. Η υπέρθεση των επιπέδων A,B,C, δίνει μέσω του επιπέδου D, το επίπεδο Ε στο οποίο χαρτογραφούνται οι περιοχές που είναι λευκές και στα τρια αρχικά επίπεδα.


    


    Το τελικό στάδιο αφορά στην εκτέλεση του μοντέλου εντός του διαθέσιμου υπολογιστικού συστήματος και στη δημιουργία των τελικών παραγόμενων. Τα παραγόμενα αυτά, τα οποία συχνά παρουσιάζουν τα αποτελέσματα διαφόρων σεναρίων ανάλυσης, συνήθως έχουν τη μορφή χάρτη. Οι χάρτες αυτοί στην απλούστερη μορφή τους είναι δυαδικοί (binary maps) παρουσιάζοντας τις περιοχές που ικανοποιούν (ή όχι) συνδυαστικά μια σειρά από επιθυμητά κριτήρια. Οι χάρτες αυτοί αναφέρονται και ως «χάρτες ικανότητας» (capability maps), καθώς παρουσιάζουν με έναν απόλυτο τρόπο (ναι/όχι) την ικανότητα περιοχών να φιλοξενήσουν συγκεκριμένες χρήσεις. Στην πραγματικότητα ένας δυαδικός - δίτιμος χάρτης είναι το αποτέλεσμα του συνδυασμού θεματικών επιπέδων με απλούς κανόνες (rules) οι οποίοι μπορούν να χρησιμοποιούν διάφορους τελεστές και λογικούς ή αριθμητικούς ελέγχους (π.χ. +, -, AND, OR, <, >, κλπ.). για παράδειγμα το αποτέλεσμα που παρουσιάζεται στο σχήμα … προκύπτει έπειτα από την εφαρμογή του παρακάτω συνδυασμού κανόνων:


    Παραγόμενος_Χάρτης = [(ΑποστΥδρ > 500) AND (Περατότητα = «μικρή») AND (Natura = «0»)]


    Όταν η παραπάνω σχέση εφαρμόζεται σε ψηφιδωτά δεδομένα τότε η λειτουργία είναι μια απλή τοπική λειτουργία χαρτογραφικής άλγεβρας. Όταν τα συνδυαζόμενα επίπεδα είναι διανυσματικά θα πρέπει αρχικά να λάβει χώρα μια λειτουργία υπέρθεσης (π.χ. Union) και στη συνέχεια, στον πίνακα περιγραφών του παραγόμενου επιπέδου, θα πρέπει να εκτελεστούν οι επιθυμητοί κανόνες. Μ’ αυτόν τον τρόπο, εντοπίζονται οι χωρικές οντότητες οι οποίες συγκεντρώνουν συνδυαστικά το σύνολο των επιθυμητών χαρακτηριστικών.


    Αυτή η μεθοδολογία παραγωγής δίτιμου αποτελέσματος, καθώς βασίζεται σε αυστηρούς κανόνες, έχει το μειονέκτημα ότι δεν παρέχει κανενός είδους πληροφορίες για τη διαβάθμιση του εξεταζόμενου φαινομένου. Αυτό ενέχει τον κίνδυνο να μην υπάρχει καμιά περιοχή η οποία να συγκεντρώνει συνδυαστικά το σύνολο των κανόνων. Για αυτόν τον σκοπό κατασκευάζονται οι χάρτες καταλληλότητας (Suitability maps). Για την κατασκευή αυτών των χαρτών κάθε επίπεδο μετασχηματίζεται σε έναν δίτιμο χάρτη μ’ ένα αυστηρό κριτήριο, αλλά βαθμονομείται με βάση το βαθμό κατά τον οποίο συνδέεται με το φαινόμενο που μελετάται. Έτσι, τα αποτελέσματα της ανάλυσης καταλληλότητας παρουσιάζονται σε χάρτη ο οποίος περιλαμβάνει περιοχές οι οποίες κυμαίνονται από υψηλή σε χαμηλή καταλληλότητα. Ένα μοντέλο καταλληλότητας απαντά σε κάποιο ερώτημα χωροθέτησης του τύπου «πού είναι η καταλληλότερη θέση για την τοποθέτηση…»;


    Χαρακτηριστικά παραδείγματα αυτού του τύπου ανάλυσης είναι:


    · Η ανάλυση των Χρήσεων Γης και οι περιβαλλοντικές εφαρμογές (Chalkias & Lazaridi 2011) όπου τα μοντέλα καταλληλότητας χρησιμοποιούνται για τη χωροθέτηση χρήσεων και υπηρεσιών, καθώς και για το σχεδιασμό του χώρου. Τα αποτελέσματα αυτής της ανάλυσης αξιοποιούνται στη διαδικασία λήψης αποφάσεων που σχετίζονται με τη διαχείριση του περιβάλλοντος σε ένα στρατηγικό επίπεδο.


    · Οι εφαρμογές στη Γεωργία, όπου μοντέλα καταλληλότητας χρησιμοποιούνται για τον εντοπισμό περιοχών κατάλληλων για συγκεκριμένους τύπους καλλιεργειών. Σ’ αυτές τις εφαρμογές κύρια στόχευση αποτελεί η αποτελεσματική και βιώσιμη αξιοποίηση των φυσικών πόρων. Καθώς κάθε τύπος καλλιέργειας απαιτεί διαφορετικές συνθήκες (εδαφικές, κλιματολογικές, κ.λ.π), η ανάλυση αυτού του τύπου μπορεί να επικεντρώνεται κάθε φορά στην εξέταση συνδυασμού χωρικών κριτηρίων στο πλαίσιο ενός ΓΠΣ.


    · Στρατιωτικές εφαρμογές: Σ’ εφαρμογές στο πεδίο της άμυνας, η ανάλυση καταλληλότητας μπορεί να βοηθήσει στον εντοπισμό στρατηγικών περιοχών (π.χ. για την τοποθέτηση ενός παρατηρητηρίου), τη χωροθέτηση στρατιωτικών βάσεων (π.χ. για ανεφοδιασμό) και τον εντοπισμό εχθρικών θέσεων (π.χ. οχυρωμάτων με συγκεκριμένα χαρακτηριστικά).


    · Εφαρμογές ανάλυσης εγκλήματος, στις οποίες επιχειρείται η αξιολόγησης της χωρικής διάστασης της εγκληματικότητας ή και της παραβατικότητας μέσα από την εξέταση μιας σειράς παραγόντων που σχετίζονται με αυτή. Τα αποτελέσματα αυτών των αναλύσεων μπορούν να βοηθήσουν τις αρμόδιες αρχές στη λήψη εστιασμένων μέτρων πρόληψης ή και καταστολής της εγκληματικότητας.
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    Σε κάθε εφαρμογή πολυκριτηριακής ανάλυσης στη Γεωγραφία, το βασικό ερώτημα σχετίζεται με φαινόμενα τα οποία διαδραματίζονται στο χώρο. Συνεπώς, τα παραγόμενα των μοντέλων αυτού του τύπου αναφέρονται σε τμήματα του χώρου ή σε χωρικές μονάδες. Επιπρόσθετα, τα κριτήρια τα οποία λαμβάνουν μέρος στην ανάλυση έχουν χωρική κατανομή και αναφέρονται ως «χωρικά κριτήρια»


    Η χωρική πολυκριτηριακή ανάλυση (ΧΠΚΑ), προϋποθέτει την αξιοποίηση χωρικών κριτηρίων και έχει ως αποτέλεσμα την αξιολόγηση εναλλακτικών επιλογών με γεωγραφική διάσταση. Στην ορολογία των ΓΠΣ, αυτές οι εναλλακτικές επιλογές μπορεί να αντιστοιχίζονται σε σημειακές, γραμμικές ή επιφανειακές οντότητες (αντικείμενα ενός διανυσματικού μοντέλου) ή σε διακριτά τμήματα χώρου (ψηφίδες ενός ψηφιδωτού μοντέλου).


    Στην κλασική, μη χωρική ΠΚΑ, εφαρμόζονται μέθοδοι οι οποίες εξετάζουν έναν καθορισμένο, συνήθως μικρό, αριθμό εναλλακτικών επιλογών (alternatives). Η προσέγγιση αυτή, παρότι εφαρμόζεται και σε γεωγραφικές εφαρμογές (για παράδειγμα όταν γίνεται η αξιολόγηση ενός αριθμού προεπιλεγμένων θέσεων για πιθανή τοποθέτηση αιολικού πάρκου), δεν είναι ο κανόνας σε περιπτώσεις χωρικών προβλημάτων, καθώς τα περισσότερα από αυτά είναι συνεχή. Αυτό πρακτικά σημαίνει ότι κάθε τμήμα της περιοχής μελέτης αποτελεί δυνητικά και μια προτεινόμενη χωρική εναλλακτική επιλογή (spatial alternative). Η ελάχιστη χωρική μονάδα ή ελάχιστη χαρτογραφήσιμη μονάδα (minimum mapping unit - MMU) ενός ΓΠΣ σχετίζεται άμεσα μ’ αυτές τις χωρικές εναλλακτικές επιλογές. Όταν τα χωρικά κριτήρια είναι ψηφιδωτής μορφής, τότε η ελάχιστη χωρική μονάδα αντιστοιχεί σε μια ψηφίδα. Εναλλακτικά, μπορούν να χρησιμοποιηθούν ζώνες στα συνεχή θεματικά επίπεδα. Σ’ αυτήν την περίπτωση, οι χωρικές εναλλακτικές επιλογές προκύπτουν μετά από το συνδυασμό των ζωνών (Chakhar and Mousseau 2008).


    Τις τελευταίες δεκαετίες, οι εφαρμογές χωρικής πολυκριτηριακής ανάλυσης αποτελούν ένα ιδιαίτερα δημοφιλές υπόβαθρο ανάπτυξης εφαρμογών των ΓΠΣ, σε επιστημονικές περιοχές όπως το περιβάλλον, ο αστικός και περιφερειακός σχεδιασμός, οι γεωεπιστήμες, η διαχείριση αποβλήτων, η υδρολογία, η γεωργία κ.α. (Malczewksi, 2006). Μια αναζήτηση στη βάση βιβλιογραφικών δεδομένων SCOPUS (www.scopus.com) των επιστημονικών άρθρων τα οποία στις λέξεις κλειδιά έχουν τους όρους “ΓΠΣ” AND “MULTICRITERIA”, απέφερε ως αποτέλεσμα 530 επιστημονικά άρθρα (αναζήτηση Σεπ. 2015). Πάνω από τα μισά από αυτά τα άρθρα ανήκουν στο πεδίο των περιβαλλοντικών επιστημών (314 άρθρα), ενώ τα υπόλοιπα κύρια πεδία εφαρμογής της μεθόδου είναι κατά σειρά οι γεωεπιστήμες (159 άρθρα), οι κοινωνικές επιστήμες (154 άρθρα), η οικολογία και οι βιολογικές επιστήμες (105 άρθρα), η πληροφορική (75 άρθρα) οι επιστήμες μηχανικού (53 άρθρα) και η ενέργεια (28 άρθρα).


    Αναφορικά με τα εργαλεία και το λογισμικό που είναι διαθέσιμα για αυτόν τον σκοπό, θα πρέπει να σημειωθεί ότι τα περισσότερα σύγχρονα λογισμικά ΓΠΣ παρέχουν λειτουργίες για χωρική πολυκριτηριακή ανάλυση. Σε γενικές γραμμές, απαντώνται τρεις βασικοί τύποι σύνδεσης λογισμικών ΓΠΣ με τεχνικές ΠΚΑ:


    


    · Πλήρης σύνδεση (full coupling), κατά την οποία ένα ενιαίο λογισμικό παρέχει και τις δύο δυνατότητες,


    · Ισχυρή σύνδεση (tight coupling), η οποία συνήθως υλοποιείται με την ενσωμάτωση ειδικών προσθηκών εφαρμογής μεθόδων ΠΚΑ σε ένα λογισμικό ΓΠΣ, και


    · Χαλαρή σύνδεση (loose coupling) η οποία επιτυγχάνεται με ανεξάρτητη λειτουργία δύο πακέτων και με ανταλλαγή δεδομένων μεταξύ τους.


    


    Μεταξύ των διαδεδομένων σύγχρονων λογισμικών ΓΠΣ το λογισμικό IDRISI, το παλαιότερο λογισμικό Common GIS και η αυτόνομη εφαρμογή Decerns GIS DE παρέχουν πλήρη σύνδεση ΓΠΣ – ΠΚΑ, ενώ για τα περισσότερα διαδεδομένα λογισμικά ΓΠΣ υπάρχει πλήθος επεκτάσεων (add-ons) πακέτων ΠΚΑ οι οποίες εξασφαλίζουν ισχυρή σύνδεση με τα ΓΠΣ. Αυτό ισχύει και για τα λογισμικά ArcGIS και QGIS τα οποία χρησιμοποιούνται στα πρακτικά παραδείγματα του συγγράμματος. Επεκτάσεις αυτού του τύπου για το λογισμικό ArcGIS είναι, μεταξύ άλλων, η επέκταση MCDAS, η επέκταση MCDA4ArcMap και η επέκταση VISTA. Στο λογισμικό QGIS οι επεκτάσεις geoUmbriaSUIT, EasyAHP και Vector MCDA παρέχουν δυνατότητες ΠΚΑ, ενώ στο λογισμικό ΓΠΣ GRASS μπορεί για αυτόν τον σκοπό να χρησιμοποιηθεί η επέκταση TMCDA.


    Τέλος, θα πρέπει να σημειωθεί ότι την τελευταία δεκαετία, με την αλματώδη ανάπτυξη εφαρμογών WebGIS και την ανάπτυξη συμμετοχικών ΓΠΣ (Participatory GIS ή PGIS) στο γενικότερο πλαίσιο της δεύτερης έκδοσης του διαδικτύου (Web 2.0), έχουν προταθεί πολλές εφαρμογές χωρικής πολυκριτηριακής ανάλυσης στο διαδίκτυο οι οποίες περιλαμβάνουν άμεση συμμετοχή των πολιτών (μεταξύ άλλων Jankowski 2009, Boroushaki and Malczewski 2010). Στις μέρες μας, οι τεχνικές χωρικής πολυκριτηριακής ανάλυσης σε συνδυασμό με τα συμμετοχικά ΓΠΣ μπορούν να αξιοποιήσουν τις απόψεις όλων των ενδιαφερόμενων μερών σε περιβαλλοντικά προβλήματα και συνεπώς δυνητικά, μπορούν να αποτελέσουν εργαλεία κοινωνικής συμμετοχής στη λήψη αποφάσεων.


    


    [bookmark: _Toc438361145]3.4. Η διαδικασία της Χωρικής Πολυκριτηριακής Ανάλυσης με χαρτογραφική υπέρθεση


    Η διαδικασία της ΧΠΚΑ με σταθμισμένη χαρτογραφική υπέρθεση στο πλαίσιο ενός Γεωγραφικού Πληροφοριακού Συστήματος ακολουθεί, σε γενικές γραμμές, τα παρακάτω βήματα (Σχήμα 3.5, Σχήμα 3.6):


    · Καθορισμός κύριου ερωτήματος και αρχικών συνθηκών ανάλυσης.


    · Επιλογή μεταβλητών ( δημιουργία δευτερογενών μεταβλητών) και περιορισμών


    · Επαναταξινομήσεις – δημιουργία πίνακα αποφάσεων


    · Καθορισμός Συντελεστών Βαρύτητας και κανόνων αποφάσεων – συνδυασμού κριτηρίων


    · Συνδυασμός σταθμισμένων μεταβλητών (παραγωγή αποτελεσμάτων)


    · Ανάλυση ευαισθησίας


    · Πιστοποίηση - Έλεγχοι αποτελεσμάτων


    Αρχικά, θα πρέπει να γίνει η αναγνώριση και ο σαφής ορισμός του προβλήματος. Συνήθως, αυτό σχετίζεται με κάποιες επιθυμητές ιδιότητες του χώρου. Η αρχική αυτή φάση – η οποία εντάσσεται στον εννοιολογικό σχεδιασμό του μοντέλου – περιλαμβάνει επιπρόσθετα και τον καθορισμό των βασικών συνθηκών ανάλυσης, όπως είναι ο προσδιορισμός των επιμέρους στόχων, ο καθορισμός των εναλλακτικών επιλογών (χωρικές μονάδες αναφοράς), καθώς και ο προσδιορισμός του αριθμού των ληπτών της απόφασης. Αν και συνήθως ένας λήπτης - εμπειρογνώμονας αναπτύσσει το μοντέλο, δεν λείπουν οι περιπτώσεις στις οποίες επιτροπή εμπειρογνωμόνων αναλαμβάνει τη διαμόρφωση των κανόνων λήψης αποφάσεων. Επιπλέον, στις μέρες μας και μέσα από τη λογική των συμμετοχικών ΓΠΣ, τον ρόλο αυτόν μπορούν να αναλάβουν και ομάδες πολιτών οι οποίοι συνδιαμορφώνουν τις αποφάσεις.


    Στη συνέχεια, ακολουθεί η φάση του προσδιορισμού και της κατασκευής των κριτηρίων ανάλυσης ή χωρικών μεταβλητών. Τα κριτήρια αυτά σχετίζονται με τους επιμέρους στόχους (objectives) και τις μετρήσεις - περιγραφές (attributes) των επιμέρους στόχων. Τα χωρικά αυτά κριτήρια αντιστοιχούν στα θεματικά επίπεδα ενός ΓΠΣ. Η επιλογή των κριτηρίων βασίζεται συνήθως, στην εμπειρία των ερευνητών και τη σχετική βιβλιογραφία. Δεν είναι λίγες οι περιπτώσεις κατά τις οποίες είναι απαιτητή επιπλέον επεξεργασία (π.χ. στατιστική ανάλυση εκτεταμένης λίστας κριτηρίων ή εργασία πεδίου για την αξιολόγηση των κριτηρίων) ώστε να βοηθήσει σ’ αυτήν τη φάση. Οι επιθυμητές προδιαγραφές των δεδομένων (η κλίμακα και η μορφή των πρωτογενών στοιχείων) καθορίζονται επιπλέον σ’ αυτήν τη φάση. Εδώ, επίσης, προσδιορίζονται και οι περιορισμοί (restrictions) του μοντέλου και καθορίζονται τα θεματικά επίπεδα τα οποία περιγράφουν αυτούς τους περιορισμούς. Μετά την επιλογή των μεταβλητών και των καθορισμό των πρωτογενών δεδομένων τα οποία θα πρέπει να εισαχθούν στο υπό διαμόρφωση ΓΠΣ, σειρά έχουν οι αρχικές επεξεργασίες σ’ αυτά τα δεδομένα και η διαμόρφωση των θεματικών επιπέδων. Σ’ αυτό το στάδιο επεξεργασίας αξιοποιούνται οι δυνατότητες για εισαγωγή, μετασχηματισμούς και επεξεργασίες γεωγραφικών δεδομένων τις οποίες παρέχει ένα ΓΠΣ. Η γεωαναφορά σαρωμένων χαρτών, οι ψηφιοποιήσεις, καθώς και άλλοι μετασχηματισμοί (π.χ. αλλαγή συστήματος αναφοράς) και επεξεργασίες (π.χ. αλλαγή μεγέθους ψηφίδας ή συγνωνεύσεις θεματικών κατηγοριών) αποτελούν χαρακτηριστικά παραδείγματα αρχικών επεξεργασιών στα δεδομένα.


    Σε αρκετές εφαρμογές πολυκριτηριακής ανάλυσης η υλοποίηση επιμέρους στόχων απαιτεί τη δημιουργία δευτερογενών θεματικών επιπέδων μέσα από χωρικές επεξεργασίες και αναλύσεις στο πλαίσιο ενός ΓΠΣ. Για παράδειγμα, αν η «Κλίση των εδαφών» αποτελεί ένα κριτήριο για την ανάλυση ενός φαινομένου και τα διαθέσιμα αρχικά δεδομένα είναι τα στοιχεία ενός τοπογραφικού χάρτη, τότε μετά την ψηφιοποίηση των ισοϋψών καμπυλών και των υψομετρικών σημείων από τον τοπογραφικό χάρτη, θα πρέπει να γίνουν οι δευτερογενείς επεξεργασίες α) «δημιουργία ψηφιακού μοντέλου εδάφους από δεδομένα υψομέτρου» και β) «δημιουργία επιπέδου κλίσης εδαφών από Ψηφιακό μοντέλο εδάφους» .


    Το επόμενο βήμα σχετίζεται με την ομογενοποίηση και την ποσοτικοποίηση των κριτηρίων. Όπως έχει αναφερθεί, ένα από τα ιδιαίτερα κρίσιμα χαρακτηριστικά της χωρικής πολυκριτηριακής ανάλυσης είναι η δυνατότητα συνδυαστικής αξιοποίησης χωρικών μεταβλητών με ποσοτικά, αλλά και με ποιοτικά χαρακτηριστικά. Έτσι, στο πλαίσιο εφαρμογών ΧΠΑ συχνά οι λήπτες αποφάσεων καλούνται να αξιολογήσουν θεματικά επίπεδα με διάφορες κλίμακες ταξινόμησης. Οι τιμές - χαρακτηριστικά που αποδίδονται στις γεωγραφικές οντότητες ταξινομούνται στις παρακάτω κλίμακες:


    · Ονομαστική (nominal), η οποία δεν ακολουθεί κάποια αριθμητική κλίμακα, αλλά περιγράφει μη-ποσοτικά, μη-γραμμικά χαρακτηριστικά, όπως για παράδειγμα η ιδιότητα "λιθολογία" μπορεί να πάρει τις τιμές “ψαμμίτες”, “ασβεστόλιθοι”, “σχιστόλιθοι” κ.λ.π. Είναι ο απλούστερος θεματικός τύπος γεωγραφικών οντοτήτων. Ακόμα και όταν οι τιμές που αποδίδονται σε δεδομένα αυτού του τύπου είναι αριθμοί, δεν έχει νόημα η διεξαγωγή πράξεων μεταξύ τους. (π.χ άθροιση ταχυδρομικών κωδικών δύο δήμων). Πρόκειται για κλίμακα ποιοτικού χαρακτήρα.


    · Τακτική ή ταξινομική (ordinal), η οποία ακολουθεί μια κλίμακα σε σειρά, όπου λαμβάνει χώρα ταξινόμηση των οντοτήτων μετά από σύγκρισή τους ανά ζεύγη. Ως παράδειγμα αναφέρεται η καταλληλότητα των εδαφών για κάποια καλλιέργεια η οποία παίρνει τις τιμές 3: μεγάλη, 2: μέτρια, 1: μικρή. Οι αριθμητικές πράξεις μεταξύ τέτοιων τιμών δεν έχουν νόημα. Συνεπώς, δε σημαίνει ότι η κλάση «2» έχει διπλάσια καταλληλότητα από την κλάση «1». Θεωρείται κλίμακα υβριδικού χαρακτήρα η οποία συγκεντρώνει και ποιοτικά και ποσοτικά χαρακτηριστικά.


    · Διαστημική (interval), στην οποία κάθε οντότητα τοποθετείται σε μια αριθμητική τακτική κλίμακα, με αυθαίρετο μέγεθος μέτρησης όπως για παράδειγμα η μέση θερμοκρασία σε κάποιο μετεωρολογικό σταθμό. Η πρόσθεση και η αφαίρεση μεταξύ των τιμών είναι επιτρεπτές, σε αντίθεση με τον πολλαπλασιασμό και τη διαίρεση. Επιπρόσθετα, η μηδενική τιμή δε δείχνει απουσία του φαινομένου (0 βαθμοί κελσίου δεν σημαίνουν «απουσία θερμοκρασίας»).


    · Και τέλος αναλογική (ratio), η οποία αναφέρεται σε αριθμητική κλίμακα με απόλυτο μηδενικό σημείο εκκίνησης. Σ’ αυτό το επίπεδο, αν μια τιμή είναι πολλαπλάσια μιας άλλης αυτή αναπαριστά και πολλαπλάσια ποσότητα. (π.χ μήκος οδικού άξονα 1000 Km είναι διπλάσιο από τα 2000 Km, και πληθυσμός 0 σημαίνει απουσία κατοίκων).


    Σ’ αυτήν τη φάση της ΧΠΚΑ, συνήθως, δεδομένα σε ποσοτικά και ποιοτικές κλίμακες ταξινόμησης μετασχηματίζονται σε ενιαία τακτική κλίμακα. Έτσι, για παράδειγμα ένα επίπεδο το οποίο περιγράφει την απόσταση από το οδικό δίκτυο (αναλογική κλίμακα ταξινόμησης), μετασχηματίζεται στο επίπεδο «καταλληλότητας λόγω απόστασης από το οδικό δίκτυο» με τακτική κλίμακα ταξινόμησης και 5 κλάσεις (πολύ μικρή-VL, μικρή-L, μέση-M, μεγάλη-H, Και πολύ μεγάλη-VH) με βάση τους παρακάτω κανόνες ταξινόμησης: IF ((DistHyro < 100) THEN OUT_DistHydro = “VL”) ELSEIF ((100 < DistHyro < 200) THEN OUT_DistHydro = “L”) ELSEIF ((200 < DistHyro < 500) THEN OUT_DistHydro = “M”) ELSEIF ((500 < DistHyro < 1000) THEN OUT_DistHydro = “H”) ELSEIF ((1000 < DistHyro) THEN OUT_DistHydro = “VL”)


    Η φάση της ομογενοποίησης των δεδομένων εκτός από την επαναταξινόμηση σε τακτική κλίμακα περιλαμβάνει και διαμόρφωση των παραγόντων - μεταβλητών σε ενιαία κλίμακα και με ενιαία μονάδα αναφοράς.
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    Σχήμα 3.5 Βήματα υλοποίησης Χωρικής Πολυκριτηριακής Ανάλυσης (φάσεις 1-4).


    


    Στη συνέχεια ακολουθεί η διαμόρφωση της στάθμισης (καθορισμός συντελεστών βαρύτητας) και των κανόνων σύνθεσης των μεταβλητών από τους λήπτες αποφάσεων.


    


    [image: ]


    Σχήμα 3.6 Βήματα υλοποίησης Χωρικής Πολυκριτηριακής Ανάλυσης (φάσεις 5-8).


    


    Σ’ αυτήν τη φάση, οι προτιμήσεις των αναλυτών, αναφορικά με τα κριτήρια, ενσωματώνονται στη μοντελοποίηση. Οι προτιμήσεις αυτές ποσοτικοποιούνται με τη μορφή συντελεστών βαρύτητας ή απλά βαρών (weights), οι οποίοι εκφράζουν τη σχετική σπουδαιότητα κάθε κριτηρίου. Συνήθως, αυτοί οι συντελεστές εκφράζονται με δεκαδικούς αριθμούς στο διάστημα 0-1 οι οποίοι αθροίζονται στο 1. Το βήμα αυτό είναι ιδιαίτερα καθοριστικό για την μοντελοποίηση, καθώς αν είναι γνωστοί οι συντελεστές βαρύτητας κάθε κριτηρίου και παράλληλα έχουν οριστεί τα ομογενοποιημένα κριτήρια και οι εναλλακτικές επιλογές, μπορεί να δημιουργηθεί και ο πίνακας αποφάσεων ο οποίος δείχνει την τελική αξιολόγηση κάθε εναλλακτικής επιλογής.


    


    Στο επόμενο στάδιο της ΧΠΚΑ, αξιοποιούνται τα παράγωγα από τα προηγούμενα στάδια, δηλαδή οι κρίσεις των αναλυτών - εμπειρογνωμόνων, καθώς και τα ομογενοποιημένα κριτήρια, έτσι ώστε να γίνει η συνολική αξιολόγηση των εναλλακτικών επιλογών. Στο σημείο αυτό, θα πρέπει να τεθούν οι κανόνες επιλογής των εναλλακτικών επιλογών με βάση τα κριτήρια και τους συντελεστές βαρύτητας. Αυτοί οι κανόνες μπορεί να οδηγούν στην επιλογή της εναλλακτικής επιλογής (ή των εναλλακτικών επιλογών) που ικανοποιούν κάποια ή κάποιες συνθήκες ή μπορεί να έχουν ως αποτέλεσμα την βαθμονόμηση των εναλλακτικών επιλογών. Στην περίπτωση της ΧΠΚΑ, το αποτέλεσμα αυτής της φάσης μπορεί να οδηγήσει είτε στη χαρτογράφηση των περιοχών που ικανοποιούν μια σειρά από κανόνες, είτε στη χαρτογράφηση της καταλληλότητας σε επίπεδο χωρικής μονάδα αναφοράς. Ένας συνηθισμένες τρόπος διαμόρφωσης της τελικής καταλληλότητας των χωρικών μονάδων αναφοράς είναι η σταθμισμένη άθροιση των ομογενοποιημένων τιμών τους με χαρτογραφική υπέρθεση. Θα πρέπει να τονιστεί ότι, για τη χαρτογράφηση της καταλληλότητας ιδιαίτερη σημασία έχει, τόσο η επιλογή του συμβολισμού όσο και η μέθοδος ταξινόμησης για τον προσδιορισμό της καταλληλότητας. Σε τέτοιου τύπου μοντέλα, το παραγόμενο, συνήθως, χαρτογραφείται με τη χρήση διχρωμίας στο συμβολισμό έτσι ώστε να είναι άμεσα αναγνωρίσιμες οι περιοχές με τιμές μεγαλύτερες και μικρότερες από μια μέση τιμή η οποία αντιστοιχεί στη μέση καταλληλότητα. Τέλος, σημειώνεται ότι μπορούν να εκτελεστούν διάφορα σενάρια συνδυασμού των κριτηρίων τα οποία και να αποδίδουν διαφορετικά αποτελέσματα.


    


    Η ανάλυση ευαισθησίας (Sensitivity Analysis), και οι τελικοί έλεγχοι των αποτελεσμάτων του μοντέλου, αποτελούν και τα τελικά στάδια υλοποίησής του. Παρότι το τελικό αυτό στάδιο είναι σημαντικό για την πιστοποίηση του μοντέλου, συχνά παραλείπεται και τα αποτελέσματά του υιοθετούνται αυτούσια, χωρίς περαιτέρω ελέγχους. Για να εξετασθεί η αξιοπιστία του μοντέλου, πραγματοποιείται η ανάλυση ευαισθησίας του, η οποία υποδεικνύει τη σταθερότητα του ή με μικρές αλλαγές στη βαθμονόμηση των κριτηρίων σε ενιαία κλίμακα, είτε στους συντελεστές βαρύτητας (Malczewski, 1999). Αν σ’ αυτό το στάδιο αποδειχθεί ότι το μοντέλο είναι ευάλωτο σε αλλαγές των τιμών των μεταβλητών ή των συντελεστών που επιλέχθηκαν, τότε είτε τροποποιούνται οι συντελεστές βαρύτητας, είτε επανεξετάζονται τα προηγούμενα στάδια της μοντελοποίησης και πραγματοποιείται καλύτερη εξειδίκευση στην επιλογή των κριτηρίων.


    


    Τέλος, η πιστοποίηση - επικύρωση του μοντέλου σχετίζεται με τη σύγκριση των αποτελεσμάτων -εκτιμήσεων του μοντέλου, σε σχέση με την πραγματική κατάσταση. Η φάση αυτή, η οποία συνήθως λαμβάνει χώρα σε επιλεγμένες περιοχές της περιοχής μελέτης, γίνεται μετά από εκτιμήσεις (ή μετρήσεις) του φαινομένου στο πεδίο ή με την αξιοποίηση της Τηλεπισκόπησης. Στο Σχήμα 3.6, παρουσιάζεται μια συνηθισμένη αλληλουχία βημάτων ελέγχου στα αποτελέσματα ενός μοντέλου ΧΠΚΑ. Σύμφωνα με αυτή, με δεδομένο ότι έχει ήδη παραχθεί ένας χάρτης από το μοντέλο, λαμβάνει χώρα τυχαία δειγματοληψία στην περιοχή μελέτης και στη συνέχεια στα σημεία της δειγματοληψίας καταγράφεται η «πραγματική τιμή» για το φαινόμενο το οποίο έχει αποτιμηθεί με μοντελοποίηση ΧΠΚΑ. Έπειτα, γίνεται η σύγκριση «πραγματικών» - «εκτιμώμενων» τιμών είτε με τον υπολογισμό των κατάλληλων δεικτών (π.χ. δείκτης “K”) είτε με στατιστική επεξεργασία και χαρτογράφηση των υπολοίπων (residuals) τα οποία αντιστοιχούν στις διαφορές των πραγματικών τιμών από τις εκτιμώμενες για τα σημεία δειγματοληψίας.
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    Στο κεφάλαιο αυτό επιχειρήθηκε μια επισκόπηση του αντικειμένου και των μεθόδων χωρικής πολυκριτηριακής ανάλυσης με την αξιοποίηση της τεχνολογίας των ΓΠΣ. Παρότι το πεδίο αυτό απασχολεί την επιστημονική κοινότητα εδώ και αρκετές δεκαετίες, νέες μέθοδοι και εργαλεία υλοποίησης εφαρμογών ΧΠΚΑ σε περιβάλλον ΓΠΣ, προτείνονται διαρκώς. Συνεπώς, ο αποτελεσματικός σχεδιασμός και υλοποίηση των μεθόδων ΧΠΚΑ προϋποθέτει τόσο γνώσεις τεχνικών πολυκριτηριακής ανάλυσης αποφάσεων όσο και γνώσεις χωρικής ανάλυσης και ΓΠΣ. Παραπάνω, παρουσιάστηκε μια εισαγωγή στο αντικείμενο, στο βασικό θεωρητικό του υπόβαθρο και επιπλέον δόθηκε ένα παραδειγματικό σχήμα υλοποίησης εφαρμογής μεθόδων ΧΠΚΑ στο πλαίσιο ενός ΓΠΣ. Τέλος, παρακάτω, στο κριτήριο αξιολόγησης 2, παρουσιάζεται ένα πρακτικό παράδειγμα εφαρμογής της μεθόδου για την αποτίμηση ενός γεωγραφικού φαινομένου με τη μορφή εκπαιδευτικής άσκησης.
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    Λογισμικά πλήρους σύνδεσης ΓΠΣ - ΠΚΑ


    COMMON ΓΠΣ:  http://www.iais.fraunhofer.de/1871.html?&L=1


    DECERNS ΓΠΣ DE:  http://deesoft.ru/lang/en/product-decerns-mcda/


    IDRISI: https://clarklabs.org/terrset/


    


    Επεκτάσεις ArcΓΠΣ


    MCDAS  http://arcscripts.esri.com/details.asp?dbid=16856


    MCDA4ArcMAP  https://mcda4arcmap.codeplex.com/


    VISTA  www.natureserve.org/conservation-tools/natureserve-vista


    AHP extension  http://arcscripts.esri.com/details.asp?dbid=14894


    


    Επεκτάσεις QΓΠΣ


    Geoumbriasuit  https://plugins.qGIS.org/plugins/geoUmbriaSUIT/


    easy AHP  https://plugins.qGIS.org/plugins/EasyAHP/


    Vector MCDA  https://plugins.qGIS.org/plugins/VectorMCDA/


    


    Επεκτάσεις GRASS  https://grass.osgeo.org/grass70/manuals/addons/


    Μέθοδος AHP  r.mcda.ahp


    Μέθοδος ELECTRE r.mcda.electre


    Μέθοδος PROMETHEE r.mcda.promethee


    Αλγόριθμος TOPSIS r.mcda.topsis
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    [bookmark: _Toc438361149]Κριτήριο Αξιολόγησης 1 - Ερωτήσεις Κατανόησης


    1. Τι είναι η πολυκριτηριακή ανάλυση αποφάσεων και ποια τα πλεονεκτήματα της ως μέθοδος υποστήριξης λήψης αποφάσεων;


    2. Ποια είναι τα στάδια υλοποίησης της μεθόδου ΠΚΑ;


    3. Ποιες είναι οι ιδιαιτερότητες της χωρικής πολυκριτηριακής ανάλυσης και πώς αυτές αντιμετωπίζονται.


    4. Τι γνωρίζετε για την μοντελοποίηση καταλληλότητας με χαρτογραφική υπέρθεση θεματικών επιπέδων;


    5. Με ποιο τρόπο η τεχνολογία των ΓΠΣ υποστηρίζει τη Χωρική Πολυκριτηριακή Ανάλυση;


    


    [bookmark: _Toc438361150]Κριτήριο Αξιολόγησης 2 - AΣΚΗΣΗ: Δημιουργία μοντέλου χωρικής πολυκριτηριακής ανάλυσης με σταθμισμένη χαρτογραφική υπέρθεση
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    Η συγκεκριμένη άσκηση πραγματεύεται την κατασκευή μοντέλου πολυκριτηριακής ανάλυσης με χαρτογραφική υπέρθεση θεματικών επιπέδων σε περιβάλλον ΓΠΣ. Το παράδειγμα που παρουσιάζεται αφορά στον προσδιορισμό της επιδεκτικότητας σε διάβρωση για τη Ν. Γαύδο και έχει άμεση σχέση με την μοντελοποίηση καταλληλότητας η οποία περιγράφηκε στο θεωρητικό μέρος. Σκοπός της άσκησης είναι η δημιουργία ενός μοντέλου αποτίμησης και χαρτογράφησης της επιδεκτικότητας σε διάβρωση για την περιοχή μελέτης αξιοποιώντας την τεχνική της σταθμισμένης χαρτογραφικής υπέρθεσης ψηφιδωτών δεδομένων σε περιβάλλον ΓΠΣ. Επιπρόσθετα, και με βάση τα τελικά αποτελέσματα της μοντελοποίησης, θα προσδιοριστούν τα τμήματα του οδικού δικτύου τα οποία βρίσκονται σε περιοχές μεγάλης επιδεκτικότητας.


    


    Η υλοποίηση του μοντέλου θα γίνει με χαρτογραφική υπέρθεση ψηφιδωτών θεματικών επιπέδων - κριτηρίων που σχετίζονται με το φαινόμενο που μελετάται. Έτσι, οι εναλλακτικές επιλογές (alternatives) του μοντέλου, αντιστοιχούν σε ψηφίδες μεγέθους 30 Χ 30 μέτρων. Η κλίμακα εργασίας είναι 1:50000 και το σύστημα αναφοράς που χρησιμοποιείται είναι το Ελληνικό Γεωδαιτικό Σύστημα Αναφορά 1987 (ΕΓΣΑ 87).


    Στο σημείο αυτό πρέπει να οριστούν τα χαρακτηριστικά της ανάλυσης, ώστε η διαδικασία που θα επακολουθήσει να εφαρμόζεται εντός στην περιοχή και τα αποτελέσματα να έχουν τα επιθυμητά χωρικά χαρακτηριστικά. Καθώς η εφαρμογή θα υλοποιηθεί σε περιβάλλον ArcΓΠΣ, αρχικά ενεργοποιείται η επέκταση Spatial Analyst, μέσω της οποίας θα γίνει η μοντελοποίηση και σ’ αυτό το εργαλείο (Σχήμα 3.7) επιλέγονται (μενού Spatial Analyst > Options) τα παρακάτω:


    · Στην επιλογή General ως Analysis mask (χωρική μάσκα περιοχής μελέτης) επιλέγεται το θεματικό επίπεδο ‘land’, το οποίο αντιστοιχεί ακριβώς στα όρια της περιοχής μελέτης. Το ίδιο θεματικό επίπεδο προσδιορίζει και τα όρια της περιοχής μελέτης (Extend).


    · Στην επιλογή Cell Size, ορίζεται το μέγεθος που θα έχει κάθε ψηφίδα, επομένως, στο analysis cell size ορίζονται τα 30Χ30 μέτρα.


    Η ανάλυση γίνεται με βάση προκαθορισμένους κανόνες και συντελεστές βαρύτητας. Παρότι το μοντέλο που παρουσιάζεται έχει καθαρά εκπαιδευτικό χαρακτήρα και περιλαμβάνει αρκετές παραδοχές οι οποίες το καθιστούν μη επιχειρησιακό στη μορφή που παρουσιάζεται εδώ, μπορεί να αποτελέσει τη βάση για ανάπτυξη ολοκληρωμένου συστήματος αποτίμησης της επιδεκτικότητας σε διάβρωση.
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    Σχήμα 3.7 Αρχικές ρυθμίσεις στην επέκταση Spatial Analyst.
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    Μετά από αναζήτηση της σχετικής βιβλιογραφίας, καθορίστηκαν τα κριτήρια για την αποτίμηση του φαινομένου. Οι παράγοντες - κριτήρια από τους οποίους θεωρείται ότι εξαρτάται το φαινόμενο στη συγκεκριμένη άσκηση είναι:


    · η βλάστηση


    · η λιθολογία


    · η κλίση του εδάφους


    · ο προσανατολισμός των επιφανειών


    · η απόσταση από το υδρογραφικό δίκτυο


    · και η απόσταση από την ακτογραμμή


    Για την ενσωμάτωση των παραγόντων αυτών στο λογισμικό ArcΓΠΣ δημιουργήθηκε χωρική βάση δεδομένων η οποία αποτελείται από τα παρακάτω θεματικά επίπεδα:


    · Βλάστηση (επίπεδο Vegetation, διανυσματικό επίπεδο με πολυγωνικές οντότητες)


    · Λιθολογία (επίπεδο Lithology, διανυσματικό επίπεδο με πολυγωνικές οντότητες)


    · Ψηφιακό μοντέλο υψομέτρων της περιοχής (επίπεδο DEM, ψηφιδωτό επίπεδο)


    · Υδρογραφικό δίκτυο (επίπεδο Hydro, διανυσματικό επίπεδο με γραμμικές οντότητες)


    · Ισοϋψείς καμπύλες (επίπεδο Contour, διανυσματικό επίπεδο με γραμμικές οντότητες)


    · Όριο περιοχής μελέτης (επίπεδο Land, διανυσματικό επίπεδο με πολυγωνικές οντότητες)


    Οι παράγοντες που θα μελετηθούν, περιγράφονται για την περιοχή μελέτης από τα διαθέσιμα θεματικά επίπεδα που παρατέθηκαν παραπάνω (Σχήμα 3.8). Για κάποιους από τους παράγοντες, τα διαθέσιμα επίπεδα μπορούν να χρησιμοποιηθούν σχεδόν αυτούσια, όπως είναι τα επίπεδα της βλάστησης και της λιθολογίας για τα οποία χρειάζεται να γίνει ο μετασχηματισμός τους σε ψηφιδωτή μορφή, ενώ οι υπόλοιποι παράγοντες προκύπτουν σε επόμενη φάση από δευτερογενείς επεξεργασίες στο πλαίσιο του ΓΠΣ της περιοχής. Σημειώνεται, επίσης, ότι στην τελική φάση της ανάλυσης θα χρησιμοποιηθεί και το επίπεδο του οδικού δικτύου.
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    Σχήμα 3.8 Αρχικά θεματικά επίπεδα περιοχής μελέτης: a)Land – Roads, b)DEM, c)Contours, d)Lithology, e)Rivers, f)Vegetation.
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    Στις περισσότερες εφαρμογές Χωρικής Πολυκριτηριακής Ανάλυσης οι παράγοντες οι οποίοι εξετάζονται, δεν αντιστοιχούν σε πρωτογενή δεδομένα, αλλά προκύπτουν μέσα από δευτερογενείς επεξεργασίες χωρικής ανάλυσης. Έτσι για παράδειγμα σε μια περιβαλλοντική εφαρμογή στην οποία αναλύονται οι συνθήκες ορατότητας από ένα συγκεκριμένο σημείο, δημιουργείται το επίπεδο ορατότητας από αρχικές πληροφορίες υψομέτρου όπως είναι τα υψομετρικά σημεία και οι ισοϋψείς καμπύλες μέσα από τη δημιουργία ενός Ψηφιακού Μοντέλου Εδάφους και την εκτέλεση του αλγορίθμου Viewshed Analysis. Στην περίπτωση της άσκησης που παρουσιάζεται εδώ, τα θεματικά επίπεδα - κριτήρια κλίσης, προσανατολισμού, απόστασης από υδρογραφικό και απόστασης από την ακτογραμμή δημιουργήθηκαν με τις κατάλληλες επεξεργασίες από τα αρχικά πρωτογενή δεδομένα στο πλαίσιο του ΓΠΣ της περιοχής μελέτης.
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    Σχήμα 3.9 Δευτερογενή θεματικά επίπεδα κλίσης και προσανατολισμού. Δημιουργία από το ΨΜΕ.


    


    Με βάση το Ψηφιακό Μοντέλο Υψομέτρων DEM (Digital Elevation Model) της Γαύδου, δημιουργούνται δυο ψηφιδωτά θεματικά επίπεδα (Σχήμα 3.9) τα οποία αντιστοιχούν στην κλίση και τον προσανατολισμό ή έκθεση των εδαφών (περισσότερες πληροφορίες για τα ΨΜΕ, μπορεί να βρει ο αναγνώστης στο κεφ. 5). Για το σκοπό αυτό, χρησιμοποιείται η επέκταση Spatial Analyst και αξιοποιούνται οι λειτουργίες ανάλυσης επιφανειών (Surface Analysis). Η βασική διαδικασία που ακολουθείται είναι η εξής:


    για την κλίση:  Spatial Analyst > Surface > Slope, και στο παράθυρο που εμφανίζεται, καθορίζεται το επίπεδο DEM ,ως επίπεδο μοντέλου υψομέτρων, οι μονάδες μέτρησης της κλίσης (στο παράδειγμά μας είναι οι μοίρες), και το όνομα του παραγόμενου επιπέδου.


    για την έκθεση: Spatial Analyst > Surface > Aspect, και στο παράθυρο που εμφανίζεται καθορίζεται το επίπεδο DEM, ως επίπεδο μοντέλου υψομέτρων, και το όνομα του παραγόμενου επιπέδου του προσανατολισμού των επιφανειών.


    Για τη δημιουργία των κριτηρίων απόστασης από το υδρογραφικό δίκτυο και την ακτογραμμή, τα αρχικά δεδομένα αντιστοιχούν σε γραμμικά διανυσματικά επίπεδα. Καθώς η τελική στόχευση είναι η αξιολόγηση της επιδεκτικότητας σε διάβρωση στο σύνολο του νησιού, θα πρέπει κάθε κριτήριο να περιέχει πληροφορίες για όλη την έκταση της περιοχής μελέτης.
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    Σχήμα 3.10 Δευτερογενή θεματικά επίπεδα απόστασης από το υδρογραφικό δίκτυο (ρέματα) και ακτογραμμή.


    


    Μια απλή μετατροπή των γραμμικών θεματικών επιπέδων από διανυσματική σε ψηφιδωτή μορφή θα έδινε ως παραγόμενα ψηφιδωτά θεματικά επίπεδα με τιμές μόνο για τις ψηφίδες που βρίσκονται πάνω στις γραμμικές οντότητες των δεδομένων εισόδου. Με αυτόν τον τρόπο δεν θα υπήρχε αξιολόγηση του κριτηρίου στις υπόλοιπες περιοχές της περιοχής μελέτης. Αντί γι’ αυτό, τα αρχικά επίπεδα μετατρέπονται σε ψηφιδωτά επίπεδα απόστασης από τις γραμμές (Σχήμα 3.10) με τη λειτουργία Distance της επέκτασης Spatial Analyst. Με βάση το διανυσματικό θεματικό επίπεδο (shapefile) του υδρογραφικού δικτύου (rivers) εκτελείται η παρακάτω διαδικασία για τον υπολογισμό της απόστασης:


    Spatial Analyst > Distance > Euclidean Distance


    Input raster > shapefile rivers > OK


    η οποία δίνει ως αποτέλεσμα το επίπεδο-κριτήριο της απόστασης από τους κλάδους του υδρογραφικού δικτύου.


    Με παρόμοιο τρόπο, για τη δημιουργία του θεματικού επιπέδου απόστασης από την ακτογραμμή, θα πρέπει αρχικά να επιλεγούν οι γραμμές με υψόμετρο = 0 από το επίπεδο των ισοϋψών καμπυλών και στη συνέχεια, σε περιβάλλον Spatial Analyst εκτελούνται τα παρακάτω βήματα:


    Spatial Analyst > Distance > Euclidean Distance


    Input raster > shapefile contours > OK


    Το αποτέλεσμα είναι η δημιουργία του ψηφιδωτού θεματικού επιπέδου της απόστασης από την ακτογραμμή. Σημειώνεται ότι, καθώς έχει οριστεί ως επίπεδο περιορισμού (mask) της ανάλυσης το πολύγωνο που αντιστοιχεί στην ξηρά, το αποτέλεσμα της λειτουργίας Distance υπολογίζεται μόνο για την περιοχή εντός του νησιού.
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    Τα θεματικά επίπεδα τα οποία προέκυψαν ως παραγόμενα των δευτερογενών επεξεργασιών σε συνδυασμό με τα αρχικά επίπεδα της βλάστησης και της λιθολογίας, αντιστοιχούν στους παράγοντες οι οποίοι αναλύονται στη συνέχεια. Τα επίπεδα αυτά έχουν μετατραπεί σε ψηφιδωτή μορφή, περιλαμβάνοντας ψηφίδες με τιμές σε διάφορες κλίμακες. Για παράδειγμα, το επίπεδο της βλάστησης περιέχει τιμές στην ονομαστική κλίμακα ταξινόμησης ενώ το επίπεδο της απόστασης από το υδρογραφικό δίκτυο περιέχει ψηφίδες με τιμές στην αναλογική κλίμακα. Επιπρόσθετα, το επίπεδο της βλάστησης έχει σαφή διακριτά όρια μεταξύ των διαφορετικών κατηγοριών βλάστησης, ενώ το επίπεδο της απόστασης από το υδρογραφικό δίκτυο (ή της κλίσης) παρουσιάζει τους αντίστοιχους παράγοντες με συνεχή μεταβολή στο χώρο. Για το συνδυασμό των επιπέδων αυτών ο οποίος θα πραγματοποιηθεί σε επόμενη φάση, θα πρέπει να γίνει μετασχηματισμός των τιμών τους έτσι ώστε οι ψηφίδες τους να περιέχουν τιμές σε ενιαία, κοινή κλίμακα ταξινόμησης.


    


    Συνεπώς, σ’ αυτό το στάδιο, δεδομένα από ποιοτικές ή ποσοτικές κλίμακες ταξινόμησης ομογενοποιούνται σε ενιαία, τακτική κλίμακα. Στην άσκηση που παρουσιάζεται εδώ, χρησιμοποιείται ενιαία τακτική κλίμακα στο διάστημα 1 – 9, όπου η τιμή 1 αντιστοιχεί σε περιοχές με πολύ μικρή, η τιμή 3, σε περιοχές με μικρή, η τιμή 5, σε περιοχές με μέση, η τιμή 7, σε περιοχές με μεγάλη και η τιμή 9, σε περιοχές με πολύ μεγάλη επιδεκτικότητα σε διάβρωση ενώ οι ενδιάμεσες τιμές αντιστοιχούν σε ενδιάμεσες τιμές επιδεκτικότητας. Η ταξινόμηση αυτή για τα επίπεδα με ονομαστική κλίμακα ταξινόμησης (όπως είναι τα επίπεδα της βλάστησης και της λιθολογίας), γίνεται για κάθε κατηγορία, ενώ για τα επίπεδα με ποσοτική ταξινόμηση (π.χ. τα επίπεδα των κλίσεων ή της απόστασης από το υδρογραφικό) γίνεται αφού οριστούν αρχικά κάποιες κατηγορίες τιμών τους. Στο παρακάτω σχήμα (Σχήμα 3.11) παρουσιάζεται η αντιστοίχιση αρχικών τιμών κριτηρίων με τιμές επιδεκτικότητας σε διάβρωση στην τακτική κλίμακα.


    Η εκτέλεση της επαναταξινόμησης στο λογισμικό ArcΓΠΣ γίνεται μέσα από το εργαλείο Spatial Analyst > Reclassify, δίνοντας τα παράγωγα θεματικά επίπεδα των επαναταξινομημένων παραγόντων σε ενιαία κλίμακα.


    Ιδιαίτερη προσοχή θα πρέπει να δοθεί στην επαναταξινόμηση του προσανατολισμού, καθώς οι τιμές που περιλαμβάνει είναι ειδικού τύπου (κυκλική ταξινόμηση, με τις τιμές «0» και «360» να έχουν την ίδια σημασία: «Βόρειος Προσανατολισμός»). Επιπρόσθετα, στο επίπεδο αυτό η τιμή «-1» αντιστοιχεί σε επίπεδες επιφάνειες, οι οποίες δεν έχουν προσανατολισμό προς μια διεύθυνση. Για αυτό το επίπεδο, η επαναταξινόμηση υλοποιείται ως εξής: οι ψηφίδες με αρχική τιμή -1 (επίπεδες επιφάνειες) παίρνουν την τιμή «4», οι ψηφίδες με βορειοδυτικό προσανατολισμό (αρχική τιμή 0° - 45°) παίρνουν την τιμή «7», οι ψηφίδες με ανατολικό προσανατολισμό (αρχική τιμή 45° - 135°) παίρνουν την τιμή «4», οι ψηφίδες με νότιο προσανατολισμό (αρχική τιμή 135° - 225°) παίρνουν την τιμή «8», οι ψηφίδες με δυτικό προσανατολισμό (αρχική τιμή 225° - 315°) παίρνουν την τιμή «4» και τέλος οι ψηφίδες με βορειοδυτικό προσανατολισμό (αρχική τιμή 315° - 360°) παίρνουν την τιμή «7».


    Σημειώνεται ότι, καθώς τα επίπεδα μετά τις επαναταξινομήσεις είναι συγκρίσιμα, μπορούν να χαρτογραφηθούν με ενιαίο συμβολισμό. Ο συνηθέστερος συμβολισμός δεδομένων σε τακτική κλίμακα ταξινόμησης στην οποία υπάρχει κάποια ενδιάμεση τιμή - όπως είναι στο παράδειγμα η τιμή ¨5¨ η οποία αντιστοιχεί σε μέτρια επιδεκτικότητα σε διάβρωση, είναι με διχρωμία. Στο παράδειγμα της άσκησης, επιλέχθηκε η χρήση του κίτρινου χρώματος για την ενδιάμεση τιμή και η διαβάθμιση σε τόνους το κόκκινου για τις τιμές υψηλής επιδεκτικότητας (τιμές > 5) και σε τόνους του πράσινου για τις τιμές χαμηλής επιδεκτικότητας (τιμές < 5) (Σχήμα 3.12).
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    Σχήμα 3.11 Αντιστοίχιση αρχικών τιμών θεματικών επιπέδων με τελικές τιμές σε ενιαία τακτική κλίμακα.


    


    


    [bookmark: _Toc438361155]Καθορισμός κανόνων σύνθεσης παραγόντων και συντελεστών βαρύτητας


    Η επαναταξινόμηση των παραγόντων υλοποιήθηκε έτσι ώστε να είναι εφικτή, σε επόμενο στάδιο, η συνδυαστική αξιοποίησή τους με βασικό στόχο τη συνολική αποτίμηση του φαινομένου. Όπως αναφέρθηκε και στο θεωρητικό μέρος του κεφαλαίου, η σύνθεση των παραγόντων γίνεται με διάφορες μεθόδους. Στην άσκηση που παρουσιάζεται εδώ, η σύνθεση των παραγόντων λαμβάνει χώρα αρχικά με την εφαρμογή κανόνων επιλογής και στη συνέχεια με την εφαρμογή σταθμισμένης άθροισης των παραγόντων με δύο διαφορετικά σενάρια σε κάθε περίπτωση. Σε κάθε περίπτωση, η λειτουργία που εφαρμόζεται είναι μια τοπική (Local) λειτουργία υπέρθεσης ψηφιδωτών δεδομένων, καθώς η τιμή κάθε ψηφίδας στο παραγόμενο επίπεδο, εξαρτάται αποκλειστικά και μόνο από τις τιμές της συγκεκριμένης ψηφίδας στα επίπεδα τα οποία υπερτίθενται.
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    Σχήμα 3.12 Επαναταξινομημένα θεματικά επίπεδα με τιμές σε ενιαία τακτική κλίμακα: a) βλάστηση, b) λιθολογία, c) απόσταση από ακτογραμμή, d) απόσταση από ρέματα, e) κλίση, f) έκθεση. Η τιμή 1 αντιστοιχεί στην πολύ μικρή, ενώ η τιμή 9 στην πολύ μεγάλη επιδεκτικότητα σε διάβρωση.


    


    Η σύνθεση των κριτηρίων με τον καθορισμό κανόνων επιλογής των παραγόντων στοχεύει στον εντοπισμό περιοχών οι οποίες συγκεντρώνουν συνδυαστικά μια σειρά από επιθυμητά (ή μη επιθυμητά) χαρακτηριστικά. Στην εφαρμογή της άσκησης, αρχικά θα αναζητηθούν οι περιοχές στις οποίες η τιμή της επιδεκτικότητας, για όλους τους παράγοντες είναι μεγαλύτερη από τη «μέση επιδεκτικότητα», έτσι όπως καθορίστηκε στην ενιαία κλίμακα. Δηλαδή, θα γίνει η αναζήτηση-επιλογή όλων των ψηφίδων με τιμή επιδεκτικότητας μεγαλύτερη από «5» για κάθε παράγοντα. Στη συνέχεια, καθώς ο παράγοντας της απόστασης από την ακτογραμμή, ο οποίος σχετίζεται με τη διάβρωση λόγω κυματισμού, είναι αρκετά περιορισμένος χωρικά έχοντας τιμές μεγαλύτερες του 5 για μια στενή παράκτια ζώνη, θα εφαρμοστεί εκ νέου η σύνθεση με τον ίδιο κανόνα επιλογής για όλα τα κριτήρια εκτός από το κριτήριο της απόστασης από την ακτογραμμή. Στην πραγματικότητα, το δεύτερο αυτό λιγότερο αυστηρό σενάριο, αποτυπώνει ότι ακριβώς και το πρώτο στην παράκτια ζώνη. Επιπρόσθετα, παρουσιάζει και όλες τις περιοχές στην ενδοχώρα με τιμή επιδεκτικότητας σε διάβρωση > 5. Η εφαρμογή των κανόνων επιλογής στις ομογενοποιημένες μεταβλητές λαμβάνει χώρα μέσα από την επέκταση Spatial Analyst > Raster Calculator όπου εισάγονται οι παρακάτω συνθήκες χαρτογραφικής άλγεβρας:


    


    S1_1 ([F_Vegetation] > 4) AND ([F_Lithology] > 4) AND ([F_Aspect] > 4) AND ([F_DistStreams] > 4) AND ([F_DistCoast]) > 4) AND ([F_Slope > 4)


    S1_2 ([F_Vegetation] > 4) AND ([F_Lithology] > 4) AND ([F_Aspect] > 4) AND ([F_DistStreams] > 4) AND ([F_Slope > 4)


    


    Για την εφαρμογή της σταθμισμένης άθροισης των παραγόντων, εφαρμόζονται, επίσης, δύο σενάρια σύνθεσης τα οποία διαφέρουν ως προς τους συντελεστές βαρύτητας. Στο πρώτο, οι τιμές των συντελεστών είναι παραπλήσιες, ενώ στο δεύτερο θεωρείται ότι η κλίση των εδαφών και η λιθολογία έχουν μεγαλύτερη βαρύτητα. Τα τελικά αποτελέσματα προκύπτουν από την άθροιση των σταθμισμένων κριτηρίων με βάση τους συντελεστές βαρύτητας που φαίνονται στο (Σχήμα 3.13).
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    Σχήμα 3.13 Συντελεστές βαρύτητας των δύο σεναρίων σταθμισμένης άθροισης.


    


    Η σταθμισμένη υπέρθεση των μεταβλητών υλοποιείται με το εργαλείο σταθμισμένης άθροισης ψηφιδωτών δεδομένων (Weighted Sum) από την εργαλειοθήκη ArctoolBox > Spatial Analyst Tools > Overlay > Weighted Sum (Σχήμα 3.14). Με το εργαλείο αυτό η υλοποίηση των δύο σεναρίων σταθμισμένης άθροισης με υπέρθεση ψηφιδωτών επιπέδων γίνεται σε ένα γραφικό περιβάλλον όπου ο χρήσης τα επίπεδα / μεταβλητές που θα συνδυαστούν, το πεδίο το οποίο περιέχει την τιμή που θα χρησιμοποιηθεί για την υπέρθεση και τους συντελεστές βαρύτητας για κάθε μεταβλητή. Στη συνέχεια, εκτελείται η σταθμισμένη άθροιση αφού πρώτα καθοριστεί το όνομα και ο κατάλογος αποθήκευσης του παραγόμενου θεματικού επιπέδου.
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    Σχήμα 3.14 Σταθμισμένη άθροιση ψηφιδωτών επιπέδων με το εργαλείο Weighted Sum του λογισμικού ArcGIS.


    


    Εκτός από το εργαλείο σταθμισμένης άθροισης το λογισμικό ArcGIS παρέχει ένα ακόμη πιο ευέλικτο διαδραστικό εργαλείο για την σταθμισμένη υπέρθεση ψηφιδωτών επιπέδων. Το εργαλείο αυτό το οποίο ονομάζεται “Weighted Overlay” είναι διαθέσιμο από την εργαλειοθήκη ArctoolBox. Η χρήση του, προϋποθέτει την ύπαρξη κατηγοριοποιημένων ψηφιδωτών θεματικών επιπέδων για κάθε κριτήριο. Δεν είναι απαραίτητη η ύπαρξη ενιαίας τακτικής κλίμακας στα δεδομένα, αφού αυτή μπορεί να προσδιοριστεί δυναμικά, μέσα από το εργαλείο, από το χρήστη. Με διαδραστικό τρόπο καθορίζονται, επίσης, από το χρήση οι συντελεστές βαρύτητας, καθώς επίσης και το επιθυμητό εύρος τιμών του τελικού παραγόμενου επιπέδου. Έτσι, για την υλοποίηση του σεναρίου S2_2 με την εφαρμογή Weighted Overlay ακολουθούνται τα παρακάτω βήματα:


    1. Ενεργοποίηση της εφαρμογής από το ArctoolBox > Spatial Analyst Tools > Overlay > Weighted Overlay.


    2. Προσθήκη των ψηφιδωτών θεματικών επιπέδων -κριτηρίων στον πίνακα σταθμισμένης υπέρθεσης. Η προσθήκη γίνεται πατώντας το εικονίδιο με το σταυρό και ολοκληρώνεται με τον καθορισμό του επιπέδου και της ιδιότητας του (όνομα πεδίου) η οποία θα χρησιμοποιηθεί στην υπέρθεση. Στην περίπτωση των επαναταξινομημένων επιπέδων η στήλη αυτή είναι η στήλη VALUE, ενώ στα κατηγοριοποιημένα θεματικά επίπεδα R_Vegatation και R_Lithology είναι οι στήλες CLASS και ID οι οποίες περιέχουν κωδικούς για τους τύπους βλάστησης και λιθολογίας αντίστοιχα.


    3. Καθορισμός των συντελεστών βαρύτητας (βαθμός επιρροής στο τελικό αποτέλεσμα) κάθε κριτηρίου. Για κάθε κριτήριο, η βαρύτητα προσδιορίζεται μ’ έναν ακέραιο αριθμό (ποσοστό επί τοις εκατό). Το άθροισμα των συντελεστών βαρύτητας θα πρέπει να είναι ίσο με εκατό.


    4. Για κάθε κριτήριο, καθορισμός του πεδίου το οποίο θα χρησιμοποιηθεί στην σταθμισμένη υπέρθεση. Το πεδίο αυτό, θα πρέπει να περιέχει τιμές οι οποίες αντιστοιχούν σε διακριτές κατηγορίες.


    5. Καθορισμός της τιμής, σε ενιαία τακτική κλίμακα, για κάθε κατηγορία του επιπέδου. Οι προκαθορισμένες τιμές για κάθε κατηγορία είναι οι ακέραιοι 1-9, ενώ μπορούν να καταχωριστούν σε μια κατηγορία και οι τιμές Nodata και Restricted οι οποίες αντιστοιχούν είτε σε περιοχές με έλλειψη δεδομένων είτε σε περιοχές οι οποίες επιθυμούμε να μην συμπεριληφθούν στην ανάλυση.


    6. Καθορισμός της κλίμακας αποτίμησης για το τελικό παραγόμενο της υπέρθεσης. Η προκαθορισμένη επιλογή είναι η διατήρηση της κλίμακας 1-9, αλλά ο χρήσης μπορεί να επιλέξει μια από τις άλλες συνήθεις κλίμακες (π.χ. στο διάστημα 1 – 5) να καθορίσει μια άλλη.


    7. Καθορισμός ονόματος και καταλόγου αποθήκευσης του παραγόμενου.


    8. Εκτέλεση της εφαρμογής με βάση τις παραπάνω επιλογές.


    Στο παρακάτω σχήμα (Σχήμα 3.15) φαίνεται η υλοποίηση των βημάτων αυτών για τη δημιουργία του τελικού παραγόμενου σύμφωνα με το σενάριο S2_2.
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    Σχήμα 3.15 Σταθμισμένη υπέρθεση με το εργαλείο Weighted Overlay του λογισμικού ArcGIS.


    


    Με την εφαρμογή αυτή, οι χρήστες μπορούν να υλοποιούν εύκολα διαφορετικά σενάρια υπέρθεσης, όπως επίσης και να αποθηκεύουν ή να ανακαλούν αποθηκευμένα σενάρια.


    Εναλλακτικά, η σταθμισμένη χαρτογραφική υπέρθεση των ομογενοποιημένων μεταβλητών μπορεί να υλοποιηθεί μέσα από την επέκταση Spatial Analyst > Raster Calculator, όπου εισάγονται οι παρακάτω συνθήκες χαρτογραφικής άλγεβρας:


    S2_1 (([F_Vegetation] + [F_Lithology] + [F_Aspect] + [F_DistStreams] + [F_DistCoast]) * 0.16)) + ([F_Slope] * 0.2)


    


    S2_2 (([F_Vegetation] + [F_Aspect] + [F_DistStreams] + [F_DistCoast]) * 0.1)) + ([F_Lithology] * 0.2) + (F_ [Slope] * 0.4)


    


    [bookmark: _Toc438361156]Συνδυασμός μεταβλητών - παραγωγή αποτελεσμάτων


    Στη συνέχεια, παρουσιάζονται οι χάρτες (Σχήματα 3.16, 3.17) που προέκυψαν από την χαρτογραφική υπέρθεση των παραγόντων για τα 4 διαφορετικά σενάρια τα οποία παρουσιάστηκαν παραπάνω.
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    Σχήμα 3.16 Τελικό παραγόμενο επίπεδο σύμφωνα με τa σενάριa S1_1 και S1_2.
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    Σχήμα 3.17 Τελικό παραγόμενο επίπεδο σύμφωνα με τa σενάριa S2_1 και S2_2.


    [bookmark: _Toc438361157]Αξιολόγηση οδικού δικτύου με βάση την επιδεκτικότητα σε διάβρωση


    Για την αξιολόγηση του οδικού δικτύου, ως προς την επιδεκτικότητα του υποστρώματός του σε διάβρωση, ακολουθήθηκε παρόμοια μέθοδος, όπως και για την υλοποίηση των σεναρίων υπέρθεσης. Έτσι, το διανυσματικό επίπεδο του οδικού δικτύου, αρχικά μετατράπηκε σε ψηφιδωτό επίπεδο. Η μετατροπή αυτή έγινε μέσα από η λειτουργία Spatial Analyst > Convert > Features to Raster, όπου ορίστηκε το επίπεδο εισόδου (διανυσματικό επίπεδο οδικού δικτύου), το πεδίο το οποίο θα μεταφερθεί, ως τιμή για κάθε ψηφίδα του παραγόμενου επιπέδου (πεδίο TYPE) και τέλος το όνομα και ο κατάλογος αποθήκευσης του παραγόμενου ψηφιδωτού επιπέδου (Σχήμα 3.18).
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    Σχήμα 3.18 Μετατροπή του διανυσματικού θεματικού επιπέδου Roads σε ψηφιδωτή μορφή.


    


    Στη συνέχεια επαναταξινομήθηκε το παραγόμενο ψηφιδωτό επίπεδο των δρόμων έτσι ώστε να λάβει την τιμή «1» σε όλο το μήκος του, αφού αρχικά θα αντιμετωπιστούν όλα τα τμήματα του δικτύου με ενιαίο τρόπο. Η μετατροπή αυτή έγινε μέσα από το εργαλείο επαναταξινόμησης του Spatial Analyst (Spatial Analyst > Reclassify) αφού ορίστηκε ότι για κάθε κατηγορία η επαναταξινομημένη τιμή θα είναι η τιμή «1». To αποτέλεσμα αυτής της ενέργειας είναι η δημιουργία του επιπέδου των δρόμων με τιμή 1 σε κάθε ψηφίδα του (επίπεδο RoadsGrid).


    


    Κατόπιν, μέσα από το εργαλείο Raster Calculator πραγματοποιήθηκε τοπική (Local) λειτουργία υπέρθεσης του επιπέδου του οδικού δικτύου με το tτελικό παραγόμενο επίπεδο του σεναρίου S2_2 η οποία είχε τη μορφή:


    


    OutputRoad = ([RoadsGrid] * [S2_2])


    


    έτσι ώστε οι ψηφίδες του νέου επιπέδου να «κληρονομήσουν» τις τιμές του υποστρώματος για όσα κελιά αποτελούν το οδικό δίκτυο (1* «τιμή επιδεκτικότητας σε διάβρωση σεναρίου1» = «τιμή επιδεκτικότητας σε διάβρωση σεναρίου»). Για τις υπόλοιπες ψηφίδες, η τοπική λειτουργία πολλαπλασιασμού της τιμής του επιπέδου επιδεκτικότητας S2_2 με την τιμή NoData δίνει,,ως αποτέλεσμα NoData και συνεπώς το παραγόμενο επίπεδο έχει μόνο τις ψηφίδες που βρίσκονται στο οδικό δίκτυο. Το αποτέλεσμα αυτής της ανάλυσης φαίνεται στο (Σχήμα 3.19).
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    Σχήμα 3.19 Aξιολόγηση του οδικού δικτύου με βάση την επιδεκτικότητα σε διάβρωση. Με κόκκινες αποχρώσεις φαίνονται τα τμήματά του με μεγάλη επ­­­ιδεκτικότητα ενώ με πράσινες αυτά με μικρή.


    


    Σημειώνεται ότι, η ίδια μεθοδολογία ακολουθείται και στην περίπτωση που θέλουμε να κατηγοριοποιήσουμε εκτός από το οδικό δίκτυο και μία περιμετρική ζώνη (buffer zone) εκατέρωθεν αυτού. H διαφορά είναι ότι πρώτα πρέπει να δημιουργηθεί αυτή τη ζώνη είτε με την κατάλληλη εντολή από την εργαλειοθήκη του ArcΓΠΣ (ArcToolBox > Analysis Tools > Buffer) και να την μετατρέψουμε σε ψηφιδωτή μορφή είτε απευθείας από την επέκταση του Spatial Analyst (Spatial Analyst > Distance > Straight Line) παραλείποντας τη διαδικασία της μετατροπής.


    


    Αν επιθυμούμε την καταγραφή της επιδεκτικότητας σε διάβρωση, αλλά και του τύπου του οδικού δικτύου, μπορεί να χρησιμοποιηθεί η τοπική εντολή συνδυασμού (COMBINE) του ψηφιδωτού θεματικού επιπέδου οδικού δικτύου (χωρίς να έχει προηγηθεί επαναταξινόμησή του σε ενιαία τιμή) με το επίπεδο του Σεναρίου S2_2, αφού πρώτα αυτό κατηγοριοποιηθεί. Η εντολή συνδυασμού Combine είναι διαθέσιμη μέσα από το μενού ArcToolBox > Spatial Analyst Tools > Local > Combine και η εντολή κατηγοριοποίησης του επιπέδου S2_2 είναι διαθέσιμη από το ArcToolBox > Spatial Analyst Tools > Reclass > Slice. Το αποτέλεσμα της εφαρμογής της είναι ένα ψηφιδωτό θεματικό επίπεδο με όλους τους δυνατούς συνδυασμούς των τιμών των επιπέδων εισαγωγής στον πίνακα περιγραφών του (Σχήμα 3.20).
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    Σχήμα 3.20 Συνδυασμός (Combine) των κατηγοριών οδικού δικτύου με τις κατηγορίες επιδεκτικότητας σε διάβρωση.


    


    Απ’ το επίπεδο αυτό μπορεί να γίνει η επιλογή οποιουδήποτε συνδυασμού τύπου οδικού δικτύου – κατηγορίας επιδεκτικότητας σε διάβρωση. Το (Σχήμα 3.21) δείχνει την επιλογή των περιοχών με τύπο οδικού δικτύου «1» (κύριοι χωματόδρομοι) και επιδεκτικότητα σε διάβρωση « > 3» (μεγάλη και πολύ μεγάλη επιδεκτικότητα).
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    Σχήμα 3.21 Επιλογή περιοχών με τύπο οδικού δικτύου = 1 και επιδεκτικότητα σε διάβρωση > 3.


    



    [bookmark: _Toc438361158]­Κεφάλαιο 4: Μεθοδολογία Αναλυτικής Ιεράρχησης


    


    Σύνοψη


    Στο κεφάλαιο αυτό παρουσιάζεται η μεθοδολογία της αναλυτικής ιεράρχησης (AHP: Analytic Hierarchy Process) και αναλύονται τεχνικές αξιοποίησης αυτής της μεθόδου για την επίλυση γεωγραφικών προβλημάτων. Συγκεκριμένα, χρησιμοποιείται η μέθοδος AHP ως εργαλείο λήψης χωρικών αποφάσεων. Στόχος του κεφαλαίου είναι αφενός η κατανόηση του τρόπου χρήσης της μεθόδου αναλυτικής ιεράρχησης στο πλαίσιο πολυκριτηριακής ανάλυσης χωρικών αποφάσεων, αφετέρου η πρακτική χρήση της μεθόδου σε χωρικά προβλήματα με την αξιοποίηση των Γεωγραφικών Πληροφοριακών Συστημάτων (GIS). Αρχικά, γίνεται η εισαγωγή στη θεωρία της αναλυτικής ιεράρχηση, δίνεται το γενικό σκεπτικό ανάπτυξης της μεθόδου σε γεωγραφικές εφαρμογές και παρουσιάζεται η δομή του κεφαλαίου. Στη συνέχεια, παρουσιάζεται εκτενέστερα η μέθοδος με λεπτομερή αναφορά στα στάδια υλοποίησής της. Τέλος, το κεφάλαιο ολοκληρώνεται με την παρουσίαση παραδειγματικής πρακτικής εφαρμογής ανάλυσης με τη μέθοδο AHP σε περιβάλλον GIS.


    


    Προαπαιτούμενη γνώση


    Οι προαπαιτούμενες γνώσεις τις οποίες θα πρέπει να έχει ο αναγνώστης εστιάζονται στην κατανόηση της πολυκριτηριακής ανάλυσης με σταθμισμένη χαρτογραφική υπέρθεση στην εξοικείωση με λειτουργίες υπέρθεσης διανυσματικών και ψηφιδωτών χωρικών δεδομένων, καθώς και σε βασικές γνώσεις άλγεβρας πινάκων.
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    Κύρια επιδίωξη στις εφαρμογές γεωγραφικής ανάλυσης, αποτελεί η λήψη αποφάσεων με βάση την εξέταση μεταβλητών που σχετίζονται με το υπό μελέτη φαινόμενο. Οι μεταβλητές αντιμετωπίζονται συνδυαστικά έτσι ώστε, μετά τη σύνθεση τους να προσδιορίζονται οι βέλτιστες, ανάμεσα σε διαφορετικές εναλλακτικές επιλογές. Είναι γεγονός ότι η ανάπτυξη των Γεωγραφικών Πληροφοριακών Συστημάτων (GIS) βοήθησε σημαντικά στην επίλυση προβλημάτων λήψης αποφάσεων που αφορούν στο σχεδιασμό και τη διαχείριση του χώρου, αφού τα GIS παρέχουν τη δυνατότητα συνδυασμού μεγάλου όγκου γεωγραφικών πληροφοριών. Όπως παρουσιάστηκε αναλυτικά στο προηγούμενο κεφάλαιο, μία από τις αρκετά δημοφιλείς μεθόδους αυτού του είδους είναι η πολυκριτηριακή ανάλυση, η οποία στα GIS, συνήθως, αποδίδεται ως πολυκριτηριακή χαρτογραφική υπέρθεση, ενώ μία διαδεδομένη εκδοχή αυτής της μεθόδου είναι η ανάπτυξή της σε συνδυασμό με τη μέθοδο της Αναλυτικής Ιεράρχησης (Analytical Hierarchy Process, AHP).


    


    Η AHP προτάθηκε από τον T.L. Saaty (Saaty, 1978, Saaty 1987) και στηρίζεται στην αρχή ότι, για τη λήψη μίας απόφασης, η εμπειρία και η γνώση των ανθρώπων είναι το ίδιο σημαντική με τα διαθέσιμα δεδομένα. Στα ελληνικά έχει προταθεί η απόδοση της μεθόδου με τον όρο «Μέθοδος Αναλυτικής Ιεράρχησης» ή «Διαδικασία Αναλυτικής Ιεράρχησης». Η μέθοδος AHP χαρακτηρίζεται από τρεις βασικές ιδιότητες:


    


    · Είναι αναλυτική, εμπεριέχοντας μαθηματική και λογική αιτιολόγηση για τη λήψη αποφάσεων. Έτσι, συμβάλλει στην ανάλυση του προβλήματος σε μια λογική βάση και στη μετατροπή των σκέψεων και διαισθήσεων του αποφασίζοντος σε αριθμητικές αξιολογήσεις.


    · Δομεί το πρόβλημα σε μια ιεραρχία, με στόχο τη μείωση της πολυπλοκότητας του μέσα από την αποδόμησή σε υπο-προβλήματα.


    · Τέλος, η AHP ορίζει μια ρητή διαδικασία για τη λήψη αποφάσεων. Οι εμπειρία του εμπειρογνώμονα (ή των εμπειρογνωμόνων) ενσωματώνονται στη διαδικασία λήψης αποφάσεων, η οποία αναπτύσσεται σε επιστημονική βάση, κάνοντας ευκολότερη τη συλλογική λήψη αποφάσεων.


    Πρόκειται για μία γενικότερη υπολογιστική θεωρία η οποία χρησιμοποιεί τόσο παραγωγική όσο και επαγωγική λογική λαμβάνοντας υπόψη πολλούς διαφορετικούς παράγοντες ταυτόχρονα, ενώ εφαρμόζεται αρκετά αποτελεσματικά τόσο στις θετικές όσο και στις κοινωνικές επιστήμες. Η μέθοδος αυτή χαρακτηρίζεται από ορισμένα σημαντικά πλεονεκτήματα με κυριότερα τα παρακάτω:


    · Απλή τεκμηρίωση.


    · Εύκολη επαναληψιμότητα.


    · Πολυκριτηριακός χαρακτήρας.


    · Κατανόηση του υπό μελέτη προβλήματος, με την αποσύνθεσή του μέσω της ιεραρχικής δομής.


    · Δυνατότητα συνδυασμού ποιοτικών και ποσοτικών δεδομένων.


    · Αξιοποίηση εμπειρίας ειδικών.


    · Δυνατότητα προσδιορισμού τυχόν ασυνεπειών στις κρίσεις των εμπειρογνωμόνων.


    Τα χαρακτηριστικά της αυτά είναι ιδιαίτερα σημαντικά σε εφαρμογές ανάλυσης του χώρου. Τα στάδια υλοποίησης της μεθόδου AHP είναι (Saaty, 1987; 1996):


    · Αποδόμηση του μελετώμενου προβλήματος σ’ ένα ιεραρχικό (ή δικτυακό) μοντέλο, το οποίο απαρτίζεται από τις βασικές συνιστώσες του επιτρέποντας τις συγκρίσεις κατά ζεύγη.


    · Συγκριτική αξιολόγηση κάθε συνιστώσας- κριτηρίου / υποκριτηρίου.


    · Σύνθεση των αξιολογημένων κριτηρίων με σκοπό την παραγωγή των τελικών αποτελεσμάτων.


    · Εύρεση βέλτιστης / επιθυμητής επιλογής.


    Έτσι, προηγείται η ιεράρχηση του προβλήματος με τον καθορισμό των βασικών συνιστωσών-κριτηρίων με βάση τα οποία θα γίνει η ανάλυση, ακολουθεί η συγκριτική κατάταξη των κριτηρίων (η οποία προκύπτει συνήθως από την εμπειρία των εμπειρογνωμόνων) και τέλος, πραγματοποιείται η σύνθεση αυτών ώστε να παραχθεί το τελικό αποτέλεσμα, ως η βέλτιστη εναλλακτική λύση σύμφωνα με τις προτεραιότητες και τους στόχους που έχουν τεθεί από τον ερευνητή. Η μεθοδολογία της AHP, παρά την εκτεταμένη χρήση της, έχει υποστεί κριτική, κυρίως λόγω της αδυναμίας της για τη διαχείριση της αβεβαιότητα των αποφάσεων των εμπειρογνωμόνων οι οποίοι εμπλέκονται στην υλοποίησή της. Στην κλασσική προσέγγιση της AHP, οι ανθρώπινες απόψεις απεικονίζονται με απόλυτες τιμές μέσα σ’ ένα αυστηρό αριθμητικό πλαίσιο. Όμως, σε πρακτικό επίπεδο, είναι δύσκολο οι προτιμήσεις των ανθρώπων να εκφραστούν με απόλυτη σαφήνεια μ’ έναν και μόνο αριθμό σε μία συγκεκριμένη κλίμακα. Για την επίλυση τέτοιων προβλημάτων, αναπτύχθηκαν τις τελευταίες δεκαετίες διάφορες παραλλαγές της AHP με σημαντικότερη την ασαφή Αναλυτική Ιεράρχηση (fuzzy AHP), η οποία βασίζεται στη θεωρία της ασαφούς λογικής (Dagdeviren and Yuksel, 2008).
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    Η μεθοδολογία της αναλυτικής ιεράρχησης παρέχει το πλαίσιο για την οργάνωση ενός προβλήματος λήψης απόφασης, για την αναπαράσταση και ποσοτικοποίηση των παραμέτρων που το αποτελούν, για τη σύνθεση αυτών των παραμέτρων με ένα τελικό στόχο και για την αξιολόγηση των εναλλακτικών επιλογών που ενδεχομένως υπάρχουν για την πραγματοποίηση αυτού του στόχου.


    Η μέθοδος μοντελοποιεί κάθε πρόβλημα παρουσιάζοντας το με τη μορφή μίας ιεραρχίας κριτηρίων, η οποία έχει τη δομή δένδρου. Στην κορυφή του δένδρου αυτού τοποθετείται ο βασικός στόχος του προβλήματος που μελετάται, δηλαδή η ζητούμενη βέλτιστη απόφαση / επιλογή. Επειδή ο βασικός στόχος είναι γενικός, αναλύεται σε κριτήρια, τα οποία με τη σειρά τους αναλύονται, επιπλέον, σε υποκριτήρια κ.λ.π, έως ότου να φτάσει κάποιος στα ελάχιστα δομικά στοιχεία της ιεραρχίας στη βάση του δένδρου. Στη συνέχεια, με τη διεξαγωγή συγκρίσεων, η μέθοδος αποδίδει βαρύτητες σε κάθε κριτήριο και βαθμούς προτίμησης σε κάθε διαφορετική κατηγορία κριτηρίων, λαμβάνοντας υπόψη την άποψη του λήπτη της απόφασης ή των ειδικών / εμπειρογνωμόνων πάνω στο εκάστοτε πρόβλημα.


    Η εφαρμογή της μεθόδου περιλαμβάνει δύο γενικές φάσεις, τη δόμηση της ιεραρχίας και το στάδιο της αξιολόγησης των επιμέρους κριτηρίων και υποκριτηρίων. Το στάδιο της αξιολόγησης βασίζεται στην ιδέα των συγκρίσεων ανά ζεύγη (pairwise comparisons), των διαφόρων κριτηρίων και επιλογών. Τα ερωτήματα που τίθενται σ’ αυτό το στάδιο είναι της μορφής «Με δεδομένα ένα κριτήριο και δύο υπο-κριτήρια, ποιο υπο-κριτήριο συμβάλει περισσότερο στην διαμόρφωση του κριτηρίου και σε ποιόν βαθμό». Το αποτέλεσμα αυτών των συγκρίσεων είναι η δημιουργία ενός πίνακα συγκρίσεων ανά ζεύγη (Comparison Matrix).


    Από κάθε πίνακα τέτοιων συγκρίσεων, προκύπτει ένα ιδιοδιάνυσμα, το οποίο αντικατοπτρίζει τη μονοδιάστατη κλίμακα, στην οποία ποσοτικοποιούνται οι συντελεστές βαρύτητας των κριτηρίων και υπο-κριτηρίων σε κάθε επίπεδο ιεραρχίας. Επομένως, τα στοιχεία κάθε επιπέδου της ιεραρχίας συγκρίνονται μεταξύ τους, ανά ζεύγη, με κριτήριο την συμβολή τους στην επίτευξη ενός καθορισμένου στόχου, ο οποίος αποτελεί στοιχείο του αμέσως παραπάνω επιπέδου της ιεραρχίας. Η διαδικασία αυτή παράγει μια σχετική κλίμακα μέτρησης της βαρύτητας ή προτεραιότητας κάθε στοιχείου, αναφορικά με το κριτήριο ή τα κριτήρια που βρίσκονται στο παραπάνω επίπεδο και συνδέονται μ’ αυτό. Τα τρία επιμέρους στάδια τα οποία συγκροτούν την συγκεκριμένη ενέργεια είναι τα εξής:


    · ανάπτυξη ενός συγκριτικού πίνακα για κάθε επίπεδο της ιεραρχίας, ξεκινώντας από την κορυφή προς τα κάτω,


    · υπολογισμός των συντελεστών βαρύτητας για κάθε στοιχείο της ιεραρχίας και


    · εκτίμηση του δείκτη συνέπειας (consistency index).


    Αυτά τα τρία στάδια εκτελούνται διαδοχικά για όλα τα επίπεδα της ιεραρχίας. Ο τελικός συντελεστής βαρύτητας που αποδίδεται σε κάθε στοιχείο του χαμηλότερου επιπέδου της ιεραρχίας προκύπτει από τον συνυπολογισμό όλων των επιμέρους βαρυτήτων των στοιχείων των ανωτέρων επιπέδων, που συνδέονται με κάθε εναλλακτική. Η αρχή αυτή είναι γνωστή ως προσθετικός, συσσωρευτικός κανόνας και έχει το πλεονέκτημα της εύκολης κατανόησης της κατανομής της συνολικής βαρύτητας στα επιμέρους τμήματά της. Τα σύνθετα βάρη αποδίδουν τη σημαντικότητα των κριτηρίων, βάσει των οποίων δημιουργούνται τα εναλλακτικά σενάρια για την αξιολόγηση των τελικών επιλογών και την υποστήριξη στη λήψη αποφάσεων (Malczewski, 1999).


    


    Όπως όλες οι θεωρίες, έτσι και η AHP βασίζεται σε αξιώματα. Όσο λιγότερα είναι τα αξιώματα στα οποία εδράζεται μια θεωρία, τόσο περισσότερο γενική και εφαρμόσιμη είναι. Η AHP βασίζονται σε τρία σχετικά απλά αξιώματα.


    Το πρώτο αξίωμα, το οποίο χαρακτηρίζεται ως “αντίστροφο αξίωμα”, δηλώνει ότι εάν υπάρχει ένα συγκριτικό ζεύγος στοιχείων Pc(Ea,Eb) όπου C αναπαριστά την αριθμητική σχέση μεταξύ των a και b, τότε Pc(Ea,Eb)=1/Pc(Eb,Ea). Για παράδειγμα, εάν το a είναι 5 φορές μεγαλύτερο από το b, τότε το b είναι το 1/5 του a.


    Το δεύτερο αξίωμα, ονομάζεται “αξίωμα ομοιογένειας” και δηλώνει ότι τα συγκρινόμενα στοιχεία οφείλουν να μην παρουσιάζουν σημαντικές διαφορές. Σε αντίθετη περίπτωση, το παραγόμενο αποτέλεσμα τείνει να παρουσιάζει σημαντικό σφάλμα. Η ομοιογένεια αφορά στις τιμές των μεταβλητών, αλλά ως ένα βαθμό και στους συντελεστές βαρύτητας. O λεκτικός προσδιορισμός σύγκρισης ανά ζεύγη στην AHP κυμαίνεται σε αριθμητική κλίμακα από 1έως 9 σε σειρά σπουδαιότητας. Η αριθμητική ή η γραφική μέθοδος επιλογής από τους ειδικούς (Expert choice), αποδίδει συντελεστές βαρύτητας στα επιμέρους κριτήρια επιτρέποντας τη «χαλάρωση» του αξιώματος. Σημειώνεται ότι μ’ αυτόν τον τρόπο αποδίδονται συντελεστές βαρύτητας στο διάστημα 0-1 οι οποίοι έχουν άθροισμα ίσο με 1.


    Το τρίτο αξίωμα, το καλούμενο ως “αξίωμα ανεξαρτησίας”, δηλώνει ότι αξιολογήσεις για τα στοιχεία, ή προτεραιότητες των στοιχείων σε μια ιεράρχηση δεν εξαρτώνται από στοιχεία σε κατώτερο επίπεδο. Αυτό το αξίωμα εφαρμόζεται μόνο στα πλαίσια μιας ιεραρχικής σύνθεσης. Ενώ τα δύο πρώτα αξιώματα είναι, από την εμπειρία, απολύτως συνεπή με τις εφαρμογές στον πραγματικό κόσμο, το τρίτο αξίωμα απαιτεί προσεκτική εξέταση και συχνά παραβιάζεται.


    Οι ιεραρχίες διαδραματίζουν πολύ σημαντικό ρόλο στη μελέτη των επιπτώσεων των εναλλακτικών επιλογών, στους αντικειμενικούς στόχους ενός συστήματος. Με την περιγραφή του προβλήματος με μια ιεραρχική δομή, είναι δυνατόν να αναγνωριστούν όλοι οι σημαντικούς παράγοντες και τα επίπεδα στα οποία ανήκουν και να μετρηθεί η αλληλεπίδραση μεταξύ αυτών των επιπέδων.


    Οποιοδήποτε πολύπλοκο πρόβλημα για το οποίο απαιτείται συγκρότηση, μέτρηση και σύνθεση κριτηρίων, αποτελεί ιδανικό πεδίο ανάπτυξης της μεθοδολογίας «Αναλυτικής Ιεράρχησης». Παρόλα αυτά, η AHP σπάνια χρησιμοποιείται μόνη της. Κυρίως χρησιμοποιείται μαζί με ή σε συνεργασία με άλλες μεθοδολογίες (Forman and Gass, 2001).
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    Η πολυκριτηριακή ανάλυση σε εφαρμογές μοντελοποίησης του χώρου είναι η μεθοδολογία με την οποία παράμετροι που σχετίζονται με το υπό μελέτη φαινόμενο αξιολογούνται και συσχετίζονται. Η μέθοδος αυτή, παρότι αρχικά χρησιμοποιήθηκε για την αποτίμηση της καταλληλότητας της γης (Land Suitability, Mendoza 1997) σήμερα χρησιμοποιείται ευρέως για την αποτίμηση διάφορων χωρικών φαινομένων. Το βασικό σκεπτικό της μεθόδου σχετίζεται με την «ανάμειξη» των παραμέτρων εισαγωγής με στόχο την αξιολόγηση του χώρου. Ένα γενικό μοντέλο αυτού του τύπου περιγράφεται από τη σχέση S = f (z1, z2, …zn), όπου το S αντιστοιχεί στην τιμή της καταλληλότητας και τα (z1, z2, …zn) είναι οι παράμετροι οι οποίες επηρεάζουν / συνδέονται με τον υπό μελέτη φαινόμενο στην περιοχής ενδιαφέροντος. Το βασικό ζητούμενο σε ένα τέτοιο μοντέλο είναι η ποσοτικοποίηση του βαθμού επιρροής (μεμονωμένα αλλά και συνδυαστικά) των παραμέτρων (z1, z2, …zn) στη διαμόρφωση και ποσοτικοποίηση της καταλληλότητας (S). Έτσι, το μοντέλο θα πρέπει να περιλαμβάνει αποτελεσματικές μεθοδολογίες για το συνδυασμό των παραμέτρων εισόδου. Συχνά, σε γεωγραφικά προβλήματα οι παράμετροι/κριτήρια διαμορφώνονται από υποκριτήρια με τρόπο ανάλογο με αυτόν του υπολογισμού της συνολικής καταλληλότητας. Από τα παραπάνω, είναι φανερό ότι η μεθοδολογία της αναλυτικής ιεράρχησης (AHP) έχει πεδίο εφαρμογής σε περιπτώσεις πολυκριτηριακής ανάλυσης, καθώς μπορεί να αξιοποιηθεί για το συνδυασμό των παραμέτρων (κριτήρια και υποκριτήρια) με στόχο την τελική αποτίμηση και σε επόμενο στάδιο χαρτογράφησης της καταλληλότητας. Τα πλεονεκτήματα από τη χρήση της AHP στην ανάλυση προβλημάτων αυτού του τύπου είναι:


    · Επειδή η AHP παρέχει μια ιεραρχικά δομημένη προσέγγιση για την ποσοτικοποίηση της καταλληλότητας, με την αποσύνθεση του προβλήματος σε ιεραρχικά επίπεδα και μονάδες, επιτρέπει τη σε βάθος ανάλυση των κριτηρίων και στην πληρέστερη κατανόηση του υπό μελέτη προβλήματος.


    · Η μέθοδος δεν βασίζεται τόσο στην πληρότητα και αρτιότητα των δεδομένων, αλλά πολύ περισσότερο στις κρίσεις των εμπειρογνωμόνων αναφορικά με τη σχετική σπουδαιότητα των παραμέτρων, όπως και στην πρόσληψή τους για τη σχέση των παραμέτρων με το φαινόμενο.


    · Η μέθοδος AHP είναι ένας ρητός και εύκολα επανεκτελέσιμος τρόπος ανάλυσης του χώρου. Η διαφάνεια της μεθόδου κάνει τα αποτελέσματά της πιο εύκολα αποδεκτά, ιδιαίτερα σε εφαρμογές χωροθετήσεων ειδικών χρήσεων γης.


    · Η σταθμισμένη ποσοτικοποίηση των παραμέτρων μέσα από συγκρίσεις ανά ζεύγη είναι μια σχετικά απλή και εύκολα εφαρμόσιμη διαδικασία, η οποία επιτρέπει ταυτόχρονα τον έλεγχο ασυνεπειών στις συγκρίσεις των κριτηρίων.


    · Η μέθοδος επιτρέπει τη συμμετοχή τόσο επιστημόνων / ειδικών εμπειρογνωμόνων όσο και διαχειριστών του χώρου στην διαδικασία διαμόρφωσης των σταθμισμένων κριτηρίων και υποκριτηρίων. Επιπλέον, είναι δυνατή η συμμετοχή πολιτών σε αυτήν τη διαδικασία είτε στο σύνολό τους, είτε σε διακριτές ομάδες (π.χ. συνταξιούχοι, οικονομικά ενεργοί, μητέρες κλπ.).


    


    Όπως έχει αναφερθεί σε προηγούμενο κεφάλαιο, εδώ και αρκετές δεκαετίες η επιστημονική κοινότητα έχει επισημάνει τα πλεονεκτήματα από την αξιοποίηση των Συστημάτων Γεωγραφικών Πληροφοριών σε συνδυασμό με τις τεχνικές πολυκριτηριακής ανάλυσης αποφάσεων (Malczewski, 1999, Jenssen, 1992, Jankowski et al., 1997). Η δυνατότητα αξιοποίησης ποικίλων δεδομένων (συχνά διαφόρων κλιμάκων ταξινόμησης και από διάφορες πηγές), οι δυνατότητες συνδυαστικής χρήσης θεματικών επιπέδων πληροφορίας, η δυνατότητα ανάπτυξης μοντέλων ανάλυσης του χώρου, καθώς και οι εξελιγμένες δυνατότητες για τεκμηρίωση και οπτικοποίηση της ανάλυσης και των αποτελεσμάτων της είναι μερικά από τα σπουδαιότερα πλεονεκτήματα της χρήσης ΓΠΣ στην πολυκριτηριακή ανάλυση.


    Στη διαδικασία αυτή, ιδιαίτερα σημαντικές είναι οι φάσεις της διαμόρφωσης και ποσοτικοποίησης των κριτηρίων και της ποσοτικοποίησης του βαθμού επιρροής κάθε κριτηρίου με το φαινόμενο που μελετάται μέσα από την απόδοση συντελεστών βαρύτητας. Επιπρόσθετα, ιδιαίτερα καθοριστική είναι και η εννοιολογική οργάνωση του μοντέλου με τον προσδιορισμό του τρόπου συνδυασμού κριτηρίων και υποκριτηρίων. Τα ιδιαίτερα χαρακτηριστικά της μεθοδολογίας AHP, τα οποία παρουσιάστηκαν παραπάνω, επιτρέπουν την αποτελεσματική υλοποίηση αυτών των φάσεων. Αρχικά, προσδιορίζεται το βασικό περίγραμμα του φαινόμενου που μελετάται, καθώς και των χαρακτηριστικών της μοντελοποίησης. Στο στάδιο αυτό καθορίζεται η περιοχή μελέτης, περιγράφεται το φαινόμενο / πρόβλημα το οποίο θα μελετηθεί και προσδιορίζονται η κλίμακα εργασίας, όπως και η χωρική μονάδα αναφοράς (ΧΜΑ). Η τελευταία ορίζεται σε συνάρτηση με την κλίμακα, αλλά και τα δεδομένα. Συνήθως, η ΧΜΑ είναι μια τετραγωνική ψηφίδα - όταν η μοντελοποίηση γίνεται με raster δεδομένα – ή πολύγωνα, όταν τα διαθέσιμα δεδομένα είναι διανυσματικού τύπου (Vector data). Για παράδειγμα, όταν η ανάλυση περιλαμβάνει σύνθεση δεδομένων απογραφών θα πρέπει να οριστεί ΧΜΑ η οποία θα αντιστοιχεί σε μονάδες διοικητικής διαίρεσης (π.χ. Δήμοι σχεδίου «Καλλικράτης»), καθώς τα δεδομένα απογραφής συλλέγονται σε επίπεδο μονάδων διοικητικής διαίρεσης. Στη φάση αυτή, χρήσιμος είναι και ο προσδιορισμός της ελάχιστης χωρικής μονάδας (ΕΧΜ). Στην περίπτωση των ψηφιδωτών δεδομένων, το εμβαδόν της ΕΧΜ ισούται με την έκταση μιας ψηφίδας, ενώ στην περίπτωση κατά την οποία χρησιμοποιηθούν διανυσματικά δεδομένα, η ΕΧΜ καθορίζεται βάσει κλίμακας εργασίας και κλίμακας αρχικών δεδομένων. Στη συνέχεια, για τη διαμόρφωση ενός μοντέλου πολυκριτηριακής ανάλυσης, σε συνδυασμό με την μεθοδολογία AHP και τα ΓΠΣ ακολουθούνται τα παρακάτω διαδοχικά βήματα:


    · Αποδόμηση του προβλήματος και καθορισμός ιεραρχικής δομής. Εδώ προσδιορίζονται τα κριτήρια, τα υποκριτήρια και οι εναλλακτικές επιλογές (alternatives). Επίσης, σ’ αυτό το βήμα καθορίζεται και ο τρόπος συνδυασμού των επιμέρους στοιχείων της ιεραρχίας.


    · Προσδιορισμός θεματικών επιπέδων GIS. Εδώ γίνεται επίσης, και η αντιστοίχιση των θεματικών επιπέδων GIS με κριτήρια / υποκριτήρια της ιεραρχίας.


    · Δημιουργία πινάκων σύγκρισης ανά ζεύγη. Έλεγχος ασυνέπειας. Υπολογισμός συντελεστών βαρύτητας κριτηρίων / υποκριτηρίων. Για την υλοποίηση αυτού του βήματος θα πρέπει να λάβει χώρα συγκριτική αξιολόγηση των κριτηρίων από έναν ή περισσότερους εμπειρογνώμονες.


    · Δημιουργία – οργάνωση ΧΒΔ. Εδώ δημιουργούνται και οργανώνονται στο πλαίσιο ενός GIS τα θεματικά επίπεδα τα οποία προσδιορίστηκαν προηγουμένως. Εκτός από τις συμβατότητες που αφορούν στις γεωγραφικές τους διαστάσεις (ενιαία κλίμακα και χρονική αναφορά) θα πρέπει να φροντίσουμε και για την ομοιογένεια των τιμών τους η οποία συνήθως επιτυγχάνεται με επαναταξινομήσεις σε ενιαία τακτική κλίμακα.


    · Διαμόρφωση σταθμισμένων κριτηρίων – υποκριτηρίων. Σε αυτήν τη φάση αξιοποιούνται τα παραγόμενα των δύο προηγούμενων βημάτων (συντελεστές βαρύτητα, επαναταξινομημένα κριτήρια) και δημιουργούνται τα σταθμισμένα κριτήρια / υποκριτήρια.


    · Σύνθεση σταθμισμένων κριτηρίων σ’ όλη την ιεραρχική δομή με αποτέλεσμα την αποτίμηση του φαινόμενου για κάθε χωρική μονάδα στην περιοχή μελέτης. Αυτό μπορεί να οδηγήσει είτε στη επιλογή της περιοχής με την μεγαλύτερη καταλληλότητα είτε στη χαρτογράφηση της χωρικής κατανομής της καταλληλότητας στην περιοχή μελέτης.


    · Έλεγχος των αποτελεσμάτων – Ανάλυση ευαισθησίας. Όπως κάθε εφαρμογή μοντελοποίησης, έτσι και η μέθοδος η οποία περιγράφεται παραπάνω, θα πρέπει να ολοκληρώνεται με τον έλεγχο και την πιστοποίηση των αποτελεσμάτων της. Συνήθως, αυτό πραγματοποιείται με έλεγχο των πραγματικών συνθηκών σε επιλεγμένα σημεία στο πεδίο ή / και με την αξιοποίηση εικόνων Τηλεπισκόπησης. Τέλος, η ανάλυση ευαισθησίας (Sensitivity analysis) η οποία πραγματοποιείται σ’ αυτό το τελικό στάδιο έχει ως κύρια στόχευση τη διερεύνηση των αλλαγών που επιφέρουν μικροαλλαγές στα τελικά αποτελέσματα σχετικά με την απόδοση συντελεστών βαρύτητας στα κριτήρια / υποκριτήρια (Malczewski, J. 1999, 2004).


    Για την καλύτερη κατανόηση των φάσεων αυτών παρουσιάζεται παρακάτω ένα παράδειγμα ανάπτυξης εφαρμογής πολυκριτηριακής ανάλυσης με τη συνδυαστική χρήση των ΓΠΣ και της μεθοδολογίας αναλυτικής ιεράρχησης


    


    [bookmark: _Toc438361162]4.4 Παράδειγμα χρήσης γεωγραφικής εφαρμογής της μεθοδολογίας AHP
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    Κύριος στόχος της παραδειγματικής εφαρμογής που παρουσιάζεται παρακάτω είναι η μελέτη του φαινόμενου «Επιστροφή στην Ύπαιθρο» με τη χρήση της μεθόδου Αναλυτικής Ιεράρχησης (AHP), σε συνδυασμό με την αξιοποίηση των Γεωγραφικών Συστημάτων Πληροφοριών (ΓΣΠ). Το φαινόμενο αυτό – το οποίο είναι γνωστό και ως ανάστροφη αστικοποίηση (counter urbanization) - αναφέρεται στη μετεγκατάσταση πληθυσμού σε μια αγροτική περιοχή (Ανθοπούλου, 2001). Η απόφαση επιστροφής στην ύπαιθρο, τμήματος του αστικού πληθυσμού, επηρεάζεται από ένα σύνολο δεδομένων, τα οποία προκύπτουν από την ιεράρχηση και αξιολόγηση ορισμένων κριτηρίων, βάσει της σπουδαιότητάς τους, όπως αυτή ορίζεται από τους πολίτες που την εφαρμόζουν. Το σύνολο των παραπάνω κριτηρίων έχει γεωγραφική διάσταση και μπορεί να χαρτογραφηθεί, επομένως το φαινόμενο μπορεί να αναλυθεί με τη μεθοδολογία της Αναλυτικής Ιεράρχησης (Παπαδόπουλος, κα. 2008). Θα πρέπει να σημειωθεί ότι η εφαρμογή που παρουσιάζεται παρακάτω έχει καθαρά εκπαιδευτικό χαρακτήρα, και παρότι παρουσιάζει συστηματικά την εφαρμογή της μεθόδου AHP, δεν μπορεί να θεωρηθεί ως ολοκληρωμένη εφαρμογή αποτίμησης του φαινόμενου της επιστροφής στην ύπαιθρο. Έτσι, και τα αποτελέσματα τα οποία παρουσιάζονται στο συγκεκριμένο σημείο, δεν μπορούν να χρησιμοποιηθούν ως επιβεβαιωμένες αξιολογήσεις του φαινόμενου για την περιοχή μελέτης.


    Στο παράδειγμα αυτό θεωρείται ότι τα κριτήρια τα οποία συνδέονται με το υπό μελέτη φαινόμενο είναι: α) το χωρικό, β) το δημογραφικό, γ) το κριτήριο απασχόλησης και δ) το αγροτικό κριτήριο.


    Το χωρικό κριτήριο απαρτίζεται από μεταβλητές που σχετίζονται με την χωρική οργάνωση της περιοχής μελέτης. Για την εφαρμογή, οι μεταβλητές αυτές είναι η μέση κλίση του εδάφους, η προσβασιμότητα σε οικισμούς και υπηρεσίες, καθώς και η εγγύτητα σε ακτές. Ήπιες κλίσεις εδάφους συνεπάγονται υψηλό βαθμό «καταλληλότητας» της περιοχής. Όσον αφορά στην εγγύτητα σε ακτές και την προσβασιμότητα σε οικισμούς, χαμηλές τιμές χρονοαπόστασης υποδηλώνουν άμεση πρόσβαση σε βασικές υπηρεσίες και υποδομές των αστικών κέντρων όπως και στις ακτές, συνεπώς θεωρείται ότι αντιστοιχούν σε περιοχές με υψηλό βαθμό καταλληλότητας.


    To κριτήριο της απασχόλησης, αποτελεί ενδεχομένως τον πιο σημαντικό παράγοντα επιστροφής στην ύπαιθρο για τις οικονομικά ενεργές ηλικιακές ομάδες, ιδιαίτερα σε περιόδους οικονομικής κρίσης. Σημαντικός παράγοντας έλξης θεωρείται η δυνατότητα εργασίας εκτός πρωτογενούς τομέα και γι’ αυτό το ποσοστό απασχολούμενων στη διοίκηση και το εμπόριο, καθώς και το ποσοστό πολυαπασχόλησης (δηλαδή άτομα τα οποία κάνουν παραπάνω από μία δουλειές) στο σύνολο των απασχολούμενων, υποδεικνύουν το βαθμό διαφοροποίησης της οικονομίας. Το σύνολο των εργαζόμενων σε απόλυτους αριθμούς είναι άλλη μία ένδειξη της ευνοϊκής κατάστασης της αγοράς εργασίας.


    Το δημογραφικό κριτήριο επιχειρεί να παρουσιάσει τη δυναμική της περιοχής όσον αφορά την πληθυσμιακή της σύνθεση. Ένας χαμηλός δείκτης γήρανσης, σε συνδυασμό με χαμηλό δείκτη εξάρτησης, υποδεικνύουν ευνοϊκές συνθήκες για ανάπτυξη, αφού ο οικονομικά ενεργός πληθυσμός είναι αυτός που δίνει ώθηση στην αγορά. Παράλληλα, μεγάλο ποσοστό μεταναστών σημαίνει ότι η οικονομία της περιοχής αποτελεί πόλο έλξης και άρα παρέχει θέσεις εργασίας. Από το κριτήριο αυτό μπορεί να εξαχθούν εκτιμήσεις σχετικά με τη δημογραφική οργάνωση, αλλά και την οικονομική ευρωστία της περιοχής μελέτης, στοιχεία τα οποία σχετίζονται με το υπό μελέτη φαινόμενο.


    Τέλος, το αγροτικό κριτήριο όταν εφαρμόζεται, περιγράφεται από τις μεταβλητές της κάλυψης γης μέσης κλίσης του εδάφους. Οι ήπιες κλίσεις του εδάφους και τα υψηλά ποσοστά καλλιεργούμενων εκτάσεων θεωρείται ότι είναι στοιχεία τα οποία ευνοούν την καταλληλότητα των χωρικών μονάδων.


    Όπως γίνεται αντιληπτό από τα παραπάνω, τα σύνθετα αυτά κριτήρια αποτελούν πολυμεταβλητούς δείκτες, οι οποίοι ανταποκρίνονται σε συγκεκριμένα χαρακτηριστικά της υπαίθρου και υπολογίζονται μέσω στατιστικών και χωρικών στοιχείων. Το φαινόμενο, εκτός από τα επιμέρους σύνθετα κριτήρια αναλύεται και σε υποκριτήρια/μεταβλητές, προκειμένου να είναι πιο εύκολη η επίλυσή του. Καθένα δηλαδή από τα σύνθετα κριτήρια (χωρικό, δημογραφικό, απασχόλησης, αγροτικό) αποτελείται από επιμέρους υπο-κριτήρια, τα οποία προκύπτουν είτε από στατιστικά στοιχεία, είτε από χωρικά και βάσει αυτών υπολογίστηκαν οι τιμές των σύνθετων κριτηρίων.


    Ως περιοχή εφαρμογής του παραδείγματος επιλέχθηκε ο Νομός Ηλείας και η ανάλυση γίνεται σε επίπεδο δημοτικών διαμερισμάτων (δ.δ προ σχεδίου Καποδίστρια) με βάση τα στοιχεία της απογραφής του 2001. Η χωρική μονάδα αναφοράς είναι το πολύγωνο που αντιστοιχεί σ’ ένα δημοτικό διαμέρισμα. Έτσι, η τελική επιδίωξη είναι ο υπολογισμός του βαθμού καταλληλότητας ή «ευνοϊκότητας» των δ.δ. της περιοχής μελέτης για την ανάπτυξη του φαινομένου, καθώς και η χαρτογράφηση της χωρικής κατανομής αυτής της καταλληλότητας. Θα πρέπει να σημειωθεί ότι το κάθε δ.δ. της περιοχής μελέτης αποτελεί και μια εναλλακτική επιλογή (alternative) στην ιεραρχία της AHP.


    


    [bookmark: _Toc438361164]4.4.2 Αποδόμηση προβλήματος – Καθορισμός Ιεραρχίας


    Για την αναγνώριση της τυπολογίας της υπαίθρου στην περιοχή μελέτης υιοθετήθηκαν τέσσερα κριτήρια τα οποία αντανακλούν τα χωρικά χαρακτηριστικά, τις δημογραφικές τάσεις, τις ευκαιρίες απασχόλησης και τις δυνατότητες για τη γεωργική ανάπτυξη της υπαίθρου, καλύπτοντας ένα αντιπροσωπευτικό φάσμα παραμέτρων για τους παράγοντες που σχετίζονται με την έννοια της «καταλληλότητας για επιστροφή στην ύπαιθρο». Έτσι, στο ανώτερο επίπεδο της ιεραρχικής οργάνωσης (επίπεδο Α στο σχήμα 4.1) τοποθετείται η συνολική αποτίμηση του φαινόμενου και αμέσως μετά (επίπεδο Β) τα τέσσερα βασικά κριτήρια-μεταβλητές τα οποία σχετίζονται με το φαινόμενο. Για την περιγραφή των βασικών κριτηρίων του επιπέδου Β χρησιμοποιούνται τα υποκριτήρια τα οποία δομούν το επίπεδο C. Για παράδειγμα, για την αποτίμηση της καταλληλότητας λόγω των αγροτικών χαρακτηριστικών, μελετώνται οι αγροτικές χρήσεις και η κλίση του εδάφους για κάθε χωρική μονάδα. Επομένως, τα υποκριτήρια C αναφέρονται στις οντότητες του αμέσως κατώτερου επιπέδου (επίπεδο D) οι οποίες στο παράδειγμά μας είναι τα δ.δ. του Ν. Ηλείας. Τα παραπάνω, φαίνονται διαγραμματικά στο (Σχήμα 4.1).
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    Σχήμα 4.1 Ιεραρχική δομή μοντέλου AHP.


    


    Παρακάτω (Σχήμα 4.2) παρουσιάζονται τα κριτήρια και οι πρωτογενείς μεταβλητές (υποκριτήρια) οι οποίες τα συνθέτουν (Χαλκιάς & Παπαδόπουλος, 2007). Η πηγή των πρωτογενών μεταβλητών για τα δύο πρώτα σύνθετα κριτήρια (δημογραφικό, απασχόλησης) είναι τα στοιχεία απογραφής 2001 της ΕΛΣΤΑΤ, ενώ για το χωρικό και το αγροτικό κριτήριο οι πρωτογενείς μεταβλητές είναι προϊόντα επεξεργασιών στο πλαίσιο GIS με την αξιοποίηση των επιπέδων κλίσης, οικισμών, ακτογραμμής και κάλυψης γης της περιοχής.
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    Σχήμα 4.2 Σύνθετα κριτήρια και πρωτογενείς μεταβλητές προβλήματος.


    


    [bookmark: _Toc438361165]4.4.3 Προσδιορισμός θεματικών επιπέδων ΓΠΣ – αντιστοίχιση με κριτήρια / υποκριτήρια. Καθορισμός δευτερογενών επεξεργασιών (εφόσον απαιτούνται)


    Στη συνέχεια, θα πρέπει να δημιουργηθεί για την περιοχή μελέτης η ιεραρχική δομή η οποία περιγράφηκε παραπάνω στο πλαίσιο ενός ΓΠΣ. Για το σκοπό αυτό, και λαμβάνοντας υπόψη ότι η χωρική μονάδα αναφοράς είναι το δ.δ., είναι ιδιαίτερα σημαντική η ενσωμάτωση στο μοντέλο χωρικού υποβάθρου το οποίο και θα περιέχει τις χωρικές οντότητες που αναλύονται (δημοτικά διαμερίσματα). Ο παρακάτω χάρτης (Σχήμα 4.3) παρουσιάζει αυτό το χωρικό υπόβαθρο (πηγή: http://geodata.gov.gr)
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    Σχήμα 4.3 Χάρτης χωρικών μονάδων αναφοράς (δημοτικά διαμερίσματα) περιοχής μελέτης.


    


    Θα πρέπει να σημειωθεί ότι, όλες οι τιμές για τα κριτήρια και τα υποκριτήρια του μοντέλου θα πρέπει να υπολογίζονται για τις χωρικές οντότητες αναφοράς, δηλαδή τα δημοτικά διαμερίσματα. Τα υποκριτήρια που συνδέονται με το κριτήριο απασχόλησης και το δημογραφικό κριτήριο, συνδέονται άμεσα με το χωρικό υπόβαθρο, αφού αυτές οι πρωτογενείς μεταβλητές είναι άμεσα διαθέσιμες για κάθε δ.δ από τις εθνικές απογραφές. Για το χωρικό και το αγροτικό κριτήριο οι πρωτογενείς μεταβλητές είναι θεματικά επίπεδα συνεχούς κατανομής στο χώρο (κλίση εδαφών, επίπεδα χρονοαποστάσεων, επίπεδο κάλυψης γης κατά CORINE). Ορισμένα από αυτά τα επίπεδα προκύπτουν έπειτα από προεπεξεργασίες στο πλαίσιο του ΓΠΣ της περιοχής μελέτης. Για παράδειγμα τα επίπεδα χρονοαποστάσεων προκύπτουν μέσα από μοντέλα ανάλυσης κόστους μετακίνησης, ενώ το επίπεδο των κλίσεων από το Ψηφιακό μοντέλο εδάφους της περιοχής μελέτης. Η ανάλυση αυτών των προεπεξεργασιών ξεφεύγει από τους στόχους αυτού του κεφαλαίου. Σε κάθε περίπτωση, μετά τη δημιουργία των δευτερογενών μεταβλητών ακολούθησε η ανάλυση ανά ζώνη έτσι ώστε, να υπολογιστούν οι μέσες/αντιπροσωπευτικές τιμές των μεταβλητών για κάθε δημοτικό διαμέρισμα. Για παράδειγμα, η συνδυαστική ανάλυση του επιπέδου της κλίσης και του επιπέδου της διοικητικής διαίρεσης δίδει ως παραγόμενο τον υπολογισμό της μέσης κλίσης ανά δ.δ. Το παραγόμενο αυτό αξιοποιείται στο πλαίσιο της παρούσας μοντελοποίησης.


    


    [bookmark: _Toc438361166]4.4.4 Δημιουργία – Οργάνωση Χωρικής Βάσης Δεδομένων


    Στη συνέχεια, πραγματοποιήθηκε η ομοιογενοποίηση των κριτηρίων με κατηγοριοποίηση (classification) κάθε κριτηρίου σε μια ενιαία τακτική κλίμακα ταξινόμησης. Η κλίμακα αυτή είχε πέντε κλάσεις, οι οποίες αντιστοιχούν στον βαθμό σύνδεσης της κάθε μεταβλητής με το φαινόμενο της ανάστροφης αστικοποίησης, όπου (1=πολύ μικρή, 2=μικρή, 3=μέτρια, 4=μεγάλη και 5=πολύ μεγάλη). Έτσι κατηγοριοποιηθήκαν οι πρωτογενείς μεταβλητές οι οποίες δημιούργησαν τα κριτήρια. Η κατηγοριοποίηση των σύνθετων κριτηρίων έχει σκοπό τη δημιουργία συγκρίσιμων μεγεθών για κάθε κριτήριο (Χαλκιάς & Παπαδόπουλος 2007). Με βάση τις επεξεργασίες οι οποίες αναφέρθηκαν παραπάνω, δημιουργήθηκε ο πίνακας περιγραφών για το χωρικό υπόβαθρο της περιοχής μελέτης (δ.δ. Ν. Ηλείας), ο οποίος περιέχει όλα τα πεδία τα οποία αντιστοιχούν στις πρωτογενείς μεταβλητές (κατώτερο επίπεδο της ιεραρχίας) (Σχήμα 4.4).
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    Σχήμα 4.4 Πίνακας περιγραφών πρωτογενών μεταβλητών για τις χωρικές μονάδες της περιοχής μελέτης.


    


    Αφού εισαχθεί ο πίνακας αυτός σε περιβάλλον GIS (π.χ. στο περιβάλλον εργασίας ΑrcMap του ArcGIS), δημιουργούνται τα αντίστοιχα πεδία κατηγοριοποίησης για κάθε πρωτογενή μεταβλητή εντός του πίνακα περιγραφικών χαρακτηριστικών της βάσης μέσω του εργαλείου “add field”. Ακολούθως, με την χρήση του εργαλείου επιλογής με βάση θεματικά χαρακτηριστικά (“select by attributes”), γίνεται η επιλογή του εύρους τιμών κάθε πρωτογενούς μεταβλητής κι έπειτα η εισαγωγή της νέας κλάσης για τις επιλεχθείσες τιμές στο αντίστοιχο νέο πεδίο ταξινόμησης της μεταβλητής. Η διαδικασία επαναλαμβάνεται, ώσπου να εισαχθούν όλες οι νέες κλάσεις των πρωτογενών μεταβλητών για κάθε σύνθετο κριτήριο του μοντέλου. Ο υπολογισμός των νέων τιμών στα νέα πεδία ταξινόμησης κάθε μεταβλητής, γίνεται με το εργαλείο “field calculator”. Η νέα ταξινόμηση των πρωτογενών μεταβλητών κάθε κριτηρίου γίνεται σύμφωνα με τους ακόλουθους πίνακες αντιστοίχισης (Σχήματα 4.5, 4.6, 4.7, 4.8). :
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    Σχήμα 4.5 Ταξινόμηση πρωτογενών μεταβλητών Χωρικού Κριτηρίου.
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    Σχήμα 4.6 Ταξινόμηση πρωτογενών μεταβλητών Κριτηρίου Απασχόλησης.
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    Σχήμα 4.7 Ταξινόμηση πρωτογενών μεταβλητών Δημογραφικού Κριτηρίου.
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    Σχήμα 4.8 Ταξινόμηση πρωτογενών μεταβλητών Αγροτικού Κριτηρίου.


    


    [bookmark: _Toc438361167]4.4.5 Κύρια επεξεργασία και έλεγχος συνέπειας


    Το στάδιο της κύριας επεξεργασίας έχει δύο βασικά σκέλη: α) Τη σύνθεση – δημιουργία κάθε σύνθετου κριτηρίου από τις αντίστοιχες πρωτογενείς ταξινομημένες μεταβλητές και β) τη σύνθεση – δημιουργία του παραγόμενου, η οποία αφορά στην κατηγοριοποίηση, ως προς την καταλληλότητα για την ανάπτυξη (η οποία θα αναφέρεται και ως «ευνοϊκότητα») του φαινόμενου της «Επιστροφής στην ΄Υπαιθρο», από τα σύνθετα κριτήρια που δημιουργήθηκαν στην προηγούμενη φάση.


    Αρχικά, και σύμφωνα με την μέθοδο ΑΗΡ, γίνεται σύγκριση ανά ζεύγη (pairwise comparison) των πρωτογενών παραγόντων κάθε κριτηρίου, σύμφωνα με την υποκειμενική (προσωπική, εμπειρική, βιβλιογραφική, έρευνα πεδίου, κ.τ.λ) άποψη του ερευνητή, ως προς την σχέση σημαντικότητας που έχουν οι παράγοντες μεταξύ τους, άρα και τον ανάλογο βαθμό συμμετοχής του καθενός στην δημιουργία του κάθε σύνθετου κριτηρίου. Από τη σύγκριση αυτή και με την ανάλογη μήτρα υπολογισμών της μεθόδου, προκύπτει η κανονικοποίηση των τιμών σύγκρισης και τέλος ο συντελεστής βαρύτητας με τον οποίο κάθε πρωτογενής μεταβλητή θα συμμετάσχει στη δημιουργία του αντίστοιχου σύνθετου κριτηρίου. Ακολουθεί ο έλεγχος συνέπειας της σύγκρισης των μεταβλητών και των συντελεστών βαρύτητας που προέκυψαν. Ο λόγος συνέπειας δε θα πρέπει να ξεπερνά το 10% (CR ≤ 0.10) για να θεωρείται λογική η ιεράρχηση και η σχέση σύγκρισης που έχει πραγματοποιηθεί μεταξύ των πρωτογενών παραγόντων και να είναι αποδεκτοί οι συντελεστές βαρύτητας που προέκυψαν (Saaty, & Vargas, 1987). Η σύγκριση ανά ζεύγη γίνεται σύμφωνα με την θεμελιώδη κλίμακα σύγκρισης που έχει εισάγει ο Saaty (έχει ήδη περιγραφεί σε προηγούμενη παράγραφο) και παρατίθεται ανεπτυγμένη ακολούθως (Σχήμα 4.9):
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    Σχήμα 4.9 Θεμελιώδης κλίμακα σύγκρισης.


    


    Στη συνέχεια παρουσιάζονται η ιεράρχηση σημαντικότητας που πραγματοποιήθηκε μεταξύ των πρωτογενών παραγόντων κάθε κριτηρίου, ο πίνακας σύγκρισης (ανά ζεύγη) αυτών, και τέλος οι συντελεστές βαρύτητας που προέκυψαν για κάθε παράγοντα με τους οποίους θα συμμετάσχουν στην δημιουργία του σύνθετου κριτηρίου. Επιπλέον, παρατίθεται και η τιμή του λόγου συνέπειας που προέκυψε για κάθε σύγκριση. Σημειώνεται ότι η σχέση ανίσωσης μεταξύ των πρωτογενών παραγόντων που παρουσιάζεται παρακάτω, αντιπροσωπεύει τη σχετική σημαντικότητά τους και εκφράζει τη σχέση των συντελεστών βαρύτητας οι οποίοι αντιστοιχούν σε κάθε παράγοντα.


    


    [bookmark: _Toc438361168]4.4.5.1 Χωρικό κριτήριο


    Η ιεράρχηση των παραγόντων του Χωρικού Κριτηρίου που καθορίστηκε, ως προς την μεταξύ τους σημαντικότητα είναι: Χ2>Χ3>Χ1 (Σχήμα 4.10).
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    Σχήμα 4.10 Σύγκριση ανά ζεύγη και συντελεστές βαρύτητας παραγόντων Χωρικού Κριτηρίου.


    


    Ο λόγος συνέπειας που υπολογίστηκε είναι: CR=0,05


    Επομένως, το Χωρικό Κριτήριο θα υπολογιστεί σύμφωνα με την ακόλουθη σχέση:


    0,0698 * Χ1 + 0,7644 * Χ2 + 0,1659 * Χ3


    


    [bookmark: _Toc438361169]4.4.5.2 Κριτήριο Απασχόλησης


    Η ιεράρχηση των παραγόντων του Κριτηρίου Απασχόλησης που καθορίστηκε, ως προς την μεταξύ τους σημαντικότητα είναι: ΑΠ2>ΑΠ1>ΑΠ3 (Σχήμα 4.11).
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    Σχήμα 4.11 Σύγκριση ανά ζεύγη και συντελεστές βαρύτητας παραγόντων Κριτηρίου Απασχόλησης.


    


    Ο λόγος συνέπειας που υπολογίστηκε είναι: CR=0,06


    Άρα το Κριτήριο Απασχόλησης θα υπολογιστεί σύμφωνα με την ακόλουθη σχέση:


    0,1718 * ΑΠ1 + 0,7530 * ΑΠ2 + 0,0752 * ΑΠ3


    


    [bookmark: _Toc438361170]4.4.5.3 Δημογραφικό κριτήριο


    Η ιεράρχηση των παραγόντων του Δημογραφικού Κριτηρίου που καθορίστηκε, ως προς την μεταξύ τους σημαντικότητα είναι: Δ2>Δ1>Δ3 (Σχήμα 4.12).
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    Σχήμα 4.12 Σύγκριση ανά ζεύγη και συντελεστές βαρύτητας παραγόντων Δημογραφικού Κριτηρίου.


    


    Ο λόγος συνέπειας που υπολογίστηκε είναι: CR=0,06


    Επομένως, το Δημογραφικό Κριτήριο θα υπολογιστεί σύμφωνα με την ακόλουθη σχέση:


    0,2895 * Δ1 + 0,6463 * Δ2 + 0,0641 * Δ3
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    Η ιεράρχηση των παραγόντων του Αγροτικού Κριτηρίου το οποίο καθορίστηκε, ως προς την μεταξύ τους σημαντικότητα είναι: ΑΓ1>ΑΓ2 (Σχήμα 4.13).
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    Σχήμα 4.13 Σύγκριση και συντελεστές βαρύτητας παραγόντων Αγροτικού Κριτηρίου.


    Σημειώνεται ότι, όταν οι παράγοντες είναι δύο, δεν κρίνεται σκόπιμος ο υπολογισμός του δείκτη συνέπειας, αφού η αντίστροφη τιμή καταχωρείται αυτόματα. Συνεπώς, το αγροτικό κριτήριο θα υπολογιστεί σύμφωνα με την ακόλουθη σχέση: 0,8571 * ΑΓ1 + 0,1429 * ΑΓ2


    Η εφαρμογή όλων των σχέσεων που προέκυψαν από τις ανωτέρω αναλύσεις γίνεται στο περιβάλλον διαχείρισης του πίνακα περιγραφών. Στο λογισμικό ArcMap και στον πίνακα περιγραφικών χαρακτηριστικών της βάσης δεδομένων δημιουργούνται 4 νέα πεδία με το εργαλείο “add field”, ένα για κάθε σύνθετο κριτήριο του μοντέλου. Σ’ κάθε ένα από αυτά, με τη χρήση του εργαλείου “field calculator”, εφαρμόζεται καθεμία από τις παραπάνω σχέσεις κατ’ αντιστοιχία. Υπογραμμίζεται ότι, οι παράγοντες που αναφέρονται στις ανωτέρω σχέσεις αντιστοιχούν στα πεδία των κατηγοριοποιημένων (και όχι των αρχικών) πρωτογενών παραγόντων που δημιουργήθηκαν.


    Το τελευταίο βήμα της μεθόδου αφορά στη δημιουργία – υπολογισμό του ζητούμενου επιπέδου πληροφορίας που αφορά στην καταλληλότητα των περιοχών του νομού Ηλείας, ως προς το φαινόμενο της «Επιστροφής στην Ύπαιθρο». Για την παραγωγή του επιπέδου πληροφορίας αυτού, ακολουθείται η ίδια διαδικασία με παραπάνω, με τη διαφορά ότι η σύγκριση ανά ζεύγη γίνεται πλέον στα 4 σύνθετα κριτήρια που παρήχθησαν στα προηγούμενα βήματα, τα οποία και συνθέτουν το τελικό ζητούμενο επίπεδο πληροφορίας σύμφωνα με το συντελεστή βαρύτητας που θα υπολογιστεί για το καθένα. Η ανάλυση παρουσιάζεται στη συνέχεια.


    [bookmark: _Toc438361172]4.4.6 Σύνθεση σταθμισμένων κριτηρίων


    Η ιεράρχηση των σύνθετων κριτηρίων που καθορίστηκε, ως προς την μεταξύ τους σημαντικότητα είναι: ΑΠ>Χ>ΔΗ>ΑΓ (Σχήμα 4.14).
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    Σχήμα 4.14 Σύγκριση ανά ζεύγη και συντελεστές βαρύτητας σύνθετων κριτηρίων.


    Ο λόγος συνέπειας που υπολογίστηκε είναι: CR=0,04


    Επομένως, το επίπεδο πληροφορίας της ευνοϊκότητας ως προς την επιστροφή στην ύπαιθρο θα υπολογιστεί σύμφωνα με την ακόλουθη σχέση: 0,3260 * Χ + 0,5059 * ΑΠ + 0,1137 * ΔΗ + 0,0543 * ΑΓ


    Έτσι, στον πίνακα περιγραφικών χαρακτηριστικών της βάσης δεδομένων δημιουργείται ένα νέο πεδίο με το εργαλείο “add field”, στο οποίο και εφαρμόζεται η ανωτέρω σχέση με το εργαλείο “field calculator”. Το πεδίο αυτό είναι και το ζητούμενο επίπεδο πληροφορίας της παρούσας εργασίας (Σχήμα 4.15).
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    Σχήμα 4.15 Υπολογισμός τελικού επιπέδου πληροφορίας καταλληλότητας για ανάπτυξη του φαινόμενου – Εργαλείο Field Calculator του λογισμικού ArcGIS.


    


    Ολοκληρώνοντας την διαδικασία, γίνεται σύνδεση του διανυσματικού πολυγωνικού επιπέδου του υποβάθρου (“d_d_Hleias.shp”) με τον πίνακα περιγραφικών δεδομένων (“pinakas_dedomenwn.dbf”) μέσω του κοινού τους πεδίου “Code_1991” με το εργαλείο “Join”.
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    Ένας τρόπος ανάλυσης ευαισθησίας ενός μοντέλου, είναι με τη διαφοροποίηση του συντελεστή βαρύτητας του ισχυρότερου παράγοντα κατά ένα μικρό ποσοστό, με την ταυτόχρονη αντίθετη διαφοροποίηση του συντελεστή του δεύτερου ισχυρότερου παράγοντα, έτσι ώστε το τελικό άθροισμα των συντελεστών να είναι ίδιο με το αρχικό (πριν δηλαδή γίνει καμία τροποποίηση). Στη συνέχεια, η διαδικασία αυτή μπορεί να επαναληφθεί για όσες τιμές τροποποίησης αποφασιστούν. Οι τιμές που θα υπολογιστούν για κάθε περίπτωση τροποποίησης του μοντέλου αποτελούν τις αποκλίσεις από το αρχικό και ως εκ τούτου, μπορούν να εξαχθούν χρήσιμα συμπεράσματα ως προς την ευαισθησία (ή μη) του αποτελέσματος σε αυτές τις μικρές αλλαγές. Το ποσοστό της κάθε τροποποίησης δεν θα πρέπει να είναι σημαντικό καθώς υπάρχει κίνδυνος να αλλοιωθεί το μοντέλο. Στην παρούσα εργασία επιλέγονται 3 σενάρια ανάλυσης ευαισθησίας.


    


    Στο πρώτο σενάριο ευαισθησίας, ο συντελεστής βαρύτητας του σύνθετου κριτηρίου της Απασχόλησης, αυξάνεται κατά 0,05 και αντίστοιχα, ο συντελεστής βαρύτητας του δεύτερου ισχυρότερου κριτηρίου που είναι το Χωρικό, μειώνεται κατά 0,05. Οι συντελεστές βαρύτητας των υπόλοιπων κριτηρίων δεν τροποποιούνται. Σημειώνεται ότι ,οι αναφερόμενοι συντελεστές βαρύτητας είναι εκείνοι οι οποίοι υπολογίστηκαν στο τελευταίο βήμα της διαδικασίας για την παραγωγή του επιπέδου πληροφορίας της καταλληλότητας για ανάπτυξη του υπό μελέτη φαινόμενου, όπως περιγράφεται στην προηγούμενη παράγραφο. Στον πίνακα περιγραφικών χαρακτηριστικών -όπως έγινε και στην κύρια μεθοδολογία- δημιουργείται ένα νέο πεδίο με το εργαλείο “add field” και με το εργαλείο “field calculator” εφαρμόζεται σε σχέση με τους νέους συντελεστές. Ο πίνακας με τους νέους συντελεστές των σύνθετων κριτηρίων του σεναρίου ευαισθησίας 1, καθώς και η νέα σχέση που προκύπτει και θα παράγει το νέο επίπεδο πληροφορίας, παρουσιάζονται ακολούθως (Σχήμα 4.16).
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    Σχήμα 4.16 Συντελεστές βαρύτητας σύνθετων κριτηρίων Σεναρίου Ευαισθησίας 1.


    


    Επομένως, το επίπεδο πληροφορίας της καταλληλότητας, ως προς την επιστροφή στην ύπαιθρο, όπως προκύπτει από το Σενάριο Ευαισθησίας 1 του μοντέλου, θα υπολογιστεί σύμφωνα με την ακόλουθη σχέση:


    


    0,2760 * Χ + 0,5559 * ΑΠ + 0,1137 * ΔΗ + 0,0543 * ΑΓ


    


    Το δεύτερο σενάριο ευαισθησίας, είναι το αντίστροφο του πρώτου. Σ’ αυτήν την περίπτωση, ο συντελεστής βαρύτητας του σύνθετου κριτηρίου της Απασχόλησης μειώνεται κατά 0,05 και αντίστοιχα ο συντελεστής βαρύτητας του Χωρικού αυξάνεται κατά 0,05. Έπειτα, ακολουθείται η ίδια διαδικασία με το πρώτο σενάριο, σύμφωνα με τον ακόλουθο πίνακα (Σχήμα 4.17).
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    Σχήμα 4.17 Συντελεστές βαρύτητας σύνθετων κριτηρίων Σεναρίου Ευαισθησίας 2.


    


    Επομένως, το επίπεδο πληροφορίας της ευνοϊκότητας ως προς την επιστροφή στην ύπαιθρο, όπως προκύπτει από το Σενάριο Ευαισθησίας 2 του μοντέλου, θα υπολογιστεί σύμφωνα με την ακόλουθη σχέση:


    


    0,3760 * Χ + 0,4559 * ΑΠ + 0,1137 * ΔΗ + 0,0543 * ΑΓ


    


    Το τρίτο σενάριο ευαισθησίας εφαρμόζεται σε προηγούμενο βήμα της αρχικής μεθοδολογίας σε σχέση με τα δύο προηγούμενα σενάρια. Σύμφωνα με το σενάριο αυτό, γίνεται επαναταξινόμηση των πρωτογενών μεταβλητών, του ισχυρότερου σύνθετου κριτηρίου του μοντέλου που είναι αυτό της Απασχόλησης, σε νέες κλάσεις. Η διαφορά με την αρχική μεθοδολογία είναι ότι, η ευνοϊκότερη κλάση 5 μειώνεται κατά 0,25 και η αμέσως επόμενη κλάση 4 αυξάνεται κατά 0,25. Οι υπόλοιπες κλάσεις διατηρούνται ως έχουν. Ο νέος πίνακας ταξινόμησης παρουσιάζεται στην συνέχεια (Σχήμα 4.18).
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    Σχήμα 4.18 Νέα ταξινόμηση πρωτογενών μεταβλητών Κριτηρίου Απασχόλησης – Σενάριο Ευαισθησίας 3.


    


    Στη συνέχεια, η διαδικασία ακολουθείται, όπως ακριβώς περιγράφηκε στην αρχική μεθοδολογία. Υπολογίζεται το νέο σύνθετο κριτήριο Απασχόλησης με τους ίδιους συντελεστές βαρύτητας (όπως είχαν υπολογιστεί στο αρχικό) για κάθε νέα σταθμισμένη πρωτογενή μεταβλητή, και στην συνέχεια υπολογίζεται το νέο επίπεδο πληροφορίας ως προς την καταλληλότητα για ανάπτυξη του φαινόμενου με τους ίδιους συντελεστές βαρύτητας για κάθε σύνθετο κριτήριο (όπως είχαν υπολογιστεί αρχικά). Σημειώνεται ότι όπου απαιτείται, για να παραχθεί το Σενάριο Ευαισθησίας 3, δημιουργούνται τα απαιτούμενα νέα πεδία στο πίνακα περιγραφικών χαρακτηριστικών της βάσης δεδομένων και γίνονται οι ανάλογες πράξεις σ’ αυτά, χρησιμοποιώντας τους τρόπους και τα εργαλεία που έχουν προαναφερθεί στην μεθοδολογία.


    


    [bookmark: _Toc438361174]4.4.8 Τελικά αποτελέσματα μοντέλου


    Όπως έχει αναφερθεί, για την ανάπτυξη του μοντέλου αποτίμησης του φαινόμενου «Επιστροφή στην Ύπαιθρο» και τον προσδιορισμό των δ.δ. του Νομού Ηλείας που μπορούν να λειτουργήσουν ως κύριοι υποδοχείς του φαινόμενου, καθορίστηκαν τέσσερα σύνθετα κριτήρια τα οποία στην πραγματικότητα αποτελούν τα βασικά κριτήρια στα οποία στηρίζεται η δημιουργία του μοντέλου. Στη συνέχεια παρουσιάζονται τ’ αποτελέσματα της επεξεργασίας και της ανάλυσης των κριτηρίων αυτών, καθώς κι εκείνα της τελικής τους σύνθεσης (τελικός χάρτης καταλληλότητας δ.δ για ανάπτυξη του φαινόμενου). Θα πρέπει να σημειωθεί ότι για τη δημιουργία των θεματικών χαρτών οι οποίοι παρουσιάζονται παρακάτω, τα δ.δ. της περιοχής μελέτης ταξινομούνται με βάση την τυπική απόκλιση των τιμών που απεικονίζονται κάθε φορά. Μ’ αυτόν τον τρόπο διασφαλίζεται ότι η κεντρική κλάση αντιπροσωπεύει τα δ.δ. με τιμές κοντά στη μέση, ενώ τα όρια των κλάσεων με τιμές μεγαλύτερες και μικρότερες από την κεντρική καθορίζονται με βάση την τυπική απόκλιση.
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    Το κριτήριο αυτό δημιουργήθηκε από την σύνθεση τριών πρωτογενών μεταβλητών, της κλίσης, της χρονοαπόστασης από οικισμούς και της χρονοαπόστασης από τις ακτές. Στην παρούσα ανάλυση επιλέχθηκε ως σημαντικότερη μεταβλητή η χρονοαπόσταση από οικισμούς, δεύτερη σημαντικότερη η απόσταση από ακτές και τελευταία, η κλίση. Σύμφωνα με την ανάλυση και σύνθεση των αρχικών δεδομένων (πρωτογενών τιμών) των τριών αυτών μεταβλητών, όπως περιγράφηκε στην μεθοδολογία, προκύπτει η ακόλουθη κατάταξη των δ.δ. του Νομού Ηλείας, ως προς την καταλληλότητα για ανάπτυξη του υπό μελέτη φαινόμενου, σύμφωνα με το Χωρικό Κριτήριο (Σχήμα 4.19).
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    Σχήμα 4.19 Χωρικό Κριτήριο – καταλληλότητα για ανάπτυξη του φαινόμενου.
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    Το κριτήριο αυτό δημιουργήθηκε από την σύνθεση τριών πρωτογενών μεταβλητών, του ποσοστού (%) των διοικητικών στελεχών και των εμπόρων, του συνόλου των απασχολούμενων και της πολυαπασχόλησης. Στην παρούσα ανάλυση επιλέχθηκε ως σημαντικότερη μεταβλητή το σύνολο των απασχολούμενων, δεύτερη σημαντικότερη το ποσοστό (%) των διοικητικών στελεχών και των εμπόρων και τελευταία η πολυαπασχόληση. Σύμφωνα με την ανάλυση και σύνθεση των αρχικών δεδομένων (πρωτογενών τιμών) των τριών αυτών μεταβλητών, όπως περιγράφηκε στην μεθοδολογία, προκύπτει η ακόλουθη κατάταξη των δ.δ. του Νομού Ηλείας, ως προς την ευνοϊκότητα του υπό μελέτη φαινόμενου, με βάση το Κριτήριο Απασχόλησης (Σχήμα 4.20).
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    Σχήμα 4.20 Κριτήριο Απασχόλησης – καταλληλότητα για ανάπτυξη του φαινόμενου.
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    Το κριτήριο αυτό δημιουργήθηκε από τη σύνθεση τριών πρωτογενών μεταβλητών, του δείκτη γήρανσης, του δείκτη εξάρτησης και του ποσοστού (%) των μεταναστών. Στην παρούσα ανάλυση επιλέχθηκε ως σημαντικότερη μεταβλητή ο δείκτης εξάρτησης, δεύτερη σημαντικότερη ο δείκτης γήρανσης και τελευταία το ποσοστό των μεταναστών. Σύμφωνα με την ανάλυση και σύνθεση των αρχικών δεδομένων (πρωτογενών τιμών) των τριών αυτών μεταβλητών, όπως περιγράφηκε στην μεθοδολογία, προέκυψε η ακόλουθη κατάταξη των δ.δ. του Νομού Ηλείας, ως προς την καταλληλότητα για ανάπτυξη του υπό μελέτη φαινόμενου, σύμφωνα με το Δημογραφικό Κριτήριο (Σχήμα 4.21).
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    Σχήμα 4.21 Δημογραφικό Κριτήριο – καταλληλότητα για ανάπτυξη του φαινόμενου.
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    Το κριτήριο αυτό δημιουργήθηκε από τη σύνθεση δύο πρωτογενών μεταβλητών, των ευνοϊκών γεωργικών χρήσεων και της κλίσης. Στην παρούσα ανάλυση, επιλέχθηκε ως σημαντικότερη μεταβλητή οι ευνοϊκές γεωργικές χρήσεις και δεύτερη σημαντικότερη, η κλίση των εδαφών. Σύμφωνα με την ανάλυση και σύνθεση των αρχικών δεδομένων (πρωτογενών τιμών) των δύο αυτών μεταβλητών, όπως περιγράφηκε στην μεθοδολογία, προκύπτει η ακόλουθη κατάταξη των δ.δ. του Νομού Ηλείας ως προς την καταλληλότητα για ανάπτυξη του υπό μελέτη φαινόμενου, με βάση το Αγροτικό Κριτήριο (Σχήμα 4.22).
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    Σχήμα 4.22 Αγροτικό Κριτήριο – καταλληλότητα για ανάπτυξη του φαινόμενου.
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    Η τελική κατάταξη ως προς την καταλληλότητα για ανάπτυξη του φαινομένου των δ.δ. του Νομού Ηλείας που μπορούν να λειτουργήσουν ως κύριοι υποδοχείς του φαινόμενου της επιστροφής στην ύπαιθρο, δημιουργήθηκε από την σύνθεση των τεσσάρων σύνθετων κριτηρίων που παρουσιάστηκαν παραπάνω, του χωρικού, της απασχόλησης, του δημογραφικού και του αγροτικού. Στην παρούσα ανάλυση επιλέχθηκε ως σημαντικότερο κριτήριο η απασχόληση, δεύτερο σημαντικότερο το χωρικό, τρίτο σημαντικότερο το δημογραφικό και τελευταίο το αγροτικό. Σύμφωνα με την σύνθεση των τεσσάρων αυτών σύνθετων κριτηρίων, όπως περιγράφηκε στην μεθοδολογία, προέκυψε η ακόλουθη τελική κατάταξη των δ.δ. του Νομού Ηλείας, ως προς την καταλληλότητα για ανάπτυξη του υπό μελέτη φαινόμενου. Η κατάταξη που ακολουθεί γίνεται με βάση την τακτική κλίμακα ταξινόμησης (1 – 5). Στον χάρτη που ακολουθεί, παρουσιάζονται ποσοτικά και οι εκτάσεις (km2) που αντιστοιχούν σε κάθε κλάση (Σχήμα 4.23).
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    Σχήμα 4.23 Συνολική αποτίμηση καταλληλότητας για ανάπτυξη του φαινόμενου.
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    Σχήμα 4.24 Συνολική αποτίμηση καταλληλότητας για ανάπτυξη του φαινόμενου – Τοπική σχετική κλίμακα.


    


    Μια εναλλακτική χαρτογραφική παρουσίαση της ευνοϊκότητας του φαινόμενου είναι η κατάταξη της ανωτέρω τελικής ανάλυσης σε τοπική κλίμακα. Ως ελάχιστη τιμή κατάταξης επιλέχτηκε η ελάχιστη τιμή που υπολογίστηκε από το μοντέλο και ως μέγιστη τιμή κατάταξης, η μέγιστη τιμή που υπολογίστηκε από το μοντέλο. Το διάστημα μεταξύ αυτών των τιμών χωρίστηκε ισομερώς σε 3 κλάσεις (ταξινόμηση ίων διαστημάτων με 3 κλάσεις). Η κατάταξη αυτή σε τοπική κλίμακα, καθώς και οι εκτάσεις (km2) που αντιστοιχούν σε κάθε κλάση παρουσιάζονται στο χάρτη του (Σχήμα 4.24).


    


    [bookmark: _Toc438361180]4.4.10 Αποτελέσματα ανάλυσης ευαισθησίας


    Για την ανάλυση ευαισθησίας δημιουργήθηκαν τρία σενάρια. Στο πρώτο σενάριο, αυξάνεται ο συντελεστής βαρύτητας του σημαντικότερου κριτηρίου (της Απασχόλησης) κατά 0,05 και μειώνεται ο συντελεστής βαρύτητας του δεύτερου σημαντικότερου κριτηρίου (του Χωρικού) κατά 0,05, ενώ οι συντελεστές των υπολοίπων κριτηρίων διατηρούνται σταθεροί. Το δεύτερο σενάριο είναι το αντίθετο του πρώτου, όπου μειώνεται ο συντελεστής βαρύτητας του κριτηρίου της Απασχόλησης κατά 0,05 και αυξάνεται αυτός του Χωρικού κριτηρίου κατά 0,05, ενώ και στο σενάριο αυτό οι συντελεστές των υπολοίπων κριτηρίων παραμένουν αμετάβλητοι. Στο τρίτο σενάριο, γίνεται επαναταξινόμηση των τριών πρωτογενών μεταβλητών του σημαντικότερου κριτηρίου (της Απασχόλησης), αλλάζοντας τις δύο υψηλότερες κλάσεις από τιμή 5 σε 4,75 και από τιμή 4 σε 4,25 και στην συνέχεια ακολουθείται η αρχική διαδικασία, ως και την παραγωγή του τελικού ζητούμενου επιπέδου πληροφορίας. Αναλυτικότερα, τα σενάρια ανάλυσης ευαισθησίας του μοντέλου, περιγράφονται στο κεφάλαιο της μεθοδολογίας. Ακολούθως, παρουσιάζονται τα αποτελέσματα των σεναρίων, καθώς και η σύγκρισή τους με το αποτέλεσμα του μοντέλου (Σχήματα 4.25, 4.26, 4.27).
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    Σχήμα 4.25 Τελική κατάταξη καταλληλότητας για ανάπτυξη του φαινόμενου των δ.δ. του Νομού Ηλείας – Ανάλυση ευαισθησίας Σενάριο 1.
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    Σχήμα 4.26 Τελική καταλληλότητας για ανάπτυξη του φαινόμενου– Ανάλυση ευαισθησίας Σενάριο 2.
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    Σχήμα 4.27 Τελική κατάταξη καταλληλότητας για ανάπτυξη του φαινόμενου– Ανάλυση ευαισθησίας Σενάριο 3.


    


    Στους πίνακες και στα διαγράμματα που ακολουθούν, παρουσιάζεται η ποσοτική σύγκριση των σεναρίων ανάλυσης ευαισθησίας με το κανονικό αποτέλεσμα του μοντέλου. Οι τιμές αφορούν στην ποσοστιαία (%) κατανομή των εκτάσεων που αντιστοιχεί σε κάθε κλάση (Σχήμα 4.28, Σχήμα 4.29).
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    Σχήμα 4.28 Ποσοστιαίες κατανομές (%) των εκτάσεων των δ.δ. του νομού Ηλείας ανά κλάση ευνοϊκότητας του φαινόμενου
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    Σχήμα 4.29 Διάγραμμα ποσοστιαίων κατανομών (%) των εκτάσεων των δ.δ. του νομού Ηλείας, ανά κλάση καταλληλότητας για ανάπτυξη του φαινόμενου.


    


    Στα σενάρια ανάλυσης ευαισθησίας του μοντέλου, οι αποκλίσεις που εμφανίζονται είναι μικρές. Το σενάριο 3 σχεδόν ταυτίζεται με τα κανονικά αποτελέσματα του μοντέλου. Στο πρώτο σενάριο, η μεγαλύτερη απόκλιση εμφανίζεται στην κλάση 4 και είναι της τάξης του 5,09% (διαφορά σε ποσοστό έκτασης που περιλαμβάνει η κλάση σε σύγκριση με το αντίστοιχο ποσοστό του μοντέλου). Στο δεύτερο σενάριο, η μεγαλύτερη απόκλιση εμφανίζεται στην κλάση 3 και είναι της τάξης του 2,73% (διαφορά σε ποσοστό έκτασης που περιλαμβάνει η κλάση σε σύγκριση με το αντίστοιχο ποσοστό του μοντέλου). Οι αποκλίσεις αυτές χαρακτηρίζονται, ως μικρές, και το μοντέλο, ως σταθερό (Σχήμα 4.30, Σχήμα 4.31).
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    Σχήμα 4.30 Διαφορά ποσοστιαίων κατανομών (%) των εκτάσεων των δ.δ. του νομού Ηλείας, ανά κλάση καταλληλότητας για ανάπτυξη του φαινόμενου, κάθε σεναρίου ανάλυσης ευαισθησίας από το μοντέλο.
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    Σχήμα 4.31 Διάγραμμα διαφοράς ποσοστιαίων κατανομών (%) των εκτάσεων των δ.δ. του νομού Ηλείας, ανά κλάση καταλληλότητας για ανάπτυξη του φαινόμενου, κάθε σεναρίου ανάλυσης ευαισθησίας από το μοντέλο.
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    Η πολυκριτηριακή ανάλυση με την χρήση της μεθοδολογίας Αναλυτικής Ιεράρχησης, αποτελεί ένα χρήσιμο εργαλείο έρευνας σε εφαρμογές λήψης χωρικών αποφάσεων. Η τεχνική ΑΗΡ έχει ένα ευρύ φάσμα εφαρμογών με πολύ ικανοποιητικά αποτελέσματα. Αποτελεί μια δομημένη, τεκμηριωμένη, αυτοελεγχόμενη και σχετικά εύκολη στην εφαρμογή της, τεχνική.


    Η δυνατότητα της μεθόδου για συνδυαστική αξιοποίηση «ποσοτικών» και «ποιοτικών» κριτηρίων με χωρική διαφοροποίηση την καθιστά κατάλληλη για την ανάλυση πολύπλοκων γεωγραφικών φαινομένων και προβλημάτων. Η εφαρμογή της μεθοδολογίας AHP στο πλαίσιο ενός GIS σε εφαρμογές πολυκριτηριακής ανάλυσης με σταθμισμένη χαρτογραφική υπέρθεση αποτελεί ένα ισχυρό αναλυτικό εργαλείο. Επιπλέον, με την αποδόμηση του υπό μελέτη προβλήματος και τη δόμηση της ιεραρχίας στο πλαίσιο ανάπτυξης της AHP, ενισχύεται η συνολική κατανόηση του προβλήματος και της σχέσης του με τα κριτήρια και τα υποκριτήρια. Τέλος, η αξιολόγηση των παραγόντων από τους ειδικούς/εμπειρογνώμονες, αλλά δυνητικά και από πολίτες ή ομάδες πολιτών είναι ιδιαίτερα χρήσιμη και αποτελεσματική σε γεωγραφικές εφαρμογές.
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    [bookmark: _Toc438361184]Κριτήριο Αξιολόγησης 1 - Ερωτήσεις Κατανόησης


    


    1. Ποιες είναι οι φάσεις υλοποίησης της μεθοδολογίας αναλυτικής ιεράρχησης;


    2. Ποια είναι η κλίμακα συγκριτικής αξιολόγησης των κριτηρίων στον πίνακα σύγκρισης ανά ζεύγη;


    3. Τι εξυπηρετεί ο έλεγχος της συνέπειας στην αποτίμηση της σπουδαιότητας των παραγόντων στη μεθοδολογία της αναλυτικής ιεράρχησης; Σχεδιάστε έναν πίνακα σύγκρισης ζευγών μεγέθους 3Χ3 ο οποίος να περιέχει λογικές ασυνέπειες.


    4. "Η μεθοδολογία της Αναλυτικής Ιεράρχησης θα μπορούσε να συνδυαστεί με τα συμμετοχικά GIS για την αξιοποίηση των απόψεων των πολιτών". Σχολιάστε την παραπάνω πρόταση δίνοντας ένα παράδειγμα εφαρμογής της.
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    Σύνοψη


    Στο κεφάλαιο αυτό παρουσιάζονται τα ψηφιακά μοντέλα εδάφους (ΨΜΕ). Αρχικά, γίνεται μια εισαγωγή στο αντικείμενο, δίνονται οι βασικοί ορισμοί και παρουσιάζονται οι κύριες πηγές δεδομένων για την κατασκευή ενός ΨΜΕ. Στη συνέχεια παρουσιάζονται οι δύο βασικοί τύποι των ψηφιακών μοντέλων εδάφους: το μοντέλο τριγωνικού ακανόνιστου δικτύου (TIN) και το ψηφιακό μοντέλο υψομέτρων (DEM). Ακολουθεί η αναφορά στα παραγόμενα δεδομένα από την ανάλυσης ενός ΨΜΕ, καθώς και στους εναλλακτικούς τρόπους οπτικοποίησης των δεδομένων υψομέτρου. Κατόπιν, παρουσιάζονται οι δυνατότητες δημιουργίας, παρουσίασης και αξιοποίησης ενός ΨΜΕ σε περιβάλλον λογισμικού Συστημάτων Γεωγραφικών Πληροφοριών. Τέλος, το κεφάλαιο ολοκληρώνεται με την υλοποίηση παραδειγματικής πρακτικής εφαρμογής ανάλυσης επιφάνειας σε περιβάλλον GIS.


    


    Προαπαιτούμενη γνώση


    Οι προαπαιτούμενες γνώσεις τις οποίες θα πρέπει να έχει ο αναγνώστης εστιάζονται στις βασικές δομές χωρικών δεδομένων (vector και raster μοντέλα) και στη βασική κατανόηση στοιχείων ενός κλασικού τοπογραφικού χάρτη (ισοϋψείς καμπύλες, ισοδιάσταση, κλίση/έκθεση εδάφους κλπ)
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    Η τεχνολογία των ψηφιακών μοντέλων εδάφους (Digital Terrain Models - DTM, ή και Digital Elevation Models - DEM) αποτελεί ένα χρήσιμο βοήθημα στη διαδικασία ανάλυσης, επεξεργασίας και παρουσίασης πληροφοριών που σχετίζονται με το φυσικό περιβάλλον (Σχήμα 5.1). Παρότι έχουν χρησιμοποιηθεί ήδη από τη δεκαετία του 1950 (Miller & Laflamme, 1958), η ανάπτυξη της επιστήμης της πληροφορικής, καθώς και της επιστήμης των γεωγραφικών πληροφοριών, αναβάθμισε το ρόλο τους στις μέρες μας και τα κατέστησε ιδιαίτερα αξιόπιστα και χρήσιμα (Chang, 2003). Έτσι, θεωρούνται απαραίτητο στοιχείο σε πολλές εφαρμογές γεωγραφικής ανάλυσης (Catlow, 1986, Peckham & Jordan, 2007).
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    Σχήμα 5.1 Ψηφιακό μοντέλο εδάφους του κόσμου με βάση δεδομένα υψομέτρου και βαθυμετρίας από τον δορυφόρο NOAA ETOPO1. Πηγή: https://www.flickr.com/photos/kevinmgill/5853039006/in/photostream/.


    


    Ψηφιακό Μοντέλο Εδάφους (ΨΜΕ) θεωρείται κάθε “ψηφιακή αναπαράσταση του εδάφους”. Παρότι με βάση τον ορισμό αυτό οι ψηφιακές αναπαραστάσεις ισοϋψών καμπυλών και υψομετρικών σημείων μπορούν να θεωρηθούν ΨΜΕ, συνήθως με τον όρο αυτό υπονοούνται χωρικά μοντέλα με συνεχή κατανομή στο χώρο (Χαλκιάς, 2006). Ο όρος Digital Elevation Model / Matrix (DEM) είναι πιο ειδικός και αναφέρεται μόνο στην ψηφιακή αναπαράσταση υψομέτρων, ενώ ο όρος Digital Surface Model (DSM) χρησιμοποιείται επίσης σε ψηφιακές αναπαραστάσεις της γήινης επιφάνειας λαμβάνοντας υπόψη κι άλλα στοιχεία εκτός από το υψόμετρο, όπως είναι οι ανθρώπινες κατασκευές, η βλάστηση κ.λ.π. (Li et al., 2004) (Σχήμα 5.2).
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    Σχήμα 5.2 Ψηφιακό μοντέλο εδάφους (digital terrain model – γαλάζιο χρώμα) και ψηφιακό μοντέλο επιφάνειας (digital surface model- κόκκινο χρώμα).


    Η δημιουργία των ψηφιακών μοντέλων εδάφους βασίζεται σε αρχεία καταγραφών υψομέτρου (δειγματοληψίες) της γήινης επιφάνειας. Τα αρχεία αυτά μπορεί να αντιστοιχούν σε άμεσες καταγραφές και ενόργανες μετρήσεις (π.χ. με χρήση θεοδόλιχου, διαφορικού GPS κλπ), να προέρχονται από φωτογραμμετρική ανάλυση σε στερεοζεύγη αεροφωτογραφιών είτε τέλος να είναι παράγωγα δορυφορικής τηλεπισκόπησης (π.χ. δεδομένα Synthetic Aperture Radar (SAR) ή δεδομένα Light Detection And Ranging (LIDAR) (Batsavlias, 1999). Η δημιουργία των ψηφιακών μοντέλων εδάφους γίνεται με δύο βασικές τεχνικές: α) με την αξιοποίηση δεδομένων Τηλεπισκόπησης και β) με τη χρήση άμεσων καταγραφών υψομέτρου. Είναι προφανές ότι η πρώτη μέθοδος πλεονεκτεί σε περιπτώσεις στις οποίες επιχειρείται η κατασκευή ψηφιακού μοντέλου εδάφους για όλη τη γήινη επιφάνεια ή για εκτεταμένες περιοχές της.
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    Σχήμα 5.3 Στην εικόνα αυτή της NASA χρησιμοποιούνται τα υψομετρικά δεδομένα του συστήματος SRTM σε συνδυασμό με δορυφορική εικόνα Landsat. Κάτω και αριστερά φαίνεται το ακρωτήριο της Καλής Ελπίδας στη Νότια Αφρική.[1] Πηγή: http://photojournal.jpl.nasa.gov/catalog/PIA04961.
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    Ο γαλλικός δορυφόρος SPOT 1 (1986) παρείχε το πρώτο σύστημα αυτόματης δημιουργίας υψομετρικών δεδομένων για εκτεταμένες περιοχές της γης (και με ικανοποιητική ακρίβεια) με τη σύνθεση στερεοζεύγους εικόνων. Μέχρι σήμερα, έχουν αναπτυχθεί για αυτό το σκοπό αρκετά συστήματα τα οποία βασίζονται σε παρόμοιες μεθόδους ή στην λογική των ενεργητικών συστημάτων (radar). Ενδεικτικά αναφέρονται τα συστήματα ERS, SRTM, ASTER και τα πιο σύγχρονα HRS του SPOT5, RDARSAT-1 και SkyMed (Σχήμα 5.3).


    Για τη δημιουργία ψηφιακών μοντέλων εδάφους σε μικρότερης έκτασης περιοχές αξιοποιούνται άλλες ψηφιακές καταγραφές (συνήθως ισοϋψείς καμπύλες ή/ και υψομετρικά σημεία) οι οποίες έχουν δημιουργηθεί με άμεση συλλογή στοιχείων είτε στο πεδίο είτε με φωτογραμμετρικές μεθόδους. Με αυτόν τον τρόπο και με τεχνικές χωρικής παρεμβολής (spatial interpolation) είναι δυνατή η δημιουργία ΨΜΕ. Αυτή η μέθοδος είναι αρκετά δημοφιλής στις περιπτώσεις κατά τις οποίες δεν υπάρχει η δυνατότητα αξιοποίησης εικόνων στερεο-ζεύγους ή αντίθετα όταν υπάρχουν διαθέσιμα θεματικά επίπεδα δεδομένων με πληροφορία υψομέτρου (ισοϋψείς καμπύλες, υψομετρικά σημεία κ.λ.π). Επιπρόσθετα, αυτή η μέθοδος χρησιμοποιείται σε περιπτώσεις μελέτης ορεινών περιοχών με πολύ τραχύ ανάγλυφο, όπου η χρήση άλλων μεθόδων παρουσιάζει αρκετά προβλήματα. Οι αλγόριθμοι χωρικής παρεμβολής οι οποίοι αξιοποιούνται συνήθως, είναι είτε γενικής χρήσης (π.χ. μέθοδος Kriging) είτε ειδικά σχεδιασμένοι αλγόριθμοι για τη δημιουργία ΨΜΕ (π.χ. αλγόριθμoς ANUDEM). Είναι προφανές ότι η ποιότητα ενός ΨΜΕ σχετίζεται άμεσα με την ποιότητα των πρωτογενών δεδομένων τα οποία χρησιμοποιήθηκαν για την κατασκευή του. Άλλοι παράγοντες οι οποίοι επηρεάζουν την πιστότητα καταγραφής του υψομέτρου είναι η πυκνότητα δειγματοληψίας, το μέγεθος της ψηφίδας, ο αλγόριθμος παρεμβολής, αλλά και η τραχύτητα του υπό μελέτη ανάγλυφου.


    Η ανάπτυξη τεχνικών ψηφιακής αναπαράστασης του ανάγλυφου ξεκίνησε λόγω της σχετικής ακαταλληλότητας των κλασικών μεθόδων αναπαράστασης για ανάλυση και μοντελοποίηση. Είναι γεγονός ότι η αναπαράσταση συνεχών οντοτήτων με τις ισοϋψείς καμπύλες, ενώ είναι ιδανική για την παραστατική παρουσίαση του φαινομένου, δεν ενδείκνυται για ποσοτική ανάλυση (Σχήμα 5.4).
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    Σχήμα 5.4 Αναπαράσταση αναγλύφου με ισοϋψείς καμπύλες και ψηφιακό μοντέλο εδάφους.


    


    Oι δυνατότητες τις οποίες συγκεντρώνουν τα ψηφιακά μοντέλα εδάφους για την παρουσίαση, επεξεργασία και ανάλυση υψομετρικών δεδομένων τα καθιστούν απαραίτητο συστατικό ενός ολοκληρωμένου Συστήματος Γεωγραφικών Πληροφοριών. Σε ένα ΨΜΕ, σε κάθε σημείο με συντ/νες x,y, αντιστοιχεί μία τιμή της μεταβλητής z (υψόμετρο). Έτσι, το υψόμετρο μιας περιοχής μελέτης, θεωρείται ότι μεταβάλλεται χωρικά με συνεχή τρόπο. Θα πρέπει να σημειωθεί ότι κατακόρυφα πρανή και περιοχές με αρνητικές κλίσεις – οι οποίες στην πραγματικότητα είναι εξαιρετικά σπάνιες περιπτώσεις – δεν περιλαμβάνονται σε ένα ΨΜΕ αυτού του τύπου. Επιπρόσθετα σημειώνεται ότι, με ανάλογο τρόπο μοντελοποιούνται και άλλα φαινόμενα / μεταβλητές τα οποία μεταβάλλονται χωρικά με συνεχή τρόπο και τα οποία συνήθως αποδίδονται με τη χρήση ισοκαμπυλών (π.χ. ισοϋέτιες, ισόσειστες καμπύλες, κ.λ.π). Τα μοντέλα αυτά είναι γνωστά με την ονομασία 2.5D.
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    Σε ένα ψηφιακό μοντέλο εδάφους τα βασικά δεδομένα εισαγωγής είναι οι καταγραφές του υψομέτρου. Οι καταγραφές αυτές προέρχονται είτε από ψηφιακά δεδομένα (θεματικά επίπεδα Σ.Γ.Π, αρχεία ASCII κλπ), είτε από δεδομένα Τηλανίχνευσης - φωτογραμμετρικές αποδόσεις του αναγλύφου, δεδομένα radar, αλτιμέτρων κλπ - είτε από μετρήσεις πεδίου. Τα ιδιαίτερα χαρακτηριστικά αυτών των στοιχείων, όπως είναι η χωρική ακρίβεια απόδοσης, η ισοδιάσταση των υψομετρικών καμπυλών κλπ, συναρτώνται άμεσα με τις απαιτήσεις για την πιστότητα του μοντέλου, το είδος της εφαρμογής, καθώς και τους περιορισμούς του διαθέσιμου υλικού και λογισμικού.


    Εκτός από τα υψομετρικά δεδομένα, ο ακριβής υπολογισμός ψηφιακού μοντέλου εδάφους απαιτεί ακόμη και τις περιγραφές πρόσθετων δεδομένων τα οποία επηρεάζουν το σχήμα του αναγλύφου. Aυτά έχουν να κάνουν με δομικά στοιχεία που συνιστούν ανωμαλίες της συνεχούς επιφάνειας και είναι συνήθως το υδρογραφικό δίκτυο, τα ρήγματα, όρια λιμνών κλπ, τα οποία καλούνται γραμμές διακοπής του αναγλύφου (breaklines).
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    Από τις πρώτες δεκαετίες κατά τις οποίες προτάθηκαν από την επιστημονική κοινότητα τα ΨΜΕ (δεκαετίες ΄50 και ’60) μέχρι και σήμερα, έχουν χρησιμοποιηθεί αρκετά είδη ψηφιακών μοντέλων εδάφους. Οι διαφορές τους εντοπίζονται στη δομή αποθήκευσης και στον τρόπο διαχείρισης των δεδομένων. Στις μέρες μας χρησιμοποιούνται κυρίως δύο τύποι ψηφιακών μοντέλων εδάφους: τα ακανόνιστα τριγωνικά δίκτυα (Triangulated Irregular Network), και τα ψηφιακά υψομετρικά μοντέλα DEM (digital elevation matrices) (Li et al., 2004). Η πρώτη κατηγορία (ΤΙΝ), επειδή έχει ακανόνιστα πολυγωνικά αντικείμενα (τρίγωνα) ως δομικές μονάδες, έχει αντιστοιχίες με το διανυσματικό μοντέλο (vector), ενώ η δεύτερη κατηγορία ΨΜΕ (DEM), λόγω του ότι αποτελείται από στοιχειώδη ομοειδή αντικείμενα έχει αναλογίες με το ψηφιδωτό μοντέλο (raster).
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    Τα μοντέλα ΤΙΝ παριστούν τη συνεχή επιφάνεια σαν ένα σύνολο από τρίγωνα τα οποία έχουν για κορυφές σημεία με καθορισμένη τιμή της μεταβλητής Ζ (υψόμετρο) και συντ/νες Χ, Υ. Η δημιουργία των τριγώνων αυτών πρέπει να ικανοποιεί το κριτήριο Delaunay, σύμφωνα με το οποίο ο περιγεγραμμένος κύκλος στις κορυφές του τριγώνου, δε θα πρέπει να περιέχει άλλο σημείο. Μ’ αυτόν τον τρόπο όλοι οι κόμβοι συνδέονται με τους δύο πλησιέστερους. επίσης, η ικανοποίηση του κριτηρίου αυτού εξασφαλίζει τη μονοσήμαντη δημιουργία των τριγώνων, η οποία επιπλέον, δεν εξαρτάται από τη σειρά επεξεργασίας των δεδομένων (Σχήμα 5.5).
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    Σχήμα 5.5 Τριγωνισμός, σύμφωνος με το κριτήριο Delaunay.


    


    Τα στοιχεία ενός μοντέλου ΤΙΝ (Σχήμα 5.6)είναι τα παρακάτω:


    · Κόμβοι (Nodes): Είναι το βασικό στοιχείο του μοντέλου ΤΙΝ. Οι κόμβοι δημιουργούνται από τα δεδομένα εισαγωγής. Κάθε κόμβος είναι κορυφή τριγώνου και έχει μια τιμή Ζ της συνεχούς μεταβλητής, καθώς και συντεταγμένες Χ,Υ.


    · Πλευρές Τριγώνων (edges): Κάθε κόμβος συνδέεται με τους δύο πλησιέστερούς του σύμφωνα με το κριτήριο Delaunay. Κάθε πλευρά έχει δύο κόμβους, αλλά κάθε κόμβος μπορεί να ανήκει σε περισσότερες από δύο πλευρές.


    · Τρίγωνα (triangles): Κάθε τρίγωνο του μοντέλου περιγράφει ένα τμήμα της επιφάνειας. Είναι η στοιχειώδης δομική μονάδα και μπορεί να δώσει ποσοτικά στοιχεία σχετικά με την κλίση, τον προσανατολισμό, την επιφάνεια κ.λ.π. επίσης, ο συνδυασμός τριγώνων μπορεί να δώσει πληροφορίες σχετικές με τους όγκους, τις τομές επιφανειών, τις συνθήκες ορατότητας κ.λ.π.
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    Σχήμα 5.6 Τα βασικά στοιχεία του μοντέλου TIN.


    


    Η τοπολογική πληροφορία ενός μοντέλου ΤΙΝ περιλαμβάνει στοιχεία για κάθε τρίγωνό του (Σχήμα 5.7). Συγκεκριμένα, για κάθε τρίγωνο καταγράφονται:


    · ο αριθμός αναγνώρισής του


    · οι αριθμοί αναγνώρισης των γειτονικών του τριγώνων


    · οι τρεις κόμβοι του


    · οι συντεταγμένες χ, ψ των κόμβων του


    · οι τιμές της μεταβλητής Ζ για κάθε κόμβο


    · ο τύπος της κάθε πλευράς του


    · Γενικές πληροφορίες (μεταδεδομένα) οι οποίες αφορούν στις μονάδες μέτρησης, στο είδος της προβολής κ.λ.π.
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    Σχήμα 5.7 Δομή και τοπολογία του μοντέλου ΤΙΝ.


    


    [bookmark: _Toc438361190][bookmark: _Toc368154571]5.3.2 Ψηφιακά μοντέλα υψομέτρου ή Μοντέλα κανάβου (Digital ElevationModels / Matrices)


    Στα σημειακά μοντέλα υψομετρικών πινάκων, η συνεχής επιφάνεια παρίσταται σαν ένας κάναβος σημείων τα οποία ισαπέχουν και στα οποία αντιστοιχεί κάποια τιμή της μεταβλητής Ζ. Υπάρχει η δυνατότητα αντιστοίχισης μιας τιμής Ζ σ’ ένα σημείο του μοντέλου – συνήθως στο κέντρο βάρους - (μοντέλο lattice) ή σε μια στοιχειώδη επιφάνεια (μοντέλο grid). Γενικά, στα σημειακά μοντέλα υψομέτρων σημειώνονται τα παρακάτω στοιχεία:


    · κωδικοί αναγνώρισης των σημείων


    · συντεταγμένες Χ,Υ αρχικού σημείου αναφοράς σε πραγματικές μονάδες


    · απόσταση μεταξύ των σημείων σε πραγματικές μονάδες


    · αριθμός σημείων


    · πίνακας με τις τιμές της μεταβλητής Ζ για κάθε σημείο.


    


    Σημειώνεται ότι οι συντεταγμένες Χ,Υ αποθηκεύονται μόνο για το σημείο αναφοράς. Πρέπει να τονιστεί ότι, η αύξηση της ανάλυσης -διακριτική ικανότητα- (resolution) του μοντέλου μεγιστοποιεί και την ακρίβεια αναπαράστασης της φυσικής πραγματικότητας, αυξάνοντας όμως και τις απαιτήσεις για αποθήκευση των ψηφιακών δεδομένων (Σχήμα 5.8).
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    Σχήμα 5.8 Ανάλυση μοντέλου DEM.


    


    Η δομή των δεδομένων με τη μορφή πινάκων έχει αναλογίες με τις δομές αποθήκευσης των ηλεκτρονικών υπολογιστών. Για παράδειγμα, κάθε σημείο ενός Κανάβου υψομέτρων μπορεί να αποθηκευτεί στον ηλεκτρονικό υπολογιστή με τη χρήση τριών αριθμών, τις καρτεσιανές συντεταγμένες x, y, και την τιμή του υψομέτρου z. Έτσι, η διαχείριση των πινάκων υψομέτρων με τους ηλεκτρονικούς υπολογιστές είναι εύκολη και γρήγορη. Επίσης, η εφαρμογή ειδικών αλγορίθμων ανάλυσης και επεξεργασίας της πληροφορίας σχετικά με τα σημειακά ψηφιακά μοντέλα εδάφους, είναι πολύ εύκολη. Παρόλα αυτά, για την όσο το δυνατόν ακριβέστερη προσαρμογή των μοντέλων αυτών στις πραγματικές συνθήκες, απαιτείται πυκνό δίκτυο σημείων.


    Από την άλλη, στα μοντέλα ΤΙΝ, συνδυάζονται καλύτερα οι δομές της επιφάνειας με τις τριγωνικές μορφές του μοντέλου. Επίσης, παρέχεται πιστή απεικόνιση της τραχύτητας του ανάγλυφου. όμως, τα μοντέλα αυτά είναι πιο πολύπλοκα, απαιτούν ακριβή καταγραφή πολλών τοπολογικών σχέσεων και παρουσιάζουν αρκετές δυσκολίες στη διαχείριση. Άξιο αναφοράς είναι επίσης, ότι υπάρχουν αλγόριθμοι ανάλυσης οι οποίοι, ενώ εφαρμόζονται στα σημειακά μοντέλα, παρουσιάζουν τεχνικές δυσκολίες εφαρμογής στα μοντέλα ΤΙΝ. Δεν υπάρχει καθολική υπεροχή κάποιου είδους ψηφιακού μοντέλου εδάφους. Ο βαθμός καταλληλότητας κάθε δομής δεδομένων εξαρτάται από αρκετούς παράγοντες (π.χ την εφαρμογή, την επιθυμητή ακρίβεια κ.λ.π). Έτσι, αποκτά ιδιαίτερη σημασία η δυνατότητα μετατροπών από τη μια δομή στην άλλη και η ευελιξία του όλου υπολογιστικού συστήματος δόμησης των ψηφιακών μοντέλων εδάφους.


    Στο παρακάτω διάγραμμα παρουσιάζονται διαδικασίες υλοποίησης – ελέγχου – διορθώσεων ψηφιακών μοντέλων εδάφους, καθώς και μετατροπών μεταξύ των διαφόρων τύπων ΨΜΕ σε περιβάλλον συστήματος γεωγραφικών πληροφοριών (Σχήμα 5.9).
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    Σχήμα 5.9 Ροή δεδομένων για τη δημιουργία ΨΜΕ και τους μετασχηματισμούς μεταξύ διαφορετικών τύπων ΨΜΕ.


    


    [bookmark: _Toc438361191]5.4 Παρεμβολή


    Στα ψηφιακά μοντέλα εδάφους ευρύτατα χρησιμοποιούνται μέθοδοι παρεμβολής για την εκτίμηση του υψομέτρου σ’ όλα τα σημεία της περιοχής την οποία καταλαμβάνει το μοντέλο, ανεξάρτητα με το αν στα σημεία αυτά υπάρχουν ή όχι αρχικές μετρήσεις. Σε γενικές γραμμές, με τις μεθόδους παρεμβολής επιτυγχάνεται :


    · ο υπολογισμός της μεταβλητής z (υψόμετρο) σε ένα συγκεκριμένο σημείο


    · ο υπολογισμός της τιμής του υψομέτρου στα σημεία ενός κανονικού Κανάβου με βάση τις τιμές του υψομέτρου στα αρχικά σημεία δεδομένων


    · η πύκνωση ή και η αραίωση των κανάβων υψομέτρου


    Παρότι έχουν προταθεί πολλές μέθοδοι παρεμβολής, δεν υπάρχει κάποια η οποία να έχει γενική ισχύ. Η επιλογή της μεθόδου παρεμβολής για ένα ψηφιακό μοντέλο εδάφους αποτελεί συνάρτηση πολλών παραμέτρων (ποιότητα διαθέσιμης πληροφορίας, επιθυμητή ακρίβεια, χρόνος υλοποίησης, είδος εφαρμογής κλπ). Ακολουθούν δύο βασικές μέθοδοι παρεμβολής τιμών υψομέτρου σε τριγωνικό δίκτυο και σε ψηφιακό μοντέλο υψομέτρων.


    [bookmark: _Toc438361192][bookmark: _Toc368154573]5.4.1 Γραμμική Παρεμβολή (linear interpolation) σε μοντέλο ΤΙΝ


    Σύμφωνα με τη μέθοδο αυτή, η συνεχής επιφάνεια θεωρείται ότι αποτελείται από τρίγωνα τα οποία έχουν σταθερή κλίση. Το υψόμετρο του σημείου, στο οποίο επιχειρείται να υπολογιστεί η τιμή της μεταβλητής με παρεμβολή, εξαρτάται από το υψόμετρο των γειτονικών κόμβων του μοντέλου. Γι’ αυτόν τον υπολογισμό, αρχικά, θεωρείται μια κατακόρυφος στο επίπεδο το οποίο ορίζουν οι τρεις γειτονικοί κόμβοι του σημείου. Το ζητούμενο είναι η τιμή του υψομέτρου του σημείου τομής της κατακορύφου με το επίπεδο (Σχήμα 5.10). Η γενική εξίσωση για τη γραμμική παρεμβολή ενός σημείου (Χ,Ψ,Ζ) σε μια τριγωνική επιφάνεια είναι:
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    Σχήμα 5.10 Γραμμική παρεμβολή σε ΨΜΕ για τον υπολογισμό υψομέτρου. A,B,C,D είναι σταθερές που καθορίζονται από τις συντεταγμένες των κορυφών του τριγώνου.


    


    [bookmark: _Toc438361193][bookmark: _Toc368154574]5.4.2 Διγραμμική παρεμβολή (bilinear interpolation) σε μοντέλο DEM


    Με τη μέθοδο αυτή υπολογίζεται το υψόμετρο ενός σημείου από τα υψόμετρα των τεσσάρων πλησιέστερων σημείων του κανάβου, σε συνάρτηση και με την απόσταση από αυτά τα σημεία. Το παρακάτω σχήμα (Σχήμα 5.11) παρουσιάζει τον τρόπο υπολογισμού του υψομέτρου σε ένα σημείο με τη διγραμμική παρεμβολή.
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    Σχήμα 5.11 Διγραμμική παρεμβολή σε ΨΜΕ, όπου z : το ζητούμενο υψόμετρο, z1,z2,z3,z4,z13,z24 : τα υψόμετρα των κόμβων και των ενδιάμεσων σημείων, R : η ανάλυση (resolution) σε πραγματικές μονάδες, a, b : αποστάσεις του σημείου από τον κάναβο.


    


    [bookmark: _Toc438361194][bookmark: _Toc368154575]5.5 Εφαρμογές – Ανάλυση – Παρουσίαση


    Μετά τη δημιουργία του ψηφιακού μοντέλου εδάφους μπορεί να εξαχθούν από αυτό πολλά παράγωγα θεματικά επίπεδα. Παρακάτω, περιγράφονται συνοπτικά οι παραγόμενες πληροφορίες τις οποίες μπορούν να ληφθούν από ένα ψηφιακό μοντέλο εδάφους:


    · υπολογισμός - με παρεμβολή - τιμών υψομέτρου


    · δημιουργία ισοϋψών καμπυλών


    · υπολογισμός κλίσεων και προσανατολισμού


    · υπολογισμός εμβαδών και αποστάσεων στην περιοχή μελέτης


    · υπολογισμός όγκων


    · καθορισμός συνθηκών ορατότητας από ένα ή περισσότερα σημεία


    · τομές κατά μήκος επιφανειών


    · προσδιορισμός ιδιαίτερων μορφών του ανάγλυφου (υδροκρίτες, κοίτες κ.λ.π)


    · σκίαση του ανάγλυφου, με καθορισμό της θέσης της φωτεινής πηγής


    · δημιουργία αρχείων εικονικών πτήσεων – εικονικών διαδρομών


    [bookmark: _Toc438361195][bookmark: _Toc368154576]5.5.1 Υπολογισμός - με παρεμβολή - τιμών υψομέτρου


    Τέτοιοι υπολογισμοί γίνονται από όλα τα είδη DTM, με εντολές οι οποίες και χρησιμοποιούν την αντίστοιχη μέθοδο παρεμβολής του μοντέλου.


    [bookmark: _Toc438361196][bookmark: _Toc368154577]5.5.2 Δημιουργία ισοϋψών καμπυλών


    Η δημιουργία ενός ψηφιακού μοντέλου εδάφους, μας δίνει τη δυνατότητα παραγωγής ισάριθμων γραμμών που παριστούν τη συνεχή επιφάνεια του μοντέλου. Όταν η επιφάνεια είναι το ανάγλυφο, προκύπτουν οι ισοϋψείς καμπύλες. Επιλέγεται η επιθυμητή ισοδιάσταση των καμπυλών και ο υπολογισμός γίνεται αυτόματα με την εφαρμογή των καταλλήλων αλγορίθμων. Υπάρχει, επίσης, η δυνατότητα παραγωγής χαρτών με χρωματική απόδοση υψομετρικών ζωνών, από το ψηφιακό μοντέλο εδάφους,. Σημειώνεται ότι, οι παράγωγες ισοϋψείς καμπύλες αξιοποιούνται, μεταξύ άλλων, και για τον έλεγχο της πιστότητας του μοντέλου συγκρινόμενες με ισοϋψείς καμπύλες από τοπογραφικούς χάρτες.


    [bookmark: _Toc438361197][bookmark: _Toc368154578]5.5.3 Υπολογισμός κλίσης και προσανατολισμού του εδάφους


    Η δυνατότητα δημιουργίας παράγωγων θεματικών επιπέδων, συχνά αποτελεί κύριο λόγο για τη δημιουργία ενός ψηφιακού μοντέλου εδάφους. Η κλίση και ο προσανατολισμός του εδάφους μιας περιοχής είναι πληροφορίες οι οποίες είναι ιδιαίτερα χρήσιμες σε πληθώρα εφαρμογών. Ως κλίση (slope) μιας επιφάνειας, ορίζεται ο μέγιστος ρυθμός μεταβολής του υψομέτρου, υπολογίζεται δε, σε μοίρες ή σε ποσοστό επί τοις εκατό. Παρακάτω (Σχήμα 5.12), περιγράφεται ενδεικτικός αλγόριθμος ο οποίος χρησιμοποιείται για τον υπολογισμό της κλίσης :
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    Σχήμα 5.12 Υπολογισμός κλίσης εδάφους από ΨΜΕ.


    


    Ο προσανατολισμός ή έκθεση (aspect) μιας επιφάνειας αντιστοιχεί στη διεύθυνση κατά την οποία παρατηρείται ο μέγιστος ρυθμός μεταβολής του υψομέτρου και συνήθως μετριέται με το αζιμούθιο της διεύθυνσης αυτής, δηλ. σε μοίρες από 0 έως 360 κατά τη φορά του ρολογιού, με προσανατολισμό αναφοράς το Βορρά. Στο τριγωνικό μοντέλο ΤΙΝ, η κλίση και ο προσανατολισμός υπολογίζονται για κάθε τρίγωνο και ομαδοποιούνται σε μεγαλύτερες περιοχές, ανάλογα με τις απαιτήσεις του χρήστη, ώστε να παράγονται θεματικοί χάρτες (Σχήμα 5.13, Σχήμα 5.14). Στα σημειακά ψηφιακά μοντέλα εδάφους, ο υπολογισμός των μεγεθών αυτών γίνεται με την εφαρμογή των κατάλληλων αλγόριθμων παρεμβολής, στον πίνακα υψομέτρων.
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    Σχήμα 5.13 Χάρτης κλίσης εδάφους.


    


    [image: ][bookmark: _Toc368154579]


    Σχήμα 5.14 Χάρτης έκθεσης εδάφους.


    


    [bookmark: _Toc438361198]5.5.4 Υπολογισμός εμβαδών και αποστάσεων λαμβάνοντας υπόψη το ανάγλυφο


    Με τους κατάλληλους αλγόριθμους, οι οποίοι αξιοποιούν την πληροφορία του υψομέτρου από ένα ΨΜΕ, γίνεται ο υπολογισμός "πραγματικών" εμβαδών και αποστάσεων. Είναι φανερό, ότι οι τιμές των εμβαδών και των αποστάσεων που υπολογίζονται κατ' αυτόν τον τρόπο για πολύγωνα και γραμμές πάνω στο χάρτη, είναι μεγαλύτερες απ’ αυτές που υπολογίζονται από τους δυσδιάστατους χάρτες (εκτός από τις περιπτώσεις επίπεδων επιφανειών) και ανταποκρίνονται περισσότερο στην πραγματικότητα (Σχήμα 5.15).
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    Σχήμα 5.15 Πραγματική τοπογραφική επιφάνεια, σε σχέση με την προβολή της στο επίπεδο.


    [bookmark: _Toc438361199][bookmark: _Toc368154580]5.5.5 Υπολογισμός όγκων


    Μια ιδιαίτερα χρήσιμη δυνατότητα μετρήσεων από ένα ΨΜΕ, είναι αυτή του υπολογισμού του όγκου μεταξύ του ανάγλυφου και ενός καθορισμένου επιπέδου αναφοράς (Σχήμα 5.16). επίσης, είναι δυνατός ο υπολογισμός του όγκου που βρίσκεται μεταξύ δύο επιφανειών, οι οποίες καθορίζονται από το χρήστη (π.χ μεταξύ επιφάνειας υδροφόρου ορίζοντα και επιφάνειας αδιαπέρατου υποβάθρου).
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    [bookmark: _Toc368154581]Σχήμα 5.16 Πραγματικός υπολογισμός όγκων από ΨΜΕ. {base_value} : επίπεδο αναφοράς, ΖΜΙΝ : ελάχιστο υψόμετρο, ΖΜΑΧ: μέγιστο υψόμετρο.


    


    [bookmark: _Toc438361200]5.5.6 Ανάλυση συνθηκών ορατότητας από ένα ή περισσότερα σημεία


    Η βασική διαδικασία για την ανάλυση συνθηκών ορατότητας από ένα ψηφιακό μοντέλο εδάφους περιλαμβάνει τον καθορισμό της ύπαρξης οπτικής επαφής μεταξύ δύο σημείων εκείνου του παρατηρητή και αντίστοιχα του στόχου. Σημαντικό στοιχείο, επίσης, είναι η δυνατότητα ποσοτικοποίησης των συνθηκών ορατότητας (Chalkias et al., 2005). Έτσι, μπορούν να κατασκευαστούν χάρτες στους οποίους να παρουσιάζονται με τον κατάλληλο συμβολισμό, οι ορατές περιοχές από μια θέση παρατήρησης. Οι χάρτες αυτοί είναι ιδιαίτερα χρήσιμοι σε εφαρμογές χωροθετήσεων, καθώς συχνά είναι επιθυμητός ο προσδιορισμός των περιοχών που είναι (ή όχι) ορατές από συγκεκριμένα σημεία ειδικού ενδιαφέροντος, προσομοιώνοντας έτσι το αισθητικό κριτήριο. Για παράδειγμα, σε μια εφαρμογή χωροθέτησης αιολικού πάρκου, δεν είναι επιθυμητή η τοποθέτηση του πάρκου σε περιοχές ορατές από οικισμούς ή / και σημαντικούς αρχαιολογικούς χώρους (Σχήμα 5.17).
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    [bookmark: _Toc368154582]Σχήμα 5.17 Μοντελοποίηση συνθηκών ορατότητα από ένα ΨΜΕ.


    [bookmark: _Toc438361201]5.5.7 Δημιουργία μηκοτομών - τρισδιάστατων γραφημάτων (block diagrams)


    Η δημιουργία μηκοτομών της επιφάνειας του εδάφους, γίνεται καθορίζοντας τη γραμμή κατά μήκος της οποίας θα γίνει η τομή άμεσα ή από ένα θεματικό επίπεδο. Παρέχεται η δυνατότητα για μεμονωμένες τομές ή και για σειρά τομών. Η εμφάνιση δε αυτών των τομών, μπορεί να γίνει με μια ποικιλία μορφών (Σχήμα 5.18).
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    Σχήμα 5.18 Δημιουργία μηκοτομών από ΨΜΕ.


    


    Επίσης, παρέχεται η δυνατότητα παραγωγής εικόνων τρισδιάστατου πλέγματος από ψηφιακό μοντέλο εδάφους, καθώς και άλλων τύπων τρισδιάστατων γραφημάτων (Σχήμα 5.19).


    [bookmark: _Toc368154583][image: ]


    Σχήμα 5.19 Δημιουργία τρισδιάστατων απεικονίσεων από ΨΜΕ.


    [bookmark: _Toc438361202]5.5.8 Καθορισμός ειδικών γεωμορφών


    Έχουν αναπτυχθεί αρκετοί αλγόριθμοι, οι οποίοι επιτρέπουν τον αυτόματο υπολογισμό ιδιαίτερων μορφών του ανάγλυφου, όπως μορφολογικών ορίων, σημείων ιδιαίτερης σημασίας για το μοντέλο (Very Important Points) τοπικού μέγιστου και ελάχιστου υψόμετρου, υδρολογικών στοιχείων (λεκάνες απορροής, ρέματα, υδροκρίτες) κ.λ.π. Τα υδρολογικά στοιχεία επιφανείας - λεκάνες απορροής και υδατορέματα - υπολογίζονται αυτόματα, είτε από μοντέλα ΤΙΝ, είτε συνηθέστερα από τα δεδομένα ψηφιακών μοντέλων υψομέτρων DEM (Σχήμα 5.20).
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    Σχήμα 5.20 Προσδιορισμός υδρολογικών λεκανών και υδρογραφικού δικτύου από ΨΜΕ.


    [bookmark: _Toc438361203]5.5.9 Σκίαση του ανάγλυφου (hillshading) με καθορισμό της θέσης της φωτεινής πηγής


    Είναι δυνατή η σκίαση της επιφάνειας με τρόπο ο οποίος καθορίζεται, ανάλογα με την εφαρμογή. Η σκίαση αυτή είναι ιδιαίτερα χρήσιμη για την παρουσίαση της υψομετρικής πληροφορίας η οποία λαμβάνεται από το μοντέλο (Horn, 1981). Για τη δημιουργία χάρτη σκίασης ανάγλυφου, οι παράμετροι που καθορίζονται είναι:


    · η θέση του παρατηρητή


    · η θέση του στόχου παρατήρησης


    · η ακριβής θέση της φωτεινής πηγής


    Τα χαρακτηριστικά της σκίασης (τόνοι σκιών, γωνία φωτισμού κλπ) υπολογίζονται για κάθε δομικό στοιχείο του μοντέλου και ομαδοποιούνται σε μεγαλύτερες περιοχές (Σχήμα 5.21).
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    Σχήμα 5.21 Χάρτης σκιασμένου ανάγλυφου από ΨΜΕ (θέση φωτεινής πηγής: ΒΔ, ύψος: 40°.


    


    [bookmark: _Toc438361204]5.5.10 Υπέρθεση εικόνων τηλεπισκόπησης και θεματικών επιπέδων σε ΨΜΕ (Drapping)


    Με τη διαδικασία αυτή, θεματικά επίπεδα χωρικών πληροφοριών και εικόνες τηλεπισκόπησης είναι δυνατόν να παρουσιάζονται, με υπέρθεση, πάνω στο ψηφιακό μοντέλο εδάφους της περιοχής στην οποία αναφέρονται (Fisher & Unwin, 2002). Επιπρόσθετα, μπορεί να υλοποιηθεί προεκβολή γεωγραφικών οντοτήτων με βάση το ύψος τους. Για παράδειγμα, με αυτόν τον τρόπο, έχοντας την κάτοψη ενός κτιρίου είναι δυνατόν να οπτικοποιηθεί μια τρισδιάστατη απεικόνισή του, με καθορισμό του ύψους του κτιρίου. Η τεχνική αυτή είναι ιδιαίτερα χρήσιμη για τη δημιουργία ρεαλιστικών απεικονίσεων (Llobera, 2003) (Σχήμα 5.22).


    


    [image: ]


    Σχήμα 5.22 Οπτικοποίηση εικόνας τηλεπισκόπησης και θεματικού επιπέδου κτιρίων, με υπέρθεση και προεκβολή των κτιρίων πάνω σε ψηφιακό μοντέλο εδάφους (Πηγή: Google Earth).


    


    Συμπερασματικά, τα ψηφιακά μοντέλα αποτελούν ιδιαίτερα σημαντικά εργαλεία αποτίμησης και ανάλυσης της επιφάνειας του εδάφους, αλλά και αναπαράστασης – χαρτογραφικής της απόδοσης. Τα τυπικά εξαγόμενα δεδομένα από ένα ΨΜΕ, όπως χάρτες κλίσεων και προσανατολισμού, καθώς και η ανάλυση συνθηκών ορατότητας, είναι ιδιαίτερα χρήσιμα σε πληθώρα εφαρμογών. Οι χάρτες σκιασμένου ανάγλυφου και τα προοπτικά γραφήματα,- σε συνδυασμό μάλιστα και με δεδομένα τηλεπισκόπησης-, αποδίδουν ιδιαίτερα παραστατικά την επιφάνεια της γης, αποτελώντας σημαντικά επικουρικά στοιχεία για την εκτίμηση του τοπίου.


    Τέλος, ιδιαίτερης αξίας για τη συσχέτιση της πληροφορίας της μεταβλητής που αναπαρίσταται με άλλες θεματικές πληροφορίες της περιοχής μελέτης, είναι τα ποσοτικά εξαγόμενα από τα μοντέλα. Η σπουδαιότητα και ο ρόλος τους στην προσπάθεια αξιολόγησης και ανάλυσης του φυσικού περιβάλλοντος αναβαθμίζεται, όταν συνδυάζονται με άλλες γεωγραφικές πληροφορίες. Γι’ αυτόν ακριβώς το λόγο πρέπει να θεωρούνται αναπόσπαστο τμήμα ενός ολοκληρωμένου ΓΠΣ. Σημαντική ιδιότητα του ΓΠΣ, θα πρέπει να θεωρείται τόσο η υποστήριξη των δύο βασικών τύπων ψηφιακών μοντέλων εδάφους (TIN, DEM) όσο και οι δυνατότητες μετατροπών από τον ένα τύπο στον άλλο.


    


    [bookmark: _Hlk422211741][bookmark: _Toc438361205]5.6 Εργασία με ΨΜΕ σε περιβάλλον λογισμικού GIS


    Στη συνέχεια, θα παρουσιαστούν οι δυνατότητες εργασίας με ΨΜΕ, σε περιβάλλον λογισμικού GIS και συγκεκριμένα, στο διαδεδομένο λογισμικό ArcGIS της ESRI. Στο λογισμικό αυτό, έπειτα από τις επεκτάσεις 3d Analyst και Spatial Analyst, παρέχονται αρκετές δυνατότητες δημιουργίας και αξιοποίησης ψηφιακών μοντέλων εδάφους – διαφόρων τύπων – οι οποίες και αναπτύσσονται παρακάτω. Θα πρέπει να σημειωθεί ότι, παρότι η αναφορά σε συγκεκριμένες λειτουργίες του λογισμικού γίνεται για την έκδοση ArcGIS 9.x, η βασική λειτουργικότητα είναι παρόμοια και για τις μεταγενέστερες εκδόσεις του ArcGIS (εκδόσεις 10.x).


    [bookmark: _Toc438361206]5.6.1 Μοντέλα ΤΙΝ στο ArcGIS


    Τα μοντέλα ΤΙΝ παριστούν τη συνεχή επιφάνεια σαν ένα σύνολο από τρίγωνα τα οποία έχουν για κορυφές σημεία με γνωστό υψόμετρο και συντεταγμένες Χ, Υ. Τα δεδομένα τύπου ΤΙΝ, εισάγονται άμεσα στο ArcGIS και μπορούν να απεικονιστούν με διάφορους τρόπους. Τα μοντέλα αυτά δομούνται από τρίγωνα, τα οποία με τη σειρά τους δημιουργούνται από κορυφές και πλευρές. Τα ΤΙΝ είναι δυνατό να περιέχουν γραμμές διακοπής (breaklines), οι οποίες αντιστοιχούν σε γραμμικές οντότητες, οι οποίες με τη σειρά τους διαδραματίζουν σημαντικό ρόλο στον καθορισμό της επιφάνειας. Παραδείγματα τέτοιων γραμμικών οντοτήτων, αποτελούν τα ρήγματα και τα υδατορέματα.


    Είναι δυνατή η απεικόνιση ενός μόνο τύπου δομικών στοιχείων του ΤΙΝ (π.χ. μόνο τις κορυφές των τριγώνων) ή όλων των τύπων, όπως επίσης και ο συμβολισμός τους με διαφορετικούς τρόπους. Μετά την εισαγωγή του μοντέλου ΤΙΝ στον πίνακα περιγραφών με δεξί κλικ > properties > symbology πάνω στο επίπεδο ΤΙN, εμφανίζεται το παρακάτω παράθυρο επιλογών (Σχήμα 5.23).
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    Σχήμα 5.23 Διαχείριση μοντέλου ΤΙΝ σε περιβάλλον ArcGIS.


    


    Η επιλογή Edge Types, σχετίζεται με τα γραμμικά χαρακτηριστικά του TIN και η επιλογή Elevation με τον τρόπο παρουσίασης των τριγωνικών επιφανειών. Έτσι, γίνεται η επιλογή της εμφάνισης ή όχι των γραμμών διακοπής και των πλευρών των τριγώνων, της παλέτας αντιστοίχισης χρωμάτων – υψομέτρων, ο αριθμός υψομετρικών ζωνών κ.λ.π. Επίσης, με την επιλογή Show hillshade Illumination, απεικονίζονται τα τρίγωνα του μοντέλου με φωτοσκίαση, η οποία δίνει την αίσθηση της τρίτης διάστασης. Με τη χρήση της επέκτασης ArcScene, η οποία αποτελεί τμήμα της επέκτασης 3d Analyst, μπορεί να παρουσιαστεί ένα ψηφιακό μοντέλο εδάφους σε τρισδιάστατο γράφημα (Σχήμα 5.24).
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    Σχήμα 5.24 Τρισδιάστατο γράφημα οπτικοποίησης ΨΜΕ μέσα από το υποπρόγραμμα ArcScene.


    


    Η απεικόνιση των τριγώνων μπορεί να γίνει -εκτός από υψομετρικές ζώνες- και με άλλους τρόπους, όπως για παράδειγμα με την επιλογή add από το Layer > Properties > Symbology (Σχήμα 5.25).
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    Σχήμα 5.25 Οπτικοποίηση μοντέλου ΤΙΝ με χρωματική διαβάθμιση ανά ζώνη έκθεσης.


    [bookmark: _Toc438361207]5.6.2 Μοντέλα DEM στο ArcGIS


    Στα μοντέλα αυτού του τύπου, η επιφάνεια του εδάφους μοντελοποιείται με Κάναβο σημείων τα οποία ισαπέχουν και στα οποία αντιστοιχεί τιμή της μεταβλητής Ζ. Υπάρχει η δυνατότητα αντιστοίχισης μιας τιμής Ζ σ’ ένα σημείο του Κανάβου – συνήθως στο κέντρο βάρους - (μοντέλο lattice) ή σε μια στοιχειώδη επιφάνεια (μοντέλο grid). Γενικά, στα σημειακά μοντέλα πινάκων εμφανίζονται τα παρακάτω στοιχεία:


    · συντεταγμένες Χ,Υ αρχικού σημείου αναφοράς σε πραγματικές μονάδες


    · απόσταση μεταξύ των σημείων σε πραγματικές μονάδες (μέγεθος ψηφίδας)


    · αριθμός σημείων (αριθμός στηλών, αριθμός γραμμών)


    · πίνακας με τις τιμές της μεταβλητής Ζ (υψομέτρου) για κάθε σημείο.


    Σημειώνεται ότι οι συντεταγμένες Χ,Υ αποθηκεύονται μόνο για το σημείο αναφοράς. Παρακάτω παρουσιάζονται οι βασικές ιδιότητες ενός επιπέδου DEM μέσα από το λογισμικό ArcGIS (Σχήμα 5.26).
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    Σχήμα 5.26 Ιδιότητες επιπέδου DEM.


    


    Η χρήση των επεκτάσεων Spatial analyst και 3dAnalyst στο λογισμικό ArcGIS, επιτρέπει την απόδοση και αξιοποίηση δεδομένων αυτού του τύπου (δεδομένα DEM). Η οπτικοποποίηση των δεδομένων DEM που απεικονίζουν συνεχείς επιφάνειες, μπορεί να γίνει είτε με την απεικόνιση σε κατηγορίες τιμών είτε με συνεχή χρωματική διαβάθμιση (stretching) των τιμών υψομέτρου.


    Η ταξινόμηση σε ομάδες τιμών γίνεται με τον καθορισμό του πλήθους των ομάδων, των ορίων της κάθε κατηγορίας καθώς και του τρόπου απόδοσης κάθε κατηγορίας, συνήθως με διαφορετικό χρώμα μέσα από μια μεγάλη γκάμα διαθέσιμων παλετών απόδοσης του υψομέτρου (Σχήμα 5.27).
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    Σχήμα 5.27 Συμβολισμός μοντέλου DEM σε ζώνες υψομέτρων.


    


    Το αποτέλεσμα είναι η απόδοση του ανάγλυφου σε χρωματικές ζώνες, αφού κάθε ψηφίδα απεικονίζεται με το χρώμα που αντιστοιχεί στην κατηγορία τιμών υψομέτρου στην οποία ανήκει. Η απεικόνιση αυτή μπορεί να γίνει πολύ παραστατική με την προσθήκη φωτοσκίασης (hillshade), όπως στο παρακάτω σχήμα (χάρτης δεξιά) (Σχήμα 5.28).


    [image: ]


    [bookmark: _Hlk422211685]Σχήμα 5.28 Χαρτογραφική απεικόνιση ΨΜΕ με χρωματικές ζώνες σε συνδυασμό με σκιασμένο ανάγλυφο.


    


    Η απεικόνιση ψηφιακών μοντέλων υψομέτρου (Σχήμα 5.29) τα οποία αναπαριστούν συνεχείς επιφάνειες με συνεχή χρωματική παλέτα (όχι κατηγοριοποίηση τιμών, όπως πριν), γίνεται ως εξής:


    · Δεξί κλικ στον πίνακα περιγραφών του επιπέδου όπου πραγματοποιείται η απεικόνιση, με συνεχή παλέτα χρωμάτων


    · Κλικ στην επιλογή symbology


    · Κλικ στην επιλογή Stretched


    · Επιλογή χρωματικής παλέτας


    · Επιλογή ΟΚ
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    [bookmark: _Hlk422215680]Σχήμα 5.29 Απεικόνιση ΨΜΕ με συνεχή χρωματική παλέτα, (τόνοι του γκρι).
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    [bookmark: _Toc438361209]Κριτήρια Αξιολόγησης


    [bookmark: _Toc438361210]Κριτήριο Αξιολόγησης 1 - ΑΣΚΗΣΗ


    


    Για την περιοχή μελέτης (ν. Ανάφη), ζητείται να χαρτογραφηθούν οι περιοχές οι οποίες συγκεντρώνουν τα παρακάτω χαρακτηριστικά:


    1. Βρίσκονται σε σημεία με κλίση < 30º


    2. Έχουν Νότιο προσανατολισμό


    3. Δεν είναι ορατές από τον βασικό οικισμό (Χώρα) και από την κύρια παραλία του νησιού.


    4. Απέχουν περισσότερο από 1.25 Km από την ακτογραμμή.


    


    Ο προσδιορισμός των περιοχών αυτών θα αξιοποιηθεί σε προκαταρτική μελέτης χωροθέτησης αιολικού πάρκου. Για την ολοκλήρωση της άσκησης δίνονται τα θεματικά επίπεδα για τις ισοϋψείς καμπύλες, τα υψομετρικά σημεία, τις θέσεις του οικισμού και της παραλίας και το όριο της περιοχής μελέτης (ν. Ανάφη). Τα δεδομένα αυτά προέρχονται από το χάρτη γενικής χρήσης της ΓΥΣ κλίμακας 1:50.000 (σύστημα γεωαναφοράς: ΕΓΣΑ 87).


    


    Το αποτέλεσμα θα πρέπει να παρουσιαστεί σε χάρτη, σε συνδυασμό με το χάρτη σκιασμένου ανάγλυφου της περιοχής μελέτης καθώς και σε προοπτικό 3δ διάγραμμα.


    


    [bookmark: _Toc438361211]ΕΠΙΛΥΣΗ


    


    [bookmark: _Toc438361212]Αρχικές ενέργειες – Εισαγωγή των αρχικών δεδομένων


    


    Τα δεδομένα της άσκησης (τα οποίο και δίνονται) είναι τα παρακάτω θεματικά επίπεδα (με τη μορφή Shapefile):


    α) ισοϋψείς καμπύλες (επίπεδο ContourLines - γραμμικά δεδομένα)


    β) υψομετρικά σημεία (επίπεδο Elevations - σημειακά δεδομένα)


    γ) οι θέσεις του οικισμού και της παραλίας (επίπεδο Points of Interest - σημειακά δεδομένα)


    δ) το περίγραμμα της περιοχής μελέτης (επίπεδο LAND - πολυγωνικά δεδομένα)


    Μετά την αποθήκευση των δεδομένων στον τοπικό δίσκο και την εκκίνηση του λογισμικού ArcMap, [bookmark: _Hlk422215735]ακολουθεί η εισαγωγή των αρχικών θεματικών επιπέδων σε περιβάλλον ArcMap με την εντολή File > Add Data και την κατάδειξη των θεματικών επιπέδων LAND, PointofInterest, ContourLines και Elevations, στο δένδρο δεδομένων εισαγωγής. Το αποτέλεσμα αυτής της ενέργειας είναι η εμφάνιση των αρχικών δεδομένων σε περιβάλλον ArcMap (Σχήμα 5.30).
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    Σχήμα 5.30 Τα αρχικά δεδομένα (παρουσίαση σε περιβάλλον ArcMap).


    


    Στη συνέχεια, θα πρέπει να ενεργοποιηθούν οι επεκτάσεις 3d Analyst και Spatial Analyst (μενού Tools > Extensions και επιλογή των δύο αυτών επεκτάσεων). Κατόπιν, καθορίζονται οι παράμετροι της ανάλυσης στο spatial analyst (Spatial Analyst > Options) ως εξής:


    · Analysis Extend : Same as LAND


    · Analysis Mask: Same as Land


    · Cell Size: 30 m


    Με την ενέργεια αυτή καθορίζονται τα χαρακτηριστικά όλων των παραγόμενων θεματικών επιπέδων, τύπου GRID, μέσα από την ανάλυση με την επέκταση Spatial Analyst. Έτσι, τα όρια (extend) κάθε παραγόμενου επιπέδου, δηλαδή το ελάχιστο περιβάλλον –ορθογώνιο- καθορίζεται από τις ελάχιστες και μέγιστες Χ και Υ συντεταγμένες του επιπέδου LAND. Η ανάλυση θα περιορίζεται μόνο στην ξηρά (επιλογή Mask με το επίπεδο LAND) και το μέγεθος της ψηφίδας των παραγόμενων καθορίζεται να είναι 30m. Η τελευταία αυτή επιλογή είναι σε άμεση συνάρτηση με την κλίμακα των αρχικών δεδομένων.


    


    [bookmark: _Toc438361213]Δημιουργία – παρουσίαση ΨΜΕ


    Μετά την εισαγωγή των αρχικών δεδομένων στο ArcMap και την ενεργοποίηση / αρχική παραμετροποίηση των επεκτάσεων 3d Analyst και Spatial Analyst, σειρά έχει η δημιουργία του ΨΜΕ της περιοχής μελέτης. Το ArcGIS παρέχει αλγόριθμους δημιουργίας τόσο μοντέλων τύπου ΤΙΝ όσο και DEM. Στην εφαρμογή που παρουσιάζεται εδώ, εκτελείται η εντολή Topo to Raster,η οποία αξιοποιεί έναν αλγόριθμο ειδικά σχεδιασμένο για δημιουργία ΨΜΕ τύπου DEM, από θεματικά επίπεδα τοπογραφικού χάρτη. Η δυνατότητα αυτή ενεργοποιείται από το υποπρόγραμμα ArcToolbox > Spatial Analyst Tools> Interpolation > Topo to Raster, μέσω του οποίου προσδιορίζονται τα δεδομένα εισόδου για τη δημιουργία του ΨΜΕ της περιοχής (Σχήμα 5.31).
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    Σχήμα 5.31 Δημιουργία ΨΜΕ τύπου DEM με το εργαλείο Topo to Raster σε περιβάλλον ArcGIS.


    


    Ο αλγόριθμος αυτός, αξιοποιεί θεματικά επίπεδα τα οποία περιλαμβάνουν πληροφορίες για το ανάγλυφο της περιοχής μελέτης. Τα επίπεδα αυτά για την περιοχή μελέτης είναι: α) το επίπεδο elevations (υψομετρικά σημεία με καταγραφή του υψομέτρου στο πεδίο elev) β) το επίπεδο contourLines (ισοϋψείς καμπύλες με καταγραφή του υψομέτρου στο πεδίο elev) και γ) το επίπεδο Land (όριο του μοντέλου, χωρίς καταγραφή υψομέτρου). Η εφαρμογή του αλγορίθμου έχει ως αποτέλεσμα τη δημιουργία του DEM της περιοχής μελέτης το οποίο φαίνεται στο παρακάτω σχήμα (Σχήμα 5.32).
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    Σχήμα 5.32 ΨΜΕ τύπου DEM για τη ν. Ανάφη ως αποτέλεσμα της εφαρμογής του εργαλείου Topo to Raster σε περιβάλλον ArcGIS.


    


    Για την καλύτερη αναπαράσταση του ανάγλυφου μπορεί να συνδυαστεί ο παραπάνω χάρτης με το χάρτη σκιασμένου αναγλύφου (Hillshade map). Αρχικά, δημιουργείται ο χάρτης αυτός με το εργαλείο Spatial Analyst > Surface Analysis > Hillshade. Εδώ, ο χρήστης μπορεί να προσδιορίσει τη θέση της φωτεινής πηγής εισάγοντας αζιμούθιο και ύψος. Το αποτέλεσμα της ενέργειας αυτής - διατηρώντας την προκαθορισμένη θέση της φωτεινής πηγής - φαίνεται στο παρακάτω σχήμα (Σχήμα 5.33).


    [image: ]


    Σχήμα 5.33 Χάρτης σκιασμένου ανάγλυφου (Hillshade Map) ν. Ανάφης.


    


    Με την εφαρμογή του εφέ διαφάνειας (εργαλειομπάρα Εffect > Τransparency) στο επίπεδο Hillshade μπορεί να οπτικοποιηθεί το ανάγλυφο με συνδυασμό χρωματικών ζωνών και σκίασης (Σχήμα 5.34).
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    Σχήμα 5.34 Χάρτης σκιασμένου ανάγλυφου σε συνδυασμό με χρωματικές ζώνες.


    


    


    


    [bookmark: _Toc438361214]Δημιουργία παραγόμενων θεματικών επιπέδων από ανάλυση ΨΜΕ


    Το επόμενο βήμα για την υλοποίηση της άσκησης σχετίζεται με τη δημιουργία των δευτερογενών επιπέδων κλίσης, έκθεσης και συνθηκών ορατότητας από το ΨΜΕ. Τα επίπεδα αυτά δημιουργούνται με τα εργαλεία Slope, Aspect και Viewshed αντίστοιχα, κάτω από το μενού Spatial Analyst > Surface Analysis (Σχήμα 5.35).
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    Σχήμα 5.35 Χάρτες κλίσης και έκθεσης του εδάφους. Στον πάνω χάρτη με κόκκινο χρώμα απεικονίζονται οι απότομες κλίσεις του εδάφους και με πράσινο, οι ήπιες. Στον κάτω χάρτη, με αποχρώσεις του κόκκινου εμφανίζονται οι βόρειες εκθέσεις με αποχρώσεις του κίτρινου οι ανατολικές, με αποχρώσεις του γαλάζιου οι νότιες και με αποχρώσεις του μωβ οι δυτικές εκθέσεις.


    


    Για την κατασκευή του χάρτη ορατότητας από συγκεκριμένα σημεία παρατήρησης (οικισμός και κύριες παραλίες του νησιού), αξιοποιείται το εργαλείο Spatial Analyst > Surface Analysis > Viewshed. Για την εκτέλεση του αλγόριθμου θα πρέπει να προσδιοριστεί το ΨΜΕ της περιοχής μελέτης, καθώς και τα σημεία παρατήρησης. Στην περίπτωση της άσκησης, τα σημεία αυτά έχουν καταγραφεί στο θεματικό επίπεδο Points Of Interest. Το αποτέλεσμα είναι η δημιουργία χάρτη στον οποίο παρουσιάζονται οι περιοχές που είναι (ή όχι) ορατές από τα σημεία παρατήρησης (Σχήμα 5.36).
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    Σχήμα 5.36 Χάρτης ορατότητας από τα σημεία παρατήρησης. Οι πράσινες περιοχές είναι οι ορατές, ενώ οι κόκκινες περιοχές δεν έχουν οπτική επαφή με τα σημεία παρατήρησης.


    


    Μετά τη δημιουργία των δευτερογενών παραγόμενων από το ΨΜΕ, σειρά έχει η δημιουργία των επιπέδων –κριτηρίων, τα οποία στην ουσία αντιστοιχούν σε επαναταξινομήσεις των παραγομένων χαρτών κλίσης έκθεσης και ορατότητας. Έτσι, δημιουργούνται νέα θεματικά επίπεδα, εντολή Spatial Analyst > Reclassify με βάση τις παρακάτω ταξινομήσεις: α) Στο επίπεδο Reclas_Slope, τιμή 1 για κλίσεις < 30º και τιμή 0 για τις υπόλοιπες, στο επίπεδο Reclas_Aspect, τιμή 1 για εκθέσεις στο διάστημα 135 – 225 και τιμή 0 για τις υπόλοιπες, και στο επίπεδο Reclas_Viewshed, τιμή 1 για τις μη ορατές και τιμή 0 για τις ορατές περιοχές από τα σημεία ενδιαφέροντος. Μ’ αυτόν τον τρόπο στα επαναταξινομημένα επίπεδα, οι τιμές 1 αντιστοιχούν στις περιοχές με σχετικά ήπιες κλίσεις, νότια έκθεση και μη ορατές από τη Χώρα και τις παραλίες (Σχήμα 5.37, Σχήμα 5.38).
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    Σχήμα 5.37 Επαναταξινομημένο επίπεδο κλίσης. Οι περιοχές με πράσινο χρώμα αντιστοιχούν σε κλίσεις < 30º.
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    Σχήμα 5.38 Επαναταξινομημένο επίπεδο εκθέσεων. Οι περιοχές με κίτρινο χρώμα αντιστοιχούν σε νότιες εκθέσεις.


    


    Σ’ αυτό το σημείο δημιουργείται και ο χάρτης – κριτήριο της απόστασης από την ακτογραμμή. Για το σκοπό αυτό αρχικά εκτελείται η εντολή Spatial Analyst > Distance > Straight line στην οποία επιλέγεται ευθεία απόσταση από τις ισοϋψείς (στις οποίες έχει προηγηθεί η επιλογή η ισοϋψής με υψόμετρο 0). Το αποτέλεσμα από την εκτέλεση αυτής της εντολής είναι η δημιουργία του επιπέδου απόστασης από την ακτογραμμή. Στη συνέχεια, με την εντολή επαναταξινόμησης δημιουργείται ο χάρτης – κριτήριο απόστασης από την ακτή Recl_DistanceToCoast με τιμή 1 για απόσταση > 1250 και τιμή 0 για απόσταση < 1250 (Σχήμα 5.39).
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    Σχήμα 5.39 Επαναταξινομημένο επίπεδο απόστασης από την ακτογραμμή. Οι περιοχές με κίτρινο χρώμα απέχουν < 1250 από την ακτογραμμή.


    


    [bookmark: _Toc438361215]Σύνθεση δεδομένων


    Η τελική φάση ανάλυσης των δεδομένων περιλαμβάνει την εύρεση των περιοχών στη ν. Ανάφη, οι οποίες συγκεντρώνουν συνδυαστικά το σύνολο των κριτηρίων που αναπτύχθηκαν στην προηγούμενη παράγραφο. Αυτό καθίσταται δυνατόν με τη χρήση του εργαλείου Raster Calculator (μενού Spatial Analyst > Raster Calculator) και την εισαγωγή της παρακάτω συνθήκης επιλογής δεδομένων με τη χρήση της Άλγεβρας μεταξύ χαρτων (Map Algebra). Στο παρακάτω σχήμα, φαίνεται η σύνταξη αυτής της τοπικής λειτουργίας ανάλυσης ψηφιδωτών δεδομένων μέσα από το εργαλείο Raster Calculator του ArcGIS (Σχήμα 5.40).
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    Σχήμα 5.40 Σύνθεση κριτηρίων με το εργαλείο Spatial Analyst > Raster Calculator.


    


    Το παραγόμενο από την ενέργεια που παρουσιάστηκε παραπάνω, είναι ένα ψηφιδωτό θεματικό επίπεδο στο οποίο οι ψηφίδες με τιμή 1 αντιστοιχούν σε περιοχές οι οποίες συγκεντρώνουν το σύνολο των επιθυμητών κριτηρίων. Οι περιοχές αυτές φαίνονται στον επόμενο χάρτη με κόκκινο χρώμα (Σχήμα 5.41).
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    Σχήμα 5.41 Τελικός χάρτης στον οποίο φαίνονται με κόκκινο χρώμα οι περιοχές οι οποίες συγκεντρώνουν το σύνολο των επιθυμητών κριτηρίων. Έχει χρησιμοποιηθεί και η τεχνική του εφέ διαφάνειας, για την ταυτόχρονη παρουσίαση και του επιπέδου σκίασης του ανάγλυφου.


    


    Από τον πίνακα περιγραφών του παραγόμενου επιπέδου (σύνθεση κριτηρίων) φαίνεται ότι 1849 ψηφίδες σε σύνολο 42743 έχουν την τιμή 1, δηλαδή συγκεντρώνουν το σύνολο των επιθυμητών κριτηρίων. Απ’ αυτό συνάγεται ότι ~ 1,7 τετραγωνικά χιλιόμετρα (1840 Χ 30μ Χ 30μ) ή 4,3 % της έκτασης της Ανάφης συγκεντρώνει το σύνολο των επιθυμητών κριτηρίων (Σχήμα 5.42).
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    Σχήμα 5.42 Πίνακας περιγραφών παραγόμενου επιπέδου.


    


    Τέλος, για την παρουσίαση του τελικού σύνθετου χάρτη με τη μορφή προοπτικού γραφήματος, χρησιμοποιείται η εφαρμογή ArcScene του λογισμικού ArcGIS. Μετά το άνοιγμα της εφαρμογής (το οποίο μπορεί να γίνει και μέσα από την επέκταση 3d Analyst), εισάγεται (με την επιλογή File > Add Data) το τελικό παραγόμενο ψηφιδωτό επίπεδο (Σχήμα 5.43).
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    Σχήμα 5.43 Το περιβάλλον ArcScene.


    


    Με την ενέργεια αυτή παρουσιάζεται σε προοπτικό γράφημα το τελικό παραγόμενο επίπεδο, αλλά δεν εμφανίζονται οι υψομετρικές διαφορές, καθώς όλο το νησί τοποθετείται σε υψόμετρο 0. Με δεξί κλικ πάνω στο θεματικό επίπεδο και με την επιλογή Properties > Base Heights, εμφανίζεται το παρακάτω παράθυρο από το οποίο μπορούν να ρυθμιστούν οι παράμετροι εμφάνισης του θεματικού επιπέδου. Εδώ, στην επιλογή Height επιλέγεται η δυνατότητα λήψης υψομέτρων από άλλο επίπεδο και καθορίζεται ως τέτοιο επίπεδο το ΨΜΕ της Ανάφης. Επίσης, στην επιλογή Z Unit Conversion εισάγεται η τιμή 2. έτσι ώστε, να δωθεί έμφαση στην 3δ απεικόνιση των δεδομένων. Η ενέργεια αυτή πρακτικά σημαίνει ότι τα δεδομένα θα παρουσιαστούν με το διπλάσιο υψόμετρο από το πραγματικό τους (Σχήμα 5.44).
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    Σχήμα 5.44 Καθορισμός παραμέτρων 3d οπτικοποίησης.


    


    Η εφαρμογή όλων των παραπάνω παραμέτρων παρουσίασης του τελικού θεματικού επιπέδου έχει ως αποτέλεσμα τη δημιουργία του 3δ προοπτικού γραφήματος το οποίο παρουσιάζεται παρακάτω (Σχήμα 5.45).
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    Σχήμα 5.45 Οπτικοποίηση αποτελεσμάτων από το υποπρόγραμμα ArcScene .


    


    [bookmark: _Toc438361216]Κριτήριο Αξιολόγησης 2 – Ερωτήσεις Κατανόησης


    · Ποια η διαφορά των Ψηφιακών Μοντέλων Υψομέτρου από τα Ψηφιακά Μοντέλα Επιφανειών


    · Με ποιους εναλλακτικούς τρόπους κατασκευάζεται ένα Ψηφιακό Μοντέλο Εδάφους;


    · Ποιοι είναι οι κύριοι τύποι Ψηφιακών Μοντέλων εδάφους και ποια είναι η βασική διαφορά τους;


    · Τι γνωρίζετε για τα βασικά παραγόμενα θεματικά επίπεδα ενός Ψηφιακού Μοντέλου Εδάφους;


    · Ποιες οι μονάδες και ποια τα όρια των τιμών του θεματικού επιπέδου της κλίσης και ποια του επιπέδου του προσανατολισμού εδαφών;


    



    [bookmark: _Toc438361217]ΠΑΡΑΡΤΗΜΑ: ΑΓΓΛΟ - ΕΛΛΗΝΙΚΗ ΤΕΧΝΙΚΗ ΟΡΟΛΟΓΙΑ


    


    A


    Add-ons: Επεκτάσεις λογισμικών


    Allocation: εγγύτητα σε πλησιέστερη οντότητα


    Alternatives (in MCDA): Εναλλακτικές Επιλογές


    Analysis Mask: Χωρική μάσκα περιοχής μελέτης


    Analytic Hierarchy Process: Διαδικασία Αναλυτικής Ιεράρχησης


    Aspect: Προσανατολισμός ή έκθεση


    Attribute: Περιγραφή, Χαρακτηριστικό


    


    B


    Bilinear interpolation: Διγραμμική παρεμβολή


    Binary maps: Δυαδικοί (δίτιμοι) χάρτες


    Breaklines: Γραμμές διακοπής


    Buffer Zone: Περιμετρική ή περιβάλλουσα ζώνη, ζώνη επιρροής


    


    C


    Capability Maps: Χάρτες ικανότητας


    Cartographic Overlay: Χαρτογραφική Υπέρθεση


    Cell: Ψηφίδα ή κελί


    Classification: Ταξινόμηση ή κατηγοριοποίηση


    Clip: Αποκοπή ή περικοπή δεδομένων


    Comparison matrix: Πίνακας Συγκρίσεων


    Consistency Index: Δείκτης Συνέπειας


    Convex Hull: Κυρτό κέλυφος


    Counter Urbanization: Ανάστροφη Αστικοποίηση


    


    D


    Decision Matrix: Πίνακας Αποφάσεων


    Digital ElevationModels / Matrices: Ψηφιακά μοντέλα υψομέτρου ή μήτρες υψομέτρων


    Digital Surface Model: Ψηφιακό μοντέλο επιφάνειας


    Direction: Κατεύθυνση σε πλησιέστερη οντότητα


    Dissolve: Συγχώνευση δεδομένων


    Drapping: Υπέρθεση εικόνας σε ανάγλυφο


    


    E


    Edge Detection Function: Λειτουργία ανίχνευσης ορίων


    Edges: Πλευρές τριγώνων


    Erase ή Difference: Απαλοιφή ή διαφορά δεδομένων


    Extend: Όρια ανάλυσης


    Euclidean Distance: Eυκλείδεια ή ευθεία απόσταση


    


    F


    Field: Πεδίο


    Focal functions: Εστιακές λειτουργίες


    FocalSUM Function: κεντρική λειτουργία άθροισης τιμών


    Foul coupling: Πλήρης σύνδεση (μοντέλων)


    Fuzzy Logic: Ασαφής Λογική


    G


    Global functions: Γενικευμένες λειτουργίες


    Global Range Function: Γενικευμένη λειτουργία εύρους τιμών


    


    H


    Hillshade map: Χάρτης σκιασμένου ανάγλυφου


    Hillshading: Σκίαση ανάγλυφου


    


    I


    Identity: Ταυτοποίηση


    Intersect: Τομή δεδομένων


    Interval (scale of measurement): Διαστημική κλίμακα μετρήσεων


    


    K


    Kernel ή moving window: Περιοχή ή παράθυρο γειτονίας


    


    L


    Layer: Επίπεδο ή θεματικό επίπεδο GIS


    Linear interpolation: Γραμμική παρεμβολή


    Local functions: Τοπικές λειτουργίες


    Loose coupling: Χαλαρή σύνδεση (μοντέλων)


    


    M


    Map Algebra: Άλγεβρα χαρτών ή Χαρτογραφική Άλγεβρα


    Mask layer: Επίπεδο περιορισμού δεδομένων ανάλυσης (χωρική μάσκα)


    ΜΕΑΝ Function: Λειτουργία μέσου όρου


    Merge: Συνένωση


    Minimum Mapping Unit: Ελάχιστη Χωρική Μονάδα


    MultiAttribute Decision Analysis: Ανάλυση Αποφάσεων Πολλαπλών Περιγραφών


    MultiCriteria Decision Analysis: Πολυκριτηριακή Ανάλυση Αποφάσεων


    MultiObjective Decision Analysis: Ανάλυση Αποφάσεων Πολλαπλών Στοχεύσεων


    Multiline: Πολλαπλή γραμμική οντότητα


    Multipoint: Πολλαπλή σημειακή οντότητα 


    Multipolygon: Πολλαπλή πολυγωνική οντότητα


    


    N


    Nodes: Κόμβοι


    Nominal (scale of measurement): Ονομαστική κλίμακα μετρήσεων


    


    O


    Objectives: Στοχεύσεις (επιμέρους στόχοι στην Ανάλυση αποφάσεων)


    Ordinal (scale of measurement): Τακτική ή ταξινομική κλίμακα μετρήσεων


    Overlay: Υπέρθεση δεδομένων


    


    P


    Pairwise comparison: Σύγκριση ανά ζεύγη


    


    Q


    Query: Ερώτημα (σε βάση δεδομένων)


    


    R


    Residuals: Υπόλοιπα μοντελοποίησης


    Remote Sensing: Τηλεπισκόπηση


    Ratio (scale of measurement): Αναλογική κλίμακα μετρήσεων


    RANGE Function: Λειτουργία εύρους τιμών


    Raster layers ή grids: Ψηφιδωτά θεματικά επίπεδα


    Raster model: Ψηφιδωτό μοντέλο


    Resolution: Διακριτική ικανότητα


    


    S


    Sensitivity Analysis: Ανάλυση Ευαισθησίας


    Sliver polygon: Σφηνοειδές ή επίμηκες πολύγωνο


    Slope: Κλίση


    Spatial Alternative: Χωρική εναλλακτική επιλογή


    Spatial Database: Χωρική Βάση Δεδομένων


    Spatial interpolation: Χωρική παρεμβολή


    Split: Λειτουργία διαχωρισμού οντοτήτων


    Straight line: Απόσταση σε ευθεία γραμμή


    Stretching Colors: Συνεχής χρωματική διαβάθμιση


    Suitability Maps: Χάρτες Καταλληλότητας


    Suitability Modeling: Μοντελοποίηση Καταλληλότητας


    Symmetrical difference: Συμμετρική διαφορά δεδομένων


    Surface Analysis: Ανάλυση Επιφανειών


    


    T


    Thinness index: Δείκτης λέπτυνσης


    Tight coupling: Ισχυρή σύνδεση (μοντέλων)


    Tile: Τεμάχιο


    Triangles: Τρίγωνα


    Triangulated Irregular Network: Τριγωνικό ακανόνιστο δίκτυο


    


    U


    Union: Ένωση δεδομένων


    


    V


    Vector spatial model: διανυσματικό μοντέλο χωρικών δεδομένων


    Very Important Points: Κρίσιμα σημεία (περιγραφής αναγλύφου)


    


    W


    Weights: Βάρη ή συντελεστές βαρύτητας


    Weighted Overlay: Σταθμισμένη υπέρθεση


    


    Z


    Zonal functions: Λειτουργίες ζώνης


    Zonal geometry functions: Λειτουργίες ζώνης ανάλυσης γεωμετρίας


    Zonal statistics functions: λειτουργίες ζώνης στατιστικής ανάλυσης


    


    [bookmark: _Toc438361218]Δικτυακοί τόποι με τεχνική ορολογία GIS


    http://support.esri.com/en/knowledgebase/Gisdictionary/browse


    http://www.wiley.com/college/chrisman/glossary.html


    http://wiki.gis.com/wiki/index.php/GIS_Glossary


    http://web.gps.caltech.edu/gislab/Acronyms/Acronyms.html



    [bookmark: _Toc438361219]ΒΙΒΛΙΟΓΡΑΦΙΑ


    ArcGIS for Desktop – ArcMap (Aνάκτηση 27.10.2015) https://goo.gl/OPVwsG


    Baltsavias, E.P. (1999). Airborne laser scanning: existing systems and firms and other resources. ISPRS Journal of Photogrammetry & Remote Sensing, 54(1):164–198.


    Boroushaki, S., & J. Malczewski. (2010). Measuring consensus for collaborative decision-making: a GIS-based approach. Computers, Environment and Urban Systems, 34 (4):322–332.


    Bruns, H.T., & Μ. Egenhofer. (1990). Similarity of Spatial Scenes, in: Kraak, J.M. & Molenaar M. (eds). Seventh International Symposium on Spatial Data Handling. Delft, The Netherlands, Taylor & Francis, London, 173–184.


    Burrough, P. A., & MacDonnell, R. A. (2000). Principles of geographical information systems. Oxford: Oxford Univ. Press.


    Catlow, D.R. (1986). The multi-disciplinary applications of DEMs. Auto-Carto London, 1:447–454.


    Chakhar, S., & V. Mousseau. (2008). GIS-based multicriteria spatial modeling generic framework. International Journal of Geographical Information Science, 22 (11): 1159–1196.


    Chalkias, C., & Κ.Lasaridi, K. (2011). Benefits from GIS Based Modelling for Municipal Solid Waste Management. in: Integrated Waste Management. Volume I, Sunil Kumar (Ed.). 417– 436, InTech. ελεύθερα διαθέσιμο στο: http://www.intechopen.com/articles/show/title/benefits-from-gisbased-modelling-for-municipal-solid-waste-management.


    Chalkias, C., Petrakis, M., Psiloglou, B., & Lianou Μ. (2005). Modelling of light pollution in suburban areas using remotely sensed imagery and GIS, Journal of Environmental Management, 79:57-63.


    Chang, K.T. (2003). Introduction to geographic information systems. Boston, MA: McGraw-Hill.


    Clarke, A., Gruen, A., & Loon, J. (1982). A contour-specific interpolation algorithm for DEM generation. International Archive of Photogrammetry and Remote Sensing, 14(3):68–81.


    Dagdeviren, M., & Ι.Yuksel. (2008). Developing a fuzzy analytic hierarchy process (AHP) model for behavior-based safety management. Information Sciences, 6(178):1717-1733.


    DeMers, M. (2002). GIS Modelling in Raster. John Wiley & Sons.


    Fischer, M. M., & Getis, A. (2010). Handbook of applied spatial analysis: Software tools, methods and applications. Berlin: Springer.


    Fisher, P.& Unwin, D. (2002). Virtual Reality in Geography. Taylor & Francis.


    Forman, E., & S. Gass. (2001). The Analytic Hierarchy Process – An Exposition. Operations Research, 49(4): 469-486.


    Horn, B.K.P. (1981). Hill shading and the reflectance map. Proceedings of IEEE, 69(1):14–47.


    Jankowski, P. (2009). Towards participatory geographic information systems for community-based environmental decision making. Journal of Environmental Management, 90 (6):1966-1971.


    Jankowski, P., Nyerges, T., Smith, A., Moore, T., & E. Horvath. (1997). Spatial group choice: a SDSS tool for collaborative spatial decision-making. International Journal of Geographical Information Systems, 11(6):566-602.


    Jenssen, R. (1992). Multiobjective decision support system for environmental management. Dordrecht. The Netherlands. Kluwer Academic.


    Li, Z., Zhu, Q., & Gold, C. (2004). Digital Terrain Modelling, Principles and Mehodology. CRC Press.


    Llobera, M. (2003). Extending GIS-based visual analysis: the concept of visualscapes. International Journal of Geographical Information Science, 17(1):25–48.


    Longley, P. A., Goodchild, M., Maguire, D. J., & Rhind, D. (2005). Geographic Information Systems and Science. John Wiley & Sons.


    Malczewski, J. (1999). GIS and multicriteria decision analysis. NewYork. John Wiley & Sons.


    Malczewski, J. (2004). GIS-based land-use suitability analysis: a critical overview. Progress in Planning, 1(62):3-65.


    Malczewski, J. (2006). GIS-based multicriteria decision analysis: a survey of the literature. International Journal of Geographical Information Science, 20(7):703–726.


    McHarg, I. L. (1969). Design with nature. NY: Natural History Press.


    Miller, C., & Laflamme, R. (1958). The digital terrain model — theory and applications. Photogrammetric Engineering, 24:433–442.


    O'Sullivan, D., & Unwin, D. (2002). Geographic information analysis. Hoboken, NJ: Wiley.


    Peckham, R. J., & Jordan, G. (2007). Digital terrain modelling: Development and applications in a policy support environment. Berlin: Springer.


    QGIS User Guide http://docs.qgis.org/2.8/en/docs/user_manual/


    Saaty, T. (1987). The Analytic Hierarchy Process: What it is and how it is used. Math Modelling, 9:161-176.


    Saaty, T.L. & Vargas, L.G. (1987). Uncertainty and Rank Order in the Analytic Hierarchy Process, European Journal of Operational Research, 32(1):107-117.


    Saaty, T.L. (1978). Modeling Unstructured Decision Problems-The Theory of Analytical Hierarchies, Mathematics and Computers in Simulation, XX:147- 158.


    Saaty, T.L. (1980). The Analytical Hierarchy Process. New York: McGraw Hill.


    Saaty, T.L. (1996). Multicriteria Decision Making, The Analytic Hierarchy Process. Planning, Priority Setting, Resource, Allocation. RWS Publications, Pittsburgh.


    Shepard, R. B. (2005). Quantifying environmental impact assessments using fuzzy logic, New York: Springer.


    Smith, M.J., Goodchild, M.F., & Longley, P.A. (2015). Geospatial Analysis, UK: Winchelsea, free on-line version: www.spatialanalysisonline.com


    Tobler,W.R. (1970). A Computer Movie Simulating Urban Growth in the Detroit Region. Economic Geography,46, doi:10.2307/143141.


    Tomlin, D. (1990). GIS and Cartographic Modeling. ESRI Press.


    Verbyla, D. (2002). Practical GIS Analysis. London: Taylor and Francis.


    Ανθοπούλου, Θ. (2001). Γεωγραφικές διαφοροποιήσεις χωρικές και κοινωνικές ανασυνθέσεις του υπαίθριου χώρου. σελ. 103-145, στο Ανθοπούλου Θ. & Μωυσίδης Α. (επιμ.). Από τον Αγροτικό Χώρο στην Ύπαιθρο Χώρα: Μετασχηματισμοί και σύγχρονα δεδομένα του αγροτικού κόσμου στην Ελλάδα, Αθήνα, Gutenberg.


    Κουτσόπουλος, Κ. (2002). Γεωγραφικά συστήματα πληροφοριών και ανάλυση χώρου. Αθήνα, Εκδόσεις Παπασωτηρίου.


    Παπαδόπουλος, Α.Γ., Χαλκιάς Χ., Α. Φάκα. (2008). Η επανεξέταση της ελληνικής υπαίθρου μέσα από μια δυναμική μεθοδολογική προσέγγιση. Εφαρμογή με την αξιοποίηση των Γεωγραφικών Συστημάτων Πληροφοριών για την Πελοπόννησο. Επιθεώρηση Κοινωνικών Ερευνών A(125):99-129.


    Παππάς, Β. (2011). Γεωγραφικά Συστήματα Πληροφοριών και Σχεδιασμός του Χώρου. Εκδόσεις Πανεπιστημίου Πατρών.


    Φώτης, Γ. (2009). Ποσοτική Χωρική Ανάλυση. Αθήνα, Εκδόσεις Παπασωτηρίου.


    Χαλκιάς, Χ. (2006). Όροι και έννοιες επιστήμης γεωγραφικών πληροφοριών. Αθήνα, Εκδόσεις ΙΩΝ.


    Χαλκιάς, Χ. και A.Γ. Παπαδόπουλος. (2007). Η συνδυαστική χρήση των ΓΠΣ και της μεθοδολογίας της αναλυτικής ιεράρχησης για την κατασκευή ενός ταξινομικού σχήματος των αγροτικών περιοχών. Μελέτη περίπτωσης. Πελοπόννησος, Πρακτικά Συνεδρίου, 8ο Πανελλήνιο Γεωγραφικό Συνέδριο, 4-7 Οκτωβρίου 2007, Αθήνα.



    [bookmark: _Toc438361220]Βιντεοδιαλέξεις μαθήματος


    Το παρόν σύγγραμμα υποστηρίζεται από βιντεοσκοπημένες διαλέξεις και παρουσιάσεις του Αναπληρωτή Καθηγητή Χρίστου Χαλκιά που δόθηκαν για το μάθημα «Γεωγραφικά Πληροφοριακά Συστήματα ΙΙ» στο πλαίσιο του επιχειρησιακού προγράμματος εκπαίδευσης και δια βίου μάθησης «Ανοικτά Ακαδημαϊκά Ψηφιακά Μαθήματα» και είναι ελεύθερα διαθέσιμες στον ιστότοπο www.opencources.hua.gr.

  

OEBPS/Images/image160.jpg





OEBPS/Images/image063.jpg
2(1/0]0
Eukreiseia [1.4) 4 [ 1 | 0
améoraon
amétkaz (101 (1
1.4/ 1]1.4/ 2






OEBPS/Images/image055.jpg
INPUT 1 INPUT 2 OUTPUT
3[2]0 2[3[s 1[4]s
123 2[00 9 1l2[3
7[1]0 110 6lolo

OUTPUT = Subtract (INPUT 1, INPUT 2)






OEBPS/Images/image012.jpg
Et + b.nuleg (Ax /AY)]
N1 £ b.ouvieg  (Ax / Ay)]
Kal

Ez2 % b.nuleq™ (Ax / Ay)]
Nz * b.ouvleg ! (Ax /Ay)]





OEBPS/Images/image029.jpg
FID | Shape*| Soils | Slope | Veg

3039 |Polygon 508 60 17
3040 |Polygon 508 60 19
3041 |Polygon 508 60 157
3042 |Polygon 508 60 158
3043 |Polygon 508 60 160






OEBPS/Images/image098.jpg
Emotpogr| omy $radpo
[
[ I I |

Xopikég Anacydlnon Anpoypapuar Aypotikoe
ouvoiKkec Suiphpwon FAPUKTIPUS,

Xz Al'[n All2 Al'[“Al'b A|

& AR AR A AN & &






OEBPS/Images/image169.jpg





OEBPS/Images/image020.jpg





OEBPS/Images/image126.jpg
2500
2000
1500
1000
500
000

2(MIKPH)

3(MeskH) 4(MEFARH) 5 (MOAY MEFARH)
KAAZEIZ

——MONTEAD

——3ENAPIO T
——JENAPIO2
- ENAPIO3






OEBPS/Images/image152.jpg





OEBPS/Images/image128.jpg
——ZENAPIO 1

——SENAPIO2
——ZENAPIO3

<
e, F
N

KAAZEIE






OEBPS/Images/image039.jpg





OEBPS/Images/image136.jpg
iakprmii} ikavéma 2x Aiaprmixi) ixavémra x





OEBPS/Images/image170.jpg
VALUE* | COUNT
v g 0/ 40894
1 1e9

Rocord: 14| ¢ 1 | spows[[AT solcted | Records @outof2soketd)






OEBPS/Images/image030.jpg
ToAdywvo (t1) MoAdywvo (t2) Z0vBEn ToAUYWVWY

SQVOEIBA TIOAGYWVQ LETA QT
N Aermoupyia Tng uTrEpBeong





OEBPS/Images/image101.jpg
:{5

s






OEBPS/Images/image144.jpg
2Zmax

2Zmax

{base_value}

Zmin Zmin
{base_value}
{base_value} = Zmin Zmin < {base_value} < Zmax
Zmax
,,,,,,,,,,,,,,,, {base_value}
Zmax
Zmin
i |
e 1 {base_value} Zmin

{base_value} < Zmin

{base_value} > Zmax





OEBPS/Images/image118.jpg
KATAAAHAOTHTA

KPITHPIO AHMOTPA®IKHE AIAPOPQIHE

arton

“askoon ™ o

KATAAAHAOTHTA
MIOAY MIKPH

[ wiken
I vz

W e
I rony MeraH





OEBPS/Images/image004.jpg





OEBPS/Images/image162.jpg





OEBPS/Images/image047.jpg
Gweb s

Go-N-maBE

ST - N
& Random Setection..

g Random Selecon Within Subsets.
£ Random Points...
1 Regutc poins.

Eniire o xopoempaT Tou:
Home

nou BoToupioror xopocTipaTs oc:
Home

X ke Input feturs that touch the selecon fatres

X inchade nput featurs that overap/cros the selcton eaures
X Inchade mputfetures conpletely withn the selecton feoures
X Mévo cndeypivo v

spouprio o cdorts —
S B






OEBPS/Images/image073.jpg
anéoTaon (uétpa)
3 o- 10,000
[ 10,001 - 20,000
[ 20,001 - 30,000
[ 30,001 - 40,000
[ 40,001 - 50,000

I 50,001 - 60,000
[ 60,001 - 70,000
[ 70,001 - 80,000
[ 50,001 - 90,000
I 50,001 - 100,000






OEBPS/Images/image057.jpg
Mean Median Minimum
3.9 3 1
1/2]3
8 3[6]6 9
3/9(2

Max

Range






OEBPS/Images/image108.jpg
ANIAXXOAHZH | ATl | A2 | A3 ZYNTEAEXTET BAPYTHTAZ
All 1 1.00 0.17 3.00 0.1718
A2 6.00 1.00 8.00 0.7530
AIl3 033 0.13 1.00 0.0752






OEBPS/Images/image027.jpg
ERASE FEATURE

-0






OEBPS/Images/image014.jpg
apXIKG TTOAUywvo gwrepikn fovn gowrepikn {wvn





OEBPS/Images/image061.jpg
Output Raster

Input Raster Zonal Raster of Zonal sums
112(3[4 2(2(1]1
5 8 2 1
@l t+ -
5/5|5|5 111]12[2

Output Raster = zonal_sum(Input Raster)





OEBPS/Images/image124.jpg
KATAAAI

.o
W s ez

(METAAH)

EMIZTPO®H ZTHN YMAIOPO
ANAAYZH EYAIZOHZIAZ ZENAPIO 3

HAOTHTA

[ I I Y

KAAZEIZ EKTAZEIZ (km)

2

3
4
5

1070,682973

1119,668871
386,892574
45,239912






OEBPS/Images/image065.png
[

LELT)

B o

D —c 1YY

a

“BeZercBite






OEBPS/Images/image111.jpg
KPITHPIA XQPIKO [ ATIATXOAHEH [ AHMOT'PA®IKO | ATPOTIKO
XQPIKO 1.00 0.50 4.00 6.00
ATIAZXOAHZH 2.00 1.00 5.00 7.00
AHMOI'PA®IKO | 025 0.20 1.00 3.00
AT'POTIKO 0.17 0.14 033 1.00

KPITHPIA LYNTEAEXTEX BAPYTHTAZ

XQPIKO 0.3260

AMAZXOAHZH 0.5059

AHMOI'PA®IKO 0.1137

AT'POTIKO 0.0543






OEBPS/Images/image167.jpg





OEBPS/Images/image002.jpg
EMnvika Akadnpaika HAeKTpoviKG
Zuyypéppara kat BonBiara
www.kallipos.gr





OEBPS/Images/image045.jpg
Provder secfic fter epresson
“FIRST_NA_1" = 'NOMOT ETZANONIKHE'

 c1 i

[ ] womn | sotopne






OEBPS/Images/image075.jpg
Karei6uvon
[ Fat(-1)

B north (0 -22.5)

[ Northeast (22.5 - 87.5)
[ East (875 -112.5)
[ Ssoutheast (112.5 - 157.5)

1]
==
=
=
)

South (1§75 - 202.5)

Southwest (202.5 - 247.5)
West (247.5 - 292.5)
Northwest (292.5 - 337.5)
North (3375 - 380)






OEBPS/Images/image097.png





OEBPS/Images/image142.jpg





OEBPS/Images/image151.png
General] Souce | Dissey  Sywibclogy | Fisds |

21X

e
T
Caia— e e
S ersirera
Contono [ ] | O =] [0t |
Symbol | Range Tsbe T
catomm toana  Sae-0a
im b e e
i s oesh mare
Pty
| AT BERE
(| e dawm  mase.mae
[ | 750 77457 - 798 966064 TR7I5- 790565
bty o
D o oo oama
T,
=

e e






OEBPS/Images/image172.jpg
Layer Prog

General| Source | Extent| Displey | Symbology | Fieids | Joins & Reletes Base Haights | Rendering |
ot
€ Useacorstart v o expresion 1 et s o by
[ | 0
& Ovtan bihs o lyer o urtace:
T N | |

Rasta Resobtin.

€ Loy femre

2 Coarsion
Apply conersion fcor 1o place s i same s s score: [emom =] [ 20000

ofeat
340 offet using  constnt o eressien:

° 3

o] lean





OEBPS/Images/image070.png
L@






OEBPS/Images/image032.jpg
BStes HTPEHHBIINARS & v O

|

B

o e s s Ty

8 toocent: oo

v s X s oo o i O]






OEBPS/Images/image088.jpg





OEBPS/Images/image165.jpg





OEBPS/Images/image076.jpg





OEBPS/Images/image122.jpg
ENIZTPO®H ZTHN YMAIOPO
ANAAYZH EYAIZOHZIAZ ZENAPIO 1

KATAAAHAOTHTA

2 (MIKPH)

I s Mesh)

4 (METAAH)

I 5 oAy MeranH)

KAASEIS EKTASEIS (km’)

2 1122,97883
3 1080,62243
4 260,516464
5 158,366606






OEBPS/Images/image050.jpg
| Xpnayonoite ovo endeypiva yoparmpiamis
Nedio npoopiopod
[shape_Area

Stotsticsoupit
[ T

= 96283
Tom Anseon 137834432.904

17466836177
19266332.7527
sssarsTS2 N
60

| 07372864652
| o povoBy o s
etpoc ss1209010.518
ieanc sz (5
MAnkrporoyiioTeg Ctri+C yia va avTivpdyeTe Ta anotehéoyata ovo clipboard

I o ] [






OEBPS/Images/image148.jpg





OEBPS/Images/image016.jpg
Aikryo ToAUYGVWY
Thiessen
Torywviopog

Delauny






OEBPS/Images/image041.jpg
CEp

m
i
{
|

RLBE=-© 300 B

e

e s b toen
H-

5 8

2./ BGRR S
g 0 s D6 06 0% A B






OEBPS/Images/image105.jpg
Khdoeig Corine (COR) Class Khion (%)

5 Moévipec Kaduépyetes 7 <2

4 Apéoyn I'y 6 2-5

3 Eepoyeveic Tewpyiéc Meployéc 9 5-10

2 BoowGronor (61 ot karmonEa). gy 56371 [ 10-20
Suvvaouoi Ouuvidoue - oddow

3 AN, v 36
(Actucéc Tepoyéc, Bpayaderc xAx)|  Karyopiec 2!






OEBPS/Images/image093.jpg
EmdeKTIKOTNTA h
oe SiaBpwon

Méon

B e






OEBPS/Images/image059.jpg
slele
/ ololo
AEEBEEBEEBB H
slss[s[sls[sla[es] § oF
s[sls(s[s/ss[s/6[s| 3_ 58§
s(s[3[s(s[3(s[s([s| E@ E:5
HEHHHOHOOE TNk
s[e[a|s[a[a[a[a[a[s] S
[a[a|s(s|a[a[a[s[s] 22U 2
e[e[e[e[s[s[s[e[s]s] B2 i:
[E[e[s[E[E[a[E[E[8] E 22e
[S[E[e[8[8[8[8 8 [8] g3t
SER
Q2 o/ Tle
£ S
E3 :

|

MAPATOMENO_B

MAPATOMENO_A

oo oo o =] =[=]=]=

ol o] o]o[®]s]o]o]o]0

o]0 o]ofs]e|o]o]o]0

o[ o] e o[e[=[e[oolo

ol o] o] o m|m]o]o]o]0

ol o] o]o[®][®]| o] o] o]0
ol o[ o]0 o]o]o]0
oo o[ o®[m] o] o] o]0






OEBPS/Images/image024.jpg
INPUT ouTPUT

o | =>||lo






OEBPS/Images/image009.jpg





OEBPS/Images/image007.jpg
AR






OEBPS/Images/image033.jpg
QGIS26.1-Brighton - vector_overlay

f

Esu
T m

feseerein

BS1od AT050PBAYNARS &~ DI

& o o e X bk ooy G B






OEBPS/Images/image026.jpg





OEBPS/Images/image069.jpg





OEBPS/Images/image131.jpg





OEBPS/Images/image153.png
Edge type grouped with unique symbol '

Face elevation with graduated color ram
Face slope with graduated color ramp
Face tag value giouped with unique syt
Faces with the same symbol

Node elevation with graduated color rar
Node tag value grouped with unique syr

Nodes with the same symbol

Add Dismiss






OEBPS/Images/image060.jpg
ENINEAO
ZQONQON

ENINEAO
TIMON

o
z
s
[}
o g
co
o E
L C
(=]






OEBPS/Images/image003.png





OEBPS/Images/image043.jpg
Input layer vector
hellas_kapodistria

XproWonoieire ovo EMAEYUEVa XapOKTIPIOTIKG
Dissolve field

FIRST_NA_1
Output Shapefile

C:/Users/Chris/anafi_vector/Nomoi.shp

X Mpoodiikn anoteAéopatog aTov KapBa

] 0% oK






OEBPS/Images/image086.jpg
Pépata
AkTOypapun

AméoTaon \
amd péuata

AméoTaon amé
AkToypapun





OEBPS/Images/image114.jpg
KPITHPIA

SENSITIVITY 2 (AII - 0,05)

XQPIKO 0.3760
ATIAXXOAHZH 0.4559
AHMOT PA®IKO 0.1137

ATPOTIKO

0.0543






OEBPS/Images/image091.png
z
ol Bl
3% 3

Sum of influence: 0 Set Equal Influence
Evaluation scake(_6 From To By
[Tosby1 = [

@)
[[F:\WEF_POLYKRITHRIAKH ANALYST AND GIS\mapOverlay\52_2

Output raster






OEBPS/Images/image116.jpg
KPITHPIO XQPIKQN ZYNOHKQN

KATAAAHAOTHTA

™

KATAAAHAOTHTA





OEBPS/Images/image159.jpg
st 7] T
|oEmvaere Ponmsn
[Zcnsires ™~ Goriar
ity earciey

Le s [x |

le e o






OEBPS/Images/image138.png
Ax+By+Cz+D =0






OEBPS/Images/image155.png
ol sasc| e ity S |
=

[t oo o vaos ok clsses

g
s Clstsin
Ve [GEIE || NowaBeseuerks
Nomsisin [Te 21| | coer [ =] _ssity
Cotesn

I 7263707 01179, o4 7380205 OIS
[ ensioss 1 0570se. 70101751 20570k

170 Ssa T 121057051 41370
B 100177 2006w 141370 20590757
o0 S0z 20 Sz

T Showclass ks g s oo O ticDaa e £

[






OEBPS/Images/image103.jpg
Kidomg | Aow e + Tivoro Tohoracyshnon
EMIIOPOI (%) | arasyorobvpevey %)
5 >20 > 5000 >40
4 15-20 2000 - 5000 30-40
3 10-15 500 - 2000 20-30
2 5-10 200 - 500 10-20
1 %8 <200 0-10






OEBPS/Images/image095.jpg





OEBPS/Images/image133.jpg





OEBPS/Images/image090.jpg
@ Server Tools

- Spatial Analyst Tools

@& Conditional

& Density

@ & Distance

=& Bxraction

& Generalization

& Groundwater

@& Hydrology

#-& Interpolation

@& Local

& Map Algebra

& Math

=& Multivariate

@ & Neighborhood Ot raater

58 Overlay [F:WEF _POLYKRITHRIAKH ANALYST AND GIS \WmapOverlay\Se_21
2 Weighted Overlay
%

& Raster Creation

& Reclass

i

Concel | [Envionments... | ~show Help >> |






OEBPS/Images/image052.jpg
VALUE | COUNT | Rast | RAS2
1 2 1 []
2 2 1 1
3 1 0 1
1 3 0 0
5 1 1 3
7 1 2 1
7 2 2 2
8 1 4 3
9 1 ] 2






OEBPS/Images/image146.jpg
MHKOTOMH A1-A2

MHKOTOMH A3-A¢
!
A

e

e

MHKOTOMH AS-A6






OEBPS/Images/image005.jpg





OEBPS/Images/image078.jpg
EMIEIPOTNGMONEE

LYNT. BAPYTHTAE (W)

KPITHPIO 3

— ~

KPITHPIO |

KPITHPIO 2

KPITHPIO 31| [KPITHPIO 32

E2

E3






OEBPS/Images/image035.jpg
£

r R —

& v T o 115 X b e i






OEBPS/Images/image120.jpg
KATAAAHAOTHTA

.o
W s e
[« rany

W s con verann

EMIZTPO®H XTHN YMAIOPO

KAAZEIZ EKTAZEIE (km’)

2 1059,70319
3 1123,562982
4 393,978246
5 45,239912






OEBPS/Images/image150.jpg





OEBPS/Images/image163.jpg





OEBPS/Images/image018.jpg





OEBPS/Images/image022.jpg
INPUT OUTPUT

2> o






OEBPS/Images/image048.jpg





OEBPS/Images/image037.jpg
o et e i s [T
OBBBRR 4 0% s s 22 Go - F-mamEET 2 B B
2/ BRBRS>D O

0 08 1206 % 06 % @ [n 0
o

Ve
L
.
a
»
-
L3
@
e
@
%
A\
&
o
o
e
w2
L]

' oot i o o e e TR B






OEBPS/Images/image067.jpg
Sand
AND

Dry

£(=






OEBPS/Images/image054.jpg
(o
S
Y

A
P
N

B &2
NI

cvvekTIKéTITE ovvTekeoTég

£3Ggovg A BapdTag (W)
9 xoM x1
5 uéon x1
1 xaki x1
mEpaTOHTNTA
£dagovg
9 koA B x2
5 uéon x2
1 xoxi x2
npocPacipoéTa
9 Kahj C x1
5 péon x1
1 xoxn x1

(A* wA) + (B* wB) + (C* wC)





OEBPS/Images/image084.jpg





OEBPS/Images/image071.jpg
[X Nopata
ZoneRASTER ValueRASTER
Rowid | VALUE [COUNT|AREA| MIN| MAX [RANGE|[ MEAN| STD |SUM|VARIETY | MAJORITY |MINORITY [MEDIAN|
1 [ 5 s| o] 2 2| 06| o8] 3 3 [ 1 [
2 1 5 5| o] 3 3 11095 5 3 [ 3 1
3 2 3 s 1] 2 1| 1.667] 0471] 5 2 2 1 2
4 4 1 1 8] s 0 3 o] 3 1 3 3 3






OEBPS/Images/image129.jpg





OEBPS/Images/image135.jpg
X-Y cooRrDINATES EDGES NODES
node# coordinates A adjacent A A node #
1 x1,y1 A B, K A 1,6,7
2 X2,y2 B AGCE B 1,7,8
3 B c  BD c 1,28
° D C.E D 2,3,8
u xdlyll E  DFEL E 3,89
F E G F 3,4,9
G EH M G 4,910
Z COORDINATES H G,1 H 4,5,10
node# 7_value I HJ.N I 5,10,11
1 21 J LK J 5,6,11
2 z2
5 5 K AILN K 6711
. L B,E.M L 7,8,9
M M 7,9,
1n 211 G,L.N 9,10
N LK.M N 7,10, 11






OEBPS/Images/image038.jpg
QGIS26.1-Brighton - vector_overlay.

o i o o v e ot s e ten
|DRBRRR 0% 8 ee-E-memaERe
2/B2BAGH=s D

AR R
o

BS1ed BILEH8889NA

anteson ot 2100 B(8) 4






OEBPS/Images/image157.png
[Lorerroperics 21|

[Diam st steching vahes olang o color 1omp

oo Vs
B e
wrE o

oo [ ]

P»- e — |
=

T Oiplay BockgoundVake: [ 0 as \:l

Display NoData as H

o1 o | o






OEBPS/Images/image080.jpg





OEBPS/Images/image011.jpg





OEBPS/Images/image119.jpg
KPITHPIO ATPOTIKOY XAPAKTHPA

KATAAHAOTHTA
!

-

B

—B

- e e Kfters
- - o F o -

o

™

“askoon

KATAAAHAOTHTA
| noavmikeH

[ ke

B ez

B veran

I rony MeraH





OEBPS/Images/image046.jpg
QGIS2.6.1-Brighton - ATKHEH 2.1

BS et BTS00 BYNANS 58I

Raser s oo
OBPLIAPPLRARKR QG-
SRS Rs =

EE'. 20 E- BN

A sstmon el
 Tewerpia o

4/ e

s
Gaer
St [| moworeczmreras
o Nowor oizanon
veleny | | wowor inannin
fiveyed] o)
ot e

P S S E]"“““"' oL

s

el

eiRstAL" = owos essEAONIKE'

seonsssssrs

=
LA /{-;'4
2o

oro 114954265 =] X Botwooksoxoonsxipm_€r5c2100





OEBPS/Images/image100.jpg





OEBPS/Images/image089.jpg
ZYNTEAEZTEZ BAPYTHTAZ

Vegetation  Lithology ~ Slope Aspect  DistStreams  DistCoast

Zevdplot 0.16 0.16 0.20 0.16 0.16 0.16

Zevdplo2 0.1 0.2 0.4 0.1 0.1 0.1






OEBPS/Images/image072.jpg
VALUE | COUNT | MAJORAXIS | MINORAXIS | ORIENTATION
0 1 1 1794734 1.418862 45
1 2 1 2.16291 0.883004 161.565
2 3 1 1.758311 1.08619 23.42381
3 4 1 1.286074 0.742515 45
4 5 1 2.578082 0.987742 0
5 7 1 1.128379 1.128379 90

d = ZONALTHICKNESS Tou Polygon1





OEBPS/Images/image021.jpg
OUTPUT
CLIP FEATURE

+ 0>






OEBPS/Images/image099.jpg
ZovBera KpiTpIa

Mpwroyeveig peraphnréc.

BnHoypagid

ek ypavong (65° 7 15)
Seikmg eGdpONg (65" + 15 / 16-65)
% peravaoTiV

‘ATaoxeAong

% GTIAOXOROUHEVY WG IOIKNTIKG OTEAEXT KAl EMTIOpOI (010
GUVOAO TwV AMaOKOAOGEVN)

(o STehéxn, EmoTioves, Emopol, YTGMahor
Tpageiou)

9% TIOAUATIGOXOAOUREVALY (OTO GVOAO Tev GTTAGYOAOGHEVEON)
S0voho ATragyoAoGHEVIWY

XupiKg

MEon KNion e3090V
'XpovoaTI6aTaON G KUPIOUS OIKITHOUS
XpovoaméaTaon amd akroypap

AYpoTIKG

XpoeiG VG KaTé CORINE
Méon khion eBagiv





OEBPS/Images/image109.jpg
AHMOTPA®IKO

Al

A2 A3 ZYNTEAEXTET BAPYTHTAZ
Al 1.00 033 6.00 0.2895
A2 3.00 1.00 8.00 0.6463
A3 0.17 0.13 1.00 0.0641






OEBPS/Images/image110.jpg
ATPOTIKO ATl | AT2 SYNTEAELTEE BAPYTHTAZ
AT'1 1.00 6.00 0.8571
AT 2 0.17 1.00 0.1429






OEBPS/Images/image056.jpg
Gridin GridOut

2|0|1(1 7/8|/9|6
2 3 04 13(16|16|11
4(2|2|3 » 13|1820(|14
1/1[3]2 8 [13[13[10

Gridout = FocalSUM_3X3(Gridin)






OEBPS/Images/image145.jpg
mapampnTg

o

o ywvia 8éaong

OpATES TIEPIOXES
w—QOPATES TTEPIOXEG

KaBopiopég opatémTag o€ DTM






OEBPS/Images/image161.jpg





OEBPS/Images/image139.png
z1

24
z4

213 = [(R-b)R * (z3-z1)] + 21
224 = [(R-b)R * (24-22)] + 22

z=[ (a/R) * (224 - z13)] + z13





OEBPS/Images/image013.jpg





OEBPS/Images/image127.jpg
KAAZEID EENAPIO 1 | ZENAPIO 2 | ZENAPIO 3
2 241 175 042
3 -1.64 273 0.15
4 5.09 098 027
5 431 0.00 0.00






OEBPS/Images/image044.jpg
QGIS2:6.1-Brighton - ATKHEH 2.1 - o=

eotes s v, s siben
QS PLAAPPLRAAR G- -R-KeaBE=-O 32 @3- B%
/BB G bl T 5 3 B

08 U8 8|5 (% 06 M A b 12

e
R

suresmasns o 124954305 =) X dobwoois oxoonsytpm (7






OEBPS/Images/image001.jpg
I'eoypa@wn Avaivon pe
v afomoinon

™™g N'eominpoopuxiic

Xorkuag XpicTtog

Geographical
Analysis

==

=






OEBPS/Images/image171.jpg
| e ot vew pocknats soeten Tock wndow t
[DEE8 + »PX $BA&BDNR[+~@04GAAXLIOEN 0N






OEBPS/Images/image082.png
AT AP TOr PSR YTEPOE ATIA KANONET (QUERIES) HATAOT
(ENAI TTAGMTMENEL |- Aoumwor auor o
NEWBMTED X AGPOTH METABAHTON)
TRGUTNERTAPTOASH ~KAGOPIIMOT BIAGOPETIKH BAPYTHTA
YMEPOETH (Ui ENAR | Tzooen: Tow uETBANTON K
ITAGUIMENEE ETABAMTER) AN EXTIHIN THE KATAAOTHIAL

KAGOPZMOL TIWON KA!

'AGPOTMATOLTON o ENMERIA EPEVNHTH
ATHTAL

ZWe10)

IYNTEAELTON BAP
(@YNHORZ W =1 ¥

TATIETION ANAAYIH 7. TAANAPOMIIH, MEGOBO ANAKYTIKHE EPAPYOIH.
Ahowz ron

o TASNOMNI (ANONYTH - IXETHKH KAMAKA)

eIz ONTIKONOIZH POUATIH BABAOUTH
ANOTEAEIMATON KATAMAAOTHTA - M KATARKAGTHTA

« rvusonzuor —f3 KATAMIAO

YN - BAKPITOT TYMBONTHOT

MIKPOAMATEX I TWEE TON
EMANATAZNOMHMENGN HETABATON

MIKPOAMAATEX ITOVE IYNTEAELTEL
B THIAL

MEAETH - NEPITPAGH BIAGOPONOIHE 170 TEAKO TAPATOMENO 0T
VNN MIKPON AATN ETHN TAZNOUNIN WKAITTOVE
TYNTEAELTEL BAPYTHTAL TON METABANTON

werpyzEn

Eunen enwm






OEBPS/Images/image137.jpg
Tlpotoyevi dedopéva T

AIOPOQEEIL
DEM i TIN
Topdyoyes 1wobyeis Xapaxmpiotixd.
onueia
e P———— SOAAMATA
o fi dedous
siadiaalllon o OXIZPAAMATA






OEBPS/Images/image074.jpg





OEBPS/Images/image031.jpg
D)ﬁshp

GPS. »
OpensStreetMap »
Road graph »
Spatial Query »
“Eheyxog Tonohoyiag, »
KaTaypagi ZuvreTaypévng L

4 epyarsio Avahuong
sk Epyakeia Epeuvag

& Epyohsia rewpenpiog
S Epyahsio Aaeipiong AsBopiviv

@Web Processing  Wngidwrd

1T

@ Convex Hull(s)...
P Buffer(s)...

i Eliminate Sliver Polygons...






OEBPS/Images/image087.jpg
Anéotacn ané vsp. Sikwo

Values (m) Ems. oe AiBpwon
050 9
50-100 8
100-250 5
>250 1

Anéotacn and aktoypappr

Values (m) Ems. o¢ AiBpwon
0200 9
200-500 5
>500 1
Khioeig
VALUES (°) Emus. oe AiBpwon
05 1
510 3
1025 H
25-40 7
>40 9
Npooavarohioués
VALUES (*) Ems. oe MudBpwon
N6Tog (NA - NA) 8
BopeLog (BA - BA) 7
Mo 4
BAGotnon
Nepwypadi / CLASS Ems. o¢ AiBpwon
Mowdng /82 8
IkAnpoduANKii / 12 4
ABohoyia
Nepypadr / 1D Emus. oe AdBpwon
AMobpia/1 9
Mdpyec/3 7
AoBeotohBot / 2 3






OEBPS/Images/image015.jpg
Zuvn yopw aTro oneia
(B£aeig deypaToAniac)

Zdveg peraAnTol TAGTOUS
YUpW aTrd YPAPUIKEG OVTOTNTEG

Zdvn yOpw amé ypappég
(oBikoi Ggoveg)

Line

Buffer

PR TR

2
30
30
20
30
50

Polygon| Inside

ToMaITAEG Ziveg yipw
amé oAGywva






OEBPS/Images/image028.jpg
Aerovpyia Apluos | Tomog Tonog Tupaydpeva
eunédov | dedopévov | mapayouevoy
106800 106300 Sedopévoy
Tavronoinen / Mo Onotoediote | Hokbyave Ot apwés oveomes diazopiloviat e
| Identity | | Plion g vmepudépeves ovidureg
Toprj / Intersect Abo OROWGATOTE | TOHQOVY e T LTPODYTAL PVO 01 OVIOTTES Ot OTOlES
REpIoCOTEPE Sedopiéva sivan Kowég i ha o dedopéva ei0650u
£106500
Topperpuci Abo Tokbyova Tlohbyava AWTPODYIAL H6VO 01 OVEGTTES 01 0T0leS
Awgopd / Bev eivn Kowég 1106k 10 Sedopéver
Symmetrical £106300
difference | ) | )
“Evoon /U Mo Tokbyove | obugovapete | Almnpobviat Gk ta Sedopiéva 166500
REpLoCOTEPE Sedopéva,
£106500






OEBPS/Images/image092.jpg
s1.1

[ Aopee & I Divem (& bl V5 [Sopal> 15—
(Ve 431 Dol

= el ool
{2 S S e
R Y






OEBPS/Images/image107.jpg
XQPIKO X1 X2 X3 ZYNTEAEXTET BAPYTHTAZ
X1 1.00 0.11 033 0.0698
X2 9.00 1.00 6.00 0.7644
X3 3.00 0.17 1.00 0.1659






OEBPS/Images/image125.jpg
KAAZEIE MONTEAO | EENAPIO 1 [ SENAPIO 2 | ZENAPIO 3
2 (MIKPH) 40.41 4282 42.16 40.83
3 (MEZH) 42.84 4121 40.11 42.69
4 (METAAH) 15.02 9.93 16.00 1475
5 (TIOAY METAAH) 1.73 6.04 1.73 1.73






OEBPS/Images/image168.jpg
21X

Hillshade of TopoToR_
[Recless of Aspectof Tc
Slope of anafidem

Slope of TopoToR_cor
TopoToR_contl

[Viewshed of Points_of I

‘ >

8 = [ o | And
5 > | > | or
2 < | e [ xor

§ )| [Net

[(RecLslope

About Bulding Expressions

Evaluate

Cancel

T & [Recl Aspect] = | & [Recl Viewshed] - I[Recl DistnceToCoas]=1 =]

|
=






OEBPS/Images/image058.jpg





OEBPS/Images/image062.jpg
APXIKO ENINEAO MAPArOMENO ENINEAO

456 | 416 | 364 | 326 | 243 451 451 451 451 451

448 364 | 315 | 276 | 218 451 451 451 451 451
Global_Range

359 325 | 268 | 234 164 ; 451 451 451 451 451

306 296 | 201 133 44 451 451 451 451 451

274 | 231 184 65 5 451 451 451 451 451






OEBPS/Images/image112.jpg
_—
[Fonme 20
ome (&) |
CL i
i
g &
[ain|o]n]=in)

e .0 SR .13 R 46050






OEBPS/Images/image173.jpg





OEBPS/Images/image025.jpg
INPUT ouTPUT

5 [






OEBPS/Images/image130.jpg





OEBPS/Images/image068.jpg





OEBPS/Images/image042.jpg
“ QGIS26.1-Brighton - ATKHIH 2.1
o e tomoom e P (it Lot fas by O g Vrrs ol
DeBERRR [0%2L APPRAAR Ga-N-aeBE=-
A/BRAARIE " ERERRR &

08 (08 (s % 06 0% A (4 02

BS e BT0E0880YNANS






OEBPS/Images/image085.jpg
EMQAVEIGY

MpocavatoAiopdg

(¢éxBeon) emPaAVEIWV






OEBPS/Images/image156.jpg
£
4
&
I
H
H
g
Hy

1704 - 1031

1031 - 1361

[ 1361 - 2361






OEBPS/Images/image113.jpg
KPITHPIA SENSITIVITY 1 (Al + 0,05)
XQPIKO 0.2760
ATIALXOAHEH 0.5559
AHMOT PA®IKO 0.1137
ATPOTIKO 0.0543






OEBPS/Images/image051.jpg
2] i1 [ reeses piion Tng
Tpappr 1|2 | 1| 1 (12 |1]1 3 ﬁtg;);é'
izzzz 211 J Léhn
(11 l1l1l1lz211]1 TMivaxag AvrioToixiong
tfrfrf1j1f2]1]1
TipA .
Wneisag | 1| 1| 1|11 [2]1]1][]]~¥neida
X[z
4 Wnodwra
Lirjprjrjigzg1|1 BepaTikG eTiTedQ
L






OEBPS/Images/image094.jpg





OEBPS/Images/image143.png





OEBPS/Images/image158.jpg





OEBPS/Images/image123.jpg
EMIZTPO®H ETHN YMAIOPO
ANAAYZH EYAIZOHZIAZ ZENAPIO 2

KATAAAHAOTHTA
| RO
I 3 mezH)
[T 4 ueranv)

10 20

I 5 (TONY METAH) e et i

KNAZEIZ EKTAZEIX (km’)

2

3
4
5

1105,704061
1051,884567
419,65579
45,239912






OEBPS/Images/image106.jpg
AekTiKOG Mpoodiopiopdg olykpiong

ApiBunTIKA KAipaka

AmoAuTa TpoTIunTéD

loxupd - ardéAuTa TPOTIUNTED
loxupd TpotiunTtéo

MéTpia - IOXUPG TTPOTIUNTED
Mérpia TpoTiunTéo

EAagpd - pétpia TpoTipnTéo
EAa@pd mTpoTipntéo

E¢ igou - eAa@pd TpoTiunTéo
Eg ioou wpoTipntéo

AaNvwROONDO






OEBPS/Images/image132.jpg
AvarrapéoTaon avayAigou
pe 1000yeig KapTroAeg

-
01 02 03 04 05 06 0708-09_10 11
.

08 09 10 15 20 28 35 41 48 50 51
08 09 11 14 19 25 34 40 47 52 55
0,12 15 18 15 25 33 38 48 51 52
12 1?‘5&~l7 20 15 33 40 47 50 51
20 20 20 23-30 32 38 40 45 50 51
25 24 26 30 32°2,41 44 47 50 53/
31 30 32 35 38 40 4165 50 52 53/
38 37 39 39 40 41 43 49 51.53 S6|
42 41 42 44 45 48 49 S0 52 5157,

o1
02
03

[
06

383

AvamrapéoTaon avayAipou
HE YNIaKS HOVTEND EBGQOUS






OEBPS/Images/image017.jpg
al QGIS26.1-Brighton - vector_overlay.
e s o e naons. e ————

Go-HRaBEs-©

o Pooyuvo Voronoi
[ ——

@ oo T T i)





OEBPS/Images/image149.jpg





OEBPS/Images/image064.png
e £t View Bookmarks e Selection Lools Wdow Holp
D tew o [glf@m o
@ Open. Qo0
o sove Ctrles

e

e
B, |

e
Frere—

[ PrintPreen-.
& pioe..
' DocumentPreperes..

spatil ot + | Loy [Vevroda Foomen <] 73 I

Importfrom Arciew poject..
Export ap.

LR e——
20maich.\Map Of Gvdosmud
20\mich 201.\Prejec0id mad
40w folder G1\BXmsd

5 DAmsch_.\preject Erosion
§CAGRIEXLmed

it AR






OEBPS/Images/image081.png
APXIKEE
ENEZEPrATIEL

o METATOWATINOI (X RASTER - VECTOR)
© ETANATASINOMNIELT (1X TYTXONEYIH KATHTOPION)
 TPONONONTER XOPIKHT MONABAL (1X AMATH METEOOTE WHOIAAT)

Enezepraner
AEYTEPOTENON

METABAHTON

DTS =5 OPRTOT A RO GRToTT

oo ] TAsEoN

4.
— o
(i) o IS

“TYNHOGE NOIOTIKEL KAIOZOTIKEE KANAKEE OMOTENONOIOYNTAITE.
ENAIA TAKTION KABIAKA





OEBPS/Images/image077.jpg
KAOOPIZMOE TOY MPOBAHMATOE
KAITON ZTOXON

T

TPOZAIOPIEMOE KPITHPIQN,
THEPIOPIZVMON KAI
ENAAAAKTIKON ENIAOTON

0

ATIOTIMHEH KPITHPION,
[IPOTIMHEEQN AHIITON ATIO®AZHE

!

EMIAOTH MEOOAOY

—

KAOOPIZMOE EYNTEAEETON
BAPYTHTAZ

e —

ANAAYEH AZAGEIAT
EYAIZOHEIAT

——

TEAIKEE [IPOTAZELS






OEBPS/Images/image034.jpg
OBBRIE $0% 4

L./ BB R G B
(TR LR

SS'BDDJJ?J\JF‘

WS e 5B






OEBPS/Images/image140.jpg
£¢. kMong = V((dz/dx)? + (dz/dy)?) abce

omov ta dx,dy,dz vroroyilovrar amd éva kvntd 3X3 mapddvpo def
ghi

dz/dx =((a+2d +g) - (c +2f+1)) /(8 * andotacn onueiov katd tov GEova X)

dz/dy = ((a +2b +c) - (g +2h +1)) /(8 * andotacn onpeinv katd Tov dEovoa. y)

«\ion oe poipeg = *hion % = (y /x) * 100

/X =509
Aﬁ i

X
«\ion og poipeg =30° Khion ot poipeg =45°
whion % =58 whion % =100






OEBPS/Images/image008.jpg





OEBPS/Images/image166.jpg





OEBPS/Images/image019.jpg
|

3
L 4
B.





OEBPS/Images/image079.jpg
NEPITPAOH | TMEPITPAOH | NEPIFPA®H rPAGH TEAIKH
1 2 31 32 ATIO@AT]
NAPATOMENO | APATOMENO | IAPATOMENO [ IAPATOMENO
El TA-1
1-1 1-2 1-31 1-32
B2 TIAPATOMENO | TAPATOMENO | IAPATOMENO [ TAPATOMENO e
- 2-1 2-2 2-31 2-32 )
0 PAFOMENO | TAPATOMENO | APATOMENO | [IAPATOMENO -3
3-1 32 3-31 3-32
MPOTIMHEEL: Wi w2 Wil waz






OEBPS/Images/image141.png
RAIZEIZ






OEBPS/Images/image102.jpg
Xpovourbotacn and

Xpovourdotacn omd

Khdiome: | Khio (%) oIKiopobG (min) axtég (min)
s <2 0-10 0-15
4 2-5 10-20 15-30
3 5-10 20-30 30-45
2 10-20 30-45 45-60
1 >20 >45 >60






OEBPS/Images/image096.jpg
R e R sz

Tl oW i






OEBPS/Images/image083.jpg
 Aeaiss Coordnate Sytem

(& sty cutout wil b saved nthe same coordnate
ystem s the nput forft st  thre e
mitpe rputs)

L [ I Rge






OEBPS/Images/image115.jpg
Khdose | Aot ek + Tivoko TMoharacydknon
S| EMIIOPOI (%) | aracyohoduevey %)
475 >20 > 5000 > 40
425 15-20 2000 - 5000 30-40
3 10-15 500 - 2000 20-30
2 5-10 200 - 500 10-20
1 <5 <200 0-10






OEBPS/Images/image104.jpg
945% | ripmmgtan) | i | Mt
5 <10 <045 >11
4 10-12 0.45-0.50 -9
3 12-15 0.50-0.55 9-7
2 15-20 0.55-0.60 7-5
>20 >0.60 <5






OEBPS/Images/image134.jpg





OEBPS/Images/image117.jpg
KPITHPIO AMAZXOAHZHZ

£ B £

arton

“askoon ™ o

KATAAAHAOTHTA

I rony veraH





OEBPS/Images/image010.jpg
Stafepd miog
Chvne =100

@

Inueio

TTayog (bvng

100

100

150

170

®_ B
®E
O

O,






OEBPS/Images/image121.jpg
EMIZTPO®H XTHN YMAIOPO

] ]
§ KATAAAHAOTHTA §
| ECG KAAZEIZ EKTASEIS (km’)
MIKPH  1475,069739
§  MeEM 77040138
S METAAH  377,013453






OEBPS/Images/image154.png
Genecol Souce | Eent | Display | Symboloay |

DaaSouce

[o30 Type ot
[Flde Nesthav_g30hartuscrepath
[Fser devod.

st Ferarert

|Coordnse Syaen:

Nuberdions 430

Nunberof courns: 16

Horberof b 1
Heekae ;o ediae: 00000
Soscetpe  conievous Congesiors e
Duavpe  fowmpsont Ovacepn by 2
Caomap st P e
S

Bond TR -

Mo 347383 Menmuac e

Mo 12766540 Siddev S5

Coes 0






OEBPS/Images/image040.jpg
LA KA T

T TEEEEETT
Ve

BS e BT0EHH80YNS

St Geomecis..

[ei—
5 vt sigeours.
e

s k5 X i sabemmion 0% O]






OEBPS/Images/image053.jpg





OEBPS/Images/image147.jpg





OEBPS/Images/image066.jpg
\ Raster Calculator

Map Algebra expression

Layers and variables.

Ooen

Output raster

[ CitemplOutputDEMer ] 8|

[ ok [ comel | [Enviconments...] [ ShowHelp>> |






OEBPS/Images/image036.jpg
=3 oy e —
OEBROR 0@ 8 eo-EM-samEE” ¢
PIBEAER*D
18 08 (406 % 05 2 |

&
% eommTa
< [ |
3
»
e
-
@
@
@
5
i
3
+
3
)
[]

e T e R e B






OEBPS/Images/image023.jpg
INPUT ouTPUT






OEBPS/Images/image049.jpg





OEBPS/Images/image006.jpg





OEBPS/Images/image164.jpg
p 4 CAL
ke





